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To check for recent updates or to verify that you are using the most recent edition of a document, go to:
https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=.

This site requires an HP Passport account. If you do not have one, click the Create an account button on the
HP Passport Sign in page.

Support
Visit the HPE Software Support website at: hitps:/softwaresupport.hp.com

This website provides contact information and details about the products, services, and support that HPE
Software offers.

HPE Software Support provides customer self-solve capabilities. It provides a fast and efficient way to
access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the support website to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HPE support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To register for an HP Passport ID, go to hitps:/softwaresupport.hp.com and click Register.

To find more information about access levels, go to:
https://softwaresupport.hp.com/web/softwaresupport/access-levels

HPE Software Solutions & Integrations and Best Practices

Visit HPE Software Solutions Now at https://softwaresupport.hp.com/group/softwaresupport/search-result/-
[facetsearch/document/KM01702710 to explore how the products in the HPE Software catalog work
together, exchange information, and solve business needs.

Visit the Cross Portfolio Best Practices Library at https://npln.hpe.com/group/best-practices-hpsw to access a
wide variety of best practice documents and materials.

HPE Operations Manageri (10.10) Page 3 of 307


https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=
https://softwaresupport.hp.com/
https://softwaresupport.hp.com/
https://softwaresupport.hp.com/web/softwaresupport/access-levels
https://h20230.www2.hp.com/sc/solutions/index.jsp
https://h20230.www2.hp.com/sc/solutions/index.jsp
https://hpln.hpe.com/group/best-practices-hpsw

OMi User Guide

Contents

Part | INtrodUCtioN .. 9
Chapter 1: Navigating and Using OMi ... . 11
Chapter 2: Logging into OMi ... L 12
Chapter 3: My ACCOUNt .. 16
Chapter4: User Engagement . ... 17
Chapter 5: EVents .. 22

EVENt POty L 23
Event Correlation il 25
Event History ... . 26
Chapter 6: Event Browser ... 28
Configuring the Event Browser .. 44
Filtering by Views and View-Based Authorization ... ... .. ... ... 45
Assigningan EventtoaUserorUserGroup ........ ... ... 46
Relating Events Manually ... ... .. 47
Creating Correlation Rules from Manually-Related Events ... ... .. ... ... ........... 48
Launching Operations Orchestration Run Books ... ... . .. ... ... ... ........... 53
Viewing Closed Events ... ... 54
Exporting Event Data ... .o e 56
Event Details ..o L 57
General il 57
Additional INfo . 61
Source INfO L.l 63

A ONS 64
ANNOtatioNS . 65
Custom Attributes ..l 67
Related EVeNts ... il 69
HIS Oy < 71
Resolver Hints . il 72
INStrUCHIONS .. L 74
Forwarding ... ... . 76
EVeNt Fil OIS L 78
Filtering Methods .. il 79
How to Filter Events by Views ... .. 80
How to Filter Events by Configurationltems ... ... ... ... ... ... 81
How to View and Apply Event Filters ... . 81
How to Define Simple Event Filters ... ... 82
How to Define Advanced Event Filters ... .. .. 83
How to Share Event Filters ... .. 85
Filter Manager User Interface ... .. 85

HPE Operations Manageri (10.10) Page 4 of 307



OMi User Guide

Select an Event Filter and Manage Event Filters DialogBoxes ........................ 86

Simple Filter Configuration Dialog BoX ... ... oo 87
Advanced Filter Configuration Dialog Box ... . ... 90

Edit Expression Dialog Boxes for Advanced Filters .................................... 96
Operators Used in Filter Configuration DialogBoxes ... ... .. ................. 100
Troubleshooting and Limitations ... ... . . . L 102

Event Closing and Archiving Tools ... . . e 103
opr-archive-events Command-Line Tool . .. ... e, 103
opr-close-events Command-Line Tool . ... .. 105
Chapter 7: Health ... L 109
Event Type INdicators . . 109
Health INdiCators ... . o L 110
HI-Based KPI Calculations ... 111
ANNotation ToOl ... 114
Drilldown 10 SIteS COPE . 117
How to Find Visible and Hidden Child Cls ... ... . . 118
Service Health Components ... .. 119
Business Impact Component ... . 121
Changes and Incidents Component .. ... L 123
Custom Image CompPONeNt . . ...l 127
Geographical Map Component ...l 131
Health Indicator Component . ... .. . 139
Health Top View Component . . ... 142
Java-based Health Top View Component ... ... . . 146
Hierarchy Component ... .. 149
Neighborhood Map Component ... ... .. 160

Top View Component .. 165
Java-based Top View Component ... 171
Topology Map Component .. ... . 177

View Explorer Component ... L 184
Watch List Component . ... L 187
Chapter 8: ACHIONS ... 191
Chapter O: TOOIS ... L 195
Chapter 10: ViEWS . 198
Part Il: My Workspace ... ... 200
Chapter 11: Monitoring Your Environment With My Workspace ................................. 201
Predefined Pages ... .. 202
Available CompPONEN S ... 204
My Workspace User Interface ... ... o o e 209
My WoorkSpace ... il 209

Page Gallery Dialog BOX ... .. ..o 212
Component Gallery Dialog BOX . ...l 214
New/Edit Component Dialog BOX ... 216

HPE Operations Manageri (10.10) Page 5 of 307



OMi User Guide

Wiring Dialog BOX . ... ... . 218
Chapter 12: How to Set Up My Workspace ... .. ... . 220
User Permissions iNWoOrkSpaces ... ... o oo 222
How to Configure Page Layout —Use-Case Scenario ..o . 222
How to Create an External Component ... .. . 225
How to Create a Component Using a Dynamic URL —Use-Case Scenario ................ 226
How to Set Up Wiring Between Components ... . 227
How to Modify Page and Component Categories . ... ... ... i, 228
How to Modify the Maximum Number of Pages ... .. .. .. ... ... ... 229
How to Enable the Screen Capturing Applet ... . ... 229
Troubleshooting My WOrkspace . .......... L 230
My Workspace pages and components are missing ... . ..., 230
Part lll: Dashboards ... ... 231
Chapter 13: Monitoring Dashboard .. ... .. 233
Chapter 14: 360° VieW ... 242
Chapter 15: KP1 Over Time Dashboard . . ... e, 243
Chapter 16: Return On Investment Dashboard . ... . ... .. 247
Part IV: Operations CoNnsole ... .. .. 252
Chapter 17: Event Perspective . . ... L 253
Chapter 18: Health Perspective . ... ... L 254
Chapter 19: Performance Perspective . ... ... L 255
Understanding OMi Performance Dashboard ........ ... 255
VW EXPIONOr 255
Performance Pane ... . 256
Configuring Performance Dashboard ... ... ... 256
Configuring Rows and Charts ... ... ... 259
CoNfigUIE ROWS 259
Configure Chamts ... . 261
Date Range Panel Option .. ... 262
Editing Charts ... .. 263
Getting Started ... 274
Task 1: Creating Performance Dashboard ... ... ... ... . ... 274
Task 2: Configuring Performance Dashboard ... ... .. .. . ... 274
Task 3: Launching Performance Dashboard .......... ... .. ... ... ... ... 274
Designing Performance Dashboard . ... ... 275
Creating Performance Dashboard ... ... .. 275
Configuring Performance Dashboard ... . ... 275
Editing Charts . 276
Visualizing Events in the Performance Dashboard ... .. ... ... ... .. ............ 280
Managing Different Multiple Instances across Systems using Instance
Parameterization ... . 281

HPE Operations Manageri (10.10) Page 6 of 307



OMi User Guide

Managing Performance Dashboard . ... ... ... .. . . ... 282
Launching a Performance Dashboard . ... ... .. 283
Saving a Performance Dashboard ... ... .. 284
Exporting a Performance Dashboard ... ... .. ... 284
Importing Graph Templates ... ... 285
Duplicating Chamts 285
Importing a Performance Dashboard . . ... ... . L 286
Sharing a Performance Dashboard ... ... . ... 286
Adding and Using Favorites ... .. .. 287
Data Forwarding to Business Value Dashboard (BVD) ... .. ... ... ... 288
Using the Date Range Panel to Visualize Time-Specific Data ........................... 288
Using the Dashboard JSON . ... 289
Deleting a Performance Dashboard ... ... ... .. . ... 290
Visualizing Real-time Data .. ... ... L 291

Data SOUICES .. 292

M NS 293

Troubleshooting . .. ... . 293
TrAC NG . L 293
LOg FileS . 293
Troubleshooting Scenarios .. ... ...l 294

Chapter 20: OMi Health Status . .. ... L 304
Send Documentation Feedback ... ... ... 307

HPE Operations Manageri (10.10) Page 7 of 307



OMi User Guide

HPE Operations Manageri (10.10) Page 8 of 307



Part I: Intfroduction

OMi users use the Workspaces area to monitor the environment, manage events, and solve problems.
OMi provides default pages in the Dashboards and Operations Console workspaces for these
purposes. However, administrators may also provide specially designed pages for use by their
operators. Alternatively, users may have been given permissions to create their own pages in My
Workspace.

The different designs of the pages in Workspaces present information in different ways. The kind of
information that you can see within these pages is determined by the user roles that the administrator
assigns to you. For example, the operator Dave can see his assigned events, plus other events that he
is allowed to see, in a cross-domain view. For example, he is responsible for maintaining the enterprise
email server, but he might be able to see events that are assigned to another operator.

Learn More

About Workspaces
The Workspaces area is divided into the following main sections:

« My Workspace. My Workspace enables you and your administrators to view default pages from
OMi, and to create new pages containing OMi components and also external components. Each
page is displayed as a tab within My Workspace. For details, see "My Workspace" on page 209.

« Dashboards. Dashboards give you an overview of the health of the environment in graphical form.
The data updates in real time so that you are always presented with the most recent information.
OMi provides the following dashboards by default:

o Monitoring Dashboard. (Formerly known as Event Dashboard.) Monitoring Dashboards provide
an at-a-glance overview of the events from the environment you are monitoring. Monitoring
Dashboards enable you to quickly assess the health of the environment and to identify areas that
require your attention. For details, see "Monitoring Dashboard" on page 233.

o 360°. This page provides a high-level overview of the status of Cls in a selected view. The page
displays a hierarchy of Cls in a view, the KPIs assigned to each Cl, and their KPI statuses. For
details, see "360° View" on page 242.

o KPI Over Time. The KPI Over Time dashboard enables you to view the status or the value of
selected KPIs and Cls over time. The report also lets you choose from a number of layouts to
monitor statuses and values at a glance. For details, see "KP| Over Time Dashboard" on
page 243.

o ROI Dashboard. (Return on Investment.) The ROI Dashboard displays the proportion of events
received by OMi that have been automatically handled against those that required intervention by
operators. The higher the proportion of automatically handled events, the greater the contribution
OMi is making to the management of your infrastructure. If the cost of manually handling a typical
event is known, this value can be entered into OMi, based on which, the total cost saving
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achieved through OMi can be displayed. These statistics can be displayed for any specified time
period within which OMi has been monitoring your IT environment. For details, see "Return On
Investment Dashboard" on page 247.

« Operations Console. The Operations Console workspace is where operators perform their daily
tasks. OMi provides three predefined so-called perspectives as examples for ideal operations
workspaces:

o Event Perspective. The Event Perspective page displays event-related information in separate
panes. For details, see "Event Perspective" on page 253.

o Health Perspective. The Health Perspective page displays topological information and health
indicators related to the selected event. This display enables you to simultaneously see events
from different perspectives and helps you to better understand complex relationships and
dependencies. For details, see "Health Perspective" on page 254.

o Performance Perspective. The Performance Perspective page enables you to create and
customize performance dashboards. For details, see " Performance Perspective" on page 255.
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Chapter 1: Navigating and Using OMi

OMi runs in a web browser and uses the web browser's navigation features. For example, you can use
the web browser's back and forward buttons, the web browser's bookmarks, history, refresh, full
screen, and print features.

Each OMi Ul has a dedicated URL, which you can bookmark for quicker access to individual Uls.

Learn More

Title and Menu Bars
The title bar displays a logo, the name of the Operations Manager i product, and menus.

The submenus in the Workspaces and Administration menus can be expanded and collapsed. OMi
remembers the expand and collapse states of each submenu so that you can return to them more
easily.

You can use the search for menu items field to search the menus for a specific item. OMi suggests
matching menu items as you type.

The ﬁ% user menu displays the name of the currently logged in user. You can access all user-specific
areas using this menu, for example, account or password information. You can also log out of OMi
using the user menu.

The Help menu takes you to the OMi Online Help and to additional resources in the Internet. You can
also look up the OMi version from this menu.

Breadcrumbs

Breadcrumbs enable you to keep track of your location within OMi. They provide links back to each
page you navigated through to get to the current page.

You can view previous pages within a multi-level context by clicking one of the links in the breadcrumb.

You can hide the breadcrumbs by clicking the “~ Collapse button to the left of the Help menu. Click
' Expand to show them again.
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Chapter 2: Logging into OMi

This section provides instructions for logging into OMi.

Learn More

This section includes:

« "Accessing OMi" below
« "Requirements" below

« "Autocomplete " below

Accessing OMi

You can access OMi using a supported web browser from any computer with a network connection to
the OMi servers.

The level of access granted to a user depends on the user's permissions. For more information, see the
OMi Administration Guide.

By default, Single Sign-On (SSO) in OMi is disabled. For more information, see the OMi Administration
Guide.

Requirements

For details on browser requirements, as well as minimum requirements to view OMi, see the OMi
Installation and Upgrade Guide.

Autocomplete

The major browsers have each decided to ignore autocomplete=off in web forms.

Internet Explorer; http://blogs.msdn.com/b/ieinternals/archive/2013/09/24/internet-explorer-11-
changelist-change-log.aspx

Firefox: https://bugzilla.mozilla.org/show_bug.cgi?id=956906

As a result, when logging in to OMi you may, depending on your browser configuration, be prompted to
remember your login credentials.

If you are an end user of OMi and do not wish to have your login credentials remembered, they need not
be; indicate when prompted by your browser that you do not wish to have your login or password
information saved by the browser. Often you can instruct your browser not to prompt you in the future
for this site.

It is often possible to configure your browser to not prompt you to remember passwords at all, if you
wish to disable this ability entirely. This can often be configured either in the browser itself or via
corporate IT policy. Refer to your browser documentation or contact your System Administrator for
more details.
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Tasks

This section includes:

« "How to Log Into OMi" below
« "How to Log Out of OMi" below

How to Log Into OMi
1. Inabrowser, enter the following URL:
https://<server_name>.<domain_name>/omi
where

<server_name> and <domain_name> represent the Fully Qualified Domain Name (FQDN) of the
OMi server (for example, https://serverl.domainl.ext/omi). If there are multiple servers, or if
OMi is deployed in a distributed architecture, specify the load balancer or gateway server URL, as
required.

Note: If the Logon Banner feature is enabled, at this point a disclaimer that your work will be
monitored for attack prevention might appear. To confirm this notification and to proceed to
the log-on page, click the OK button.

2. Onthe log-on page, enter your log-on name and password. Initial access can be gained using the
administrator user name ("admin") and password.

Caution: We recommend that the system superuser change this password upon first login to
prevent unauthorized entry. For details on changing the user password, see "My Account" on
page 16. The login name cannot be changed.

Note: The password is configured in the configuration wizard.
After you log in, your login name appears at the top right of the page, under the top menu bar.

Note: If Lightweight Single Sign-On (LW-SSO) is disabled, you do not need to add the .<domain_
name> syntax in the login URL. For information on LW-SSO, see the OMi Administration Guide.

How to Log Out of OMi

When you complete your session, it is recommended that you log out to prevent unauthorized entry.

Click Log Out on the (i :) user menu.
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Tips and Troubleshooting

Login Troubleshooting

Toresolve login issues, reference the possible login failure causes in the following table using the error
number shown in the error alert dialog box. For additional troubleshooting information, refer to the Self-

Solve Knowledge Search.

Error

No. Problem/Possible Causes

LIO01 | OMifailed to connect to the
application server running on the

gateway server. This may be due to:

« The application server being down.
» Problems with the OMi service.

« The port required by the application
server being used by another
application.

LIO02 | The application server running on the
gateway server is not responding or is

not installed correctly.

LIO03 = The management database is
corrupted (for example, if a user
record was accidentally deleted from

the database).

LIO04 = The connection between the Tomcat
servlet engine and the application
server failed due to a Remote Method
Invocation (RMI) exception. This may
be due to problems in RMI calls to the

application server.

HPE Operations Manageri (10.10)

Solutions

Solution 1: Close all applications on the gateway
server machine and restart the machine.

Solution 2: Ensure that there are no other running
applications on the gateway server machine that
use this port (for example, applications that run from
the Startup directory, another instance of the
application server, an MSDE or Microsoft SQL
Server, or any other process).

Restart OMi.

Try logging in as a different user, or ask the OMi
administrator to create a new user for you.

Ensure that none of the application server ports are
in use by another process. Also, ensure that the
RMI ports are bound.

For details on ports, see the OMi Administration
Guide.
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Error
No. Problem/Possible Causes Solutions

LIO0S | The OMi login fails or hangs. This may = Ensure that the connection to the management

be due to: database is healthy:
« Aninability to connect to the 1. Inthe web browser, type
management database. https://localhost:29000 to connect to the
« The current user does not have JMX console.
access rights to a profile. 2. Click the link System > JMX MBeans >
« Authentication strategy has not Topaz > Topaz:service=Connection Pool
Information.

been set/configured correctly.
3. Locate java.lang.String
showConfigurationSummary() and click
Invoke.

4. InActive configurations in the Connection
Factory, find the appropriate row for the
management database.

5. Verify that columns Active Connection and/or
Idle Connection have a value greater than 0
for the management database.

6. If thereis a problem with the connection to the
database, verify that the database machine is
up and running. If required, rerun the Setup and
Database Configuration utility.

Solution 3: Ensure that the user has appropriate
permissions to access OMi. For details on roles and
permissions, see the OMi Administration Guide.

Solution 4: Verify that an authentication strategy
has been configured correctly. For details on
authentication strategies, see the OMi
Administration Guide.
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Chapter 3: My Account

The My Account dialog box enables individual users to change their name and time zone. In addition,
users can provide their email address.

The changes made here are also applied to user's configuration in Users, Groups and Roles. For
details, see the OMi Administration Guide.

To access

Click My Accounton the (i 1) user menu.

Tasks

How to Update My Account Information

In the Name field, type a new display name.
2. Optional. Enter your Email address. OMi currently does not use this email address.

Select the Time Zone according to your location. The time zone affects the format that the event
browser uses to display date and time of events (for example, Time Received or Time Created).
See also "Event Browser" on page 28.

4. Click Apply to save your changes.
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Chapter 4: User Engagement

Using gaming technology, User Engagement adds fascination to your work and recognizes your
achievements as you learn to use OMi and become progressively more knowledgeable.

All normal User Engagement participants (OMi users without User Engagement administration rights)
can access their Timeline, Experts, and Achievements pages from the User Engagement page in the
Workspaces area.

To access

Click User Engagement on the (i 1) user menu

Learn More

This section includes:

« "Experts" below

« "Achievements" on the next page

« "Timeline" on the next page

« "Participant Details page" on page 19

« "Privacy and Notifications" on page 19

Experts

To access

Click User Engagement on the (i Y user menu
Select Experts from the User Engagement page or the User Engagement Experts component.

A participant can see the Experts Board only if he opts to participate in expert boards in the Privacy
settings page for the current participant.

The experts boards make it easy for you to identify and contact the individuals in your organization with
the most experience of the various OMi domains. The User Engagement experts page displays the
overall most experienced individuals and those for a selected category. You can drill down into each
category and see the complete list of participants taking part in the Expert Boards.

« Overall Experts. Displays the most experienced users by combining the points earned across all
activities.

Activities may be included in more than one category but points earned for an activity are only
counted once for the Overall Experts board. The top three overall experts are displayed and the
ranking of the current user is added to the list. If you are in the top five, all top-five participants are
displayed in the list. You can drill down into the Overall Experts Board and view the complete list of
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participants and the points that they have collected. Participants may share their email addresses,
making it easier for other participants to contact experts and increase collaboration between peers.

For details on how to participate in User Engagement, Expert Boards and share your email address,
see "Privacy and Notifications" on the next page.

« Category Experts. Displays the most experienced users for each category.

Each expert board highlights the top three experts in each category and also displays the ranking of
the current user. If you are in the top five, all top-five participants are displayed in the list. You can
drill down into each expert board and view the complete list of participants and the points that they
have collected. Participants may share their email addresses, making it easier for other participants
to contact experts in the various categories and increase collaboration between peers.

Achievements

To access

Click User Engagement on the ﬁ% user menu

Select Achievements from the User Engagement Dashboard page or from the User Engagement
Achievements component.

The Achievements page displays an overview of all running achievements grouped by categories.
Disabled and paused achievements are not shown. Each category is displayed with a progress bar.

The assigned achievements help you to focus on and explore the OMi features that are most relevant to
you at the moment in more detail. This is a personal achievements list that only the owner has access
to. It is not shared with anyone else. You can also see your completed assignment history in "Timeline"
below.

Timeline

To access

Click User Engagement on the (i 1Y user menu
Select Timeline from the User Engagement page or the User Engagement Timeline component.

The Timeline page is used to show the history of a user's Achievements. The Timeline provides a
personal overview of User Engagement participation and is not shared with anyone else.

The diary is divided into the following views:

« Today

Shows your latest achievements.
« Yesterday

Shows the summary of your achievements for the previous day.
o Last Days

Shows the summary of you achievements and progress for the last days up to the day before
yesterday
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« Older
Shows the summary of your achievements and progress for the last weeks.
o This Year
Shows the summary of your achievements and progress for the current calendar year.
« Last Year
Shows the summary of your achievements and progress for the previous calendar year.

Participant Details page

To access
Click User Engagement on the (i 1Y user menu

Click the il button or your avatarimage.

The Participant Settings page specifies your login name, avatar name, and email address.

You can change your avatar from this page.

« Change Password displays the Change Password dialog box where you can change your user
account password if the user account was created in User Engagement.

The Change Password dialog box is displayed when the user is logged on to User Engagement
stand-alone Ul (which is typically used for administrative purposes only) not using OMi's lightweight
single sign-on. It is also not displayed in the User Engagement integrated into OMi Uls. The
password that you can change is the one for User Engagement and not OMi.

« Upload Avatar. Displays the Upload Avatar dialog box where you can change your avatar image. If
you would like to participate anonymously, you can choose any image to represent yourself.

« Remove Avatar. Displays the Confirmation dialog box where you can delete your avatar image.
Only displayed if an avatar image is uploaded for the participant.

« Login. Your unique account name used to log on to the User Engagement user interface. This the
same login as for OMi and cannot be edited.

« Avatar Name. Your avatar name, displayed in User Engagement and used to represent you. If you
would like to participate anonymously, you can choose any name to represent yourself.

« Email. Your email address is helpful for administration information, for example, to help reset
forgotten passwords, and is also used in the Experts Boards if you choose to make it visible.

Privacy and Notifications

To access

Click User Engagement on the ﬁ% user menu

Click the & button.

The use of all User Engagement features is entirely voluntary and allows for a high level of individual
control. You can choose to participate in User Engagement achievements and Experts Boards and
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configure your account appropriately at any time . If you do not want to participate or do not want to
make your email address visible to other participants, you can disable any of these options from the
Privacy and Notifications page. For detailed information about Experts Boards, see "Experts" on
page 17 and the User Engagement section of the OMi Administration Guide.

Notifications are used to give you timely, positive feedback of your achievement, for example, after
creating your first tool. As you become more experienced and your achievements are from a higher
level, becoming progressively more involved, notifications will be received less often, but will display
your greater achievements.

Tasks

This section includes:

« "How to Display the Complete Experts List" below
« "How to View Achievements for a Category" below
« "How to Search for Achievements" below

o "How to Upload an Avatar" below

« "How to Change Your Password" on the next page

How to Display the Complete Experts List

To display the complete list of experts (overall or for a category), click the More link associated with the
category you are interested in.

The complete list of experts is displayed in a pop-up window, including individual scores and email
addresses (where available).

How to View Achievements for a Category

To view all running achievements for a category, click the category title for which you want to view all
available achievements.

Your currently active achievements associated with the category are displayed, including
achievements that you have completed, in a dropdown box.

How to Search for Achievements

To search for achievements, enter a text string that is contained in the title of the achievement in the
Search field.

The search field filters the achievements to only display achievements which include the specified
string. Click * to clear the filter.

All achievements containing the specified string are found. If the category is selected, the filtered
achievements are displayed.

How to Upload an Avatar
1. Click Upload Avatar.
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2. Browse to the location of the avatar file that you want to upload and select the file. Optimal image
size is 150 x 150 pixels.

How to Change Your Password

The Change Password dialog box is displayed when the user is logged on to User Engagement not
using OMi's lightweight single sign-on. It is also not displayed in the User Engagement integrated into
OMi Uls. The password that you can change is the one for User Engagement and not OMi.

1. Click Change Password.

2. Enteryour existing password.

3. Enteranew password and confirm.
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Events report important occurrences in the managed environment, and are generated by source
managers. These are forwarded to OMi and are assigned to operators for resolution.

Learn More

This section includes:

« "Event Sources" below
« "Event Synchronization" below

« "Notifications" on the next page

Event Sources
Events originating from many different sources can be processed, for example:

« HPE Software applications:
o OM for UNIX

o OM for Windows

o HPE Network Node Manager i (NNMi)

o]

SiteScope
o HPE Systems Insight Manager

« Third-party management software, normally used to monitor specific environments or special needs
not monitored by other solution components:

o Microsoft Systems Center Operations Manager, Active Directory, Exchange
o BlackBerry Enterprise Server
o SAP
Alerts, for example, from Cl Status Alerts and Event Based Alerts, can also generate events in OMi.

Event Synchronization

Event synchronization enables bidirectional communication between managers, for example, OMi and
HPOM. Updates and modifications to events can be exchanged. For example, changes of ownership
or modifications to the severity status of an event are synchronized between servers. All events
forwarded from OM servers are treated as allowing read and write. Any changes made to these events
result in a back synchronization to the originating HPOM server.
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Closing, Deleting, and Archiving Events

HPOM events are not updated when using the opr-close-events tool and the opr-archive-
events tool to close, delete, and archive events. The events in HPOM remain unaffected.

Likewise, events in OMi are not affected when using the omwmsgutil tool (OM for Windows) and
opcack and opchistdown tools (OM for UNIX or Linux) to close, delete, and archive events in OM.

All these tools operate directly on their respective databases and the changes do not go through
the workflow process, resulting in the loss of synchronization between OMi and OM.

If you use these tools to close, delete, and archive events from one system (for example, OMi),
you must make the equivalent changes with the appropriate tools on the other system (for
example, OM).

Notifications

Notifications are Emails, SMSs, and Pager messages that OMi can send on receipt of events with
predefined characteristics.

For example, if critical events for the most important business-relevant services are received by OMi
during any weekend period, the engineer responsible for these services is immediately informed by an
email, SMS, or pager message, or any combination of these.

Event Priority

Event priorities can be automatically calculated from the business model and the event's severity.
Event priority is assigned one of the following values Lowest, Low, Medium, High, or Highest.

Learn More

Event Priority Calculation

The event priority calculation is executed in the event pipeline on new events. It also can be started
manually on multiple events from the console context menu.

Input parameters for the calculation are:

« Severity of the event
« Business criticality of the related Cl (if available)

Note: If no Cl is related to the selected event, the priority is None.

The business impact is provided by the Business Impact Service (BIS) and the severity is an attribute
of the event.

The calculation of priority is based on the relationship in the following table.

Impact Event Severity
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Unknown Normal Warning Minor Major Critical
Nolmpact Lowest Lowest Low Low Medium Medium
Low Lowest Lowest Low Low Medium Medium
MediumLow Low Low Low Medium Medium High
Medium Medium Low Medium Medium High High
MediumHigh High Medium Medium High High Highest
High Highest Medium High High Highest Highest

Calculated Priority in Event Forwarding

In event forwarding, the calculated priority is forwarded to the receiving application. If the Cl related to
the event is configured in the receiving application, the event priority is recalculated by each receiving
application. If the Cl related to the event is not configured in the receiving application, the event priority
contained within the forwarded event is used.

Tasks

This section includes:

HPE Operations Manageri (10.10)

» "How to Set Priorities Manually" below

« "How to Recalculate Event Priorities" below

How to Set Priorities Manually

This task describes how to manually change the automatically-assigned priority of an event.
1. Open the Event Browser to display the list of known events:

Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the event for which you want to change the priority value.

Open the Event Details pane.

Select the required priority from the Priority list.

Click Save.

o > 0N

How to Recalculate Event Priorities

This task describes how to manually recalculate the priorities for selected events in the Event Browser.
This may be necessary when Business Criticality values changed in the underlying business model,
and you want these changes reflected in your active events.

1. Open the Event Browser to display the list of known events:
Workspaces > Operations Console > <select a perspective>
2. Inthe Event Browser, select the events for which you want to recalculate the priority.
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3. Right-click one of these events and select Recalculate Priority from the context menu.
The priority value for the selected events is updated.

Event Correlation

Event Correlation is used to automatically identify and display the real cause of problems. Events that
are only symptoms of the cause event can be filtered out using the Top Level Items filter, resulting in a
clearer overview of the actual problems that need to be solved. Event correlation relies on defining
relationships between correlation rules, ETls and ETl-values associated to events, and Cls and
relations between these Cls.

The topology-based event correlation process works as follows:

« Checks whether a relationship exists between the events being correlated.
« Monitors the Cls and ETI values assigned to events being correlated.

« Determines relationship between two events by checking if there is a relationship in the topology
database between the Cls to which the events are related.

The correlation result is displayed in the Event Browser with anicon in the C column to indicate that it is
the result of a correlation process.

®a _ Event is the cause of another event
*a, _Event s the cause of one event and a symptom of another event

fa _— Event is a symptom of another event

Note: You might not be authorized to open the Correlation Rules manager. For more information
about user authorization, see the OMi Administration Guide.

Events related as a result of correlation with the selected Event are displayed in the Related Events
tab. The selected event can also be a symptom event and you can also see its cause in the Related
Events tab.

If a better correlation is achieved and the correlation rule responsible for the new correlation possesses
a higher weighting than the rule that generated the existing correlation, the new correlation replaces the
existing one.

All possible correlation results are recorded and displayed in the Potential Causes sub-tab located in
the Related Events tab. It shows the possible cause events, together with a reference to the correlation
rule that generated the correlation. Additional information, such as the rule weight factor, and the time
when the event was received, are also displayed. Operators can inspect all possible causes for a
symptom event, better understand the matching correlation rules, and, if they have the appropriate
permissions, manually change the cause of that event to any one of the available alternatives when
investigating a problem.

For details about correlated events, related events, and potential causes, see "Related Events" on
page 69.

For more information about the icons used in the Event Browser, see "Event Browser" on page 28. For
more information about setting up correlation rules, see the OMi Administration Guide.
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Event History

Event history is a log of information about who or which component has changed values of an OMi
event. This feature enables an operator to see how event attribute values changed during the life of an
event, for example, the sequence of severity changes. Event history information is available in a
separate tab in the Event Details pane and can be viewed by any user with access to that event.

Learn More

This section includes:

« "Event History Creation" below

« "Event History Characteristics" below

Event History Creation
An event history entry is created for the following cases:

« Userchanges an attribute of an event using the Event Browser.

« An external user or application changes event attributes using the Northbound Interface.
« OM or another OMi instance synchronizes an attribute change to OMi.

« Duplicate suppression changes an existing event.

« Automatic closing of related events.

« Control is transferred, canceled, or returned.

« Serveris added to the event forwarding list.

An event history entry is not created in the following cases:

« A pipeline step (for example, Cl resolution, or ETI resolution) changes an event which is not marked
as received because it is still being processed by the pipeline.

« Events which are modified by the opr-close-events tool.

Event History Characteristics
The following list summarizes the main technical characteristics of event history information:

« User cannot modify existing history information.

« Closing, deleting, and archiving events deletes history, but history is included as part of the XML
output produced by the opr-archive-events tool.

« Thereis no limit to the number of history entries per event.
History is created if one or more of the following properties of an event are modified:

« Cause (cause/symptom relationship)

« Duplicate Count (Can be enabled and disabled in the Operations Management Infrastructure
Settings under Duplicate Events Suppression Settings > Generate history lines for
Duplicate Event Suppression).
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« Correlation Rule

« Description

« Severity

o OM user

« AssignedGroup

« Custom Attributes
« Time Received

. Title

« Lifecycle state

« Priority

« Assigned User

In addition, changes to event annotations are also tracked as changes in the event history.

Tasks

Related Tasks

« "Viewing Closed Events" on page 54
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The Event Browser displays an overview of the active events that exist in the IT environment you are
monitoring. The details include, for example:

« Date and time when the event occurred.

« Host system (node) where the event occurred.

« Application that caused the event.

« Severity of the event.

« The userresponsible for solving the problem that caused the event, if assigned.

The information displayed by default is a small selection of the total information available about an
event.

All changes you make to the Event Browser layout are automatically saved to your user account. The
next time you log in, the Event Browser displays the latest events in accordance with the way you
configured the Event Browser. For example, when you log in again, the last selected view and Event
Browser tab are selected and reopened.

Selecting an event in the Event Browser displays the event's properties in the details pane, as long as

the details pane is not hidden (toggle details pane using the ¥ Show/Hide Event Details Pane
button). The details pane contains tabs that enable you to view and modify some aspects of the
selected event (for example, event properties, annotations, custom attributes, instruction text, and

priority).

To access

Workspaces > Operations Console > <select a perspective>

Learn More

This section includes:

« "Severity Assigned to Events" below

« "Filters" on the next page

« "Lifecycle Management" on the next page

« "Date Formats" on the next page

Severity Assigned to Events

Each event can be assigned a severity to shows the importance of the underlying problem. The values
are: critical, major, minor, warning, normal, and unknown. The Event Browser indicates an event's
severity with anicon.

Note: The Items bar at the bottom of the Event Browser indicates the number of active events by
severity. An active event is one that is open and being worked on.
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Filters

Filtering by events. Filtering the Event Browser content helps you to focus on the most useful
information. For example, you can filter the events displayed according to severity, assigned user,
event category, or lifecycle state. The Active Event Filter is displayed in the event filter selection field.

You can configure new filters or modify existing filters to change, increase, or decrease the information
displayed. For details, see "Event Filters" on page 78.

Note: The Event Browser cannot display unresolved and closed events at the same time. To view
closed events, see "Viewing Closed Events" on page 54.

Filtering by views or Cls. When you select a configuration item in the CI tree, OMi automatically
applies afilter to the Event Browser so that only those events are displayed that are related to the
selected configuration item. The active view is displayed in the view selection field.

Lifecycle Management

Note: It is not possible to edit an event with the state Closed, except for adding annotations and
custom attributes. To edit a closed event, you must first reopen it.

The Event Browser enables you to display and track the position of an event in a defined lifecycle. A
lifecycle is a complete series of predefined states that summarizes the event's life. The lifecycle states
are as follows:

« Open: Event is identified for investigation of the problems that caused the event. It is either not
assigned to a user or assigned but not yet being worked on.

« In Progress: Assigned user has started working on the investigation of the event's underlying
problems. The name of the assigned user appears in the User column.

« Resolved: Investigation into the selected event's underlying problem is found and fixed.
« Closed: Event is removed from the list of active events displayed in the Event Browser.

Note: Lifecycle states are linked to authorizations granted to users. For example, the user to
whom an event is assigned can change the assigned event's state from Open to In Progress
and Resolved but not to Closed. Only users with higher authority can assign events to other
users or change the event lifecycle state from Resolved to Closed.

Although the lifecycle states occur in a consecutive manner, you can set an event's lifecycle state at
any time. For example, you can assign an event to an alternative user, or reopen an investigation by
changing the event state from Closed to In Progress.

Note: You can change the lifecycle state of an event by selecting the event and selecting the
appropriate button (for example, the L Open or #% Work On button).

Date Formats

The date formats displayed in the Event Browser correspond to the language setting in the web
browser. For example, if your browser is set to en-IN (English India), the date is displayed using the
Indian date/month/year format, for example 17/7/13.
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The following date formats are currently supported:

de - German

en - English

en-GB - English United Kingdom

en-IN - English India

en-US - English United States

en-CA - English Canada

es - Spanish

fr - French

ja-Japanese

ko - Korean

ru - Russian

zh-CN - Chinese China

zh-HK - Traditional Chinese Hong Kong

zh-SG - Simplified Chinese Singapore

If no preferred language is specified, en-US is used.
Note: For base languages that are supported without any specific regional options, such as

German or French, the date format is always taken from the base language even if you have
selected a regional setting in your web browser.

For example, if you have selected fr-BE for the regional setting in your web browser, the date
format is taken from the fr setting.

Ul Reference

This section includes:

« "Event Browser Icons, Buttons, and Context Menus" below
« "Event Browser Columns" on page 38
« "Closed Events Browser" on page 43

Event Browser Icons, Buttons, and Context Menus

Some options and tools displayed in context menus require you to be logged on as a user with the
authorization to start the selected tool.

Context menu items in the Event Browser are disabled or removed completely if the user does not have
permission to perform certain operations (for example, Work On, or Close) or run certain actions (for
example, Automatic Actions or Operator Actions).
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The Performance Graph context menu items are removed completely if no metrics data is available for
the selected Cl. This is determined by the value of the Cl's Monitored By attribute and the
Performance Graphing infrastructure setting Context Menu Check.

Ul Element (A-
Z) Description

CL Reopen: Sets the lifecycle status for the selected events to Open. The events
can now be assigned to users for investigation and resolution.

p Work On: Sets the lifecycle status for the selected events to In Progress,
indicating that the underlying problems of the events are under investigation.

3 Resolve: Sets the lifecycle status for the selected events to Resolved.
= Close: Sets the lifecycle status for the selected events to Closed.

! Assign To: Opens the Event Assignment dialog box, enabling you to assign the
selected events to a specific user or user group.

% Relate Events: Opens the Relate Events dialog box, enabling you to manually
relate the selected events by assigning one event as a cause event. All other
events become symptom events.

Manually related events can also be used as the basis for automatically
generating a correlation rule. For details, see "Relating Events Manually" on
page 47 and "Creating Correlation Rules from Manually-Related Events" on
page 48.

i) Show Events Assigned to Me: Displays all events assigned to the current user
in the Event Browser. Any applied filters and views are deactivated. Repeated
selection toggles between displaying the events assigned to the current user and
displaying the events filtered by the last selected filter and view.

When Show Events Assigned to Me is selected, a confirmation of the selected
mode is displayed in the information bar.

Browser Options: Opens the Browser Options dialog box for the current Event
Browser tab. You can modify and set display options (for example, to hide or
display columns, or change the order in which the data appears, play sound on
receipt of an event). For more information, see "Configuring the Event Browser "
on page 44.

&8 Export Event List: Opens the Export Event List dialog box for the current Event
Browser where you can specify which event attributes you want to export to the
external file.

# Show/Hide Event Details Pane: Toggles between the Event browser view with
and without the Event details pane. You can also open the event details for an
event in a pop-up window using the Show > Event Details context menu item or
double-click the event.
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Ul Element (A-
Z)

o

<No Filter>

Description

Refresh: Synchronizes the event data displayed in the user interface with the
latest information available in the database on the server and forces a complete
refresh.

For information on setting the automatic update interval, see the OMi
Administration Guide.

Show/Hide Closed Events: Displays the Closed Events Browser Configuration
window used to specify the time period for the closed events to be displayed in
the Closed Events Browser. Click OK and the Events Browser displays the
closed events related to the related Cl of a current event over a selected time
period opens.

Click the 2l Hide Closed Events button to return to the Event Browser.

When Show Closed Events is selected, a confirmation of the selected mode is
displayed in the information bar, complete with the start and end times for the
displayed closed events and the creation time of the Closed Event list.

Opens the View Selector from which you can select one of the available Views. If
you have appropriate permissions, the selected view can be deselected by
selecting <No Filter>.

You can also configure users and groups so that they can see only the events
filtered by views associated with that user or group. You can also allow users or
groups to deselect the selected view and display all events.

On the first load of the Event Browser no view is selected. The selected view is
restored when the Event Browser instance is reopened.

The five most recent selections are displayed at the top of the list.

Note: The Event Browser View Selector is disabled in locked Event
Browser pages so that only events associated with a preselected view are
displayed.

Tip: Can be combined with the Search Events feature.
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Ul Element (A-
Z)

...Browse
Views

<Select an
event filter>

...Manage
Event Filters

<Search
Events>

Description

Opens the Browse Views dialog box, enabling you to select the view that you
want to apply. The contents displayed in the Event Browser are limited to the Cls
selected by the view.

If you have the appropriate permissions, you can also clear the view filter. Users
without this permission can only see events that are related to Cls that are
contained in the selected view. For details see the OMi Administration Guide.

Note: If you do not have permission to clear views, when you first attempt to
open an Event Browser, the "Select a View" message is displayed and the
Closed Events Browser button is also disabled.

When you select a view from the view drop down list (or if a view selection is
triggered externally, for example, from the View Explorer, the Event Browser
is displayed and the Closed Events Browser button is enabled.

Note: The Browse Views button is disabled in locked Event Browser pages
so that only events associated with a preselected view are displayed.

From the Browse Views dialog box, you can also open the Modeling Studio and
from which you can manage views.

For more information about views, "Views" on page 198.

Opens the Event Filter Selector from which you can select one of the available
event filters. The selected filter can be deselected by selecting <No Filter>.

The five most recent selections are displayed at the top of the list.

Tip: Can be combined with the Search Events feature.

Opens the Select an Event Filter dialog box, enabling you to select the event filter
that you want to apply.

From the Select an Event Filter dialog box, you can also open the Create New
Event Filter dialog box to create an event filter, test, edit or delete an existing
event filter.

For more information about the event filters, see "Event Filters" on page 78.

Entered text string is used to search the text displayed in the Event Browser and
display only the events containing the specified string. Clearing the field displays
all events again.

If you are also filtering by Cls, selecting a different Cl clears the search field.
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Ul Element (A-
Z) Description
Add Opens the Create New Annotation dialog box for all selected events. The
Annotation annotation is associated with all selected events on saving.
Close and Sets the lifecycle status for the selected events to Closed and resets the
Reset Health associated HI value to the default value for the selected events and on all
Indicator symptom events of the selected events that are not already closed.
Configure > Opens the Indicators manager in a new window. You need the appropriate
Event Type authorization to access the Indicators manager and other Administration
Indicators features.
Configure > Opens the Policy Management Ul in a new window.
Integration
Policies
Configure > If available, opens the graph Design Wizard in a new window. This wizard
Performance enables you to design a graph and specify its attributes and save it as a template
Graphs for later use.
Configure > Opens the Policy Editor enabling you to edit policy templates. Only the policies
Policy present in the Monitoring Automation policy inventory can be opened for editing.
Note: You need to re-deploy the policies modified in the Policy Editor
launched from the Event Browser; automatic re-deployment of updated
policies is not possible.
For information on how to deploy policy templates, see the OMi Administration
Guide.
Configure > Opens the Assignments and Tuning Ul using the CI ID of the related ClI, which
Monitoring results in displaying a list of all assignments for the particular CI. For more
information, see the OMi Administration Guide.
Configure > Opens the Tools manager in a new window. You need the appropriate
Tools authorization to access the Tools manager and other Administration features.
Configure > Opens the View Mappings manager in a new window. You need the appropriate

View Mappings

Items
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authorization to access Administration features.

Indicates the number of events by severity and assignment to individual users or
user groups. The valid severities are critical, major, minor, warning, normal, and
unknown.

The number of events displayed as a total of the number of available events
before filtering is also displayed along with the number of selected events in
brackets. For example, 25 of 40 (3) means that there are 40 possible events
available for the current user of which 25 are displayed in the Event Browser (15
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Ul Element (A-
Z) Description

have been removed by filtering). 3 events are selected in the Event Browser.
The following icons indicate event severity status:
€3 __Critical
v _ Major
. — Minor
& Warning
2 — Normal
@ — Unknown

Note: You can also configure the Event Browser to apply a background color
to the event that represents the severity of the event. For details, see
"Configuring the Event Browser " on page 44.

Usually, this is the same as the severity status of the original event, for example
as received from OM.

Selecting a severity icon results in filtering out all other events and displays only
the events with the selected severity. The filter is cleared by clicking the icon
again.

The following icons indicate the event assignment status:
&1l — Event assigned to logged-on user

25— Event assigned to one of the groups that the logged-on user is a member
of.

&% __Events assigned to other users

7 — Event assignment not known

Depending on the settings selected in the active filter, some items are displayed
with a value of 0, for example, because they are excluded by a filter.

Launch > Opens the Custom Actions menu from which you can select a custom action
Custom from a list of those configured for the Cl type associated with the selected event.
Actions

Launch > Run | Opens the Run Books menu from which you can select a Run Book from a list of
Books those configured for the Cl type associated with the selected event.

Launch > Tool @ Only available when multiple events are selected. Opens the Run Tool wizard
which you use to select a tool from a list of those configured for the Cl type
associated with the selected events.
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Z) Description

Launch > Tools Opens the Tools menu from which you can select a tool from a list of those

configured for the Cl type associated with the selected event.

Recalculate Manually recalculates the priorities for selected events in the Event Browser.
Priority If the Business Criticality was changed for one or more Cls related to events in
the Event Browser, a recalculation assigns new priority values for these events.
Select All Selects all events displayed in the Event Browser.
Note: You can copy the details of any selected events to the clipboard using
the key combination CTRL + C. Use CTRL + V to paste to the target
location. The information available in the Event Browser is copied in the
order that it is displayed. If expected information is missing, check that the
associated column is configured to be displayed in the Event Browser.
Show > If available, the Application Summary report is displayed for the selected event
Application created by BPM.
Summary
Report
Show > BPM If available, the BPM Performance Analysis report is displayed for the selected
Performance event created by BPM.
Analysis
Report
Show > BPM If available, the BPM Triage report is displayed for the selected event created by

Triage Report

Show >
Business

Service Impact

For Related CI

BPM.

Opens a new window and displays the Business Service Impact for CI
associated with the selected event.

Show > Displays information about the most recent changes to the Cl related to the
Changes For selected event.
Related CI
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Data can also be displayed for the child Cls which have an Impact relationship
with the selected ClI. If you clear the Show data for child Cls check box, data is
only shown for the selected ClI.

By default, actual changes and incidents are shown for the past week. The
requests for change area shows the changes planned during the previous week,
and those that are planned for the coming week.
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Z) Description

Show > Closed Displays the Closed Events Browser with closed events that are associated with
Events (Node)  the host system where the selected event occurred.

Click the el Hide Closed Events button to return to the Event Browser.

Show > Closed Displays the Closed Events Browser with closed events that are associated with
Events (Related the Cl related to the selected event.

Cl
) Click the 7 Hide Closed Events button to return to the Event Browser.

Show > Event Opens the event details for an event in a pop-up window and displays all
Details available information about the event.

Show > Event Opens the event in the source manager user interface connected using the BSM

in Source Connector.
Manager
Show > Opens the event in the external application that is responsible for managing the

External Details event.

Show > Filtered Displays only events that concern the Node ClI to which the selected event is
Browser (Node)  related.

Show > Filtered Displays events that concern the selected configuration item only.

Browser

(Related Cl)

Show > If available, displays performance dashboards for the selected Cl in a new
Performance window.

Dashboard (Cl)

Show > If available, displays performance dashboards for the selected Cl and the
Performance neighborhood Cls in a new window.

Dashboards

(Neighborhood)

Show > RUM If available, the RUM Event Summary report is displayed for the selected event
Event created by RUM.

Summary

Report

Show > RUM If available, the RUM Performance Analysis report is displayed for the selected
Performance event created by RUM.

Analysis

Report

Show > RUM If available, the RUM Triage report is displayed for the selected event created by
Triage Report RUM.
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Ul Element (A-

Z) Description

Show > Source = Opens the event in the Policy Management BSM Connector user interface.
Manager

Policies

Show > Related Opens the Related Events tab of the Event Details dialog box which indicates
Events the relationship of the selected event to other events. The information displayed
is the same as that available in the event details pane.

Transfer Forwards the selected event to a configured external manager application. Used

Control to when the operator is not able to solve the problem and needs to escalate the
issue, for example, create a Service Manager incident. The external manager can
be configured to return an incident ID to OMi as forwarding information.

Event Browser Columns

The following table lists the columns that are included in the Event Browser pane. For a short
explanation of the column content, check the tooltip.

Ul Element
(A-2) Description
HEEL] « Select All Events/Clear All Event Selection: Click to select or clear all event
check boxes. If there is a partial selection and you clear the Event Browser
header check box, all check boxes will be cleared. For more information on
selection check boxes, see "Configuring the Event Browser " on page 44.
A Automatic Action: Indicates if an automatic action is attached to the event and
describes its status using the following icons:
“* — Not run automatic action available for event
o — Automatic action is running
& — Automatic action executed successfully
3 — Automatic action failed to execute successfully
C Correlation: Indicates if the event has any related events that are hidden as a result

of a correlation. The following icons indicate the event's position in a chain of events:
®a _ Eventis a causein a correlation
a

%2 — Event is a cause in one correlation and a symptom in another

fa _ Eventis a symptom in a correlation

For details about correlated events, see "Related Events" on page 69.
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Ul Element
(A-2) Description

D Duplicate Count: Indicates how many duplicate events exist (for example, 2 or 3).

| Instructions: Indicates if the event contains any Instructions.

Instructions are configured in the policy that generates the event and might include,
for example, details describing automatic and operator-initiated actions, or manual
steps to follow for problem resolution.

N Annotations: Indicates if the event contains any annotations. Annotations are
comments or observations relating to the associated (or a similar) event. The
following icon indicates the presence of annotations:

— Event has annotations

For more information about annotations, see "Annotations" on page 65.

(0] Owned in HPOM: Indicates whether the event is owned by a userin OM (Y). If the
event is owned by an OM user, the user name is displayed with the prefix OM:, for
example, OM:Database Operator inthe User field (Event Browser and General tab).

R Received in Downtime: Event received from a Cl during a time period when the Cl
was in downtime (scheduled to not be available).

T Control Transferred: Indicates if the responsibility for the associated event was
transferred to an external manager.

U User Action: Indicates if a user action is attached to the event and describes its
status using the following icons:

& — Not run user action available for event

& — User action is running

&= — User action executed successfully

& — User action failed to execute successfully
Application = Application: Application that caused the event to occur.

Category Category: Name of the logical group to which the event belongs (for example,
Database, Security, or Network). An event category is similarin concept to a
message group in OM.

Cl Hint Cl Hint: Information that helps to resolve the related Cl, for example, Service name
in OM event.
Cl Type CI Type: Configuration item type associated with the event.
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Ul Element
(A-Z)

Company

Core ID

Customer

Description

ETI

Event Age

External ID
Group
ID

Manager

Node

HPE Operations Manageri (10.10)

Description

Company: A default custom attribute that is configured in the Available Custom
Attributes infrastructure setting (in Administration > Setup and Maintenance >
Infrastructure Settings > Applications > Operations Management - Custom
Attribute Settings). For details, see the OMi Administration Guide.

Core ID: Host system where the event occurred.

Customer: A default custom attribute that is configured in the Available Custom
Attributes infrastructure setting (in Administration > Setup and Maintenance >
Infrastructure Settings > Applications > Operations Management - Custom
Attribute Settings). For details, see the OMi Administration Guide.

Description: Optional information about the event in addition to the event's original
title and the text captured from the event source.

Event Type Indicator: Display name of the event type indicator (ETI) reported by
the selected event and the current value, (for example, Web application state:
Slow).

WebAppState is the name of the event type indicator. The corresponding label is Web
application state, whichis shown in the General tab. The level of the current ETI
value is Slow.

If event type indicators are assigned (see the Source Info tab) but are not being
resolved (event type indicator field in General tab is empty), the configuration must
be corrected.

Event Age: Displays the time elapsed since the event was created. The event age
is updated when the data in the Event Browser is automatically synchronized with
the database every minute or when the Event Browser is manually refreshed.

External ID: ID of the event assigned by the external manager.
Assigned Group: Name of the group to which the selected event is assigned.
ID: ID of the event. Same as the ID of the message in OM if it is forwarded to OMi.

Manager: A default custom attribute that is configured in the Available Custom
Attributes infrastructure setting (in Administration > Setup and Maintenance >
Infrastructure Settings > Applications > Operations Management - Custom
Attribute Settings). For details, see the OMi Administration Guide.

Node: Host system where the event occurred. The link opens the CI Properties
dialog box of the CI.
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Ul Element
(A-Z)

Node Hint

Object

Originating
Server

Prio

Region

Related CI

Related CI
Hint

Sending
Server

Sev

Description

Node Hint: Information used to identify node CI. For example, the hostname in OM
used to find host in the RTSM:

« DNS name of the originating server.
« Node ID of the originating server.

Object: Device such as a computer, printer, or modem.

Originating Server: Management server that initially forwarded the original event
along the chain of servers configured in a flexible management environment.

Priority: Priority assigned to the selected event (for example, Low, Medium, or High).

Region: A default custom attribute that is configured in the Available Custom
Attributes infrastructure setting (in Administration > Setup and Maintenance >
Infrastructure Settings > Applications > Operations Management - Custom
Attribute Settings). For details, see the OMi Administration Guide.

Name of the impaired configuration item where the event occurred.

If the Related Cl includes a subcomponent, it is displayed as follows: Related Cl:
Subcomponent. For example, Serverl: CPU1.

Related Cl Hint: Event information used to identify the CI related to the event.

Sending Server: Last server in the OM flexible management chain that forwarded
the event to OMi.

Severity: Severity assigned to the selected event. Usually, this is the same as the
severity status of the original event, for example, received from OM. The following
icons indicate event severity status:

& _Critical
v _ Major

£ — Minor

i — Warning
& — Normal
& — Unknown

Note: You can also configure the Event Browser to apply a background color to
the event that represents the severity of the event. For details, see "Configuring
the Event Browser " on page 44.
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Ul Element

(A-2) Description

Solution Solution: Text field used to document solutions to help operators solve the problem
indicated by the event.

Source CI Source Cl: Node where the monitoring agent or probe is running that generated the
selected event.

Source CI Source Cl Hint: Information used to identify the source ClI.

Hint

State Lifecycle State: Point in the event lifecycle that the selected event has reached:
L Open

.
#% —In Progress

. _Resolved

E!J—Closed

To change an event's lifecycle status, select the event, and select one of the status
buttons above the event list or use the context menu options. User authorizations
control the permissions to change lifecycle states.

Subcategory Subcategory: Name of the logical subgroup (category) to which the event belongs
(for example, Oracle (database), Accounts (security), orRouters

(network)).
Time Time Created: Date and time when the event was created.
Created
Time First Time First Received: Date and time when OMi first received notification of the
Received event.
Time Time Received: Date and time when the (last duplicate) event was received.
Received

Time State  Time Lifecycle State Changed: Date and time when the last lifecycle state change
Changed took place.

Title Title: Brief summary of the event.

Type Type: Type of message in OM. String used to organize different types of events
within an event category or subcategory.

User Assigned User: Name of the network user who is responsible for solving the
event's underlying problem. For example, if the event is owned by an OMi user, the
user name is displayed. If the event is owned by an OM user, the user name is
displayed with the prefix OM:, for example, OM:Database Operator.
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Closed Events Browser

You can view closed events history over a specified time period, either for all closed events of fora
selected Cl. From the Closed Events Browser, you can change the lifecycle state of any displayed
events. For details, see "Event Perspective" on page 253. All Event Browser actions relevant to closed
events can be accessed from the Closed Events Browser.

To access | Workspaces > Operations Console > <select a perspective>
Then click the Show Closed Events [ button.

Important The maximum number of events that can be displayed in the Closed Events Browser
information = can be configured in the Infrastructure Settings Manager. For details, see the OMi
Administration Guide.

Relevant For more information about viewing closed events, see "Viewing Closed Events" on
tasks page 54.

Note: Reopened events are automatically removed from the Closed Events Browser window.
However, events that are closed after the opening of the Closed Events Browser are not
automatically added to the current Closed Events Browser window. A refresh is required. The
timestamp when the snapshot was taken is displayed in the Closed Events Browser window. Only
one Closed Events Browser can be opened at a time by each user.

Troubleshooting

Event Browser does not Reconnect After Lost Server Connection is Restored

If the connection to the server is lost, the Event Browser automatically retries the connection 10 times
with an interval of 5 seconds. If the connection cannot be restored automatically, a manual option is
provided. If the manual option is also not successful, open an alternative OMi Ul and then return to the
Event Browser, for example:

Workspaces > Operations Console > <select a perspective>

Event Browser Status Bar Summary is Incorrect

If the Event Browser is in purge mode and a message storm is currently being experienced, the Event
Browser status bar may shows a summary such as "ltems: 32000 of 30000".

The second number is the total number of events that you are allowed to see. This number is calculated
on the server and always reflects the correct number, whether in purge mode or not.

The first number is the number of events that are currently in the browser. This number can be higher
than the real total number of events because the Event Browser is fully loaded adding new events
during the event storm and has not removed the purged events.

Shortly after the event storm is over, the displayed values should be aligned again.
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OM for Windows User Names are Truncated When Messages are Forwarded

By default OM for Windows has the OM for UNIX compatibility mode enabled (true)in the Server-
based Flexible Management configuration. This leads to the truncating of the user names.

Change the OM for UNIX compatibility mode settingtofalseinthe Server-based Flexible
Management namespace in the Generic Server Configuration tab.

Configuring the Event Browser

You can configure the Event Browser to display only the details that you are interested in. For example,
you can add and remove columns, customize additional tabs, and configure filters to change and
improve the way in which data displays.

All changes you make to the Event Browser layout are automatically saved to your user account. The
next time you log on, the Event Browser displays the latest events in accordance with the way you
configured the Event Browser. For example, the last selected view is selected and reopened.

To access

Click '3/ Browser Options in the Event Browser.

Tasks

How to Configure the Event Browser
1. On the Columns tab, select the columns to display in the Event Browser and click the add >
button to include them in the Display these columns box.
For a description of the available columns, see "Event Browser Columns" on page 38.
2. Select from the Display these columns box any columns that you do not want to display and
click the remove < button.

3. Select column names and rearrange their display positions by use of the t and ¥ buttons.

The first column item in the list is displayed as the first column in the Event Browser. Subsequent
column items are placed progressively to the right in the order of their appearance in the Display
these columns list.

Alternatively, to select the default columns for display in the Event Browser, click Reset to
defaults.

4. On the Other tab, configure any of the following additional options:
o Play sound notification for new events. Enables sound notification for new events.
o Compact view for events: Minimize height of rows and smaller font size. Enables the
compact view for events displayed in the Event Browser. The height of rows is minimized and

the text size is decreased. Use this option if you want more events to be displayed at once.

o Include child Cls in Cl filter. Enables filtering events by the selected Cl and any of its child
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Cls.

o Show selection check boxes. Adds a check box next to each event that enables selecting
and clearing the selection of multiple blocks of events. Selection check boxes also enable the
following functionality:

m Hold down the Shift key while clicking the right mouse button to extend the last action
(select or clear check box) from the last clicked event to the current clicked event. For
example, if you select or clear a check box and hold down the Shift key while selecting or
clearing another event, all events in between will be selected or cleared.

m Click the check box in the event browser columns header to select or clear all check boxes.
If there is a partial selection and you clear the header check box, all check boxes will be
cleared.

m Click an event row (not the check box) to clear other selections and select this event only.

o Color event background in accordance with the event's severity. Applies a colored event
background that represents the severity of the event in the Event Browser. Event background
coloring includes the following options:

m All events. All events displayed in the Event Browser are colored in accordance with the
severity of the event.

= Only events assigned to current user. Events assigned to the active user are colored in
accordance with the severity of the event. All other events are identified with the default
light background.

= Only unassigned events. Events not assigned to the current user are colored in
accordance with the severity of the event. Events assigned to the active user are identified
with a light pink colored background. Events assigned to any other users are identified with
a light yellow colored background.

5. Click OK.

Filtering by Views and View-Based Authorization

You can limit the set of events displayed in the Event Browser using views. By selecting one of the
available views from the View Selector, you display a subset of the available events filtered to include
only the events with related Cls included in the view. The View Selector displays only views for which
you have permissions.

On the first load of the Event Browser no view is selected. However, if you have selected a view, it is
reapplied when you reopen this Event Browser instance. The setting is independently stored for each
Event Browser instance.

Tip: Use the Show Events Assigned to Me ('Hl'm?) icon to display all events assigned to the
current user in the Event Browser. Any applied filters and views are deactivated. Repeated
selection toggles between displaying the events assigned to the current user and displaying the
events filtered by the last selected filter and view.

For more information about views, see "Views" on page 198.
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View Permissions

« Assigning views to roles. It is possible to limit which views a user is allowed to use. By restricting
access to specified views for a role, it is also possible to control which events a user is allowed to
see.

For details see the OMi Administration Guide.

« Permission to clear view filter. A permissionin the Operations Console > Event Browser
resource can be set to allow the user to clear the view filter and see all events. Users without this
permission will only be able to see events that are related to Cls that are contained in the selected
view.

For details see the OMi Administration Guide.

« Locked views. It is possible to disable the View Selector in the Event Browser by configuring a My
Workspace Event Browser page with a preselected view. The user will only be able to see the
events associated with the preselected view.

For details see the OMi Administration Guide.

Assigning an Event to a User or User Group

The Event Browser shows you to which user and group an event is assigned for investigation and
resolution. If the event is not yet assigned, you can assign it from the General tab in the Event Details
pane.

You can restrict user access to events on the basis of event categories. For example, some users can
be restricted to view and work on events belonging to the category Database only. Other users are
given access to events that belong to the category Systemonly.

Learn More

Event Categories

Event categories are logical groups of events with some similarities (for example, belonging to the
same problem area). Event categories help simplify the process of deciding to which user or user group
an event type should be assigned for investigation.

The Event Browser displays the category to which a selected event belongs (for example, Storage,
Database (DB), System, or WebApp (Web Application)).

Note: To display the contents of the Event Browser according to event category, include Category
as an Event Browser column option and then select the Category column header to sort
alphabetically.

Assignment of Events to Users

You can also configure rules to automatically assign incoming events to available user groups.
Automatic assigning of events to user groups responsible for solving these events significantly
improves the efficiency of event management. Each event is assigned to an appropriate user group as
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soon as it is received. All operators in a user group are permitted to work on those events assigned to
that user group. For detailed information, see the OMi Administration Guide.

Note: To display the contents of the Event Browser according to the user assigned to the event,
select the User or Group column header. To define users and user groups, choose the following
menu option:

Administration > Users > Users, Groups, and Roles

Tasks

How to Assign an Event to a User or User Group

1.

Open the Event Browser to display the list of known events:
Workspaces > Operations Console > <select a perspective>
From the Event Browser pane, select the event that you want to assign to a user.

Open the Event Assignment dialog box in one of the following ways:

o Inthe Event Browser pane, click the Assign To +44 button.
o Right-click the event and select Assign To from the context menu.

In the Assigned Group box, use the menu to select the user group to which you want to assign the
selected event (for example, Database Experts or Application Server Operators).

In the Assigned User box, use the menu to select the user to whom you want to assign the
selected event.

The users displayed in the menu are filtered according to the user group selected in the previous
step.

Note: Alternatively, in the General tab of the Event Details pane, select the user and group
from the Assigned Group and the Assigned User boxes and click the Il Save button.

Click OK.

Relating Events Manually

You manually relate selected events in the Event Browser by assigning one event as a cause event. All
other related events become symptom events.

To access

In the Event Browser, select the events that you want to relate, right-click one of these events, and
select Relate Events from the context menu.
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Tasks

How to Manually Relate an Event

In the Event Browser, select the events that you want to relate.

2. Right-click one of these events and select Relate Events from the context menu. The Relate
Events dialog box opens.

3. Select one of the events as the cause event. All other events are symptoms of the selected cause
event.

Check if the event has any related events that are hidden as a result of a correlation rule. The
following icons indicate the event's position in a chain of events:
®a _ Event s a cause in a correlation rule

a
%z — Event is a cause in one correlation rule and a symptom in another

"a _ Event is a symptom in a correlation rule
For details about correlated events, see "Related Events" on page 69.

4. Optional. Manually related events can also be used as the basis for automatically generating a
correlation rule. If you also want to create a correlation rule based on the current relationship,
select the check box Open correlation rule wizard. For details about creating a correlation rule
using the Correlation Rule Generator, see "Creating Correlation Rules from Manually-Related
Events" below.

5. Click OK.

Creating Correlation Rules from Manually-Related
Events

Manually-related events can also be used as the basis for creating new or enhancing existing
correlation rules. From the Event Browser, you need to identify related events, select a cause event,
relate them manually, and choose to create a correlation rule to reflect this relationship.

The Correlation Rule Generator wizard requires that the events being used to generate a new rule
include a Related CI.

Note: If related ETls and their values are not available, you can define indicator mapping rules to
set indicator states (see the OMi Administration Guide), and create a correlation rule for this case.
You must also modify and redeploy the event forwarding policy that created the event in OM to
provide a suitable ETI and value for this type of event. Next time such an event is received, an ETI
is included, and the associated correlation rule is triggered.

For more information about correlation rules, see the OMi Administration Guide.

To access

In the Event Browser, select the events that you want to relate, right-click one of these events, and
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select Relate Events from the context menu. Select one of the events as the cause event and then
select Open correlation rule wizard.

Tasks

How to Create Correlation Rules from Manually-Related Events

1.

10.
11.

12.
13.
14.

Open the Event Browser to display the list of known events:
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the events that you want to relate. You can select a maximum of 10
events.

Right-click one of these events and select Relate Events from the context menu.
The Relate Events dialog box opens.

Select one of the events as the cause event. All other events are symptoms of the selected cause
event.

Select Open correlation rule wizard and click OK. The Correlation Rule Generator dialog box
opens.
Click “* Use as Cause. All rules with the selected cause are displayed.

From the Select Events for Creating or Enhancing a Correlation Rule section, select
additional events that are to be included in the correlation rule.

The list of possible rules that can be enhanced is dependent on the Cl Type of the cause event
selected.

Click Create to create a correlation rule based on the specified cause and symptom events, or
select an existing correlation rule and click Enhance.

The Rule Properties page opens.

Specify the properties for a new correlation rule or make the appropriate changes to the existing
correlation rule.

Optional. If you want the correlation rule to be enabled immediately, click Active.

Optional. Select an alternative time window for this correlation rule. This defines time period used
to correlate events with an existing event. An event received after the time period is past is not be
correlated with the original event. An alternative time window overrides the global default set in the
Infrastructure Settings Manager page for Operations Management. For details, see the OMi
Administration Guide.

Click Next. The Rule Details page opens.
Optional. You can select nodes from a graph and can add additional ETls to the rule.

Click Finish to create the new correlation rule or modify the existing one.

Ul Reference

This section includes:

« "Selected Events / Select Rules Page" on the next page

« "Rule Properties Page" on page 51
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« "Rule Details Page" on the next page

Selected Events / Select Rules Page

The Correlation Rule Generator dialog box displays the Ul elements listed in the following table.

Ul Element
(A-Z)

“h

¥

i
gl

Create

Cl Type
Description
Enhance
Event Title
Include
Indicator

Indicator
State

Name

Selected
Events for
Creating or
Enhancing

Use as Cause

HPE Operations Manageri (10.10)

Description

Use as Cause: Selects the event to be used as the cause event.

Open Event Details: Opens the event details for the selected event in a pop-up
window.

Select All Events: Selects all events in the Select Events pane.
Unselect All Event: Clears all events in the Select Events pane.

Enables the creation of a new correlation rule based on the selected events.
Configuration item type associated with the event.

Brief description of the correlation rule.

If valid, enables the selection of an existing correlation rule to be modified.
Title of the selected event.

Enables you to select or clear events from the available list.

Indicator associated with the event.

State of the indicator associated with the event.

Internal name of the selected correlation rule.

Automatically generated from the Display Name value. The first character must be
a letter (A-Z, a-z) or an underscore (_). All other characters can be a letter (A-Z, a-
z), anumber (0-9), or an underscore (_). Can be manually overwritten.

Note: May be disabled for certain locales (for example ja_JP, zh_CN, ko_
KR).

Events that you selected to be the symptoms of the cause event on which the
correlation rule is based.

Event that you selected to be the cause event on which the correlation rule is to be
based.
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Rule Properties Page

The Rule Properties page displays the Ul elements listed in the following table.

Ul Element
(A-2) Description
Active Used to enable or disable the rule during runtime. By default it is disabled.

Description = Brief description of the correlation rule.

Display Display name of the selected correlation rule used in the graphical user interface.
Name
Name Internal name of the selected correlation rule.

Automatically generated from the Display Name value. The first character must be a
letter (A-Z, a-z) or an underscore (). All other characters can be a letter (A-Z, a-z), a
number (0-9), or an underscore (_). Can be manually overwritten.

Note: May be disabled for certain locales (for example ja_JP, zh_CN, ko_KR).

Time Specifies a specific time period for the selected correlation rule. By default it is not
Window enabled and the global value is used. 0 seconds also mean it is not enabled and the
global setting is used.

The range is from 0 to 9999 seconds.

Rule Details Page

The Rule Details page displays the Ul elements listed in the following table.

Ul Element

(A-2) Description

Es Binds one or more symptoms to the cause by taking the shortest path. All other
bindings are removed.

[ Displays details of the selected Cl type, including indicators and values.

Rule Topology Pane

<Dark Blue Symptom ClI type.
background>

<Light Blue  Not cause or symptom ClI type, but Cl type is part of rule topology.
background>

<Orange Cause Cl type.
background>
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Ul Element
(A-Z)

<Pink
frame>

<No
background
color>

Layout

Levels

Zoom

Description

Selected Cl type.

Cl type is not part of the rule.

Indicates that the configuration item type has an indicator state that is configured as
a symptom in the selected correlation rule.

Indicates that the configuration item type has an indicator state that is configured as
a cause in the selected correlation rule.

Adds the highlighted link (constraint) to the correlation rule. Adding a link enables
the path between the linked objects in the context of the correlation rule, which is a
requirement for topology-based event correlation. It does not change the RTSM
view model in any way.

Removes the highlighted link (constraint) from the correlation rule you are editing.
The link between the two objects is no longer recognized in the context of the
correlation rule, and any rule that relies on this link no longer works. Removing a link
from a correlation rule does not change the RTSM view model in any way.

Selects alternative ways of viewing the Rule Topology diagram. There are three
options to choose from: Hierarchical, Circular, and Concentric Radial.

Selects the depth of topology levels displayed in the Rule Topology diagram.

Controls the size of the displayed Rule Topology diagram.

Symptoms and Causes Pane

b4

Cl Type
Indicator

Indicator
State

Type

Delete Item: Deletes the selected indicator from the list of indicators included in the
correlation rule as either a symptom or a cause.

Name of the configuration item type to which the listed indicator is assigned.
Name of the indicator referenced in the selected correlation rule.

Name of the indicator state referenced in the selected correlation rule.

Indicates if the indicator is defined as a symptom or a cause in the selected
correlation rule.

Indicators Pane

S

Refreshes the contents of the Indicators list. Use if new indicators becomes
available while you are working.
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Ul Element

(A-2) Description

=) Group Indicator by Type: Toggles between a list containing all indicators and a list
divided into health indicators and event type indicators.

i Add as a Cause: Sets the selected indicator state as a cause for the configuration
item type selected in the Rule Topology pane.

[ Add as a Symptom: Adds the selected indicator state as a symptom for the

configuration item type selected in the Rule Topology pane.

Launching Operations Orchestration Run Books

If you are using HPE Operations Orchestration (OO) to automate operator tasks for analyzing or fixing
problems, these OO Run Books can be mapped to Cl Types within OMi.

Learn More

Operations Orchestration Run Books

Run Books can be started from events (shortcut menu). The Cls related to the event define which of
the available flows are suitable. When you launch a Run Book from an event, appropriate flow
parameters are automatically acquired from the Cl or event itself.

Note: When integrating Run Books from OO, you must specify for which Cl types each Run Book
is valid and define which event attributes can be used as Run Book input parameters.

If a Run Book input parameter is mapped to a Cl attribute and an event attribute, the event attribute
takes precedence (if launched from events).

Tasks

How to Launch an HPE Operations Orchestration Run Book
1. Open the Event Browser to display the list of known events:
Workspaces > Operations Console > <select a perspective>
2. Select the Run Book that you want to run on an event:
Right-click Launch > Run Books > <select a Run Book>
The selected Run Book is launched in the context of the event or the Cl associated with the
selected event.

Note: The context menu item is only visible if the logged-on user has permission to execute
Run Books. You can set permissions in Users, Groups, and Roles:
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Administration > Users > Users, Groups, and Roles

You can find the relevant categories that apply to Run Books in the Permissions Reference
section.

Viewing Closed Events

You can view the history of closed events over a specified time period. This information can help you
better understand long-standing problems. From the Closed Events Browser, you can change the
lifecycle state of any displayed events, for example, to Open.

To access

[

In the Event Browser, click “s2 Show Closed Events.

Learn More

Closed Events

The Closed Events Browser shows only a snapshot of closed events available at the time of opening
the Closed Events Browser. Reopened events are automatically removed from the Closed Events
Browser window. However, events that are closed after the opening of the Closed Events Browser are
not automatically added to the current Closed Events Browser window. A refresh is required. The
timestamp when the snapshot was taken is displayed in the Closed Events Browser window.

You can create filters to help you identify specific events, for example, to select a particular CI.

Closed events can be manually removed from the database. Use the opr-archive-events tool to delete
closed events from the database and add them to an archive file. For details, see "opr-archive-events
Command-Line Tool" on page 103.

Closed events can also be archived automatically. For details, see the OMi Administration Guide.

The maximum number of events that can be displayed in the Closed Events Browser can be configured
in the Infrastructure Settings manager. For details, see the OMi Administration Guide.

Tasks

This section includes:

« "How to View Closed Events" below

« "How to View the Closed Event History of a Cl or Node" on the next page

How to View Closed Events

1. Inthe Closed Events Browser Configuration dialog box, select whether to base filtering on the
time when the event was received or when the lifecycle state was changed to closed.

2. Specify the time period for which you want to display history. Select a predefined period:
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o Last hour

o Last 24 hours
o Last 3 days

o Last 7 days

o Last 14 days

Alternatively, select Select a custom range, specify a custom time range, and click Apply.

Optional. Select an event filter from the list to further reduce the number of events in the selected
range.

Note: The following warning indicates that the selected event filter cannot be used with
closed events, for example because it contains matches or not matches operators:

The selected filter cannot be applied to closed events.

To create another filter or modify an existing one, click the Browse (...) button, which opens the
Select an Event Filter dialog box. For information about filters, see "How to Define Simple Event
Filters" on page 82.

The number of closed events in the selected range is displayed at the bottom of the Closed
Events Browser Configuration dialog box.

Click OK to close the dialog box and display the Closed Events Browser containing the closed
events that match the specified time period and filter.

To change the time period click Reconfigure in the Closed Events Browser and modify your
selections in the Closed Events Browser Configuration dialog box.

To clear or change the event filter, select <No Filter> or another filter from the event filter drop-
down list.

Tip: Click the [Z: Hide Closed Events button to return to the Event Browser.

How to View the Closed Event History of a Cl or Node

In this task, you display a Closed Events Browser window containing all closed events associated with
the related ClI or node of a current event over a selected time period.

1.

Open the Event Browser to display the list of events:
Workspaces > Operations Console > <select a perspective>

Right-click the event for which you want to see the event history and select from the context

menu:

o Show > Closed Events (Node) for closed events that are associated with the host system
where the selected event occurred.

o Show > Closed Events (Related Cl) for closed events that are associated with the Cl related
to the selected event.
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3. Inthe Closed Events Browser Configuration dialog box, specify the time period for which you
want to display history. For more information on working with the Closed Events Browser
Configuration dialog box, see "How to View Closed Events" on page 54.

Alternatively, right-click one or more selected Cls in the View Explorer and select Show > Closed
Events. The Closed Event Browser displays all events that are associated with one of the selected Cls
or nodes.

Exporting Event Data

You can export the contents of the Event Browser to an external file. The supported formats include
Microsoft Excel and comma-separated value (.csv) lists. It is possible to export the information
selected for display in the Event Browser (default), a subset of this information or any combination of
available attributes.

Note: Alternatively, you can copy the details of any selected events to the clipboard using the key
combination CTRL + C . Use CTRL + V to paste to the target location. The information available
in the Event Browser is copied in the order that it is displayed. If expected information is missing,
check that the associated column is configured to be displayed in the Event Browser.

To access

Click £ Export Events List in the Event Browser.

Tasks

How to Export the Contents of the Event Browser
1. Optional. Filter the event browser to display only the events that you want to export.
2. Inthe Event Browser, click £ Export Events List.
The Export Event List dialog box opens.

3. Onthe Available columns tab, select the attribute columns to export and click the add = button
to include them in the Export these columns box.
Use the add all ) button to include all columns in the Export these columns box.

4. Select from the Export these columns box any columns that you do not want to export and click
the remove “ button.

Use the remove all () button to remove all columns from the Export these columns box.

5. Select column names and rearrange their export order by use of the up t and down ¥ buttons.

The first column item in the list is displayed as the first column in the exported file. Subsequent
column items are placed progressively to the right in the order of their appearance in the Export
these columns list.

Alternatively, to select the default columns for export, click Reset to defaults.
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6. From the File format list, select the format of the export file to be created:

o Comma-separated values (.csv)

Note: The content of the exported event list in . csv format is separated by semicolons.

o Microsoft Excel 2007 Workbook (. x1sx)
o Microsoft Excel 97-2003 Workbook (. x1s)

7. Click OK.
8. Enter a name and select a location for the export file and click Save.
Note: If you export the contents of the Event Browser with non-ascii characters using the

comma separated values (. csv) format and open it directly in Microsoft Excel, the characters
may be unreadable.

As the file is UTF-8 encoded, it can be read by Microsoft Excel by using one of the following
methods:

o Import the file into Excel with UTF-8 character set:
Data > Import External Data > Import Data
Text Files, 65001 encoding (UTF-8)

o Open the csv-format file with Notepad and save it with UTF-8 encoding.

Event Details

The Event Details pane displays information on the selected event.
This section covers information on the following Event Details pane tabs:

« "General" below

« "Additional Info" on page 61

« "Source Info" on page 63

« "Actions" on page 64

« "Annotations" on page 65

« "Custom Attributes" on page 67
« "Related Events" on page 69

« "History" on page 71

« "Resolver Hints" on page 72

« "Instructions" on page 74

« "Forwarding" on page 76

General

The General tab in the Event Details pane displays detailed information about the selected event
including its origin, the time at which it was created, and who is responsible for resolving the problem to
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which it relates. The values for Severity, Lifecycle State, Priority, Assigned Group, and Assigned User
can be changed using the associated lists.

Note: If afield is empty, no information exists for the selected item.

To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the General tab.

Learn More

General Event Details

The General tab in the Event Details pane displays the most commonly required information associated
with a selected event. General event information includes the following details:

« Severity: Indication of the level of the problem assigned to the selected event. Usually, this is the
same as the severity status of the original event received from OM.

« Lifecycle State: Point in the event lifecycle that the selected event has reached (Open, In
Progress, Resolved or Closed).

« Priority: Importance assigned to the selected event (for example, Low, Medium, or High).

« Locationin the network where the original problem occurred (read-only).

« Userwhois responsible for solving the problem.

« Message text in the Title field. This type of text field also supports URLs and hyperlinks (Ctrl+click).
Note: URLs that are part of an event title are rendered in the Event Browser as active links.
URLs starting with http://, https://, ftp:// and fttps:// are supported.

If the URL contains special characters, such as '%' or'/', they are automatically escaped, for
example, '%25' or '%2f'.

This poses a problem if the URL that is inserted contains already escaped characters ('%2f') as
these characters are then escaped again ('%252f') making the URL invalid.

If a URL contains escaped characters and should be stored in the event title, it should be
included in angle brackets, which prevents it from being escaped again, for example:

<http://www.google.com/search?q=abc%2fdef>

The available information displayed in the General tab summarizes the most important information
contained in the original event. A blank field indicates that no information is available. If you know that a
particular type of required information is not automatically available, you can use custom attributes to
provide this information.
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Ul Reference

Event Details General Tab

Ul Element
(A-2)

Q

Assigned
Group

Assigned
User

Category

Control
Transferred

Duplicate
Count

Event Type
Indicator

HPE Operations Manageri (10.10)

Description

Save: Saves the changed values.
Undo changes: Discards the changed values.

Name of the group to which the selected event's assigned user belongs.

Name of the user who is responsible for solving the event's underlying problem. For
example, if the event is owned by an OMi user, the user name is displayed. If the
event is owned by an OM user, the user name is displayed with the prefix OM:, for
example, OM:Database Operator.

Name of the logical group to which the event belongs, (for example, Database,
Security, or Network). The event category is similar in concept to the OM message
group.

Indicates if the responsibility for the associated event is escalated to a higher-level
manager.

Number of duplicate events associated with the selected event.

Display name of the event type indicator (ETI) used to calculate the status reported
by the selected event and the current value, (for example,
Web application state:Slow).

WebAppState is the name of the event type indicator. The corresponding label is Web
application state, whichis shown in the General tab. The level of the current ETI
value is Slow.

If event type indicators are assigned (see the Source Info tab) but are not being
resolved (event type indicator field in General tab is empty), the configuration must
be corrected.

ID of the selected event. The event reports an event that occurred in the operational
environment.
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Ul Element
(A-Z)

Lifecycle
State

Node

Priority

Related CI

Description

Point in the event lifecycle that the selected event has reached:
- Open

#_In Progress

. — Resolved

E!J—Closed

To change an event's lifecycle status, select a lifecycle state from the list and click
Save. User authorizations control the permissions to change lifecycle states.

The following list shows correlation between the state used in the incoming message
and the state used in OMi:

« Message = acknowledged; Lifecycle state = Resolved
« Message = owned; Lifecycle state = In Progress
« Message = neither acknowledged nor owned; Lifecycle state = Open

Host system where the event occurred. Use the link or #1 button to open the ClI
Properties dialog box of the CI.

The priority assigned to the selected event (for example, Low, Medium, or High).

To change an event's priority, select a priority from the list and click Save.

Name of the impaired configuration item where the event occurred. The link opens
the CI properties in a pop up window.

If the Related Cl includes a subcomponent, it is displayed as follows: Related ClI
[additional info]: Subcomponent. For example, Serverl[Windows]: CPUL.

Use the link or & button to open the CI Properties dialog box of the CI.
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Ul Element
(A-2) Description
Severity Severity assigned to the selected event. Usually, this is the same as the severity
status of the original event received from OMi. The following icons indicate event
severity status:
& _ Critical
v Major
£ — Minor
& Warning
& — Normal
& — Unknown (Cannot change severity to Unknown).
Note: You can also configure the Event Browser to apply a background color to
the event that represents the severity of the event. For details, see "Configuring
the Event Browser " on page 44.
Source CI Host system where the monitoring agent or probe is running that generated the

selected event.
Use the link or & button to open the CI Properties dialog box of the CI.

Subcategory Name of the logical subgroup (category) to which the event belongs (for example,
Oracle (database), Accounts (security), orRouters (network)).

Time Date and time when the selected event was created.

Created

Time First Date and time when OMi first received notification of the selected event.
Received

Time Date and time when the selected event was received. (In case of duplicate events,
Received the date and time the last duplicate event was received.)

Time State Date and time when the last lifecycle state change took place.
Changed

Title Brief description of the nature of the selected event.

Additional Info

The Additional Info tab in the Event Details pane displays more detailed information about the attributes
of the selected event.
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To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the Additional Info tab.

Learn More

Additional Info
Additional event information includes the following details:

« Application name

« Object

« Key

« Close events with key

« Suppress deduplication flag

« Received during Downtime flag

« Description of the event

« Solution information for the event

Ul Reference

Event Details Additional Info Tab

Ul Element

(A-2) Description

=1 Save: Saves the changed values.

®) Undo changes: Discards the changed values.

Application | Application that caused the event to occur.

Unlike the Related Cl attribute in OMi, which is a direct relationship to a Cl in the
RTSM, the application attribute is a simple string-type attributes from OM.

Examples of Application attributes are Oracle, and OS.

Close String used to automatically acknowledge duplicate events.
Events with
Key

Description = Optional information about the original event in addition to the event's original title
and the text captured from the event source.

HPE Operations Manageri (10.10) Page 62 of 307



OMi User Guide
Chapter 6: Event Browser

Ul Element

(A-2) Description

Key Key associated with the original OM event. It is an identifier used to identify the
message policy. Used for duplicates and for Close Events with Key.

Object Device such as a computer, printer, or modem.

Unlike the Related CI attribute in OMi, which is a direct relationship to a Cl in the
RTSM, the object attribute is a simple string-type attribute from OM.

Examples of Object attributes include orainst, C:, /dev/spool.

Received in  Indicates whether an event was received from a Cl during a time period when the CI
Downtime was in downtime (scheduled to not be available).

Skip Indicates whether duplicate suppression is inactive. Stops automatic discarding of
Duplicate new events that are duplicates of the selected event. Attributes can be set to
Suppression suppress deduplication of events. For details, see the OMi Administration Guide.

Solution Text field used to document solutions to help operators solve the problem indicated
by the event.
Type String used to organize different types of events within an event category or

subcategory (for example, users or applications, accounts, and security).

Source Info

The Source Info tab of the Event Details pane displays an overview of the information relating to the
identification of the source Cl of the received event.

To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the Source Info tab.

Ul Reference

Event Details Source Info Tab

Ul Element
(A-2) Description
Match Displays details of the policy that the event matched:
Information .
« Policy Name
« Policy Type
» Condition
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Ul Element

(A-2) Description

Original Displays details of the original event:
Event

« Original ID — Unique ID assigned to the original OM message by the message
policy that generated the message.

« Original Data — Original event text as captured from HPE Operations Agents
before being formatted into an OM message.

Contains information about the original input before being normalized by HPE
Operations Agent policies into a message. Typically, the information available
includes node name, message group, application, object, severity, and message
text.

Originating = Management server that forwarded the original OM event along the chain of servers
Server configured in a flexible management environment:

o DNS Name of the forwarding management server

« |IP Address of the forwarding management server

Sending Last server in the OM flexible management chain that forwarded the event to OMi:

Server o DNS Name of the last OM management server

« |P Address of the OM management server

Actions

Events from OM received by OMi may contain event-related actions. The Actions tab in the Event
Details pane displays these actions available for an event. There are two types of possible actions:
user actions and automatic action.

Click the Start button to run an action. The Stop button stops a running action from completing.

To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the Actions tab.

Learn More

Actions

OM actions can be started manually from any events which have actions associated with them. The
actions can be used to help solve the problem that caused the event or inform about the existence of a
problem, for example, by a notification.

The Event Browser displays an icon in the A column to indicate that an automatic action is available for
the selected event. Anicon in the U column indicates that a user action is available for the selected
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event. For more information about the icons used in the Event Browser, see "Event Browser" on
page 28.

Tasks

Related Tasks

« "How to Run an Event-Related Action" on page 193

o "How to Launch a Custom Action" on page 193

Ul Reference

Event Details Actions Tab

Ul Element (A-Z) Description

Action Action specification summary.
Node Target system where the action can be run.
Start Starts the action on the Cl associated with the selected event.
State Describes the status of the available action. The following states are used:
i}
& — Available
&
o — Running
£

&;- — Succeeded

& — Failed
Stop Stops the current action.

Annotations

The Annotations tab in the Event Details pane displays a list of the annotations attached to the
selected event. Annotations are comments and observations relating to the event that help the event
owner understand what the underlying problems are and how to fix them. Click the Add button to add an
annotation to the selected event.

Note: Annotations exceeding 101,298 characters are truncated in the Event Details pane.
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To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, open the Annotations tab.

Learn More

Annotations

An annotation is a free-text attachment to the description of an event used to provide information that
may be useful to solve the cause of this event. You can use the Annotations tab in the Event Details
pane to add, view, and manage the annotations associated with an event. The annotations text field
also supports URLs and hyperlinks (Ctrl+click).

The Event Browser displays icons in the annotations column N to indicate that annotations exist for a
selected event. For more information about the icons used in the Event Browser, see "Event Browser"
on page 28.

Tasks

This section includes:

« "How to Add an Annotation to an Event" below

« "How to Add an Annotation to All Selected Events" below

How to Add an Annotation to an Event
1. Open the Event Browser to display the list of known events:
Workspaces > Operations Console > <select a perspective>
In the Event Browser, select an event.
From the Event Details pane, open the Annotations tab.

Click ** Add Annotation from the Annotations toolbar to open the Create New Annotation
dialog box.

Enter the information text.
Click OK.

How to Add an Annotation to All Selected Events
1. Open the Event Browser to display the list of known events:
Workspaces > Operations Console > <select a perspective>

2. Inthe Event Browser, select all the events to which you want to add this annotation.

3. Right-click one of the selected events and click * Add Annotation from the Annotations toolbar
to open the Create New Annotation dialog box.

4. Enter the information text.
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5. Click OK.

Ul Reference

Event Details Annotations Tab

Ul Element (A-

Z) Description
Opens the Add Annotation dialog box. You can add annotation text in the Text
field.
Click OK to save the annotation.

& Opens the Modify Annotation dialog box. You can edit the annotation text in the
Text field.
Click OK to save the annotation.

ey Opens the Delete Annotation dialog box.
Click Yes to delete the annotation.

Text Content text of the annotation.

Time Created Date and time when the selected annotation was added to the event.

User Name of the user who added the selected annotation to the event.

Custom Attributes

The Custom Attribute tab in the Event Details pane displays a list of the attributes that either an
administrator or the responsible user manually configured and added to the selected event. Click the
Add button to configure a custom attribute and add it to the selected event.

Note: To add or modify custom attributes, you must be logged on as a user with permissions to

add, update, and delete custom attributes.

To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the Custom Attributes tab.

Learn More

This section includes:

« "Custom Attributes" on the next page

« "OM Trouble Ticket and Notification Flags" on the next page
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Custom Attributes

Custom attributes are additional information included in the original event forwarded by a monitoring
application such as OM. For example, you can define custom attributes to attach the location of the
problem element or contact details for the team assigned to troubleshoot the problem.

You can use the Custom Attributes tab in the Event Details pane to view and manage the custom
attributes available for an event.

You can also add custom attributes as columns to the Event Browser.

OM Trouble Ticket and Notification Flags

Policies configured in OM can set trouble ticket and notification flags. If these flags are set, the
following custom attributes in OMi are generated:

« ForwardToTroubleTicket (value= true)
« NotifyUser (value= true)

Using appropriately configured event filters, events including these custom attributes with value of
true can be automatically forwarded to an external manager using Forwarding Rules or notifications
sent using Notification Rules.

Tasks

How to Add Custom Attributes to an Event

1. Open the Event Browser to display the list of known events:
Workspaces > Operations Console > <select a perspective>
In the Event Browser, select an event.

From the Event Details pane, select the Custom Attributes tab.

Click = Add Custom Attribute to open the Add Custom Attribute dialog box.
Enter the custom attribute name and value.
Click OK.

2 e

Ul Reference

Event Details Custom Attributes Tab

Ul Element
(A-2) Description

Opens the Add Custom Attribute dialog box. You can add a name and value for the
custom attribute.

Click OK to save the custom attribute.
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Ul Element

(A-Z) Description

et Opens the Modify Custom Attribute dialog box. You can edit the custom attribute.
Click OK to save the custom attribute.

iy Opens the Delete Custom Attribute dialog box.
Click Yes to delete the custom attribute.

Name Name of the selected custom attribute defined for the selected event.

Value Value assigned to the selected custom attribute.

Related Events

The Related Events tab in the Event Details pane displays an overview of all the events that are related
to the event selected in the Event Browser. The way the events are displayed indicates if the event is
considered as a symptom or a cause in the correlation process. The event displayed in bold type in the
Related Events tab is the event that is selected in the Event Browser pane.

To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the Related Events tab.

Learn More

Related Events

To reduce the problem of duplication and overload when managing information from multiple sources,
you can set up topology-based rules. These rules correlate events by distinguishing between symptom
and cause events and present a clearer picture of the state of the operational environment that you are
monitoring.

Topology-based event correlation uses a combination of specified symptoms and a probable causes to
determine the cause of an event, which it then flags in the Event Browser. Anicon in the C column of
the Event Browser indicates that the selected event is correlated. For more information about event
correlation in general, see "Event Correlation" on page 25.

Tasks

Related Tasks
"Relating Events Manually" on page 47
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Ul Descriptions

Event Details Related Events Tab

Ul Element
(A-2) Description
o Removes the relationship between events.

Useful if you think that OMi correlated the selected event by mistake. The Unrelate
action has no effect on the correlation rule that initially established the event relation.
If you want to avoid relating the events in future, modify the associated correlation
rule.

<Severity> Severity assigned to the related event.

Tip: For a short explanation of the icons used to indicate event severity, check
the tooltip.

Assigned Name of the user who is responsible for solving the related event's underlying
User problem.

Correlation ' Link to the correlation rule used to create the relationship.
Rule

Related CI | Name of the impaired configuration item where the event occurred.
State Lifecycle state of the event (for example, Open, In Progress, or Resolved).

Time Date and time when the original message associated with the related event was
Received received from OMi.

Title A plus sign (+) icon in the event text column indicates the presence of correlated
events, which the related events tab does not by default display. Use the plus sign (+)
or minus sign (-) icons to display or hide correlated events.

Potential Causes Tab

All possible correlation results are recorded and displayed in the Potential Causes tab. It shows the
possible cause events, together with a reference to the correlation rule that generated the correlation.
Additional information, such as the rule weight factor, and the time when the related event was received
from OMi, are also displayed. Operators can inspect all possible causes for a symptom event, better
understand the matching correlation rules, and, if they have the appropriate permissions, manually
change the cause of that event to any one of the available alternatives when investigating a problem.
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Ul Element

Severity

Title

Related CI

Time
Received

State

Assigned
User

Correlation
Rule

Rule
Weight

History

Description

Relate: Replaces the current cause with cause event selected from the Potential
Causes list.

Useful if you think that OMi correlated the wrong event. The Relate action has no
effect on the correlation rules involved. If you want to automatically relate to an
alternative cause event in the future, modify the associated correlation rule.

Severity assigned to the related event.

Tip: For a short explanation of the icons used to indicate event severity, check
the tooltip.

Text of the message sent from OMi.
Bold text indicates that the event is set as the current cause.

If you want to set one of the events in the Potential Causes list as the cause, you can
do so manually using the Relate button.

Name of the impaired configuration item where the event occurred.

Date and time when the original event associated with the related event was received
from OMi.

Lifecycle state of the event (for example, Open, In Progress, or Resolved).

Name of the user who is responsible for solving the related event's underlying
problem.

Link to the correlation rule used to create the potential relationship.

Specifies a weighting for the selected correlation rule. The default value is Normal.

A correlation rule with a higher weighting can override an existing cause-symptom
relationship previously created by another correlation rule with a lower weighting.

Event history is a log of information about who or which component has changed values of an OMi
event. This feature enables an operator to see how event attribute values changed during the life of an
event, for example, the sequence of severity changes. Event history information is available in a
separate tab in the Event Details pane and can be viewed by any user with access to that event.

To access

Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the History tab.

HPE Operations Manageri (10.10) Page 71 of 307



OMi User Guide
Chapter 6: Event Browser

Learn More

History Information

The information available in the History tab includes the following, if an event is manually modified in
the event console, or automatically modified by closed related events (closing all existing related
events to a new incoming event) or has duplicate events suppressed (retain and update the original
event and close newer duplicates):

« The server's timestamp of the modification.
« The old and the new value of the modified attributes.

« Information is also available about the modifier of the event. One of the following types of information
is available:

o User name, if an OMi user has modified the event or if an external user has made the
modification.

o Title line which summarizes a change resulting from automatic closing of related events or an
automatic suppression of duplicate events.

o Integration user name of the OM synchronization, if the event is modified by a data
synchronization from OM.

« Forannotations and custom attributes, the executed action, such as delete, or modify, is displayed
in the history line entry.

Ul Reference

Event Details History Tab

Ul Element (A-2) Description
Actions Descriptions of the changes made to the event.
Modification Time Date and time when the associated change was made to the event.

Modified By User who made the associated change to the event.

<Search field> Text field used to search for strings within event history. The # button
clears the search string and displays all history information.

Resolver Hints

The Resolver Hints tab displays the information relating to the identification of the node, source Cl,
related Cl, and the ETI of the received event.
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To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the Resolver Hints tab.

Ul Reference

Event Details Resolver Hints Tab

ul

Element

(A-2) Description

ETI ETI Resolution Hint: Original string provided by the external manager, for example,

Resolution ' in a custom message attribute from OM. Can be used to associate the event with an
ETIL
You must set an attribute in the event which can be mapped to this indicator. To do
this, set a custom message attribute called ETIHint in the OM policy. Specify a
namespace for the CMA that matches the Name of the indicator, for example,
CPULoad. Specify an instance that matches an indicator state, for example, High.
When an event with an ETIHint CMA value of CPULoad:High is received, and ETI and
values exist, the event attribute Event Type Indicatoris set.

Node Information used to identify the host system in the RTSM associated with the selected

event:

« Node Hint: Hostname used to find a node in the RTSM
« DNS Name: DNS name of the originating system

« IP Address: IP address of the originating system

o Core ID: ID of the originating system

Related CI = Name of the impaired configuration item where the event occurred.

« Related CI Hint: Event information used to identify the Cl related to the event
« HPOM Service ID: Service ID used to identify the service related to the event
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Ul
Element
(A-Z) Description

Related Cl ' Information associated with the selected event:
Resolution

Info « Matched Hints Count: Number of identified hints that matched the selected Cl in

the RTSM database. This value is presented as a proportion of the number of
available identifiers extracted from the event. The available identifiers are displayed
in the following sections of the Resolver Hints tab:

o Related Cl Hint —includes colon-separated list of C| hints and must include
the host identifier.

o HPOM Service ID — Service ID, in conjunction with object and application,
used to identify the service related to the event.

o ETI Hint — Used to identify the ETI for each CI. If ETI Resolution is
successful, the ETI is assumed to be assigned to the Cl, and this Cl is given a
higher match rating.

« Status: Provides information about the matches used for related Cl resolution.
Displays information about the match:
o Success — Confirms a successful match and displays the hint used.

o Unsuccessful Cl resolution — Displays the hint that could not be resolved or
indicates that no hint was available to assess. Confirms that a match was not
possible and indicates the action taken, for example, Fallback to host.

Source Cl  Information used to identify the Cl in the RTSM that is the source of the event
associated with the selected event:

Source Cl Hint: Description of an OMi event attribute used to find the Cl in the RTSM

Instructions

The Instructions tab in the Event Details pane displays instruction information designed to help
operators handle the associated event.

To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, select the Instructions tab.
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Learn More
Instructions

Setting up instructions

Instructions are configured in the policy that generates the event. They can describe an automatic
action, provide details on how to perform an operator-initiated action, or detail the steps for resolving a
problem when a specified type of event is received.

The instruction text can be either entered directly in the Instruction Text field in the Policy Editor or
generated using external instruction interfaces. To retrieve the instructions generated externally, you
need to specify the instruction interface name and the parameter string in the Policy Editor for the
associated policy.

Note: By default, only events from OM for Windows or OM for UNIX or Linux sources can
populate the instructions tab in the Event Perspective. To extend OMi to include other event
sources, such as SiteScope or BSM Connector, to populate the instructions tab, see the OMi
Extensibility Guide (Groovy Scripts > Development and Deployment of Scripts > External
Instruction Retrieval Scripts).

Accessing instructions
The Event Browser dynamically retrieves the instructions when you select the Instructions tab.

The instruction output can be plain text or HTML. If the instruction text contains URLSs, they are
automatically converted into hyperlinks. URLs starting with http://, https://, ftp://, fttps://,
telnet://, and mailto: are supported. When you click the hyperlink, a new window opens with the
page that was returned by the script. In case of the HTML output, clicking the URL opens a new HTML
page containing the instruction text.

Note: If the event originates from an OM or another OMi server, you must configure this server as
a connected server. For details, see the OMi Administration Guide.

In flexible management environments where events can come from multiple servers, you must
connect to the server from which the policy generating the event was deployed, as only this server
has the instructions available.

Ul Reference

Event Details Instructions Tab

Ul Element Description

Instructions | Instruction text generated for the event. Instructions are configured in the associated
policy and are usually designed to help operators handle the associated event.
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Forwarding

The Forwarding tab is available for events for which ownership was transferred to an external manager.
The information displayed in this tab is dynamically loaded from the external manager when the tab is

]
opened. To load the latest information available from the external manager, click the == Refresh
button in the Forwarding tab.

For example, if your organization uses HPE Service Manager as a central service desk, you can
transfer control of events from the Event Browser to HPE Service Manager. This is often the case
when the OMi operator is not able to solve the problem and needs to assign the problem to an expert.
HPE Service Manager creates an incident returns the Incident ID to OMi. This is displayed in the
Forwarding tab with additional information about the event available from the external manager.

To access
Workspaces > Operations Console > <select a perspective>

In the Event Browser, open the Forwarding tab.

Learn More

External Target Servers
The external manager server must be specified as a target in the Connected Servers manager.

If there is a problem connecting to the system to which you want to transfer control, the event forward
request or event update synchronization request is held in a queue. If the request cannot be delivered to
the target server within the specified time, it is automatically deleted from this queue.

To set the Event Forwarding Expiration time period, see the OMi Administration Guide. The default
value is 2 hours and the minimum value is 1 hour.

Tasks

How to Transfer Control to an External Manager

1. Inthe Event Browser, select the events that you want to transfer control to an external manager.
2. Right-click one of these events and from the context menu select:

Transfer Control to > <select a manager>
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Ul Reference

Event Details Forwarding Tab

Ul Element

(A-2) Description

@ Refreshes the contents of the Forwarding tab.

| Deletes the transfer of control request for a pending transfer of control request. If the

transfer request is complete, a cancel is no longer possible and the Cancel Transfer of
Control is disabled.

Assigned Group assigned to the event by the external manager.
Group

Assigned User assigned to the event by the external manager.
User

External ID ID assigned to the event by the external manager. The link opens the event in the
external application that is responsible for managing the event.

External Node on which the external manager is hosted.
Server

Lifecycle Lifecycle state assigned to the event by the external manager.

State
Priority Priority assigned to the event by the external manager.
Severity Severity assigned to the event by the external manager.
Transfer Status of the Transfer Control request. The possible states are:
Status « Cancel Requested — For a transfer control request that is still in the queue for
processing, a request was made to cancel the transfer of control.
« Forwarded — Control of the selected event was transferred to the selected
external server.
» Queued — Request to transfer control of the selected event is in the queue for
processing.
Transfer Forwarding rule used to transfer control of an event to an external application.
Forwarding
Rule
Transfer User who transferred control of an event to an external application.
Initiated By
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Ul Element
(A-2) Description
Type Specifies how an event forwarded to a certain server is handled. The options include:

« Notify — Target server receives original events but no further updates

« Notify and Update — Target server receives original events and all further
updates

« Synchronize — Target server receives original events and all further updates and
sends back all updates

« Synchronize and Transfer Control — Target server receives original events and
updates and sends back all updates. Ownership of the event is transferred to the
other server. Only OMi users with special permission are allowed to close the
event after control is transferred, for example, an Administrator.

This option is available only if Enable Synchronize and Transfer Control is enabled
on the selected connected server. An operator may manually transfer control via
the context menu of the Event Browser.

Note: If a Forwarding entry in the forwarding table was received from another
server, the forwarding rule states which server sent this entry.

For more details, see the OMi Administration Guide.

Event Filters

You can limit the set of events displayed in the Event Browser using filters that you define to display a
subset of the available events. For example, you can filter the events displayed according to severity,
the assigned user, the event category, or the lifecycle state. You can also display the filtered events in
different pages. The Event Browser is dynamically updated. Events that no longer match a relative time
filter are removed from the Event Browser and new events that match are added.

The filters you define are available from the Select an Event Filter dialog box or the filter selection drop-
down box of the Event Browser. The active filter remains on display in the filter selection drop-down
box.

Learn More

This section includes:

« "Creating Filters" below
« "Filter Availability" on the next page

« "Filters for Closed Events Browsers" on the next page

Creating Filters

You define and edit filters using the Create New Event Filter dialog box available from the Event
Browser. Simple filtering information is grouped under the General, Dates, and Additional Event
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Properties tabs. A Simple Filter definition is the combination of all information specified in the three
tabs.

You can also use the Advanced Mode for defining more complex filters. An advanced filter definition is
specified in the Filter Definition pane using combinations of properties and operators.

Filter Availability

By default, filters for the Event Browser are visible and available only to the user who created them.
Users with appropriate OMi administration permissions can share filters, making an existing filter
available to all users.

You can create filters for use in the Event Browser, the Closed Events Browser, the Monitoring
Dashboard, and many OMi administration areas.

Filters used in administration, for example, in Forwarding Rules or Notifications, are bound to their
administration area and are not visible or usable in any other context. You can apply a different filter for
each instance of a perspective. Filters defined for the Event Browser are also available in the Closed
Events Browser and vice versa. However, the Event Browser cannot display unresolved and closed
events at the same time.

Filters for Closed Events Browsers

When investigating closed events using the Closed Events Browser, you specify the time period of
interest and optionally an event filter to further reduce the number of events in the selected range. Not
every event filter can be applied to closed events. For example, filters that contain matches or not
matches operators cannot be applied. Only closed events matching the event filter are loaded from the
database.

Filtering Methods

Large IT environments naturally create a large number of events. All active events are displayed in the
Event Browser and maintaining a clear overview of the events that require attention becomes
increasingly difficult as the number of received events increases.

You can filter the contents of the Event Browser, for example, in the Event and Health Perspectives (or
perspective containing an Event Browser and the View Explorer), according to a combination, where
available, of the following selections:

« Views

Views are used to group configuration items into logical sets. Selecting a view, the Event Browser
only displays events that are related to the Cls specified in the selected view.

« Configuration Items

Selecting one or more Cls from the Cl tree only displays events in the Event Browser that are related
to the selected Cls.

« Configuration Item Collection

Selecting a Cl Collection from the Cl tree only displays events in the Event Browser that are related
to the Cls that are contained within the selected collection.

« Event Filters
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Applying an event filter enables you to limit the type of events displayed in the Event Browser by
defining rules that filter events according to criteria such as severity, lifecycle state, or assignment
(ownership).

In the Event Browser, event filters can be shared so that all users have access to them. To be able
to share filters, you must have appropriate permissions. For details, see the OMi Administration
Guide. Shared filters are required by Monitoring Dashboard widgets.

« Quick Filters

The Event Browser status bar displays a summary of the number of events by severity and
assignment to individual users or user groups. Each status bar severity item is also a quick filter that
can be selected to display the events that correspond to the selected severity. Multiple items can be
selected to display all events with two or more severities.

« Search

Events can also be filtered by a search string. Entered text string is used to search the text
displayed in the Event Browser and display only the events containing the specified string. Clearing
the field displays all events again.

By applying a combination of the available filtering methods, you can display just the most important
events that you are responsible for. It is possible to create a view to display a Cl tree list tailored to the
responsibilities of an operator. Operators can then select a Cl from the CI tree and be shown all related
events. Alternatively, operators can define filters to, for example, show only events labeled as
Critical and Major. Combining the selection of a Cl and applying the same filter displays all events
labeled as Critical and Major for the select ClI.

Filter Selection

The contents of the Event Browser pane can be filtered by the selected view or configuration item and
by the selected event filter.

The active view or configuration item used to filter the Event Browser content is indicated in the Event
Browser title. For example, if a view with the name Host Resources is selected, the Event Browser
title displays Event Browser for Host Resources. The selected view name is also displayed in the
Event Browser status bar.

When you open the Event Browser for the first time, no filters are applied. Select an Event Filteris
displayed in the Event Browser Filter applied list and No Filter is displayed in the Event Browser
View Selector list. After you select a filter, the name of the active event filter is displayed in the filter
selection field. If you want to clear the selected filter, select No Filter. The effect of the filter on the
Event Browser is cleared, but can be reapplied as required. After you select a view, the name of the
active view is displayed in the View Selector field. If you want to clear the selected view, select No
Filter. The effect of the view on the Event browser is cleared, but can be reapplied as required.
Administrators can preselect a view for an Event Browser. In locked Event Browser pages, the View
Selector is disabled so that only events associated with a preselected view are displayed.

How to Filter Events by Views

In this task, you leam how to filter the events displayed in the Event Browser according to a view. Only
events related to configuration item included in the selected view appear in the Event Browser.

To filter events by views:
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1. Start the Event Perspective or Health Perspective:
Workspaces > Operations Console > <select a perspective>
2. Do one of the following:
o Inthe Browse Views tab of the View Explorer, use the view list to select a view to apply.

o Inthe Event Browser, select a view from the View Selector. The five most recent selections
are displayed at the top of the list.

The events displayed in the Event Browser are limited to events associated with the selected
view. The Event Browser title changes to show the view selected.

Note:

o The OMi perspectives are wired so that selecting a view in the Event Browser View
Selector disables the Cl selected in the View Explorer.

o The Event Browser View Selector is disabled in locked Event Browser pages so that only
events associated with a preselected view are displayed.

How to Filter Events by Configuration Items

In this task, you learn how to filter the events displayed in the Event Browser by configuration item.
Only events related to the selected configuration item appear in the Event Browser.

To filter events by configuration item:

1. Start a perspective containing an Event Browser and a View Explorer, for example, the Event
Perspective or the Health Perspective:

Workspaces > Operations Console > <select a perspective>
In the Browse Views tab of the View Explorer, use the view list to select a view to apply.

2. Select one or more configuration items, Cl collections, or a combination of both from the View
Explorer pane to use as an event filter.

The Event Browser displays only the events that are related to a Cl selected in the View Explorer.

The events displayed in the Event Browser are limited to events associated with the selected Cl.
The Event browser title changes to show the Cl selected.

The selected Cls are displayed in the Event Browser status bar.

Note: The OMi perspectives are wired so that selecting a Cl in the View Explorer disables the
view selected in the Event Browser View Selector.

How to View and Apply Event Filters

In this task, you learn how to display a list of configured event filters and apply one to the Event
Browser.

To view a list of configured event filters:
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1. Start a perspective containing an Event Browser and a View Explorer, for example, the Event
Perspective or the Health Perspective:

Workspaces > Operations Console > <select a perspective>
Select afilter from the Filter list.

Note: If you have selected a view from the View list, the Event Browser is also filtered by the
selected view.

2. From the Event Browser or the Closed Event Browser, open the Select an Event Filter dialog box
()
The Select an Event Filter dialog box opens containing a list of available event filters.

3. Select the event filter you want to apply.

4. Optional. Open the Create New Event Filter dialog box using the fi? Edit Item button and modify
the selected filter and click OK.

5. Click OK to enable the selected event filter.
Enabling a filter updates the contents of the browser immediately.

6. If the selected filter does not display the results you require, redefine the selected event filter or
select an alternative event filter.

Note: If you want to clear the selected filter, select No Filter from the filter selection boxes
(views and filters). Deleting the filter selected in the Event Browser from the list of filters
automatically applies no filter to the Event Browser.

How to Define Simple Event Filters

In this task, you learn how to set up a Simple Filter for the Event Browser or the Closed Event Browser
using the Create New Event Filter dialog box.

To define an event filter:

1. From the Event Browser or the Closed Event Browser, open the Select an Event Filter dialog box
using the Manage Event Filters (...) button.

The Select an Event Filter dialog box opens containing a list of available event filters.
2. From the Select an Event Filter dialog box, open the Create New Event Filter dialog box using the
New Item - button and select New Simple Filter.
The Create New Event Filter dialog box opens.
Enter a display name and description for the new filter.

4. Use the displayed tabs to configure the new filter (General, Dates, and Additional Event
Properties).

In the Create New Event Filter dialog box, if any one of the selected criteria within a frame is true,
for example, Severity of the eventis Critical, the event is selected by the filter.

All selections in the frames themselves and the other filter criteria, for example, Severity is
Critical and Assigned to is Me, must be matched by the event for it to be selected by the filter.
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For example, if the severities Critical and Major are selected within the same pane, events
exhibiting either severity are displayed. If the assignment Not assigned is also selected from
another pane, only events not assigned to a user and exhibiting one of the selected severities are
displayed.

Note:
o You must select at least one lifecycle state.

o You can use the matching criteria matches and not matches to specify a regular
expression that the filter compares with the events.

The pattern uses the syntax of the Java regular expressions class java.util.regex. For
the exact syntax of this class, see the online Java documentation.

Processing filters that contain regular expressions requires higher resources than for filters
without them and it is recommended that regular expressions are used only when a simpler
alternative is not possible.

Optional. Select Convert to Advanced to switch to the advanced filter definition mode and further
tailor your filter. For details, see "How to Define Advanced Event Filters" below.

Note: An Advanced Filter cannot be converted back to a Simple Filter.

Select OK to save the changes.

The Create New Event Filter dialog box closes and the new event filter is added to the list of filters
in the Select an Event Filter dialog box.

Optional. Select the newly created event filter and click the 2 Find Matching Events button.
This opens a new Event Browser window, displaying the results of applying the newly defined
filter. If the filter does not display the results you require, redefine the filter.

For details of the Create New Event Filter dialog box, see "Simple Filter Configuration Dialog Box" on
page 87.

How to Define Advanced Event Filters

In this task, you leam how to set up an advanced event filter for the Event Browser or the Closed Event
Browser using the Create New Event Filter dialog box.

To define an advanced event filter:

1.

From the Event Browser or the Closed Event Browser, open the Select an Event Filter dialog box
using the Manage Event Filters (...) button.

The Select an Event Filter dialog box opens containing a list of available event filters.
From the Select an Event Filter dialog box, open the Create New Event Filter dialog box using the
New Item - button and select New Advanced Filter.
The Create New Event Filter dialog box opens.
Note: Alternatively, select New Simple Filter and the Use the displayed tabs to make any

suitable Simple configurations for the new filter (General, Dates, and Additional Event
Properties). These configurations become the starting point for the advanced filter
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configuration after selecting Convert to Advanced and switching to the Advanced Filter
definition mode. For details, see "How to Define Simple Event Filters" on page 82.

3. Enter adisplay name and description for the new filter.

4. Optional. If you started with a Simple Filter, select Convert to Advanced to switch to the
advanced filter definition mode.

The Advanced Mode enables you to very precisely specify filters using a combination of
operators, properties, and expressions.

Note: Advanced Filters cannot be displayed in the Simple Filter view and it is not possible to
switch to the Simple Filter view form the Advanced Filter view.

5. Start assembling a filter by dragging properties and operators to the Filter Definition pane, for
example, Description. Alternatively, select elements or operators and add them to the active

filter specification using the Add i) button.

The Edit Expressions dialog box opens containing an editor specific to the selected property type.
6. There are two basic types of Edit Expressions dialog boxes: string filters and pre-specified filters:

o Defining a string filter:

Select a matching criteria for the selected property, for example, contains and specify a text
string to search for.

You can use the matching criteria matches and not matches to specify a regular expression
that the filter compares with the events.

The pattern uses the syntax of the Java regular expressions class java.util.regex. Forthe
exact syntax of this class, see the online Java documentation.

Processing filters that contain regular expressions requires higher resources than for filters
without them and it is recommended that regular expressions are used only when a simpler
alternative is not possible.

Optional. Select ignore case to make the expression case-insensitive.

o Defining a pre-specified filter:

Pre-specified filters are used to select attributes which have a known range of values, for
example, severities, priorities, lifecycle states, and dates.

Select a matching criteria for the selected property, for example, equals, one of, is true,
before, not older than, and, where appropriate, select one or more of the available options,
for example, severity values, priority values, dates and times, or lifecycle states.

Select OK to close the Edit Expression dialog box.
Repeat steps 5 to 7 to specify additional filtering components to the filter specification.

If you want to change an entry, double-click it. The Edit Expression window opens from which you
can change the specification of the expression.

9. Select OK to save the changes.

The Create New Event Filter dialog box closes and the new event filter is added to the list of filters
in the Select an Event Filter dialog box.

10. Optional. Select the newly created event filter and click the 2 Find Matching Events button.
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This opens a new Event Browser window, displaying the results of applying the newly defined
filter. If the filter does not display the results you require, redefine the filter.

For details of the Create New Event Filter dialog box, see "Advanced Filter Configuration Dialog Box"
on page 90.

How to Share Event Filters

In this task, you learn how to share an existing event filter.

Note:

In the Event Browser, shared filters are available for all users to apply. Only users with
permissions to create shared filters can modify or delete a shared filter. The contents of the list of
event filters displayed in the Event Filter selector include all shared filters and the filters created by
the current user. Shared filters must be used for the Monitoring Dashboard.

Shared filters can be exported using the Content manager. It is not possible to export private
filters.

To share an event filter:

1. Make sure that you have permissions to share filters. This permission can be set under:
Administration > Users > Users, Groups, and Roles

To enable filter sharing, select Shared Filters and in the Operations tab under Full Control,
select Grant.

2. Select the filter that you want to share from Event Browser:
Workspaces > Operations Console > <select a perspective>

In the Event Browser, open the Select an Event Filter dialog box using the Manage Event Filters
(...) button. The Select an Event Filter dialog box contains a list of available event filters. Select a
filter.

3. Share the filter using the Share Item “# button.

Note: You cannot revert a shared filter to a private filter. Shared filters can be deleted.
However, it is not possible to know which other users are already using it. If you want to retain
a shared filter as a private filter, duplicate it before deleting it.

Filter Manager User Interface

The Select an Event Filter and Manage Event Filters dialog boxes display a list of the filters that are
configured by the active user for the current browser or manager. You can select a filter from the list of
configured event filters and apply it, edit or delete an existing filter, or create and test a new filter.

Further filtering interface elements are described in detail in the following topics:

« "Select an Event Filter and Manage Event Filters Dialog Boxes" on the next page
« "Simple Filter Configuration Dialog Box" on page 87
« "Advanced Filter Configuration Dialog Box" on page 90
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« "Edit Expression Dialog Boxes for Advanced Filters" on page 96

« "Operators Used in Filter Configuration Dialog Boxes" on page 100

Select an

To access

Relevant
tasks

See also

Event Filter and Manage Event Filters Dialog Boxes

Workspaces > Operations Console > <select a perspective>

Open the Select an Event Filter dialog box the Manage Event Filters (...) button.

Tofilter events, see:

« "How to Filter Events by Views" on page 80.

« "How to Filter Events by Configuration Items" on page 81.
« "How to View and Apply Event Filters" on page 81.

« "How to Define Simple Event Filters" on page 82.

« "How to Define Advanced Event Filters" on page 83.

For more information about filtering events, see "Filtering Methods" on page 79 and
"Event Filters" on page 78.

The Select an Event Filter and Manage Event Filters dialog boxes display the Ul elements listed in the
following table.

Ul
Element
(A-Z)

S

%

C

Description

Synchronizes the filter data displayed in the list of available filters with the latest
information available in the database.

Opens the selection box from which you can select the type of filter that you want to
specify: Simple Filter or Advanced Filter. The Create New Event Filter dialog box
opens, from which you can create and define a new event filter.

Click OK to save the new filter.

Creates a copy of the selected filter and opens the Create New Event Filter Configuration
dialog box.

Opens the Edit Event Filter dialog box for the selected event filter from which you can
modify the selected event filter.

Click OK to save the modifications to the selected event filter.

Opens the Delete Event Filter dialog box for the selected event filter.

Click Yes to delete the selected filter annotation.

Restore To Default. Reverts a customer-modified factory-predefined filter to the factory
default version.

This option is not available for rules purely defined by the customer.
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ul
Element
(A-Z) Description

& Share Item. Event Browser filters only. Shares the selected event filter for use by all
users. Only users with permissions to create shared filters can modify or delete a shared
filter. The contents of the list of event filters displayed in the Select an Event Filter include
all shared filters and the filters created by the current user.

Q Find Matching Events. Displays events that match the selected filterin an Event
Browser pop-up window. Useful for testing an event filter before applying it to the Event
Browser.

Simple Filter Configuration Dialog Box

The Simple Filter configuration dialog boxes display the attributes that you can use either individually or
in combination to filter events before displaying them.

To access | Workspaces > Operations Console > <select a perspective>

Open the Select an Event Filter dialog box using the Manage Event Filters (...)
button.

Relevant Tofilter events, see:

tasks « "How to Filter Events by Views" on page 80

« "How to Filter Events by Configuration Items" on page 81
« "How to View and Apply Event Filters" on page 81

« "How to Define Simple Event Filters" on page 82

« "How to Define Advanced Event Filters" on page 83

« "How to Share Event Filters" on page 85

See also For more information about filtering events, see "Filtering Methods" on page 79 and
"Event Filters" on page 78.

For more information about the information displayed in the Filter Configuration tabs, see the following
sections:

« "Common Buttons and Icons" below

« "General Tab" on the next page

« "Dates Tab" on page 89

« "Additional Event Properties Tab" on page 89

Common Buttons and Icons

The Filter Configuration window includes the Ul elements listed in the following table.
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Ul Element Description

Convertto | Opens the Advanced Mode used to define more comprehensive filters. For details,
Advanced see "How to Define Advanced Event Filters" on page 83.

Note: Advanced filters cannot be displayed in the Simple Filter view.

General Tab

The General tab in the Simple Filter configuration dialog boxes display the Ul elements listed in the
following table.

Ul Element

(A-2) Description

Assigned User or user group to whom the events you want to find are assigned. Multiple

To assignments can be selected. For example, you can select Assigned To Me and
Not Assigned.

Category Category of event that you want to use as a filter option, for example: DB, Storage,

System, or WebApp.

Correlation = Select the desired option to search for all events, only top level events, or only cause
events:

All events: All events, which includes events correlated as symptoms of other
events.

All top level events: All events that not classified as symptom of another event.

All cause events: All events that are root cause events. They cannot be symptoms
of another cause event.

Description  Description of an event as displayed in the contents of the original event's
description field.

Lifecycle Stage in the problem lifecycle that the events you are looking for have reached, for

State example: Open, In Progress, Resolved or Closed. Multiple lifecycle states can be
selected.

Priority Searches for events that match the specified priorities, for example: None, Low, or

Medium. Multiple priorities can be selected.

Severity Selects an event severity to use as a filter option. Multiple severities can be
selected.

Subcategory Name of the event subcategory to which the events you are looking for belong.
Title Title of the events you are looking for.

Type Type of event you want to display with the filter.
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Dates Tab

The Dates tab in the Simple Filter configuration dialog boxes display the Ul elements listed in the

following table.

Ul Element
(A-Z)

Absolute

Time

Relative
Time

Time Created

Time
Lifecycle
State
Changed

Time
Received

Description

Specifies the date and time in absolute (calendar) terms. A time can be specified by
entering a calendar date, and time values for hours and minutes.

Specifies a point in time used to filter events. Events either before or after the
specified time can be selected using operators such as:
« older than
« not older than
The time period can be specified in minutes, hours, days, or weeks.
Note: The Event Browser is dynamically updated. Events that no longer match

arelative time filter are removed from the Event Browser and new events that
match are added.

Specifies the dates and times between which the events you are searching for
occurred.

Date and time when the last lifecycle state change took place.

Specifies the dates and times between which OMi first received notification of the
events you are searching for.

Additional Event Properties Tab

The Additional Event Properties tab in the Simple Filter configuration dialog boxes display the Ul
elements listed in the following table.

Ul Element
(A-Z)

Description

Application | Selects events linked to the named application.

Cl Type

Selects the option to search for events that are related to the specified Cl type or are a
child of the specified Cl type. The dedicated operators for filtering Cl types are:

« equals: Related CI matches a specified Cl type
« is derived from: Related Cl is derived from the specified Cl type
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Ul Element
(A-2) Description
Custom Selects the Custom Attributes editor where you can specify a custom attribute, an
Attribute operator, and a value for use in filtering.
You define a custom attribute filter by specifying the name of the custom attribute in
the field on the left, selecting a filter matching criteria from the list, and specifying the
value of the custom attribute in the field on the right.
Note: In the Advanced mode, You can add further custom attribute
specifications. These can be related using any of the available operators.
Key Selects events that contain a reference to the named key.
Object Selects events that are related to a named object, as specified in the original OM
message.
Original Original event text as captured from HPE Operations Agents before being formatted
Data into an OM message.
Contains information about the original input before being normalized by HPE
Operations Agent policies into a message. Typically, the information available
includes node name, message group, application, object, severity, and message text.
Solution A text field used to describe the solution steps taken to solve the problem identified by

the event.

Solution texts can be synchronized with external managers such as Service
Manager.

Advanced Filter Configuration Dialog Box

The Advanced filter configuration dialog boxes display the attributes that you can use either individually
or in combination to filter events before displaying them.

To access | Workspaces > Operations Console > <select a perspective>

Open the Select an Event Filter dialog box using the Manage Event Filters (...)
button.

Relevant To filter events, see:

tasks « "How to Filter Events by Views" on page 80

« "How to Filter Events by Configuration Items" on page 81
« "How to View and Apply Event Filters" on page 81

o "How to Define Simple Event Filters" on page 82

o "How to Define Advanced Event Filters" on page 83

« "How to Share Event Filters" on page 85
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See also For more information about filtering events, see "Filtering Methods" on page 79 and
"Event Filters" on page 78.

For more information about the information displayed in the Filter Configuration tabs, see the following
sections:

« "Advanced Filter Configuration" below

« "General Filter Elements" below

« "Dates Filter Elements" on the next page

« "Additional Event Properties Filter Elements" on page 93

« "Advanced Properties Filter Elements" on page 94

Advanced Filter Configuration

The filter matching criteria lists display the Ul elements listed in the following table.

Ul Element

(A-2) Description

g Opens the Edit Expression dialog box for the selected event filter element from which
you can modify the selected event filter element.
Click OK to save the modifications to the selected event filter element.

ey Deletes the selected event filter element from the selected event filter specification.

[ Toggles between full view and compact view of the filter specification.

(=R Adds a new element and opens the Expression dialog box for the newly added
element.

Edit Dialog boxes used to specify filter component definitions that describes, for example,

Expression | what values of a selected attribute is included in the filter definition.

Filter Contains the components chosen to define the filter. Properties are associated with a
Definition | value and are connected using operators.

Filter Contains the available operators and properties used to specify an advanced filter.

Elements Drag each required property or operator to the filter definition pane and drop it in its
logical location in the filter. To edit and delete entries from the filter definition, use the
buttons or double-click the expression that you want to change.

General Filter Elements

The General elements in the Advanced Filter configuration dialog boxes display the Ul elements listed
in the following table.
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Ul Element

(A-2) Description

Assigned User or user group to whom the events you want to find are assigned. Multiple

To assignments can be selected. For example, you can select Assigned To Me and
Not Assigned.

Category Category of event that you want to use as a filter option, for example: DB, Storage,
System, or WebApp.

Correlation = Select the desired option to search for all events, only top level events, or only cause
events:
All events: includes events correlated as symptoms of other events.
All top level events: includes all events that do not have a cause assigned.
All cause events: includes all events that are root cause events. They cannot be
symptoms of another cause event.

Description | Description of an event as displayed in the contents of the original event's
description field.

Lifecycle Stage in the problem lifecycle that the events you are looking for have reached, for

State example: Open, In Progress, Resolved or Closed. Multiple lifecycle states can be
selected.

Priority Searches for events that match the specified priorities, for example: None, Low, or
Medium. Multiple priorities can be selected.

Severity Selects an event severity to use as a filter option. Multiple severities can be
selected.

Subcategory Name of the event subcategory to which the events you are looking for belong.

Title Title of the events you are looking for.

Type Type of event you want to display with the filter.

Dates Filter Elements

The Dates elements in the Advanced Filter configuration dialog boxes display the Ul elements listed in
the following table.
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Ul
Element
(A-Z) Description

<Absolute Specifies the date and time in absolute (calendar) terms. A time can be specified by
Time> entering a calendar date, and time values for hours and minutes. Events either before or
after the specified time can be selected using the following operators:

« before
. after
<Relative = Specifies a point in time relative to the current time used to filter events. Events either

Time> older than or not older than the current time can be selected using the following
operators:

« older than
« not older than

The time period can be specified in minutes, hours, days, or weeks.

Note: The Event Browser is dynamically updated. Events that no longer match a
relative time filter are removed from the Event Browser and new events that match
are added.

Time Specifies the dates and times between which the events you are searching for
Created occurred.

Time First Specifies the dates and times between which OMi first received notification of the
Received | events you are searching for.

Time Specifies the dates and times between which the events you are searching for were
Received | received.

In case of duplicate events, the dates and times between which the last duplicate
events were received.

Time Date and time when the last lifecycle state change took place.
Lifecycle

State

Changed

Additional Event Properties Filter Elements

The Additional Event Properties elements in the Advanced Filter configuration dialog boxes display the
Ul elements listed in the following table.

Ul Element
(A-2) Description

Application = Selects events linked to the named application.
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Ul Element
(A-Z)

Cl Type

Custom
Attribute

Event Type
Indicator

Event Type
Indicator
Value

Key

Object

Original
Data

Solution

Description

Selects the option to search for events that are related to the specified Cl type or are a
child of the specified Cl type. The dedicated operators for filtering Cl types are:

« equals: Related Cl matches a specified Cl type
« is derived from: Related Cl is derived from the specified Cl type
Selects the Custom Attributes editor where you can specify a custom attribute, an

operator, and a value for use in filtering.

You define a custom attribute filter by specifying the name of the custom attribute in
the field on the left, selecting a filter matching criteria from the list, and specifying the
value of the custom attribute in the field on the right.

Enables you tofilter by Event Type Indicator (ETI). You can combine several
indicators using any of the operators.

Enables you to filter by Event Type Indicator (ETI) value.

Selects events that contain a reference to the named key.

Selects events that are related to a named object, as specified in the original OM
message.

Original event text as captured from HPE Operations Agents before being formatted
into an OM message.

Contains information about the original input before being normalized by HPE
Operations Agent policies into a message. Typically, the information available
includes node name, message group, application, object, severity, and message text.

A text field used to describe the solution steps taken to solve the problem identified by
the event.

Solution texts can be synchronized with external managers such as Service
Manager.

Advanced Properties Filter Elements

The Advanced Properties elements in the Advanced Filter configuration dialog boxes display the Ul
elements listed in the following table.

Ul Element (A-Z)

Assigned User

HPE Operations Manageri (10.10)

Description

Selects events that are assigned or not assigned to a user, or assigned to
the specified user.

Page 94 of 307



OMi User Guide
Chapter 6: Event Browser

Ul Element (A-2)

Assigned
Workgroup

Automatic Action
State

Cl Resolution
Quality Measure

Cl Resolution
Success Status

Control Transferred

ETI Hint
External ID

Instruction Interface
Name

Instruction
Parameter String

Received During
Downtime

Related CI Hint

User Action State

HPE Operations Manageri (10.10)

Description

Selects events that are assigned or not assigned to a group, or assigned to
the specified group.

Selects events that exhibit any of the specified Automatic Action States.
The possible states are:

« Available

« Running

« Success

« Failed

« Not Available

Selects events with the specified Cl Resolution Quality Measure.

Selects events with the specified Cl Resolution Success Status.

Selects events for which control was transferred to an external server or not
transferred to an external server.

Selects events with the specified ETI Resolution Hint.
Selects events with the specified External ID.

Selects events with the specified instruction interface name.

Selects events with the specified instruction parameter string.

Selects events which were received during downtime or not received during
downtime.

Selects events with the specified Related CI Hint.
Selects events that exhibit any of the specified User Action States. The
possible states are:

« Available

« Running

« Success

« Failed

« Not Available
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Edit Expression Dialog Boxes for Advanced Filters

The Advanced Filter configuration dialog boxes include edit expression dialog boxes dedicated to types
of expressions being specified. The follow sections describe these edit expression dialog boxes.

To access | Workspaces > Operations Console > <select a perspective>

Open the Select an Event Filter dialog box using the Manage Event Filters (...)
button.

Relevant Tofilter events, see:

tasks « "How to Filter Events by Views" on page 80

« "How to Filter Events by Configuration Items" on page 81
« "How to View and Apply Event Filters" on page 81

« "How to Define Simple Event Filters" on page 82

« "How to Define Advanced Event Filters" on page 83

« "How to Share Event Filters" on page 85

See also For more information about filtering events, see "Filtering Methods" on page 79 and
"Event Filters" on page 78.

For more information about the edit expression dialog boxes, see the following sections:

« "Attributes Included in a Preconfigured List" below

« "Attributes ldentified by a Text String" on the next page
« "Custom Attributes" on the next page

o "Events Selected by Dates" on page 98

o "Cl Type" on page 98

« "Attribute Selection from a List" on page 99

« "Numerical Values" on page 99

« "True or False" on page 99

Attributes Included in a Preconfigured List

This Edit Expression dialog box is used to typically select a combination of attributes, for example,
events assigned to the current user and events not assigned to any user.
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Edit Expression

Assigned To is one of &1 Me
5.:! My Workgroups
2 Others
5 None

o e

Select one or more of the available event attributes that you want to include in your list of events.

Attributes Identified by a Text String

This Edit Expression dialog box is used to typically select an attribute with a specified relationship to its
value, for example, events with the Category value equal to database, where the selection is
insensitive to case.

Edit Expression

Category equals v

ignare case

For the selected attribute, enter a text string to search for and select an operator to establish the
relationship between the attribute and its value. For a description of the available operators, see "Text
Operators" on page 101.

Select ignore case to search for all forms of the specified text.

Custom Attributes

This Edit Expression dialog box is used to select a custom attribute with a specified relationship to its
value, for example, events including the custom attribute ForwardToTroubleTicket with value equal to
true, where the selection is insensitive to case.
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Edit Expression

Custom Attribute | Forward ToTrouble equals v true

ignore case

For the specified custom attribute, enter a text string for the attribute value to search for and select an
operator to establish the relationship between the custom attribute and its value. For a description of
the available operators, see "Text Operators" on page 101.

Select ignore case to search for all forms of the specified text.

Events Selected by Dates

This Edit Expression dialog box is used to select events depending on when they were, created,
received, or when their lifecycle state changed. In this example, events created longer than 4 days ago
are selected.

Edit Expression

Time Created notolderthan 4 c day(s)

o e

For the selected attribute, enter a time and an operator to be used to identify the appropriate events. For
a description of the available operators, see "Date Operators" on page 100.

Cl Type

This Edit Expression dialog box is used to select events related to the specified Cl type or related to a
Cl type derived from the specified Cl type. In this example, events with a Cl type derived from the Cl
type Computer are selected.

Edit Expression

Cl Type derived from v & computer v ..

-
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Select a Cl type from the Select a Cl Type dialog box (...) and select an operator (equals or derived
from).

« equals: Related Cl matches a specified Cl type
« derived from: Related Cl is derived from the specified Cl type

Attribute Selection from a List

This Edit Expression dialog box is used to typically select one attribute from a predefined list, for
example, events assigned to workgroups.

Edit Expression

Event is assigned to any workgroup
Event is not assigned to a workgroup

'i\‘ Event is assigned to a workgroup v

o e

Select one event attribute that you want to include in your list of events, and, if necessary, specify the
value of the attribute, for example, the workgroup called Administrators.

Numerical Values

This Edit Expression dialog box is used to typically select an attribute with a specified relationship to its
numerical value, for example, events with the value of the Cl Resolution Quality Measure greater than
3.

Edit Expression

Cl Resolution Quality Measure greaterthan A 3 e

Select a value for the event attributes and select an operator to establish the relationship between the
event attribute and its value. For a description of the available operators, see "Numerical Operators" on
the next page.

True or False

This Edit Expression dialog box is used to typically select the true or false attribute value for the event
attribute being configured, for example, Control Transferred is False.
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Edit Expression

Control Transferred is True

® False

.

Select true or false for the event attribute being configured.

Operators Used in Filter Configuration Dialog Boxes

The Advanced Filter configuration dialog boxes support the operators listed in the following tables:

o "Date Operators" below
« "Numerical Operators" below
« "Text Operators" on the next page

o "True-False Operators" on page 102

Date Operators

The following table lists the operators for use in date expressions.

Operators
(A-2) Description
After When specifying absolute times, selects events that have a timestamp more recent

than the specified time.

Before When specifying absolute times, selects events that have a timestamp older than the
specified time.

not older | When specifying relative times, selects events that have a timestamp more recent than

than the selected time point, for example, not older than one day.
older When specifying relative times, selects events that have a timestamp less recent than
than the selected time point, for example, older than one day.

Numerical Operators

The following table lists the operators for use in numerical expressions.

Operators Description

= Displays any event that has a value of the selected attribute that is identical to the
specified value.
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Operators Description

< Displays any event that has a value of the selected attribute that is less than the
specified value.

<= Displays any event that has a value of the selected attribute that is lower than or
identical to the specified value. For example, selecting the value 33, for Cl Resolution
Quality Measure displays all events with Cl Resolution Quality Measure below 33%

> Displays any event that has a value of the selected attribute that is greater than the
specified value.

>= Displays any event that has a value of the selected attribute that is higher than or
identical to the specified value. For example, selecting the value 50, for Cl Resolution
Quality Measure displays all events with Cl Resolution Quality Measure values above
50%.

Text Operators
The following table lists the operators for use in text expressions.
Operators

(A-Z) Description

contains | Displays any event that contains a reference to the specified string in the selected
attribute. For example, searching for any string that contains database retumns:
« database
« database status
« Oracle Database status
equals Displays any event that has an attribute or attribute value that is identical to the

specified string. For example, searching for events of a category type that equals
database returns events of the following category:

« database

exists Displays any event that contains a custom attribute of the specified string. For
example, ABC exists displays all events that contain the custom attribute ABC.

matches | Displays any event that matches the specified regular expression.

The pattern uses the syntax of the Java regular expressions class java.util.regex.
For the exact syntax of this class, see the online Java documentation.

Processing filters that contain regular expressions requires higher resources than for
filters without them and it is recommended that regular expressions are used only when
a simpler alternative is not possible.
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Operators
(A-2) Description
not Displays any event that does not contain a reference to the specified string in the

contains | selected attribute. Searching for a string that does not contain database returns all
strings except those containing database, for example:

« Blue moon

« Almost everything else

not Displays any event that has an attribute that is not identical to the specified string. For
equals example, searching for events of a category that does not equal database returns
events with categories that are not identical to database, returns event attributes such
as:
« Storage
. DB
« Network
not Displays any event that does not match the specified regular expression.
matches

The pattern uses the syntax of the Java regular expressions class java.util.regex.
For the exact syntax of this class, see the online Java documentation.

Processing filters that contain regular expressions requires higher resources than for
filters without them and it is recommended that regular expressions are used only when
a simpler alternative is not possible.

True-False Operators

The following table lists the operators for use in true and false expressions.

Operators (A-Z) Description
False Used to match an attribute if false.
True Used to match an attribute if true.

Troubleshooting and Limitations

This section provides help for those people who are troubleshooting problems relating to OMi event
filters, including creating, modifying, and enabling filters.

Filters Not Available in Event Filter List

« Filter does not belong to active user.

« Filters are only available for the area for which they are created. For example, an Event Browser filter
is not available in an Administration Ul.
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Events Not Visible

« Make sure that the correct filter is enabled.
« Make sure that the currently enabled filter is correctly configured.

« Make sure that the currently applied Cl or View does not filter out events that you want to see.

Event Closing and Archiving Tools

You can close and archive events using the following command-line tools:

e« opr-close-events
See "opr-close-events Command-Line Tool" on page 105 for more information.
e opr-archive-events

See "opr-archive-events Command-Line Tool" below for more information.

opr-archive-events Command-Line Tool

In OMi, events are automatically archived by a background process in a configurable interval. Event
auto archiving can be configured using the infrastructure setting Event Auto Archiving Settings.
To access:

Administration > Setup and Maintenance > Infrastructure Settings

Select Applications and use the list to set the administration context to Operations Management.
Scroll to Operations Management - Event Auto Archiving Settings.

To manually delete closed events from the database and add them to an archive file, you can use the
database maintenance command-line tool opr-archive-events.

Note: Importing closed events is not supported.

Delete-Event Synchronization with Other Servers

opr-archive-events does not forward event updates to other servers, for example to other OMi or to
OM servers. The events in other OMi or OM servers remain unaffected. (This also applies to the closing
of events using the opr-close-events command-line tool.)

The opposite is also true when using the omwmsgutil (OM for Windows) tool and opcack and
opchistdown (OM for UNIX or Linux) to close, delete, and archive events in OM. The events in OMi
remain unaffected.

All these tool operate directly on their respective databases and the changes do not go through the
workflow process, resulting in the loss of synchronization between OMi and OM.

If you use these tools to close, delete, and archive events from one system (for example, OMi), you
must make the equivalent changes with the appropriate tools on the other system (for example, OM).

Alternatively, if event synchronization is required, use the OMi Event Synchronization Web Service.
For details, see the OMi Extensibility Guide.
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Location

The opr-archive-events command-line tool is available only on data processing servers at:

<OM1i_HOME>/bin/opr-archive-events

Default:

Windows: C: \HPBSM\bin
Linux: /opt/HP/BSM/bin

Synopsis

opr-archive-events

opr-archive-events -u <date> -0 <ouputPathAndFileName[-a][-s][-force][-utc]

[-1i <severities>] [-n <nodeId>]

opr-archive-events -u <date> -d [-s][-force][-utc][-1 <severities>]

opr-archive-events -h

Note: You can combine the options that are given between square brackets. Otherwise, use the

rest of the options separately.

Options

Option

-a,-
archiveOnly
<archive file>

-d,--deleteOnly
-force
-h,--help

-i,~-severities
<severities>

-n,--nodeld
<nodeld>

-0,--output
<archive_file>

.s, -
sweepOrphans

HPE Operations Manageri (10.10)

Description

Only archives events without deleting them from the database.

Deletes only the events from the database without archiving.
Archives events without asking user for confirmation.

Displays a summary of the command options and exits.

Deletes the events related to the specified node.

Path and name of XML file used to store archived events.

Archives or deletes only events having the specified severities (for example,
major, critical).

Deletes all orphaned objects not related to events. This option is ignored if -a' is
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Option Description

-t,--olderThan  Archives events which are older than the specified time.

< >
older_than Example: opr-archive-events .... -olderThan 3D12H5M12S

In the example all events which have as time received a value older than the

current time (time at executing the CLI) minus 3 days and 12 hours and 5 minutes

and 12 seconds are archived. The time argument can also accept a subset of

days, hours, minutes, and seconds, for example, the parameter "-olderThan 3D"

is also valid.
-u,--until Archives the events that where received before the specified time. The time must
<date> be specified in one of the following formats:

yyyy.mm.dd-hh:mm:ss
yyyy.mm.dd-hh:mm
yyyy.mm.dd-hh

yyyy.mm.dd

-utc Thread date/time parameter as UTC time.

Restrictions

The user running the opr-archive-events command-line tool must be a local user (Windows) or the user
under which the OMi processes are running (Linux). If the SQL Server instance uses Windows
Authentication Mode, the user running opr-archive-events must be granted access to the Events
database.

Tip: In the XML output file of the archiving tool, use the modifiedBy attribute to identify the event
property that was changed by a user, identified by their OMi username.

opr-close-events Command-Line Tool

It is possible that a certain problem in the IT environment results in the generation of a very large
number of similar events (event storm) which are received by OMi. Browsing through and filtering a
large number of events can be time-consuming and can lead to time-out errors. After an event storm
occurs, for example, you can use the opr-close-events command-line tool to close all active events that
are related to a specific node, related Cl, or a combination of both node and related ClI.

Time-outs may be experienced as a result of delays in processing a large number of events in the web
application, for example, when you select all events in the browser and attempt to close them. The user
interface server may take a long time to start up or may experience a memory bottleneck.

You can use the opr-close-events command-line tool to close a large number of events, including
related events, as experienced during an event storm, even when the OMi user interface is not
responding.

Note: Event processing might stop for some time after the tool finishes execution.
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Close-Event Synchronization with Other Servers

opr-close-events does not forward close-event updates to other servers, for example to other OMi or
to OM servers. The events in other OMi or OM servers remain unaffected. (This also applies to the
deleting and archiving of events using the opr-archive-events command-line tool.)

The opposite is also true when using the omwmsgutil (OM for Windows) tool and opcack and
opchistdown (OM for UNIX or Linux) to close, delete, and archive events in OM. The events in OMi
remain unaffected.

All these tool operate directly on their respective databases and the changes do not go through the
workflow process, resulting in the loss of synchronization between OMi and OM.

If you use these tools to close, delete, and archive events from one system (for example, OMi), you
must make the equivalent changes with the appropriate tools on the other system (for example, OM).

Alternatively, if event synchronization is required, use the OMi Event Synchronization Web Service.
For details, see the OMi Extensibility Guide.

Location

The opr-close-events command-line tool is available only on data processing servers at:
<OM1i_HOME>/bin/opr-close-events

Default:

Windows: C: \HPBSM\bin

Linux: /opt/HP/BSM/bin

Synopsis

opr-close-events [-f <date>] [-u <date>] [-s <severity>] [-force] [-utc]
[-n <ci_1id> [<ci id>, ...]] [-c <ci_id> [<ci_1id>, ...]]
opr-close-events -all [-force] [-utc]
opr-close-events -olderThan <relative time> [-force] [-n <ci_1id>
[<ci id>, ...]] [-c <ci_id> [<ci_id>, ...]]
opr-close-events -id <evt_1id> [<evt_1id>, ...]] [-force]
opr-close-events -h

Note: You can combine the options that are given between square brackets. Otherwise, use the
rest of the options separately.

Options
Option Description
-all Closes all events.
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Option

-C,--
relatedCild
<relatedCild>

-f,~from
<date>

-force
-h,--help

-i,~id <id>

-n,--node
<node>

-r,-resetHls

Description

Specify one or more CMDB ClI IDs, each representing a Cl of any type. All events
that are related to the specified Cls are closed and all event browsers are refreshed.

You can find the CMDB ID from the General properties of the related CI. For
example, the CMDB ID for the related Cl myApache Tomcat Service will be of the
following format: ef372b80d3ed6bbeecfla7d1a960dcb?.

The -c option can be used in combination with the -n option to select all events that
match both the specified node and the specified related Cl. To close events that are
related to both a node and a particular Cl, combine the -c and -n options and specify
the CMDB ID for the related Cl and the CMDB ID for the node. Your command
should take the following form:

opr-close-events -n le3aab8e7ecd24482a8118e24200f981 -c
ef372b80d3ed6bbeectla7dlas960dcb7

Closes events (including related events) received after the specified time. This
option can be combined with severity and until time. The time must be specified in
one of the following formats:

yyyy.mm.dd-hh:mm:ss
yyyy.mm.dd-hh:mm
yyyy.mm.dd-hh

yyyy.mm.dd

Closes events without asking user for confirmation.
Displays a summary of the command options and exits.

Closes events with the specified event ID(s).

Example: opr-close-events -i 0e25d750-cbd9-71e4-14c8-
Cc0a8fe380000,0beeb342-cb90-71e4-156e-c0a8fe380000 -force

Specify one or more CMDB CI IDs, each representing a Cl of type Node. All events
that are related to the specified Nodes are closed and all event browsers are
refreshed.

You can find the CMDB ID from the General properties of the related CI. For
example, the CMDB ID for the node mynode . example. com will be of the following
format: 1e3aab8e7ecd24482a8118e242001981

The -n option can be used in combination with the -¢ option to select all events that
match both the specified node and the specified related CI. To close events that are
related to both a node and a particular Cl, combine the -¢c and -n options and specify
the CMDB ID for the related Cl and the CMDB ID for the node. Your command
should take the following form:

opr-close-events -n le3aab8e7ecd24482a8118e242001981 -c
ef372b80d3ed6bbeectla7d1a960dcb7

Resets health indicators after closing of events.
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Option

-s,--severity
<severity>

-t,--olderThan
<older_than>

-u,--until
<date>

-utc

Restrictions

Description

Closes events of the specified severity. This option can be combined with from
time and until time. The severity can be one of the following: NORMAL, WARNING,
MINOR, MAJOR, CRITICAL.

Closes events which are older than the specified time.
Example: opr-close-events .... -olderThan 3D12H5M12S

In the example all events which have as time received a value older than the current
time (time at executing the CLI) minus 3 days and 12 hours and 5 minutes and 12
seconds are closed. The time argument can also accept a subset of days, hours,
minutes, and seconds, for example, the parameter "-olderThan 3D"is also valid.

Closes events received before the specified time. This option can be combined with
severity and from time. The time must be specified in one of the following formats:

yyyy.mm.dd-hh:mm:ss
yyyy.mm.dd-hh:mm
yyyy.mm.dd-hh

yyyy.mm.dd

Thread date/time parameter as UTC time.

The user running the opr-close-events command-line tool must be a local user (Windows) or the user
under which the OMi processes are running (Linux). If the SQL Server instance uses Windows
Authentication Mode, the user running opr-close-events must be granted access to the Events

database.
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OMi enables you to monitor the availability and performance of the revenue-generating applications and
services in your organization. OMi also keeps track of the health of its deployment and informs you
about problems it detects.

OMi uses data collected by HPE Software applications, such as OM and HPE Operations Agent, as
well as data collected from external monitoring tools. OMi collects metrics about end-user experience
from a range of environments, including ERP, CRM, Web, and Citrix, and about system performance
from a range of back-end infrastructure components, including web servers, J2EE applications,
databases, and network and storage devices.

The collected and aggregated data is used by the OMi health indicators (HIs) and key performance
indicators (KPIs) to provide quantifiable measurements that help you monitor how well your business is
achieving objectives. The KPIs and Hls provide real-time assessment of the present state of your
business and processes, enable you to track critical performance variables over time, and help you
assess the business impact of problems in the system.

At the top level, OMi provides an integrated view of critical applications and business processes; from
there, you can drill down to the underlying IT infrastructure associated with these critical business
processes. This drill-down view can be laid out in any number of ways, such as by data centers, by
technology clusters, by geographical locations, and so on.

Event Type Indicators

Event type indicators (ETIs) are attributes of OMi events used to categorize events according to the
type of occurrence in the managed IT environment. An OMi event is created as a result of receiving a
message from a manager, such as OM or Network Node Manager. In OM, you can configure events to
include the custom attribute ETIHint, which is used to set event type attributes. If the custom attribute
is not configured, event type attributes can be set by the applicable mapping rules. If adequate
information is not available, no ETl is set.

Any occurrence on the monitored system of a given type causing an OMi event must be assigned the
same ETI. After defining appropriate correlation rules, events are correlated based on the ETIs. The
correlation rules relate types of events that can occur on the ClI.

Learn More

ETI Characteristics
ETls are characterized by the following:

« Categorize type of event to abstract multiple event sources.

« Atleast one value is required. This value is used to describe the event occurrence in the
environment, for example, an ETI could read: System restart:Occurred. Usually, you do not need
to set any values for such ETls because, as a convenience, one value is created that is called
Occurred.
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« Events contain an ETI attribute. ETIs do not exist as instances in their own right.
« ETls without a corresponding HI are not shown within the Health Indicators pane.
« Nomanual reset necessary. An ETl is just an event attribute.

A configuration item inherits ETI assignments, including Hls, from its parent configuration item type.
For example, ETIs assigned to the configuration item type Database also apply to the configuration
item type Oracle and are applied to any Oracle Database configuration items.

Tasks

How to View Event Type Indicators

1. Open the Indicators manager:
Select an event in the Event Browser, open the context menu and select:
Configure > Event Type Indicators
2. Inthe Cl Types pane, select a Cl type.
In the Indicators pane, select an indicator.
Details of the selected indicator are displayed in the Details pane.

Health Indicators

Health indicators (HI) determine and display the health of specified aspects of a monitored Cl. An Hl is
an event-specific monitor that uses one value to represent the normal state of the Cl, for example,
System: Running. One or more additional values are used to represent any abnormal states, such as
System: Stopped. In this way, health indicators are used to show if a hardware resource is available
and responding.

Health indicators can also display the state of a software application. For example, the possible states
of a database server could be specified as: Available, Starting or Stopping. Health indicators can
also be used to show the usage of a software application, for example, whether the load is Normal,
High, orMax. Exceeded.

Only events that provide Cl state information can set an HI. Health indicators are assigned to a specific
configuration item type through the associated ETIl. OMi sets indicators automatically using event
attributes or mapping rules.

Learn More

This section includes:

« "Mapping Rules" below
« "HI-Based KPI Calculation" on the next page

Mapping Rules

Mapping rules can be used to match attributes of incoming events to defined health indicator values,
such as Low or High, for a given configuration type. For example, you can define an HI to monitor
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events related to the CPU load on UNIX systems (Cl type: Infrastructure Element > Node >
Computer > Unix). When an event reporting Low or High CPU load is received, the appropriate health
indicator value is set.

HI-Based KPI Calculation

Hls provide the data that a KPI needs to calculate the availability and performance of monitored
resources. The KPIs use calculation rules to collate the values from multiple health indicators and set a
severity level, such as: Critical, Major, Minor, or Normal. For example, a KPI for a database can
include multiple health indicators concerning the run state (Up, Down), the cache-hit ratio (0, 50, 00%),
the length of query queues (Empty, Full), and response times (#ms) to determine overall health.

For more information about KPlIs, see "H|-Based KP| Calculations" below.

Tasks

This section includes:

« "How to Reset Health Indicators" below

How to Reset Health Indicators

Resetting an HI is a way of returning an object's severity status to a defined default value such as
Normal.

Note: Resetting an Hl is not usually necessary and should be performed in exceptional
circumstances only, for example, when OMi does not reset it automatically.

1. Open the Event Browser:
Workspaces > Operations Console > <select a perspective>

2. Inthe Event Browser pane, right-click the event you want to close and for which you want to reset
the health indicator.

3. Inthe context menu that displays, select Close and Reset Health Indicator.

HI-Based KPI Calculations

Key performance indicators (KPI) apply calculation rules to the data provided by health indicators to
determine the availability and performance of the objects to which the health indicators are assigned.
The value that results from the calculation is used to set a severity level, for example, normal, warning,
minor, major, or critical.

KPIs related to the selected event are displayed in the Health Indicators pane of the Health Perspective
tab. Their color reflects the assigned severity. In the Health Top View, KPls appear under the
monitored object to which they belong.

The color of each KPI reflects the KPI's current severity status. The severity status is determined by a
business rule, which specifies how and when severity status propagates up a relationship chain. One
resource with a critical problem does not mean that all dependent resources are, by definition, also
critical. KPIs can use data from multiple sources to determine the overall affects up and down
dependency chains and determine the severity status accordingly.
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Note: The type of source determines the importance of the information provided. For example, live
data from a monitor running directly on a node is considered more important than data resulting
from business rules, which base calculations on KPI relationships and dependencies. This means
that KPI states propagated by a business rule may be overridden by live data directly from the CI.

Learn More

This section includes:

« "KPIs for Health-Based Data" below
« "KPIs for Event-Based Data" below

KPIs for Health-Based Data
The following KPlIs use health-based data:

« System and Application Performance KPI. Performance-related data from health indicators can
include values for the hit ratio in the database cache, server connection speeds, queue lengths, or
database query processing times. This example describes health indicators that are specific to the
database configuration item type. Other configuration item types have different health indicators.

« System and Application Availability KPI. Availability-related data can include server run states
(up, down, starting, stopping) or process activity (refusing, accepting connections, not responding).

KPIs for Event-Based Data

There are two additional KPI types that use event data for Unassigned or Unresolved events and are
attached by default to every configuration item. Unassigned KPIs concern events with an underlying
problem that has not yet been allocated to any user for investigation. Unresolved KPIs concern events
with underlying problems that are not yet fixed.

Note: Unassigned, event-based KPls are, by definition, also unresolved.

If an unassigned or unresolved KPI references data from more than one event, the color of the KPI
reflects the severity status set by a business rule. The business rule associated by default with
unassigned and unresolved KPls is the Operations Event Lifecycle Group Rule, which sets the status
of the KPI to the highest severity of any events associated with the related configuration item. For
example, if a KPI for an unassigned event refers to one critical and four normal events, the KPI appears
red to reflect the critical event.

Note: There is no propagation from child Cls.

Tasks

This section includes:

« "How to View KPI Business Rule Settings" on the next page

« "How to View Hl-based Key Performance Indicator Details" on the next page
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How to View KPI Business Rule Settings

In this task, you learn how to find out which business rule OMi applies to set the severity of a KPI. KPIs
use the data provided by one or more health indicators to set a specific severity level for a monitored
object. A KPI business rule specifies how the status of dependent KPIs is combined and the result
used in the calculation of a parent KPI's severity.

1.

Open the Health Perspective tab:

Workspaces > Operations Console > Health Perspective

In the Event Browser pane, select an event.

The Cl related to the event and its direct neighborhood Cls are displayed in the Health Top View.

In the Health Top View pane, hover over the CI for which you want to view the KPI business rule,
and then click the Open CI Context button that appears on the right.

In the CI context menu, click the KPIs area and check the value of the entry Business Rule to see
which business rule was used to set the severity status (for example, Worst Status Rule).

How to View HI-based Key Performance Indicator Details

In this task, you learn how to list and view the details of a KPI. KPIs use the data provided by one or
more health indicators to set a severity level (normal, warning, or critical) for the monitored object.

1.

Open the Health Perspective tab:
Workspaces > Operations Console > Health Perspective
In the Event Browser pane, select the event for which you want to view KPI details.

In the Health Indicators pane, point to the status icon of the KPI for which you want to display
details. Details of the KPI, such as Status, Business Rule name, Last Status Change date, are
displayed in a pop up dialog box.

How to Propagate and Sum Up the Events Along the Cl Impact Hierarchy

You can propagate and sum up the events along the Cl impact hierarchy using the Event KPI Group
And Sibling Rule (OM:i) for the KP1 Unresolved Events and Unassigned Events.

1.

Change the default group rule for the event based KPIs (unassigned, unresolved) to Event KPI
Group And Sibling Rule (OMi).

Change the KPI Assignment Rule (OMi KPI Assignments) on Cl Type Configuration Item to
use the Business Rule Event KPI Group and Sibling Rule (OMi) (one change for each of the
two KPls in this assignment).

Change the propagation rules on Cl Type Configuration Item (OMi Unassigned Event KPI
Propagation and OMi Unresolved Event KPI Propagation) to propagate the KPIs by using the
Event KPI Group And Sibling Rule (OMi).

Go to the rule definition in the repositories Ul and make the hidden rule parameters visible by
selecting the check box to make the rule parameter configurable. Then, update the rule of the KPI
in the KES assignment. After you save the assignment you can hide the rule parameters again.

Alternatively, you can delete the existing KPIs before running the KES assignment. This action
will cause the assignment to create the KPIs rather than update them.

Synchronize all Cls. (This may take some time, depending on the number of Cls.)
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Annotation Tool
This page enables you to annotate a snapshot of the topology map you are viewing, to highlight
important areas.

The annotation tool is identical in the Topology Map and Neighborhood Map components.

To access

Create a custom page that includes Topology Map or Neighborhood Map. Add a component which
enables you to select a Cl, such as View Explorer or Top View.

Click the Annotate |E§h button on the Topology Map or Neighborhood Map toolbar.

For details see "How to Set Up My Workspace" on page 220.

Ul Descriptions

Annotation Options
The elements that enable you to annotate your snapshot.
The annotation options are located on the left side of the annotation window.

User interface elements are described below:

Ul Element
(A-2) Description
|ﬁ| Pan Tool. Click to navigate the snapshot.

| i | Select Tool. Click and drag to select a specific area of the snapshot.
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Ul Element
(A-2) Description
|E| Shape Tool. Click and drag to add a shape to the snapshot. Clicking the shape tool
o button enables the following shape buttons:
. |E| Rectangle. Click and drag to mark an area of the snapshot with a rectangle.
. |E| Filled Rectangle. Click and drag to mark an area of the snapshot with a
filled rectangle.
. |L_| Oval. Click and drag to mark an area of the snapshot with an oval.
« L=/ Filled Oval. Click and drag to mark an area of the snapshot with a filled oval.
. |E| Rounded Rectangle. Click and drag to mark an area of the snapshot with a
round rectangle.
. |E| Filled Rounded Rectangle. Click and drag to mark an area of the snapshot
with a filled round rectangle.
Customization. After selecting this button, you can customize your line
appearance through the following parts of the interface:
« Line Type. Choose the type of line you want to add (solid line or jagged line).
« Line Width. Select the width of the line, in pixels, in the annotation.
|T| Line Tool. Click and drag to enable the line tool, which marks the selected area of
o the snapshot with a line.
Customization. After selecting this button, you can customize your line
appearance through the following parts of the interface:
« Line Style. Choose the style of line you want to add (regular line, line with
endpoints, or line with arrows).
« Line Type. Choose the type of line you want to add (solid line or jagged line).
« Line Width. Select the width of the line, in pixels, in the annotation.
|T| Text Tool. Click and drag to open a box where you can add text to the snapshot.

Example: Add the syntax: This is the problematic transaction above aline
marking an area of the snapshot.
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Ul Element
(A-2) Description

Border and Select the relevant square to choose the color of the border and fill of your
Fill Colors annotations. The available squares are:

« Upper Square. Click to choose the color of lines, as generated by the line tool
and displayed in unfilled shapes.

« Lower Square. Click to choose the color to fill shapes.

Clicking either of the squares generates a dialog box with the following tabs where
you choose the color:

« Swatches
« HSB
« RGB

Opacity Slide the opacity bar to choose the darkness level of the selected shape line, text
line, or shape color in the annotation.

Note:

« A higher opacity percentage means that the selection appears darker. A lower
opacity percentage means that the selection appears lighter.

« This field is enabled when either the shape tool, line tool, or text tool button is
selected.

Menu Bar
Displays the elements which enable you to perform actions on your snapshot.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-2Z) Description
Save. Saves the snapshot on your local machine.
Note:

« The snapshot is saved in .png format.

« You cannot select the New Folder icon £l when saving in the My
Documents directory or any of its subdirectories.

Select All. Selects all of the annotations added to your snapshot.

=
11
[

E Clear Selected. Clears all annotations.

Undo. Rolls back the most recent action performed on the snapshot.
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Ul Element (A-2) Description
(e Redo. Cancels the roll back of the most recent action performed on the
shapshot.
& Zoom In. Brings the snapshot view closer.
(=] Zoom Out. Sets the snapshot view further away.
i, Restore original size. Restores the snapshot to its original size.
= Print. Prints the snapshot.
2 Help. Displays online documentation help for the page you are currently
viewing.
The following fields are enabled when selecting the Text Tool button =il
B Bold. Makes the text bold.
I Italic. Italicizes the text.
L0 Underline. Underlines the text.
A Anti-aliasing. Adjusts the pixel reading of text or annotation lines so that
they appear smoother.
<Font Family> Select the font for the text in the report.
<Font Size> Select the size of the font in the report.

Drilldown to SiteScope

When SiteScope monitors are used to set the status of a configuration item (ClI), you can drill down
from the CI (or from a health indicator (HI) on the ClI) to a SiteScope monitor that contributes to the HI's

status.

Tasks

1. Access menu commands from a Cl or Hl in a My Workspace page or component, for example
360° View, Top View, View Explorer, or Health Indicator. Select Go to > SiteScope. The
SiteScope Ul opens directly to the parent group of the relevant monitor.

If monitors from multiple groups contribute to the Cl's or HI's status, the Drilldown to SiteScope
dialog box opens. Select the monitor to which you want to drill down and open it in SiteScope.

The Drilldown to SiteScope dialog box displays the following hierarchy:
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o The root level shows health indicators.

If you open the dialog box for a Cl, one or more Hls that contribute to the CI's status are listed.
If you open the dialog box for an HI, this HI appears as the root.

o The level below the root shows the SiteScope systems (connected server name) that have
monitors contributing to the HI.

o The lowest level shows the SiteScope monitors that contribute to the HI.

Note: In the System Monitors view, if you select Go to > SiteScope from a monitored Cl,
SiteScope opens to the monitor's parent group. If you select this from a group ClI, SiteScope
opens directly to the group.

2. Select a SiteScope monitor, and click Drilldown. SiteScope opens to the parent group of the
selected monitor.

For details on working with SiteScope, see the Using SiteScope Guide in the SiteScope Help.

How to Find Visible and Hidden Child Cls

A Cl's child Cls can be specified as included (visible) or excluded (hidden) in a specific view. The
status of any child Cl, visible or hidden, has an impact on the status of its parent Cl in any view where
the parent Cl appears. For details on including or excluding child Cls, see the Hide Cls from View
option in "Perspective-based View Editor" in the Modeling Guide.

To access

Within a Service Health component such as the Hierarchy component, right-click a Cl and select the
Show > Find Visible and Hidden Child Cls option, to show the visible and hidden child Cls that
appear in the RTSM.

Note: Hidden child Cls are only displayed if they have KPlIs.

Learn More

Example

Use the Find Visible and Hidden Child Cls option to list all of the child Cls of the selected Cl in the
RTSM. After the list of child Cls is displayed, you can search for the views the child Cl belongs to and
then display the child Cls details in the specific view.

For example, you might have the situation where, in a specific view, the Application Availability KPI's
status of the parent Cl's is Critical while the Application Availability KPI's status of the Cl's child Cls
are OK. When this happens, you would like to know what caused the status of the Application
Availability KPI to be Critical.

Find Visible and Hidden Child Cls page
The Find Visible and Hidden Child Cls page displays the following information:
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« The name of the selected ClI, whose child Cls you want to list, the Cl's KPls, and their status in the
current view.

« Alist of the child Cls (visible and hidden) that appear in the RTSM, their KPIs and their status. In the
Visible column, a checkmark indicates that the child Cl is visible in the view and an X indicates that
the child is hidden in the view.

Service Health Components

The following section describes available Service Health components.

To access
Workspaces > My Workspace

In My Workspace, click the Component button.

« Important Information: To open a component in My Workspace, select a component and drag it to
your page. The components displayed by default are those for which you have appropriate licenses.

« Relevant Tasks: "How to Set Up My Workspace" on page 220.
« Forinformation on components, see "Add components to a page" on page 220.

« Forinformation on My Workspace, see "Monitoring Your Environment With My Workspace" on
page 201.

« Forinformation on wiring, see "How to Set Up Wiring Between Components" on page 227.

Learn More

Business Impact
Displays business Cls and SLAs that are impacted by the selected CI.

For details, see "Business Impact Component" on page 121.

Changes and Incidents

Displays the incidents opened for the selected Cl, as well as planned changes and actual changes
made to the CI.

For details, see "Changes and Incidents Component" on page 123.

Custom Image

Displays a user-defined custom image that describes the real world that a view represents, with the
view's Cls represented by real-time status indicators in the image.

For details, see "Custom Image Component" on page 127.

Geographical Map

Displays, on a geographical map, real-time status indicators at the geographical location assigned to
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the view's Cls. The status indicator shows the worst status of the Cls at the geographical location.

For details, see "Geographical Map Component" on page 131.

Health Indicators

Displays details regarding the health indicators that are used to calculate and set the current status of a
selected Cl.

For details, see "Health Indicator Component" on page 139.

Health Top View

Displays a topological view of the configuration items affected by the event selected in the Event
Browser pane.

For details, see "Health Top View Component" on page 142.

Hierarchy

Displays a hierarchy of Cls in a view, the KPIs assigned to each Cl, and their KPI statuses. If you
select a Cl within the Hierarchy component you can see its detail links. When you click the detail links,
you can access additional components which provide comprehensive data regarding the CI.

For details, see "Hierarchy Component" on page 149.

KPI Over Time

The KPI Over Time dashboard enables you to view the statuses and status summaries of selected
KPIls and Cls over time. The dashboard lets you choose from a number of widgets to survey historical
KPI status data and the health of the monitored environment at a glance.

For details, see "KPI| Over Time Dashboard" on page 243 and "Working with the KPI Over Time
Dashboard as a Component" on page 245.

Neighborhood Map
Displays the parent Cls and child Cls of a selected Cl, in an interactive hierarchical graphic.

For details, see "Neighborhood Map Component" on page 160.

Top View

Displays Cl bars that represent real-time IT performance metrics mapped onto business applications,
linked by lines that represent relationships between Cls.

For details, see "Top View Component" on page 165.

Topology Map

Displays the Cls within a view in an interactive hierarchical graphic. Topology Map display links
between Cls, and enables you to view Cls divided into layers or groups.

For details, see "Topology Map Component" on page 177.
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View Explorer

Contains a list of views and ClI hierarchies in each view. The component enables you to select a view
and to select Cls, or to search for a Cl. View Explorer is used with other components which respond to
view or Cl selection.

For details, see "View Explorer Component" on page 184.

Watch List
Displays a high-level health overview of important Cls, from multiple views.

For details, see "Watch List Component" on page 187.

Business Impact Component

When you select a Cl, the Business Impact component enables you to see the business Cls and SLAs
that are impacted by that ClI. In addition, a bar icon indicates the business impact of the Cls, using a
rating from zero (no impact) to 5 (high impact).

Tip: This rating shows how much of an impact the selected Cl has on the business Cls and SLAs
in your monitored environment, helping you to prioritize your tasks when problems are detected.

To access

« Workspaces > Dashboards > 360° View
Select a Cl, and click the Business Impact link.

« You can also add this component to a user-defined page, together with a component where you can
select Cls (for example, Top View). For details, see "How to Set Up My Workspace" on page 220.

Note: The Business Impact bar is not visible by default in Service Health application components. For
details, see the OMi Administration Guide.

Learn More

The Business Impact Rating

By default, the business impact rating is based on the criticality of impacted business Cls, and the
number of impacted business Cls and SLAs. You can assign each of these metrics relative weights
and thresholds.

The Business Impact component shows the following Cl types (CITs), if they have an Impact
relationship with the selected Cl: Business Services, Business Processes, and Applications.

For details on modifying how business impact is calculated, see the OMi Administration Guide.

Tasks

This section includes:
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« "How to Select Cls for Display in the Business Impact Component" below
« "How to Modify Duration Settings" below
+ "How to Modify Refresh Rates" below

How to Select Cls for Display in the Business Impact Component

If your workspace contains a component where you can select Cls (such as Model Explorer, Top View,
Topology Map, or Hierarchy), and also contains the Business Impact component, you can select a Cl
to display its business impact.

If you are using the Business Impact component independent of other components (on a user-defined
page), you can select a Cl from within the component itself. Click the Configure Component button
# in the Business Impact component toolbar, and then click Configuration Items. Open a view within
the Configuration Items dialog box, and select a Cl to display its business impact data.

How to Modify Duration Settings

By default, the Business Impact component displays data for the previous week. You can change this
setting to previous week, day, or hour (up to the current time).

« If you are using the Business Impact component outside of the 360° View page, click the Configure
Component button # in the Business Impact component toolbar, and enter the new duration setting
in the Time Period field.

« If you are drilling down to Business Impact from the Hierarchy component, click the Configure
Component button # in the Hierarchy component toolbar, and enter the new duration setting in the
Time Period field. This setting is shared by all of the Hierarchy CI detail drill-downs.

How to Modify Refresh Rates
By default, the component is refreshed every five minutes.

You cannot modify refresh rates of the out-of-the-box pages; however you can create a user-defined
page with the components you need, and modify their refresh rates using the Component Menu

button E on the component toolbar. Select Preferences, and change the refresh rate as needed.

Ul Descriptions

Business Impact Rating Area

User interface elements are described below:
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Ul
Element
(A-Z) Description

Business This barindicates the Cl's business impact, using a rating from zero (no impact) to 5
Impact (high impact). The rating shows how much of an impact the Cl has on the business Cls
(Low to and SLAs in your monitored environment.

High) By default, the rating is based on the criticality of impacted business Cls. Within RTSM,

each Cl can have a Criticality attribute defined, with a value of 1-5. If a Cl has an
impact on one or more Cls which have this attribute defined, the Cl's business impact
rating is the worst criticality of the Cls that it impacts.

You can customize which metrics are used to calculate this rating. For details, see the
OMi Administration Guide.

Impacted Businesses Area

User interface elements are described below:

Ul Element (A-Z) Description
Current Status The worst status of the KPI assigned to the impacted Cl.

Name The name of the impacted CI.

You can click a Cl to access its corresponding Business Impact Report. For
details, see "Business Impact Report" on page 1.

Past The status of the impacted Cl over a predefined time period (default: Past
<Hour/Day/Week> week).

Tooltip: The tooltip displays a text string containing the name of the status,
and the percentage of time that the KPI held this status.

Type Cl type of the impacted CI.

Changes and Incidents Component

The Changes and Incidents component enables you to see the incidents opened for the Cl selected in
the active view, as well as requests for change and actual changes made to the CI.

To access
« Workspaces > Dashboards > 360° View
Select a Cl, and click one of the following: Actual Changes, Planned Changes, or Incidents.

« You can also add this component to a user-defined page, together with a component where you can
select Cls (for example Top View). For details see "How to Set Up My Workspace" on page 220.
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Learn More

This section includes:

« "Incidents and Requests for Change" below
o "Actual Changes" below
« "Available Cl Types" below

Incidents and Requests for Change

Information on incidents and requests for change is collected from RTSM Federation Adapters.
Federation adapters may be set up within OMi (such as the out-of-the-box adapter History Data
Source), or outside OMi (such as HPE Service Manager).

« Fordetails on setting up federation, see the RTSM Developer Reference Guide.

« Fordetails on the integration with HPE Service Manager, refer to the OMi section of the Integrations
tab in the HPE Software Integrations site.

Actual Changes

Information on actual changes is collected for Cls on the local machine, directly from RTSM. The types
of changes displayed are History Attribute Change, and History Relation Change.

« Attribute changes are displayed for each attribute marked as Change Monitored. For details, see the
Modeling Guide.

« Relationship changes are displayed if a relationship has been defined witha TRACK_LINK _
CHANGES qualifier. For details, see the Modeling Guide.

Available Cl Types

By default, incidents and requests for change are displayed for the following CI types: Business
Service, Siebel Application, Business Application, Node. If you want to view change and incident
information for other CITs, see the OMi Administration Guide.

Tasks

This section includes:

o "How to Select Cls for Display" below
« "How to Modify Duration Settings" on the next page

« "How to Modify Refresh Rates" on the next page

How to Select Cls for Display

If your workspace contains a component where you can select Cls (such as Model Explorer, Top View,
Topology Map, or Hierarchy), and also contains the Changes and Incidents component, you can select
a Cl todisplay its related changes and incidents data.

If you want to use the Changes and Incidents component independent of other components, you can
select a Cl from within the component itself. Click the Filter button in the Changes and Incidents
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component toolbar, and then click Configuration Items. Open a view within the Configuration Items
dialog box, and select a Cl to display its changes and incidents data

Note: By default, data is also displayed for the child Cls which have an Impact relationship with
the selected Cl. If you deselect the Show data for child Cls check box, data is only shown for
the selected ClI.

How to Modify Duration Settings

By default, the Changes and Incidents component displays data for the previous week. You can
change this setting to previous week, day, or hour (up to the current time).

« If you are using the Changes and Incidents component outside of the 360° View page, click the
Configure Component button * in the Business Impact component toolbar, and enter the new
duration setting in the Time Period field.

« If you are drilling down to Changes and Incidents from the Hierarchy component, click the
Configure Component button * in the Hierarchy component toolbar, and enter the new duration
setting in the Time Period field. This setting is shared by all of the Hierarchy CI detail drill-downs.

How to Modify Refresh Rates
By default, the component is refreshed every five minutes.

You cannot modify refresh rates of the out-of-the-box pages; however you can create a user-defined
page with the components you need, and modify their refresh rates using the Component Menu

button E on the component toolbar. Select Preferences, and change the refresh rate as needed.

Ul Descriptions

Actual Changes area

Ul
Element
(A-2) Description

Attribute = The name of the CI attribute that was changed.

Change  The type of change that occurred.
Type

Changer Description of the user or event that modified the Cl's property (for example, user name
or Discovery).

Cl Name The name of the CI that was changed.

Date The date and time at which the change occurred.
New The new value of the ClI attribute.
Value
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Ul

Element

(A-Z) Description

Old The previous value of the CI attribute (before the change).
Value

Related  If the change involves a changed relationship between Cls, this field shows the name of
Cl the CI whose relationship with the selected Cl was changed.

Incidents area

Ul Element
(A-2) Description

Cl Name The name of the CI that triggered the incident.

Closing The date and time at which the incident was closed.
Time

Description = Description of the incident.

ID Incident ID, as it appears in the source application (for example, within HPE Service
Manager).

Opening The date and time at which the incident was opened.

Time

Origin The source of the incident.

Severity The severity of the incident as it appears in the source application (for example,
within HPE Service Manager).

Status The status of the incident as it appears in the source application.

Update The date and time at which the incident was updated.

Time

Requests for Change area

Ul Element (A-
Z) Description
£= If you have resized columns, click to restore all the columns to their original

width.
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Ul Element (A-
Z)

(I

Cl Name
Contact Person
ID

Impact Severity
Opened By

Planned End
Date

Planned Start
Date

Risk
Assessment

Status

Summary

Description

Click to open a dialog box which enables you to select which columns are
displayed in the table.

The name of the CI for which the change is planned.

The name of the contact person regarding the change.

Change request ID, as it appears in the source application.

The degree of impact of the change, as it appears in the source application.
The name of the person who opened the change request.

The time at which the change is scheduled to end.

The time at which the change is scheduled to start.

The degree of risk of the change, as it appears in the source application.

The status of the planned change, as it appears in the source application.

A description of the planned change.

Custom Image Component

Custom Image enables you to associate a view's Cls represented by real-time status indicators with a
custom image that describes the real world that your view represents. The graphical representation of a
view used by your organization can be a logical network diagram, business logic, or any other graphic
image.

For example, you can associate a graph representing your company's network with real-time data
coming from different parts of the network:
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One custom image can be defined for each view. The image shown is the one defined for the active
view. When you select a different view, the corresponding image is automatically displayed. If you do
not define a custom image for a view, users accessing the Custom Image component see a message
stating that there is no defined image for the view.

The custom image is defined in Service Health Administration. For details, see the OMi Administration
Guide.

To access

You can create your own pages and include this component. For details, see "How to Set Up My
Workspace" on page 220.

Learn More

Examples of Custom Images

A custom image can display the status of each element in the network:
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The following are additional examples of custom images:
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Tasks

This section includes:

« "How to Work With Custom Image" below

« "How to Modify the Refresh Rate" below

How to Work With Custom Image
You work with Custom Image in two stages:

1. Within Service Health Administration, you associate an image with a view, and specify where
each Cl is located in the image. For details, see the OMi Administration Guide.

2. Within the Service Health application you can then access the Custom Image component, and
see the Cl statuses in the view, within your custom image.

Note: When a Cl is removed from the IT universe model, the corresponding Cl icon (in Service
Health Administration) and the corresponding status indicators (in Service Health) are
automatically removed from the relevant custom images.

How to Modify the Refresh Rate

You cannot modify refresh rates of the out-of-the-box pages; however you can create a user-defined
page with the components you need, and modify their refresh rates using the Component Menu

button E on the component toolbar. Select Preferences, and change the refresh rate as needed.

Geographical Map Component

This component enables you to display real-time status indicators on a geographical map, with the
view's Cls at the geographical locations they are related to. The status indicator shows the worst
status of the Cls at the geographical location. You can also access detailed information about the Cl's
KPls.

« If you have an Internet connection, Geographical Maps are displayed using Virtual Earth.
« If you do not have an Internet connection, Geographical Maps are displayed using an Offline Map.

« You can also view the Geographical Map information in a three-dimensional map, using the Google
Earth application.

Tip: If you need a zoom level of a specific area that is not available in the Geographical Map,
create a picture of the map and use the Custom Image feature instead.

To access

You can create your own pages and include this component. For details, see "How to Set Up My
Workspace" on page 220.

Learn More

This section includes:
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« "Location Status Information" below
o "MSN Virtual Earth" below

« "Offline Map" on the next page

« "Google Earth" on page 134

Location Status Information

The map displays color-coded status indicators that represent the worst KPI status for all Cls attached
to the location at each geographical location. The color coding is the same as for other icons in Service
Health.

To specify alocation, create Cls of the type location and then create relationships between the location
Cls and the Cls for which you want to display status indicators in the Geographical Map. For details,
see the Modeling Guide. If you do not relate at least one Cl in the view to a location ClI, the
Geographical Map tab displays only the map.

Each status indicator in the map can represent one or more Cls from the view with the same location. If
you select a Cl in View Explorer, the Geographical Map is redisplayed automatically and shows only
the selected Cl and the Cl's children status indicators if a location is specified for them. If you select
another view, the Geographical Map reloads automatically to show the view's Cl status indicators in
the appropriate locations.

Note: The Offline Geographical Map does not respond to changes in the Cl selection because the
Offline Map and View Explorer are not wired.

If you search for a specific Cl in View Explorer and you click the result of the search, the Geographical
Map is not automatically redisplayed. The map is redisplayed only when you go back to browser mode.
It shows only the selected Cl and the Cl's children status indicators if they are related to a location CI.

MSN Virtual Earth

If you have an Internet connection, the Geographical Map is displayed by default using Microsoft MSN

Virtual Earth. Virtual Earth presents a flat geopolitical view of the planet where you can display country
borders, geographical features, or both. If the view's Cls are assigned geographical locations, real-time
status indicators are displayed on the map at those geographical locations.

Note: The Virtual Earth map is only available in English and cannot be translated.
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Example of Virtual Earth:
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The Virtual Earth Geographical Map presents a flat geopolitical view of the planet where you can
display the country borders, the geographic features, or both.

When you magnify the view, the main cities appear for the part of the map that is displayed on the
screen.

Offline Map

If you do not have an internet connection, the Geographical Map page displays as offline map if the Use
Virtual Earth infrastructure setting is set to False (see "How to Enable the Offline Map" on page 135).
The map displays the worst status at each geographical location and detailed information about the
Cl's KPlIs.

Example of the offline map:
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The default color for the offline map is blue. To change this color, see "How to Configure the Color of
the Offline Map" on the next page.

The map provides a day-night overlay option, which shows an approximation of the day/night line. To
enable this option, see "How to Enable Day Night Overlay in the Offline Map" on the next page.

Google Earth

You can view the Geographical Map information in a three-dimensional map, using the Google Earth
application.

Example of Google Earth:

= Google Earth

File Edit View Tools Add
L

Fiy To | Find Buginesses I Dirsctions %] Business Awaikability Carar

Fly o &.g.. New York, NY

M8 HP Business Availability
5 & § End User Manitors View
SiO ﬂ End Usar Monitors
# M3 Status OK Cls
¥ Kl Staius OK Cls
FIE Connecting Lines

¥ FIET HP | oo :j

- imary Databas
8 O Geographic Web
Flm= Roads
# Pl 3D Buildings
O Sirenl View
+ P Bordars and Labels
0@ Tamc i Ll 1:;‘;,'

- OI8% w
+ Eﬂuezther | .”

Eye alt 7513.80km ()

Tasks

This section includes:

« "How to Work With Geographical Map" on the next page

« "How to Enable the Offline Map" on the next page

« "How to Configure the Color of the Offline Map" on the next page

« "How to Enable Day Night Overlay in the Offline Map" on the next page

« "Specify the Maximum Number of Cls Displayed in a Location's Tooltip" on page 136
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How to Work With Geographical Map
You work with Geographical Map in a few stages:

1. Within RTSM Administration, you create Cls of the type location and then create relationships
between the location Cls and the Cls for which you want to display status indicators.

2. In Service Health Administration, you then optionally specify the type of map you will use and
configure the map. For details, see the OMi Administration Guide.

3. Within Workspaces, you then add the Geographical Map and View Explorer components to a
page. When you access the page you see the Cl statuses in the view, based on their geographic
locations.

Note: You can modify refresh rates using the En Component Menu button on the
component toolbar. Select Preferences, and change the refresh rate as needed.

How to Enable the Offline Map

1. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
From the Applications drop-down list, select Service Health Application.
In the Service Health Application - Maps Management Properties table, locate Use Virtual
Earth and click the & Edit Setting button.

From the Value drop-down list, select False.
5. Click Save.

How to Configure the Color of the Offline Map
1. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
2. From the Applications drop-down list, select Service Health Application.
In the Service Health Application - Maps Management Properties table, locate Color

Spectrum Offline Map and click the < Edit Setting button.

4. From the Value drop-down list, select the desired color. Options are blue, pink, or grayscale.
Click Save.

How to Enable Day Night Overlay in the Offline Map
1. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
2. From the Applications drop-down list, select Service Health Application.
Inthe Service Health Application - Maps Management Properties table, locate Apply Day

Night Overlay Offline Map and click the || Edit Setting button.
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4. From the Value drop-down list, select True.
5. Click Save.

Specify the Maximum Number of Cls Displayed in a Location's Tooltip

You can specify the maximum number of Cls that can be displayed in the tooltip for a location in the
Geographical Map. The default is 10.

Keep in mind that the Cls are displayed in the CausedBy section in the tooltip, so do not specify more
than can be accommodated.

To modify the maximum number of Cls displayed in a location's tooltip, open Infrastructure Settings:

1. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
From the Applications drop-down list, select Service Health Application.

In the Service Health Application - Maps Management Properties table, locate the Maximum
Cls in location tooltip entry. Enter the new maximum.

Ul Descriptions

Geographical Map in Virtual Earth

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description

Click to zoom out completely.

Click to save changes to the Geographical Map display.

If you made changes to your map which you do not want to save, click to
revert to the last saved version of the map.

Click to open the Geographical Map for the view using Google Earth.

Enable you to zoom in and out to enlarge or shrink the map.

Click to shift the center of the map to the nearest CI.

¥ - -

oy Click to zoom out completely.

<Adjustments> Click the map and drag to move the map in the window.

Double-click the map to zoomin.
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Ul Element (A-2) Description

<Status of a The Geographical Map of the view displays the worst status at each
location> geographical location.

The color coding is the same as for other icons in Service Health.

<Tooltip> Move the cursor above a status icon to display the location tooltip that
provides the worst status for all KPls associated with the location. A KPl is
associated with a location if that KPI is assigned to at least one of the Cls
related to the corresponding location CI.

The tooltip includes the following information:

« KPI Name. The name of the KPI. The color of the header indicates the
worst status of the KPI.

« Location. The name of the location (country, city, and state, if applicable).
« Status. The status of the KPI.

« Held status since. The time and date when the KPI status changed to the
current status.

« CausedBy. The names of the Cls where the problem occurred.

Last Update Displays when the information in the component was last updated.

To manually update the information in the component, click the Refresh icon.

Road/Aerial/Bird's Click:

Eye/Hybrid/Labels « Road to display the map with the country borders.

« Aerial to display the map with the topographical features.

« Bird's Eye (inactive)

« Labels to remove all labeling on the map other than CI status indicators.
Search Use this feature to perform a search in Microsoft MSN Virtual Earth (outside of

OMi).

Geographical Map in the Offline Map

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul

Element

(A-2) Description

Kﬁ Click to zoom out completely.

=i Click to save changes to the Geographical Map display.
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Ul

Element

(A-Z) Description

(] If you made changes to your map which you do not want to save, click to revert to the
last saved version of the map.

()] Click to open the Geographical Map for the view using Google Earth.

aa Enable you to zoom in and out to enlarge or shrink the map.

<Status The Geographical Map of the view displays the worst status at each geographical
of a location.
Igcation>

[ V]
-

The color coding is the same as for other icons in Service Health.

<Tooltip> Move the cursor above a status icon to display the location tooltip that provides the
worst status for all KPlIs associated with the location. A KPI is associated with a
location if that KPI is assigned to at least one of the Cls attached to the location.

The tooltip includes the following information:

« KPI Name. The name of the KPI. The color of the header indicates the worst status
of the KPI.

« Location. The name of the location (country, city, and state, if applicable).

« Status. The status of the KPI.

« Held status since. The time and date when the KPI status changed to the current
status.

« CausedBy. The names of the Cls where the problem occurred.

<Country Move the cursor above a country to highlight the country and display the name of the
name> country.

Geographical Map in Google Earth

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element
(A-2) Description

<Places | Select the view and filter the Cls you want to display.
area>

<Status The Geographical Map of the view displays the worst status at each geographical
of a location.
I9cation>

[ ¥)

The map presents color-coded status indicators that represent the worst status at each
geographical location. The color coding is the same as for other icons in Service Health.
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Ul
Element
(A-Z) Description

<Tooltip> Move the cursor above a status icon to display the location tooltip that provides the
worst status for all KPIs associated with the location. A KPI is associated with a
location if that KPI is assigned to at least one of the Cls attached to the location.

The tooltip includes the following information:

« KPI Name. The name of the KPI. The color of the header indicates the worst status
of the KPI.

« Location. The name of the location (country, city, and state, if applicable).
« Status. The status of the KPI.

« Held status since. The time and date when the KPI status changed to the current
status.

« CausedBy. The names of the Cls where the problem occurred.

<Zoom Enables you to zoom in or out of the current display.
and

direction

tools>

Health Indicator Component

The Health Indicator component displays details regarding the health indicators (HIs) that are used to
calculate and set the current status of a selected Cl. Each HI's status and value are displayed. The
component displays the Hls grouped by two categories: HIs that are used to calculate KPIs, and Hls
that are not used in any KPI calculation. Hls that are used in calculating multiple KPIs are listed
multiple times, under each of the KPIs to which they contribute.

To access

« Select Workspaces > Dashboards > 360° View > Hierarchy. Select a Cl, and click Indicators.

« Toview HI details from another Service Health component, select a Cl, then select the Show > Hls
menu command.

« You can also add this component to a user-defined page, together with a component where you can
select Cls (for example Top View). For details, see "How to Set Up My Workspace" on page 220.

Learn More

This section includes:

« "Hls and the Event Console" below

Hls and the Event Console

When an event-based HI is created, the HI and Event Console display the same date and time.
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However, if the HI generates a change in a KPI, the KPI shows a delay of a few seconds until it is
updated with the data from the HI.

Tasks

This section includes:

« "How to Select Cls for Display" below
« "How to Reset an Hl's State to Default" below

o "How to Drill Down from the Health Indicator Component" below

How to Select Cls for Display

If your workspace contains a component where you can select Cls (such as Model Explorer, Top View,
Topology Map, or Hierarchy), and also contains the Health Indicator component, you can select a Cl to
display its related health indicators.

If you want to use the Health Indicator component independent of other components, you can select a
CI from within the component itself. Click the Filter button in the Health Indicator component toolbar,
and then click Configuration Items. Open a view within the Configuration Items dialog box, and select
a Cl to display its health indicator data.

How to Reset an HI's State to Default

In some workflows, you might have an HI showing that a problem has occurred, but when you deal with
the problem you might want to reset the HI's state to Normal (default).

Toreset an Hl to its default state, access the menu command on an HI and select Reset Health
Indicator. The HI's default state is restored immediately, and the new status is reflected in the
component when it is next refreshed.

Tip: You can also reset Hls to default outside of OMi, using the Reset HIs API. For details, see
the OMi Extensibility Guide.

Note the following:

« Local Impact Views. Hls cannot be reset to default within local impact views. This is because
resetting Hls is relevant for event-based Hls, which do not use rule calculations but set status
directly from events.

(Local impact views give you the capability to create different status calculations, which is relevant
only for KPIs. The event-based Hls in local impact views have the same status as in Global views,
and resetting them would impact their status in all views - which is not desired behavior.)

How to Drill Down from the Health Indicator Component

You can use HI context menus to access various actions or reports, based on a combination of the
relevant HI type, Cl type, and Monitored By attribute (which describes which data collector collects
information on the HI).

For example, you can drill down from an HI to the corresponding event in the Event Browser. From the
HI's menu commands, select Show Contributing Events.
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Ul Descriptions

Health Indicator Component user interface

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z)
<Cl name>

-

Lw

Health Indicator

Health Indicators
Contributing to
KPIs

Health Indicators
Not Contributing to
KPIs

KPI

Last Status Change

Trend

Value

HPE Operations Manageri (10.10)

Description
Name of the CI to which the displayed health indicators are assigned.

Click the arrow next to a Cl name to access the menu options for that Cl.
Available options depend on the type of Cl and the context menu defined for
the CI.

Click the arrow next to an HI name to access the menu options for that HI.

Reset columns width. Click to restore the width of the columns in the table
to the default widths.

Select columns. Click to select the columns you want to display in the
table.

HI status icon, and display name of the health indicator.

If the saveLastSample global parameter is set to true, you can click the Hl
link to see its last sample details. For details, see the OMi Administration
Guide.

List of the health indicators that are assigned to the selected Cl, and are
used to calculate KPls for the CI.

List of the health indicators that are assigned to the selected ClI, but are not
used to calculate any KPlIs.

Name of the KPI which uses the health indicator in calculating its status,
and current KPI status displayed by a status icon.

The date and time from when this HI has held its current status.

Trend in real-time status for the HI, using three directions: up (green arrow),
down (red arrow), and no change blue arrows).

Note: This column is not displayed by default.

Value of the HI.
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Health Top View Component

The Health Top View component displays the business availability of your system components. The ClI
icons in Health Top View provide a visual indication of the health of the related CI of the selected event,
based on the hierarchy tree structure defined for each view. The connecting lines between the icons
define the relationships between the Cls.

Note: You can refine the contents of the Health Top View pane by applying an alternative view.

You can use the View Mappings manager to map views to individual Cl types. A list of mapped views
appears in the View list in the Health Top View toolbar. The contents of the View list are determined by
the ClI type associated with the event selected in the Event Browser. For more information about view
mapping, see "Mapping Views" on page 198.

For more information about HIs and KPls, see "Health Indicators" on page 110 and "HI-Based KPI
Calculations" on page 111.

To access

You can create your own pages and include this component. For details, see "How to Set Up My
Workspace" on page 220.

Learn More

Health Top View Displays Guidance Messages
The following guidance information is available in the Health Top View pane:

« Ifnoeventis selected, a message is displayed prompting you to select an event.

« If an event without any related Cl is selected, a message is displayed informing you that there is no
Cl information.

« If an event with a related CI but without an associated view mapping is selected, a message is
displayed informing you that there is no view mapping. A link to the View Mappings manager where
you can configure a suitable view mapping is also provided.

« Ifan event with a related Cl and with a view mapping is selected, the list of mapped views is shown
in the drop-down box and the selected view is shown.

Tasks

This section includes:

« "How to Modify the Refresh Rate" below
« "How to Enable the Dark Theme" on the next page

« "How to Enable the Java-based Health Top View Component" on the next page

How to Modify the Refresh Rate

The default refresh rate for Health Top View is five seconds.
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You cannot modify refresh rates of the out-of-the-box pages. However, you can create a user-defined
page with the components you need, and modify their refresh rates as follows:

1. From the Component Menu drop-down list, select Preferences. The Health Top View Preferences
window opens.

2. Modify the refresh rate as needed, and then click OK.

How to Enable the Dark Theme

To change the appearance of the Health Top View component and use the dark theme, follow these
steps:

1. From the Component Menu drop-down list, select Preferences. The Health Top View Preferences
window opens.
2. Select the Use Dark Theme check box, and then click OK.

How to Enable the Java-based Health Top View Component

By default, the HTML5-based Health Top View component is enabled. HTML5-based Health Top View
runs independently of any third-party plug-ins. However, if you want to use the Java-based Health Top
View component, it can be configured in the Infrastructure Settings. For details, see the OMi
Administration Guide.

For details on the Java-based Health Top View component, see "Java-based Health Top View
Component" on page 146.

Ul Descriptions

Health Top View Toolbar

The following options are available in the Health Top View toolbar:

ul
Element Description

<View Select a view from the drop-down list (on the top left area of the toolbar) to display its
Selector> Cls.

<Search | Click to expand, and then type a Cl name to focus on that ClI.
Bar>

= Hierarchical Layout. Select the hierarchical layout for viewing a Cl topology. This is
o the default layout. However, if you choose a different layout for the selected view, the
layout preference is saved (that is, every time you select this view, it is displayed in the
layout that you chose last).

Note: If the screen you are using is small, the layout icons may not be visible in the
component toolbar. In this case, you can access them through the Options button.
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Circular Layout. Select the circular layout for viewing a Cl topology.

3, Organic Layout. Select the organic layout for viewing a Cl topology.

Note: The organic layout may require more time to render large topologies
compared to the other two layout types.

Options. Click to access all commonly performed operations when viewing essential
applications and business processes:

. O Reload. Click to restore the view to its original display.

. /© Zoom to Fit. Click to automatically resize the CI topology to fit the screen size.
« ZOOM. Use the slider to increase or decrease the Cl topology display size.
. DISPLAY OPTIONS.

o Show KPIs. Use the switch to show or hide KPI icons on Cls. To view a list of
Cl's KPIs and their statuses, either click the KPI icon or select Open Cl Context
> KPIsonaCl.

» Show KPIs with normal status. Use the switch to show or hide KPIs that
have the normal status.

o Show Health Indicators. Use the switch to show or hide Health Indicator icons

on Cls. To view HI details, either click 7 or select Open CI Context > Show
HisonaCl.

o Play sound notification. Use the switch to turn the sound notification option on
or off. If this option is turned on, a sound alert is played when a Cl in the view
changes its status to critical (red).

Cl Context Menu

To open the Cl context menu, either right-click the selected ClI, or hover over the selected Cl and then
click the Open Cl Context button that appears on the right. In the CI context menu, you can choose
among the following sections:
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« Button actions:

ul

Element Description

[-n-] Show subtree only. Click to focus only on a particular part of a Cl topology.

E T Show Path to Root. Click to display the path from the selected Cl to the view root CI.

Note: To view the path from the selected Cl to the view root Cl in a separate
window, press and hold the Ctrl button and click the Show Path to Root button.
Alternatively, you can right-click the selected Cl, and then select Show > Path to
Root.

nu Show Problematic Subtree. Click to display all child Cls of a problematic CI that
have the Critical or Major status. This helps you to quickly locate a problematic child
Cl that caused the selected parent Cl to have a status other than OK. If you want to
see a problematic path in isolation, you can use the Show subtree only button.

Note: To view all child Cls of a problematic Cl that have the Critical or Major
status in a separate window, press and hold the Ctrl button and click the Show
Problematic Subtree button. Alternatively, you can right-click the problematic
Cl, and then select Show > Problematic Subtree.

.,'”H= Expand to problem. Click to expand the CI topology display to show the source of a
problematic Cl (available only for Cls that have a status other than OK).

Note: To leave any of these modes, click the X button on the top left of the page.

« Event Information.
Displays allist of events in the Event Browser.
« KPIs
Shows a list of KPlIs and their statuses.
o Show Hls
Shows HI information such as the state, the value, and the last status change.
« ACTIONS
Select the action you want to execute or the tool you want to launch.

Note: To list all available actions, you can also right-click the selected ClI.

Troubleshooting

This section includes:

« "Health Top View is Empty" on the next page

« "Health Indicators Display Incorrectly" on the next page
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Health Top View is Empty

« Noeventis selected in the Event Browser.
« Noview is mapped to the related CI of the selected event.

« No Clis related to the selected event.

Health Indicators Display Incorrectly

Health indicators are used to assign a severity to a state, for example, Critical severity to the state
Unavailable. The state and the assignment are indicated in the Health Indicators pane. However,
calculation rules for a KPl may use several health indicators to set a new severity level for the object in
Health Top View.

« Noeventis selected in the Event Browser.

« The configuration item highlighted in the Health Top View pane does not have any assigned health
indicators.

« You selected an event in the Event Browser pane and a different configuration item in the Health Top
View pane.

Java-based Health Top View Component

The Java-based Health Top View component displays the business availability of your system
components. The Cl bar icons provide a visual indication of the health of the related Cl of the selected
event, based on the hierarchy tree structure defined for each view. The connecting lines between the
bars define the relationships between the Cls.

Note: You can refine the contents of the Java-based Health Top View pane by applying an
alternative view.

You can use the View Mappings manager to map views to individual configuration item types. A list of
mapped views appears in the Selected Views list in the Java-based Health Top View pane. The
contents of the Selected Views list are determined by the configuration item type associated with the
event selected in the Event Browser. For more information about view mapping, see "Mapping Views"
on page 198.

For more information about Hls and KPls, see "Health Indicators" on page 110 and "HI-Based KPI
Calculations" on page 111.

To access

You can create your own pages and include this component. For details, see "How to Set Up My
Workspace" on page 220.

Learn More

This section includes:

« "Java-based Health Top View Displays Guidance Messages" on the next page

« "Java-based Health Top View Pane" on the next page
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« "Java-based Health Top View Tooltips" below

Java-based Health Top View Displays Guidance Messages
The following guidance information is available in the Java-based Health Top View pane:

« Ifnoeventis selected, a message is displayed prompting you to select an event.

« If an event without any related Cl is selected, a message is displayed informing you that there is no
Cl information.

« If an event with a related CI but without an associated view mapping is selected, a message is
displayed informing you that there is no view mapping. A link the View Mappings manager where you
can configure a suitable view mapping is also provided.

« If an event with a related Cl and with a view mapping is selected, the list of mapped views is shown
in the drop-down box and the selected view is shown.

Java-based Health Top View Pane

Ul
Element
(A-2) Description

<Selected ' List of the views mapped to the configuration item type (and any parents) referenced by
View> the event selected in the Event Browser, which contain the Cl, and, if configured,
filtered by event category.

Select the view you want to apply to the contents of the Java-based Health Top View
pane. A view enables you to refine the type and amount of configuration items
displayed. The selected view can also affect the severity status of configuration items,
since views can exclude or include additional (related) items which have an effect on
the displayed topology.

You can map views to configuration item types. For more information about mapping
views, see "Mapping Views" on page 198.

Last Date when the Java-based Health Top View information was last refreshed.
Update

Java-based Health Top View Tooltips

When you hover the cursor over any configuration item displayed in the Java-based Health Top View
pane except the root configuration item in the tree or any item that is colored gray, OMi displays details
of the factors that contribute to the status of a configuration item, as described in the following table.

Ul Element

(A-2) Description

Business Business rule used to determine the availability and performance of the selected
Rule configuration item.
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Ul Element
(A-Z)

Cl Name
Class Type

Hidden
Child Cls

KPI Name

Last Status
Change

Status

Unassigned
Events

Unresolved
Events

Description
Name of the selected configuration item, for example, DB_Server.example. com.
The ClI type of the selected Cl.

Indicates that the selected Cl has child Cls that are not displayed in Java-based
Health Top View.

Display name of the key performance indicator to which the displayed health indicator
is assigned, for example, System Availability KPI.

For more information about KPls, see "HI-Based KP| Calculations" on page 111.

Date and time since when the current status was applied to the selected
configuration item.

Severity assigned to the selected ClI.

KPI associated with events that are either not assigned to any user or remain
unresolved. The information includes, in addition to the details shown for performance
and availability KPIs, the number of duplicate or related (and unassigned) events
associated with the selected object. The background color indicates the highest
severity of the KPIs associated with the selected object.

Troubleshooting

This section includes:

« "Java-based Health Top View is Empty" below

« "Health Indicators Display Incorrectly" below

Java-based Health Top View is Empty

« Noeventis selected in the Event Browser.

« Noview is mapped to the related Cl of the selected event.

« No Clis related to the selected event.

« Java applet did not start or is not running correctly.

Health Indicators Display Incorrectly

Health indicators are used to assign a severity to a state, for example, Critical severity to the state
Unavailable. The state and the assignment are indicated in the Health Indicators pane. However,
calculation rules for a KPl may use several health indicators to set a new severity level for the object in
Java-based Health Top View.

« Noeventis selected in the Event Browser.

« The configuration item highlighted in the Java-based Health Top View pane does not have any
assigned health indicators.
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« You selected an event in the Event Browser pane and a different configuration item in the Java-
based Health Top View pane.

Hierarchy Component

The Hierarchy component displays the hierarchy of the Cls in a view, and the real-time status of each
of the KPIs assigned to the Cls. KPIs are grouped into domains; you can collapse a domain and display
the worst status of all the KPIs in a domain. You can also filter the display to only show Cls with KPls
of a specific status, or specific Cl types.

When you select a Cl in the Hierarchy component, Cl details are displayed. You can then click the
detail links to display additional information regarding the selected Cl.

Tip: The Hierarchy display is highly customizable; you can choose to display specific
KPI domains, or filter for specific Cl statuses, in order to focus attention on areas that are of
particular interest to you.

To access

You can create your own pages and include this component. For details, see "How to Set Up My
Workspace" on page 220.

Learn More

Cl Detail Links

When you select a Cl in the Hierarchy component and then click its Cl detail links, you can access the
following information about the Cl:

« Health Indicators. Displays details regarding the health indicators (HIs) that are used to calculate
and set the status of the Cl selected in the active view. For details, see "Health Indicator
Component" on page 139.

« Changes and Incidents. Displays incidents opened for the Cl selected in the active view, as well
as requests for change and actual changes made to the CI. For details, see "Changes and Incidents
Component" on page 123.

Hierarchy Personalization

You can make the following changes in the Hierarchy component (as described in the following
sections); these are saved for future sessions (per user, per component):

« column order

« column width

« Visible/hidden columns

« collapsed/expanded KPI domains

« collapsed/expanded Cls

« sound on/off (if sound mode is set to True)

« selection of Filter Flat Mode or Filter Hierarchical Mode
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If you make changes in a user-defined page, click Save to retain the changes in the current session. To
save your settings in future sessions, click Log Out when you are ready to exit the browser. (If you
close the browser without logging out, your changes are not saved.)

Tasks

This section includes:

« "How to Create a Quick CI Filter" below

o "How to Create an Advanced Filter" on page 152

« "How to Set up Sound Notification When KPls are Critical" on page 153

« "How to Modify the Refresh Rate" on page 154

« "How to Modify the Number of Cl Levels Displayed in the Hierarchy Component" on page 154
« "How to Display Child Cls Collapsed Rather than Expanded" on page 154

How to Create a Quick CI Filter

The Hierarchy component has a quick filter mechanism that enables you to display only those Cls that
have at least one KPI in a given status. This creates a temporary filter that persists until you log off,
until you change the selection of statuses, or until you select another filter. The filter returns all of the
Cls in the view which fill the filter conditions.

Note: If more than one user is logged in at the same time using the same user name (for example,
admin), every time one of the users saves a change to the filters, the associated filters file is
updated with a copy of that user's filters.

« Totemporarily display only those Cls whose KPls have specific statuses, click the Filter button in
the Hierarchy toolbar, select one or more statuses in the filter bar that opens, and click Filter.

« Todisable filtering, click the Remove Filter button.

Example:

Without filtering, the Hierarchy component includes all KPI statuses.
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To temporarily display only those Cls whose KPls have Minor statuses, click the Filter button,
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How to Create an Advanced Filter

Advanced filters enable you to focus on specific problematic areas by filtering Cls according to specific
KPI statuses, using either temporary or permanent filters. For example, the predefined Show Errors
filter displays only those Cls which have one or more KPls in Critical status.

You can also create an advanced filter which combines filtering according to both KPI status, and ClI
type. For example, you can create a filter that only shows hosts (Node CIT) with one or more KPls in
Critical status.

The filter returns all of the Cls in the view which fill the filter conditions.

1. To create a temporary advanced filter, click the Filter button in the Hierarchy toolbar, and then
click Advanced in the filter bar.

To create a permanent advanced filter, click the Favorite Filters Menu button TE', and then click
New.
2. Inthe Status Selection pane, select check boxes for each KPI status that you want to include in
the filter.
3. (Optional) In the Type Selection pane, select a Cl type to filter which Cls will appear in the
Hierarchy display.
If you select a higher-level CIT, its descendant CITs are included in the filter as well.
4. To activate a temporary filter, click Filter.
To activate afilter and save its settings, click Filter and Save.

Example:

The Worst Hosts filter is created to display only those Cls whose CIT is Node, with at least one
KPI in Critical status.
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How to Set up Sound Notification When KPIs are Critical

You can set up Service Health to play an alert sound when the status of a KPI changes to Critical in
the Hierarchy component.

When a view is loaded for the first time, no sound is played for the KPls that are loaded at Critical
status. When the sound is switched on, a sound alert is played when a KPI in the view changes status
to Critical (red). The Critical status icon flashes until you roll your mouse over it. If a Cl in a hidden part
of the view has changed to Critical but does not change the status of any of the Cls in the currently
displayed branches, no sound is heard.

You can use the following options:

Enable or Disable Sound. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings

Choose Applications and select Service Health Application. In the Service Health Application
- Sound Notification table, locate Sound Notification. Modify the value to true to enable the
sound notification, or to false to disable it. The change takes effect immediately.

Mute or Restore. You can temporarily turn the sound option on or off using the Sound On/Off
button in the Hierarchy toolbar.

Modify the alert sound. The alert sound is an mp3 file downloaded by the browser. To use another
alert sound for Service Health, if you have administrative permissions, access <Gateway server
root directory>\AppServer\ webapps\site.war\static\dash\sounds and replace the ding.mp3 file
with your own .mp3 file (you must rename your file ding.mp3). The change takes effect after you
clear your browser cache.
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How to Modify the Refresh Rate
By default, the Hierarchy component is refreshed every 5 seconds.

You cannot modify refresh rates of the out-of-the-box pages; however you can create a user-defined
page with the components you need, and modify their refresh rates using the Component Menu

button E on the component toolbar. Select Preferences, and change the refresh rate as needed.

How to Modify the Number of Cl Levels Displayed in the Hierarchy Component

By default, the Hierarchy component displays two levels of hierarchy display. For example, when you
select a view, the component displays the view name (as the hierarchy root), and its top-level Cls.
When you drill down from a selected Cl, the selected Cl is displayed as the root, and its child Cls are
also shown.

To modify the number of levels that can be displayed in the Hierarchy component:

1. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
Choose Applications and select Service Health Application.

2. Inthe Service Health Layout Properties table, locate Business Console - Number of display
levels. You can select a value between 1 and 4. If you specify 1, the child Cls are displayed but
cannot be expanded.

How to Display Child CiIs Collapsed Rather than Expanded

1. Open Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
Choose Applications and select Service Health Application.

2. Inthe Service Health Layout Properties table, locate the Hierarchy - Default state property,
and change its value to collapsed.

Ul Descriptions

Hierarchy Toolbar

The toolbar enables you to customize how data is displayed in the Hierarchy table, and to create filters
that define which KPIs are displayed.

User interface elements are described below:

Ul

Element Description

<View Select a view from the dropdown list (to display information on the Cls in the view.
Selector>
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Ul
Element

E.

35?

<Filter
Bar>

Description

Menu. Select one of the following options:

o L2 gl Expand Available Levels/Collapse All. Click to expand or collapse the
Cls displayed in the Hierarchy component.

These buttons are enabled when one or more of the currently displayed Cls can be
expanded or collapsed.

« ! Drill Down. Select a Cl and click to drill down to its child Cls. This button is only
enabled when a Cl is selected.

If afilter is active, the drill-down opens a new browser window for the selected CI.

. ) Up One Level. Click to display the parent Cl of the CI currently displayed in the

Hierarchy component.
This button is only enabled when the currently displayed CI has a parent CI.

. Lk select Columns. Click to open the Select Columns dialog box, which enables
you to select which KPls are displayed.

Use the arrows to add or remove KPls from the display.
Filter. Click to open the filter bar, which enables you to only display Cls with at least

one KPI of a given status (for example, only display Cls with at least one KPI with
Critical status).

When the Filter button has a yellow and red border, afilter is currently active.

Remove Filter. If afilter is active, click to cancel filtering and show all KPI statuses for
all Cls.

After you press the Filter button, this bar appears directly below the Hierarchy toolbar.

Select a combination of KPI statuses, to only display Cls which have at least one KPI
with a given status.

The filter bar includes the following buttons:

« Filter. After selecting statuses, click to activate filtering.
« Clear. Click to clear all of the statuses.

« Advanced. Click to create an advanced filter. This enables you to filter specific KPls
or Cl types, and to create a permanent filter.

Note: The filter created using the filter bar is a temporary filter that persists until you log
off, until you change its selection of statuses, or until you select another filter.
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Ul
Element Description

<Favorite This list contains the predefined filters, and the filters you have created using the
Filters Advanced Filter.

List> . Select afilter to apply it to the Hierarchy display.

« Toedit, clone, or delete afilter, select the filter from this list, then click the Favorite
Filters Menu button.

Predefined filters are useful in displaying commonly required information; they cannot
be modified or deleted. These are the predefined filters:

« global: Show Errors. Displays the Cls whose KPIs have a Critical status.

« global: Show Errors and Warnings. Displays the Cls whose KPIs have a Minor,
Major, or Critical status.

« global: Show PNR. Displays, for all Cl types, only the Cls whose PNR KPI has an
OK, Warning, Minor, Major, Critical, or No Data status.

ad

Favorite Filters Menu. This opens a drop-down menu, which enables you to perform
the following actions:

« Tocreate an advanced filter, click New.

« To edit or delete afilter, select the filter from the Favorite Filters list, and click Edit or
Delete.

Note that predefined filters cannot be modified or deleted.

« Toclone afilter, select the filter from the Favorite Filters list, and click Clone.

B Filter Hierarchical Mode. When filtering is active, click to display the Cls that fill the
filter conditions within a hierarchical structure, in the context of their parent Cls.

E= Filter Flat Mode. When filtering is active, click to display the Cls that fill the filter
conditions in a non-hierarchical, list format, without displaying their parent Cls.

o e Sound On/Off. You can set up Service Health to issue an alert sound when the status
of a KPI changes to Critical.

Click to toggle the sound on or off.

Hierarchy Table Columns

User interface elements are described below as they appear in the Ul (unlabeled elements are shown in
angle brackets):

Ul Element Description

Acknowledge Set or unset acknowledgment for a Cl by clicking anicon in this column; a
check mark ] indicates that acknowledgment has been set.
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Ul Element Description

Business Impact Note: Business Impact is not visible by default. To modify, see the OMi
Administration Guide.

This bar indicates the Cl's business impact, using a rating from zero (no
impact) to 5 (high impact). The rating shows how much of an impact the ClI
has on the business Cls and SLAs in your monitored environment.

By default, the business impact rating is based on the criticality of impacted
business Cls, and the number of impacted business Cls and SLAs. For
details, see the OMi Administration Guide.

If you are in Filter Flat Mode, you can click the column header to sort by
ascending/descending order.

<KPIs> Each of the KPI columns displays the status and value of a specific KPI, for
each of the Cls displayed in the table.

<KPI Domains> KPls are grouped by domains. For example, the Application domain contains
the Application Performance and Application Availability KPIs.

You can view all the KPIs in a domain, or you can collapse a domain to view
the worst status of all the KPIs in the domain.

Last Status Displays the date and time when the Cl entered its current status.

Change If you are in Filter Flat Mode, you can click the column header to sort by

ascending/descending order.

Name This column displays the Cls in the selected view in a hierarchical structure;
you can expand a Cl to drill down to its child Cls.

Status Displays the worst KPI status for the ClI.

If you are in Filter Flat Mode, you can click the column header to sort by
ascending/descending order.

Hierarchy Table Rows

User interface elements are described below (unlabeled elements are shown in angle brackets):
Ul Element Description
<Cl name> Each row in the table shows the KPI statuses of a given CI.

- Click the down arrow next to a Cl name to access the menu options for the ClI.
Available options depend on the type of Cl and the context menu defined for the ClI.
If no context menu is defined for the CI, the menu arrow is not displayed. If amenu
option is not supported for the selected Cl, the option will be disabled or not
displayed.
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Ul Element

<KPI
status/value>

<KPI
History>
oot

f

<KPI Trend>
oot

f

Description

Displays text or an icon indicating the current status or value of the KPI.
Tooltip:

. Status. The status of the Cl (calculated according to one of the status
calculation methods). It may also display:

o Not up to date. For decayed Cls, indicating that the Cl has passed its timeout
period. (For a SiteScope Cl, this status is displayed after a SiteScope monitor
is disabled.)

o Stopped. When a Business Process is stopped.

« Business Rule. The name of the rule that calculates the KPI status or value.
« Last Status Change. The date and time since which this CI has held its current
operational status.

When you select a Cl, the history status icon displays either the worst status or the
average status for the KPI during a specified time period. For details, see the OMi
Administration Guide.

Tooltip:

« History Type. The type of history (worst status or average status) used when
calculating history status.

« Historical Worst/Average. The worst or average status of the KPI in the
selected time period.

When you select a Cl, the trend status icon shows the trend in real-time status for
the KPI, using three directions: up, down, and no change. For details, see the OMi
Administration Guide.

Tooltip:
« Trend. The trend of the KPI in the selected time period.

Defining/Editing Filters Dialog Box

This dialog box enables you to define new filters or customize existing filters. To access, select
Applications > Service Health > 360° View > Hierarchy. Click Filter and then click Advanced, or
click the Favorite Filters Menu button.
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User interface elements are described below:
ul
Element
(A-2) Description
Invert Selection. Click to select or deselect one of the statuses, for all the KPlIs.
<Status  Select the check box for each KPI status that you want to include in the filter. The
check Hierarchy display shows all the Cls that have at least one KPI that fills the filter criteria.
boxes>
Cancel Click to exit the Defining/Editing Filters dialog box without saving changes.
Filter Click to apply the filter (without saving filter settings).
Filter Click to apply the filter, and save your changes to the filter.
and Save
Filter Type the name of the filter you are creating.
Name
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Ul
Element
(A-Z)

Type
Selection

Visibility

Description

This displays a Cl type hierarchy, which you can use to filter specific Cl types. Select a
Cl type to only display Cls of this type in the Hierarchy display.

The ClI type filtering is combined with the Status filtering. For example, suppose you
select critical status for all KPls in the Status Selection pane, and the Business Element
CIT in the Type Selection pane. The Hierarchy display will only show Cls of this CIT
(and its descendant CITs), which have at least one KPI in critical status.

Note: If you select a higher-level CIT, all its descendant CITs are included in the filter as
well.

Select the required visibility option:

« Private. Create a private filter that is available only to the user who created them.
You can use the global and public active filters as templates to build private active
filters. Their names have the following syntax: private:<name>.

For each user name used when logging on to OMi, Service Health creates an
associated filters file. When you log on to OMi by using a specific user name, you can
only view and modify the filters contained in the associated filters file. The file is
updated with the filter modifications made by each user who logs in under this user
name, so any changes you make to the filters may overwrite modifications made by
previous users.

« Public. Administrators or users with the appropriate permissions can build public
active filters. Those filters are available for all users at the specific customer. You
can use the global active filters as templates to build public active filters. Their names
have the following syntax: public:<name>.

Note: Visibility is displayed only to the administrator or to a user with the appropriate
permissions.

Neighborhood Map Component

Neighborhood Map displays the parent Cls and child Cls of a selected Cl, in an interactive graphic.
Each Cl in the view is displayed as a bar, with a color-coded icon indicating its current worst KPI
status. Below the name of the Cl, icons identify its related KPIs and their current statuses.

You can view Cls within Neighborhood Map divided into layers, enabling you to focus attention on the
layer which interests you the most (for example Business Enablement, Infrastructure, or Software).

Links between Cls are shown as defined in the RTSM (without View Folding); links between the Cls
represent their physical links as they appear in the RTSM.

Tip: The Neighborhood Map is particularly useful if, for example, you want to explore the source of
a problem which may come from a Cl outside your monitored view.

HPE Operations Manageri (10.10) Page 160 of 307



OMi User Guide
Chapter 7: Health

To access

Create a custom page that includes Neighborhood Map. Add a component which enables you to select
a Cl, such as View Explorer or Top View. For details see "How to Set Up My Workspace" on page 220.

Learn More

Display Options: Plain Mode or Layer Mode
You can view Cls in Neighborhood Map in one of two modes:

« Plain mode. In plain mode, each Cl is displayed on its own.

« Layer mode. Inlayer mode Cls are divided into functional layers, such as Business Enablement,
Infrastructure, or Software. Cls are assigned to the layers based on their Layer attribute in the
RTSM. For example, in layer mode the Application Resource and Application System CITs are
assigned to the Software layer, based on their Layer attribute.

In layer mode you can move Cls in and out of layers. You can also create additional layers using the
Layer attribute in RTSM administration.

The layers in Neighborhood Map are identical to the layers in Topology Map; for details on each of the
default layers, see "Topology Map Component" on page 177.

Annotating and Saving Images

Within Neighborhood Map, you can use annotation to create and save a snapshot of the image you are
viewing, and highlight important areas of the image. Click the Capture Result and Add Annotations
button on the toolbar to access the annotation tool. The annotation tool is identical in Neighborhood
Map and Topology Map. For details, see "Annotation Tool" on page 114.

Tasks

This section includes:

« "How to Modify the Number of Cl Levels Shown in Neighborhood Map" below
« "How to Customize Neighborhood Map Display" on the next page

« "How to Modify the Refresh Rate" on the next page

How to Modify the Number of Cl Levels Shown in Neighborhood Map

By default, when a Cl is selected, Neighborhood Map shows two levels of its parent Cls and two levels
of its child Cls. In other words, Neighborhood Map shows the selected Cl in the context of its parent
Cls and their parent Cls, as well as its child Cls and their child Cls.

You can modify this setting to display one, two, or three levels of Cls, using the following infrastructure
setting:

Administration > Setup and Maintenance > Infrastructure Settings

Access Applications > Service Health Application. Locate the Neighborhood map depth entry in
the Service Health Application - Service Health Layout Properties table, and modify as required.
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How to Customize Neighborhood Map Display

The Neighborhood Map display is highly customizable; you can view Cls in layers or individually,
display minimal or detailed information on Cls and the links between them, and modify other elements
in the display. For details, refer to the Ul Description below.

Note: Customizing the Neighborhood Map display has no effect at all on the RTSM topology;

your customizations only influence how Cls are displayed in this component.

How to Modify the Refresh Rate

You cannot modify refresh rates of the out-of-the-box pages; however you can create a user-defined
page with the components you need, and modify their refresh rates using the Component Menu

button E on the component toolbar. Select Preferences, and change the refresh rate as needed.

Ul Descriptions

Neighborhood Map Toolbar

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
' Refresh. To enhance performance, Neighborhood Map does not reflect

changes made to the ClI topology within the RTSM. If you have made
changes to Cl topology in the RTSM, click Refresh to update the ClI
topology display.

Refocus. To change Neighborhood Map's focus from the selected Cl to a
different Cl, select a Cl and click Refocus.

Neighborhood Map changes focus to highlight the selected CI, and shows
its parent and child Cls.

Select. In Select mode, you can select Cls or groups to perform actions on
the selected elements. For example, you must be in Selection mode to
move Cls.

OF Interactive Zoom. In Zoom mode, click within Neighborhood Map and drag

up or down to zoom in and out of the image.

4y Pan. In Pan mode, if your Neighborhood Map image is scrollable you can
click and drag the image to move it. (If the entire image fits within your
screen this feature has no effect.)

el Fit to screen. Click to fit the graph to the pane, either by expanding it or by
reducing it. Relative proportions of the image are maintained.
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Ul Element (A-2)

Plain mode -

Description

Toggle Presentation Type. Click to switch between minimal view, which
displays only Cl icons and worst statuses, and detailed view, which also
displays Cl names and KPI statuses.

Click to open a dropdown list of display options. You can select or de-select
each of the following options:

« Show links. If you select this option, Neighborhood Map displays
arrows between Cls that are linked.

« Show link labels. If you select this option, Neighborhood Map displays
each link together with its link type (for example, Containment or
Ownership). If the Show links option is de-selected, this option is
disabled.

Click to select between the following display modes:

« Plain Mode. Each Cls is displayed standing on its own.

« Layer Mode. Neighborhood Map displays related higher-level Cls in
layers; for example, Business Element Cls are displayed in the
Business Enablement layer, while Node and Node Element Cls are
displayed in the Infrastructure layer.

Display Minimap. Click to display the Neighborhood Map image in a small
window (minimap), which is overlaid on top of the standard Neighborhood
Map.

A highlighted area within the minimap image shows which part of the
Neighborhood Map is displayed in the larger image. You can resize or move
this highlighted area to focus on the part of Neighborhood Map which is of
interest to you. To close the minimap window, click within the larger image.

Capture Result and Add Annotations. Click to open the Annotation Tool,
which creates a snapshot of the Neighborhood Map and enables you to
annotate the snapshot to highlight important areas. The tool enables you to
draw in the snapshot, or add lines or text to the image. For details, see
"Annotation Tool" on page 114.

Neighborhood Map Display

User interface elements are described below (unlabeled elements are shown in angle brackets):

HPE Operations Manageri (10.10) Page 163 of 307



OMi User Guide
Chapter 7: Health

Ul

Element

(A-Z) Description

<Cl Each Cl in the selected view is displayed as a bar within Neighborhood Map, which
nodes> contains the following elements:

(g m=™ | « Theleft side of the bar shows anicon indicating the Cl's Cl type, as represented in

the RTSM.
« Cl aggregated status is overlaid on top of the CIT icon.

« If Neighborhood Map is in detailed view, the Cl name and KPI statuses are also
displayed.

Tooltips: The tooltip for a Cl shows the Cl name and CI type. The tooltip for a KPI
shows status and performance data for the KPI:

C'\I Customer2_Snt_A...
L]
Q &

Status: Critical
Business Rule: Worzt Status Rule
Held status since: AMA0 01:35:35 PM

Dietails - Application Awailabiliy

Cl and KPI status are displayed as color-coded icons.

<layers of ' Inlayer mode, high-level Cls are displayed within layers that are divided by
Cls> functionality, such as Business Enablement or Infrastructure. Each layer is shownina
separate shaded area, labeled by the layer name.

Layers cannot be renamed or deleted; Cls can be removed from layers, or added to

them.
<links In the list of Display options, if you select Show links, Neighborhood Map displays
between arrows between Cls that are linked within the RTSM.

Cls> If you also select the Show link labels option, Neighborhood Map also displays the

link type (for example, Containment or Ownership).

<minimap  If you click the Display Minimap button, the Neighborhood Map image appears in a
image> small window (minimap), overlaid on top of the standard Neighborhood Map.

The highlighted area shows which part of the Neighborhood Map is displayed in the
| | [@rger image. Resize or move the highlighted area to focus on the part of Neighborhood
Map which is of interest to you.

Last Displays when the information in the component was last updated.

To manually update Cl statuses, click the Refresh icon.
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Top View Component

Top View enables you to see the business availability of your system components at a glance. The Cls
in the component provide a visual representation of real-time IT performance metrics mapped to
business applications, based on the hierarchy structure defined for each view. The connecting lines
between the Cls define their relationships.

View: Internal Services
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By presenting an integrated, single view of essential applications and business processes, Top View
provides you with an overall perspective on the health of your business services, and enables you to
quickly assess how a performance issue impacts the availability of any part of your business. Each Cl
is color-coded to indicate the worst status held by the Cl's KPls. You can also quickly view KPI and HI
details.

To access

When creating a custom page, Top View can be used as an independent component using its built-in
view selector, or together with another component which selects views such as View Explorer. For
details, see "How to Set Up My Workspace" on page 220.

Learn More

This section includes:

« "Interactive Map" below

« "Virtual Folders" on the next page

Interactive Map

Top View presents an interactive map of the Cls that can be manipulated using the mouse, enabling
you to focus on specific branches of the tree that are related to particular business or problem areas.
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By default, the Top View component displays four levels of Cls. The rest of the Cls are collapsed. You

can expand Cls from the fourth level and see their child Cls. The lines connecting the Cls represent the
branches of the tree. For detailed information about how to change the number of Cl levels displayed in

Top View, see the OMi Administration Guide.

Virtual Folders

By default, the maximum number of displayed child Cls of a view root Cl is 100. However, in large Cl
topologies, this number can be easily exceeded. In this case, the child Cls are evenly distributed into
virtual folders so that not too many Cls are displayed at once, and therefore, any potential performance
issues are avoided. Each virtual folder shows the number of contained Cls. After expanding it, you can
view the contained Cls in three different layouts (hierarchical, circular, or organic).

Note: The maximum number of displayed child Cls of a view root C| before introducing the virtual
folders can be defined in the Infrastructure Settings. For details, see the OMi Administration Guide.

Tasks

This section includes:

« "How to Use Keyboard Navigation" below

« "How to Customize Top View" on the next page

« "How to Enable the Java-based Top View Component" on the next page
« "How to Select a View to Display a Cl Topology" on page 168

« "How to Monitor the Status of Cls in a Topology" on page 168

« "How to Display Cl Details" on page 168

« "How to Locate a CI" on page 168

« "How to Focus on a Particular Subtree" on page 169

« "How to Modify the Refresh Rate" on page 169

« "How to Enable the Dark Theme" on page 169

How to Use Keyboard Navigation

You can use the following keyboard navigation options in Top View:

Keyboard Navigation

Option Description

Arrow keys (up, down, right, =~ Move from one CI to another.

left)

Enter Select the Cl that is currently focused.
Shift+C Center the Top View focus on the selected CI.
Plus Sign or Minus Sign Expand or collapse the selected CI.
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Keyboard Navigation
Option

Spacebar

Ctrl+Plus Sign or Ctrl+Minus
Sign

Ctrl+0

Ctrl+Shift+Plus Sign or
Ctrl+Shift+Minus Sign

Esc

Shift+V
Shift+F
Shift+L
Ctrl+Shift+M
Shift+R
Application key
F3

Shift+F3

Description
Expand or collapse the selected Cl.

Increase or decrease the Cl display size.

Zoom tofit (that is, resize the Cl topology to fit the screen size).

Zoom in or out completely.

Exit a view mode (for example, Problematic Subtree), close the Cl
context menu, or close the Options menu.

Focus on the view selector and expand the View drop-down list.
Focus on the Search bar.

Change the layout for viewing a Cl topology.

Open the Options menu.

Focus on the root ClI.

Open the CI context menu.

Show the next search resullt.

Show the previous search result.

Note: You can also search for a Cl by typing its name anywhere in the Top View page. The Search
bar becomes active automatically.

How to Customize Top View

You can customize various aspects of Top View such as the Top View layout, Cl, KPI, or HI display
options, the background image, and so on.

For details on customizing Top View, see the OMi Administration Guide.

How to Enable the Java-based Top View Component

By default, the HTML5-based Top View component is enabled. HTML5-based Top View runs
independently of any third-party plug-ins. However, if you want to use the Java-based Top View
component, it can be configured in the Infrastructure Settings. For details, see the OMi Administration

Guide.

For details on the Java-based Top View component, see "Java-based Top View Component" on

page 171.
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How to Select a View to Display a Cl Topology

Selecting a view from the drop-down list of the Top View component or any of the wired components on
the same page shows Cls in that view. The CI that you select in any of the wired components is
automatically selected in other components. For example, if you select a Cl in the View Explorer
component, this Cl is automatically selected and centered in the Top View component, and sub-
branches are expanded if necessary.

Note: Top View enables you to zoom the displayed Cl topology in and out by using the mouse
wheel, pressing Ctrl+Plus Sign or Ctrl+Minus Sign, or by using the slider that you can access
through the Options button. You can also move your displayed Cl topology around by clicking and
holding down the left mouse button. In addition, hovering over the Collapse icon creates a fading
effect and helps you to see which elements will be collapsed, if you decide to do so.

How to Monitor the Status of Cls in a Topology

You can quickly determine the status of Cls in a topology by checking icons and colors that indicate the
Cl health status. The view is automatically updated when the event status is changed or a new event is
received, as well as when there is a change in the CI topology (for example, when a new Cl is
discovered).

Note: If you want a sound alert to be played when a Cl in the view changes its status to critical
(red), make sure the Play sound notification option that you can access through the Options
button is switched on. This option is enabled by default, but you can disable it by switching it off.

How to Display Cl Details

By default, Cls are shown without their KPlIs. To display KPI icons for Cls, click the Options button,
and then switch the Show KPIs option on. You can also choose to show only the KPls that have the
normal status. In this case, make sure you switch the Show KPIs with normal status option on.

KPls are displayed with severity icons and colors based on their current statuses. To view a list of a
Cl's KPIs and their statuses, either click a KPI icon or open the Cl context menu by hovering over the
selected Cl and clicking the Open CI Context button that appears on the right. In the latter case, for
more details, open the display view by clicking the right arrow button. Go back by clicking the left arrow
button or close the display view by clicking the X button.

To display HI information, click the Options button, and then switch the Show Health Indicators

option on. Each Cl that has Hls assigned has v displayed. To view HI details, click Cor open the CI
context menu. For more information about the data displayed, see "Health Indicator Component" on
page 139.

How to Locate a Ci

To search for a specific Cl in Top View, type any part of a Cl name in the Search bar. A list of all
matching Cls in that view appears. Selecting a Cl focuses on that Cl and the branches are expanded if
necessary.
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How to Focus on a Particular Subtree

If you want to focus only on a particular part of a Cl topology, hover over the root of a subtree that you
want to view closely, and then click the Show subtree only button that appears on the left. The
selected subtree is displayed. If necessary, you can repeat this action to focus even further on the
subtree.

To go one level up in the subtree, click the up arrow on the top left of the page. To leave the Show
subtree only mode completely, click the X button on the top left of the page. The focus is kept on the
last Cl you selected.

You can also use the Show subtree only button in the Cl context menu. For details, see "C| Context
Menu" on the next page.

How to Modify the Refresh Rate
The default refresh rate for Top View is five seconds.

You cannot modify refresh rates of the out-of-the-box pages. However, you can create a user-defined
page with the components you need, and modify their refresh rates as follows:

1. From the Component Menu drop-down list, select Preferences. The Top View Preferences
window opens.

2. Modify the refresh rate as needed, and then click OK.

How to Enable the Dark Theme
To change the appearance of the Top View component and use the dark theme, follow these steps:

1. From the Component Menu drop-down list, select Preferences. The Top View Preferences
window opens.

2. Select the Use Dark Theme check box, and then click OK.

Ul Descriptions

Top View Toolbar

The following options are available in the Top View toolbar:

Ul
Element Description

<View Select a view from the drop-down list (on the top left area of the toolbar) to display its
Selector>  Cls.

<Search  Click to expand, and then type a Cl name to focus on that CI.
Bar>
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B Hierarchical Layout. Select the hierarchical layout for viewing a Cl topology. This is
the default layout. However, if you choose a different layout for the selected view, the
layout preference is saved (that is, every time you select this view, it is displayed in the
layout that you chose last).

Note: If the screen you are using is small, the layout icons may not be visible in the
component toolbar. In this case, you can access them through the Options button.

Circular Layout. Select the circular layout for viewing a Cl topology.

38, Organic Layout. Select the organic layout for viewing a Cl topology.

Note: The organic layout may require more time to render large topologies
compared to the other two layout types.

Options. Click to access all commonly performed operations when viewing essential
applications and business processes:

. O Reload. Click to restore the view to its original display.

. /© Zoom to Fit. Click to automatically resize the CI topology to fit the screen size.
« ZOOM. Use the slider to increase or decrease the Cl topology display size.
. DISPLAY OPTIONS.

o Show KPIs. Use the switch to show or hide KPI icons on Cls. To view a list of
Cl's KPIs and their statuses, either click the KPI icon or select Open Cl Context
> KPIsonaCl.

» Show KPIs with normal status. Use the switch to show or hide KPIs that
have the normal status.

o Show Health Indicators. Use the switch to show or hide Health Indicator icons
on Cls. To view HI details, either click 7 or select Open CI Context > Show

HisonaCl.

o Play sound notification. Use the switch to turn the sound notification option on
or off. If this option is turned on, a sound alert is played when a Cl in the view
changes its status to critical (red).

Cl Context Menu

To open the Cl context menu, either right-click the selected ClI, or hover over the selected Cl and then
click the Open Cl Context button that appears on the right. In the CI context menu, you can choose
among the following sections:
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« Button actions:

ul

Element Description

[-n-] Show subtree only. Click to focus only on a particular part of a Cl topology.

E T Show Path to Root. Click to display the path from the selected ClI to the view root Cl.

Note: To view the path from the selected Cl to the view root Cl in a separate
window, press and hold the Ctrl button and click the Show Path to Root button.
Alternatively, you can right-click the selected Cl, and then select Show > Path to
Root.

nu Show Problematic Subtree. Click to display all child Cls of a problematic CI that
have the Critical or Major status. This helps you to quickly locate a problematic child
Cl that caused the selected parent Cl to have a status other than OK. If you want to
see a problematic path in isolation, you can use the Show subtree only button.

Note: To view all child Cls of a problematic Cl that have the Critical or Major
status in a separate window, press and hold the Ctrl button and click the Show
Problematic Subtree button. Alternatively, you can right-click the problematic
Cl, and then select Show > Problematic Subtree.

.,'”H= Expand to problem. Click to expand the CI topology display to show the source of a
problematic Cl (available only for Cls that have a status other than OK).

Note: To leave any of these modes, click the X button on the top left of the page.

« Event Information.
Displays allist of events in the Event Browser.
« KPIs
Shows a list of KPlIs and their statuses.
o Show Hls
Shows HI information such as the state, the value, and the last status change.
« ACTIONS
Select the action you want to execute or the tool you want to launch.

Note: To list all available actions, you can also right-click the selected ClI.

Java-based Top View Component

Java-based Top View enables you to see the business availability of your system components at a
glance. The ClI bars in the component provide a visual representation of real-time IT performance
metrics mapped onto business applications, based on the hierarchy structure defined for each view.
The connecting lines between the bars define the relationships between the Cls.

HPE Operations Manageri (10.10) Page 171 of 307



OMi User Guide
Chapter 7: Health

By presenting an integrated, single view of essential applications and business processes, Java-based
Top View provides you with an overall perspective on the health of your business services, and enables
you to quickly assess how a performance issue impacts the availability of any part of your business.
Each Cl is color-coded to indicate the worst status held by the Cl's KPls. You can also quickly view
KPI details, and Cl business impact.

To access

When creating a custom page, Java-based Top View can be used as an independent component using
its built-in view selector, or together with another component which selects views such as View
Explorer. For details see "How to Set Up My Workspace" on page 220.

Learn More

This section includes:

« "Interactive Map" below
« "Understanding the Colors and the Icons" below

« "Virtual Containers" below

Interactive Map

Java-based Top View presents an interactive map of the Cls that can be intuitively manipulated using
the mouse, enabling you to drill down to specific branches of the tree and to focus on particular
business or problem areas.

By default, the Java-based Top View component displays four levels of Cls. The rest of the Cls are
collapsed. You can expand Cls from the fourth level and see their child Cls. The lines connecting the
bars represent the branches of the tree. The bars and lines can be manipulated to change the amount of
information displayed and the overall layout of the diagram.

Understanding the Colors and the Icons

Each CI contained in the view is displayed as a bar, color-coded according to the current worst
operational status for that CI.

For alist of the KPIs used in Service Health, see the OMi Administration Guide.

Note: The root Cl does not display KPI icons because it is a container and not a real ClI.

Virtual Containers

Virtual container Cls are displayed in Java-based Top View in regular Cl bars, color-coded according to
the current worst operations status for the child Cls included in that group. You cannot right-click the
bar to display context menu options.

Tasks

This section includes:
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"How to Use Java-based Top View" below
"How to Use Keyboard Navigation" below
"How to Customize Java-based Top View" below

"How to Modify the Refresh Rate" on the next page

How to Use Java-based Top View

Manipulate the display. Click and drag anywhere in the component to move and rotate the graphic
around that point. Double-click a Cl (or click the lower-right corner of a selected Cl) to rearrange
Java-based Top View with the selected Cl in the center of the display. Click Reload View in the
toolbar to restore the view to its original display.

Increase/decrease Cl display size. You can use the magnifying slider on the toolbar to increase or
decrease the Cl display size. Changes are saved per user, per component.

Show CI details. By default, Cls are shown without their KPIs. To display KPI icons for all Cls,
select Display Options > Show KPIs in the toolbar. To view a list of a Cl's KPIs and their
statuses, click a Cl.

To display HI information, select Display Options > Show Hls in the toolbar. Each Cl that has Hls
assigned will have an Cliconinits Cl bar. Click this icon to view HI details; see "Health Indicator
Component" on page 139 for more information about the data displayed.

When you hover over a Cl's status icon, its status and ClI type are displayed. When you hover over a
KPI's status icon, its status and calculation rule are shown.

Focus on problematic areas. Select a problematic Cl, then click Path to Root in the toolbar to
display the path from the selected CI to the view root CI.

You can also select a problematic Cl, then click Problematic Subtree in the toolbar to display all of
its child Cls that have Critical or Major status. This helps you find the problematic child Cl that
caused the selected parent Cl to have a status other than OK.

Locate a Cl. You can search for a Cl among the Cls currently displayed in Java-based Top View.
Type the first letters of a Cl name in the toolbar Search bar. A list of the relevant Cls currently
included in Java-based Top View display appears; select a Cl to focus on that Cl and openits Cl
details.

How to Use Keyboard Navigation

You can use the following keyboard navigation options in Java-based Top View:

Arrow keys (up, down, right, left): Move from one CI to another.
Shift-C: Center Java-based Top View focus on the selected ClI.
Plus (+) and minus (-) keys: Expand and collapse the selected ClI.

Ctrl + (plus) and Ctrl - (minus): Increase/decrease Cl display size.

How to Customize Java-based Top View

Using Service Health Administration, you can customize various aspects of the following:

Java-based Top View colors, fonts, or layout
Cl or KPI display options
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« Background image
« Number of Cl levels displayed
For details on customizing Java-based Top View, see the OMi Administration Guide.

How to Modify the Refresh Rate
The default refresh rate for Java-based Top View is 5 seconds.

You cannot modify refresh rates of the out-of-the-box pages; however you can create a user-defined
page with the components you need, and modify their refresh rates using the Component Menu

button E on the component toolbar. Select Preferences, and change refresh rates as needed.

Ul Descriptions

Java-based Top View Toolbar

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element Description

<View Selector> Select a view from the dropdown list (on the top left area of the toolbar)
to display its Cls in Java-based Top View.

<Search Bar> Type a Cl name to focus on that Cl in Java-based Top View.

Note: You can only search among the Cls currently available to Java-
based Top View; you cannot search for a Cl that is another view, orin a
hierarchy level that Java-based Top View has not accessed.

®) Reload View. Click to restore Java-based Top View to its original
display.

Path to Root. After selecting a problematic Cl, click to display the path
from the selected Cl to the view root ClI. Click again to display the full
Java-based Top View.

Note: This is disabled in local impact views where a breakdown is
configured.

Problematic Subtree. After selecting a problematic Cl, click to display
all of its child Cls with Critical or Major status; this helps you to quickly

locate a problematic child Cl. Click again to display the full Java-based

Top View.

(x]:]

Note: This is disabled in local impact views where a breakdown is
configured.
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Ul Element

|Di5|::ula'_n,-I Optionz *|

{ m]

EN

Description

Show KPIs. Click to show/hide KPI icons on Cls.

Show Hais. Click to show/hide Hl icons on Cls, which indicate whether
a Cl has Hls assigned.

Use the slider to increase or decrease the Cl display size. Changes are
saved per user, per component.

Java-based Top View Display

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-2) Description

<Cls> By default, each Cl in the selected view is shown in a bar, which contains ClI
aggregated status and Cl name:

(o R

If you select Display Options > Show KPIs in the toolbar, KPI icons are
displayed below each ClI bar:

© I

wG BG

To display details when you click a Cl, go to Administration > Setup and
Maintenance> Infrastructure Settings, select Service Health
Application from the Applications drop-down menu, and scroll to Service
Health Application - Top View (Java) Properties > Mouse action for
showing CI information box. Change the setting from None to Click ClI.

@

BusinessTransaction

Application Performance (V]

Application Availakbility Q
®)

« The detailed display shows the Cl name and status, Cl type, business
impact, KPls, and KPI statuses.

« ClandKPI statuses are displayed as color-coded icons.

« The business impact bar, using a rating from zero (no impact) to 5 (high
impact), shows how much of an impact the Cl has on the business Cls
and SLAs in your monitored environment.

Note: The Business Impact bar is not visible by default in Service
Health application components. To modify, see the OMi
Administration Guide.

« Click the target icon in the lower right corner to rearrange Java-based Top
View with the selected Cl in the center of the display.

Health Indicators: If you select Display Options > Show His in the

toolbar, and a Cl has Hls attached, the CI bar will show this icon: L. Click

the icon to view HI details; see "Health Indicator Component" on page 139
for more information about the data displayed.

Tooltips: Cl tooltips show Cl status and Cl type. KPI tooltips show status
and performance data for the KPI.
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Ul Element (A-2) Description

<right-click menu Right-click a Cl bar to list the available menu options.
options>

Last Update Displays when the information in the component was last updated.

To manually update the information in the component, click the Refresh icon.

Troubleshooting

My Workspace pages containing Java-based Top View cannot be opened

When Java-based Top View is disabled (that is, the Java Top View Enabled setting is set to False in
the Infrastructure Settings), My Workspace pages containing Java-based Top View cannot be opened.
In this case, follow these steps:

1. Enable Java-based Top View by defining the Java Top View Enabled setting as True.

2. Remove all Java-based Top View components from My Workspace pages.

3. Disable Java-based Top View again by defining the Java Top View Enabled setting as False.
4. Addthe Top View component to My Workspace pages.

For details on how to customize Java-based Top View, see the OMi Administration Guide. For details
on HTML5-based Top View, see "Top View Component" on page 165.

Topology Map Component

Topology Map enables you to assess the business availability of your system components at a glance,
using an interactive graphic representation of the Cls in a view. Each Cl in the view is displayed as a
bar, with a color-coded icon indicating its current worst KPI status. Below the name of the Cl, icons
identify its KPls, and their current statuses.

You can display Cls according to view folding (View Display), or according to the Cl definitions in the
RTSM (Graph Display). Topology Map also enables you to arrange Cls in groups (divided by CI type or
application), or in functional layers.

Tip: By presenting an integrated, single view of essential applications and business processes,
Topology Map provides you with an overall perspective on the health of your business services,
and enables you to quickly assess how a performance issue impacts the availability of any part of
your business.

To access

When creating a custom page, Topology Map can be used as an independent component using its built-
in view selector, or together with another component which selects views such as Model Explorer. For
details see "How to Set Up My Workspace" on page 220.

Learn More

This section includes:
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« "Plain Mode, Group Mode, and Layer Mode" below

"Default Layers" below

"View or Graph Display" on the next page

Plain Mode, Group Mode, and Layer Mode

You can view Cls in Topology Map in one of three ways:

Plain mode. In plain mode, the graphic display of Cls does not include groups or layers.

Group mode. In group mode, the Topology Map graphic display can include groups of Cls. Cls can
be automatically grouped by CIT.

You can also create user-defined groups, and move Cls into and out of groups, to fill your
organizational needs.

In group mode, a status icon shows the worst status of all Cls in the group, as follows:

; S0L Server €3 115 Web Server

3 Windows

Layer mode. In layer mode Cls are divided into functional layers, such as Business Enablement,
Infrastructure, or Software. Cls are assigned to the layers based on their Layer attribute in the
RTSM. For example, in layer mode the Application Resource and Application System CITs are
assigned to the Software layer, based on their Layer attribute.

In layer mode you can move Cls in and out of layers. You can also create additional layers using the
Layer attribute in RTSM administration.

Groups are only available in group mode; layers are only visible in layer mode.

If you create a new layer, click the Restore Default View button to display the layer properly in

Topology Map.

Default Layers

Within layer mode, Cls are assigned to default layers based on their CIT attributes within the RTSM.
The following section describes each of the layers that are defined out-of-the-box.

« Business Enablement. This layer contains business services, processes, and activities. These

include both business services which a business provides to another business (or one organization
provides to another within a business), and IT services which an IT organization provides to support
business services or IT operations.

A Business Service typically has an associated end-user or customer, a business application, and a
service level agreement. Examples include payment processing, backup and recovery, and self-
service help desk.

Application and Services. This layer contains applications and their core components, not
including elements that are deployable. An application is a set of components which supports a
business activity, which is seen as a whole, and is known by a specific name.
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The Application and Services layer also includes business transactions, as well as infrastructure
services that support business services and processes. Examples include voice and network
services, database services, backup and restore services, desktop services, and Windows
administration services.

« Software. This layer includes individual installations of software elements. These are executables
that can be deployed, or are deployed, on a logical system.

« Infrastructure. This layer includes logical systems such as virtualization and clustering, and
physical systems such as storage devices, network devices, and servers.

« Facilities. This layer includes locations, sites, buildings, rooms, racks, and so on.

View or Graph Display
The basic structure of the Cls in a Topology Map can be defined in one of two ways:

« View Display. This shows the topology of the view based on the View Folding, with a single root
node, and child Cls that have no recursive loops. Such loops are resolved by copying Cls, so that a
Cl can appear a few times in a view.

The view display follows the Impact model, so all the links between Cls are either Impact
(Dependency) or Impact (Containment). By default, link labels are not shown in view display.

« Graph Display. This shows the topology of the view as defined in the RTSM, without View Folding.
The links between the Cls represent their physical links as they appear in the RTSM. By default,
Topology Map shows link labels in the graph display.

Tasks

This section includes:

« "How to Customize Topology Map Display" below
« "How to Annotate and Save Images" below

« "How to Modify the Refresh Rate" on the next page

How to Customize Topology Map Display

The Topology Map display is highly customizable; you can view Cls in layers or groups, display
minimal or detailed information on Cls and the links between them, and modify other elements in the
display. For details on these options, refer to the Ul Description section below.

Note: Customizing the Topology Map display (hiding Cls, moving Cls in and out of layers, and
so on) has no effect at all on the RTSM topology; your customizations only influence how Cls are
displayed in this component.

How to Annotate and Save Images

Within Topology Map, click the Capture Result and Add Annotations button on the toolbar to
access the annotation tool. You can use annotation to create and save a snapshot of the image you are
viewing, and highlight important areas of the image. For details, see "Annotation Tool" on page 114.
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How to Modify the Refresh Rate

You cannot modify refresh rates of the out-of-the-box pages; however you can create a user-defined
page with the components you need, and modify their refresh rates using the Component Menu

button E on the component toolbar. Select Preferences, and change the refresh rate as needed.

Ul Descriptions

Topology Map Toolbar

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element

<View Selector>

'E.'a. Dizplay optionz -

Description

Select a view from the dropdown list (on the top left area of the toolbar) to
display the view in Topology Map.

Select. In Select mode, you can select Cls or groups to perform actions on
the selected elements. For example, to move Cls or groups you must be in
Selection mode.

Interactive Zoom. In Zoom mode, click within Topology Map and drag up or
down (or use your mouse wheel) to zoom in and out of the image.

Pan. In Pan mode, if your Topology Map image is scrollable you can click
and drag the image to move it. (If the entire image fits within your screen this
feature has no effect.)

Fit to screen. Click to fit the graph to the pane, either by expanding it or by
reducing it. Relative proportions of the image are maintained.

Toggle Presentation Type. Click to switch between minimal view, which
displays only Cl icons and worst statuses, and detailed view, which also
displays Cl names and KPI statuses.

Click to open a dropdown list of display options. You can select or de-select
each of the following options:

« Show links. If you select this option, Topology Map displays arrows
between Cls that are linked.

« Show link labels. If you select this option, Topology Map displays each
link together with its link type (for example, Contains or Depends on). If
the Show links option is de-selected, this option is disabled.
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Ul Element

Plain mode -

i

D)

Description

Click to select between the following display modes:

« Plain Mode. Each Cls is displayed standing on its own, not in a layer or
group.

« Group Mode. Topology Map displays related lower-level Cls in groups;
for example, within the Application System hierarchy, Cls related to SAP
or Siebel are grouped within ERP.

« Layer Mode. Topology Map displays related higher-level Cls in layers; for
example, Business Element Cls are displayed in the Business
Enablement layer, while Node and Node Element Cls are displayed in the
Infrastructure layer.

Hide Selection. Click to hide selected Cls or groups from the display. Note
that hidden Cls are still included in view calculations.

Restore Hidden. Click to restore any hidden Cls or groups to Topology Map.

New Group. In group mode, perform one of the following:

« Click the New Group button to create a new (empty) group; you can then
drag Cls into this new group.

« Select one or more Cls, then click the New Group button to create a group
which contains these Cls.

This button is only active in group mode.
Delete Group. Select a group and click the Delete Group button to delete the

group container.

If the deleted group was nested within another group, the Cls are moved to
the parent group; if the deleted group was not nested, the Cls are moved to
their original location in the view hierarchy.

This button is only active in group mode.

Rearrange Layers. In layer mode, click to rearrange the graphic display so
that the Cls and their links are neatly organized. This is useful if you have
moved Cls in and out of layers, and want to neatly rearrange the display.

Note that if you have moved Cls in and out of layers, this action does not
restore them to their original layers.

This button is only active in layer mode.

Restore Default View. Click to restore Topology Map to its original, pre-
customization settings.

Note: If you create a new layer, click Restore Default View to display the
layer properly in Topology Map.

HPE Operations Manageri (10.10) Page 181 of 307



OMi User Guide
Chapter 7: Health

Ul Element Description
View Select one of the following ways to build a Topology Map:
g::g::yGraph « View Display. This shows the topology of the view based on View

Folding, using the Impact model, with a single root node, and child Cls
that have no recursive loops.

« Graph Display. This shows the topology of the view as defined in the
RTSM, without View Folding. The links between the Cls represent their
physical links as they appear in the RTSM.

|| Display Minimap. Click to display the Topology Map image in a small
o window (minimap), which is overlaid on top of the standard Topology Map.

Drag the magnifying glass icon within the minimap to focus Topology Map to
show the area which is of interest to you. You can move the minimap by
clicking and dragging its header bar. To close the minimap window, click
within the larger Topology Map image.

|§| Capture Result and Add Annotations. Click to open the Annotation Tool,

o which creates a snapshot of the Topology Map and enables you to annotate
the snapshot to highlight important areas. The tool enables you to draw in the
snapshot, or add lines or text to the image. For details, see "Annotation Tool"
on page 114.

Topology Map Display

User interface elements are described below (unlabeled elements are shown in angle brackets):

HPE Operations Manageri (10.10) Page 182 of 307



OMi User Guide
Chapter 7: Health

Ul
Element
(A-Z)

<ClI
nodes>
Qa '.us\ogga_;ni_n

<groups
of Cls>

<layers of
Cls>

Description

Each Cl in the selected view is displayed as a bar within Topology Map, which contains
the following elements:

« Theleft side of the bar shows an icon indicating the Cl's Cl type, as represented in
the RTSM.

« Cl aggregated status is overlaid on top of the CIT icon.

« If Topology Map is in detailed view, the Cl name and KPI statuses are also
displayed.

Tooltips: The tooltip for a Cl shows the Cl name and CI type. The tooltip for a KPI
shows status and performance data for the KPI:

C'\I Customer2_Snt_A...
L]
Q &

Status: Critical
Business Rule: Worzt Status Rule
Held status since: AMA0 01:35:35 PM

Dietails - Application Awailabiliy

Cl and KPI status are displayed as color-coded icons.

In group mode, groups of related Cls are displayed within a border. Some Cls are
assigned to groups by default; you can also create groups to fit your needs.

To modify a group, click the Select button in the Topology Map toolbar. You can then
perform the following:

« Torename a group, double-click the group name and type a new name for the group.

« Toadd Cls to a group or remove Cls from a group, drag them in or out of the group.

« Tonest one group within another, drag one group inside another group.

« Tocollapse or expand a group, click the Collapse or Expand icons in the upper right
corner of the group container.

In layer mode, high-level Cls are displayed within layers that are divided by
functionality, such as Business Enablement or Infrastructure. Each layeris shownin a
separate shaded area, labeled by the layer name.

Layers cannot be renamed or deleted; Cls can be removed from layers, or added to
them.
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ul

Element

(A-Z) Description

<links Inthe list of Display options, if you select Show links, Topology Map displays
between arrows between Cls that are linked within the RTSM.

Cls>

If you also select the Show link labels option, Topology Map also displays the link
type (for example, Contains or Depends on).

Note: If a Cl outside a group links to a number of Cls inside a group, when the group is
collapsed no link label is shown; when the group is expanded link labels are shown for
each link.

<minimap If you click the Display Minimap button, the Topology Map image appears in a small
image> window (minimap), overlaid on top of the standard Topology Map.

The highlighted area shows which part of the Topology Map is displayed in the larger
~==f | image. Resize or move the highlighted area to focus on the part of Topology Map which
is of interest to you.

<right- Right-click a ClI bar to list the available menu options.
click

menu

options>

Last Displays when the information in the component was last updated.

Update To manually update the information in the component, click the Refresh icon.

View Explorer Component

The View Explorer displays configuration items from the Run-time Service Model database (RTSM).
The displayed selection can be filtered by applying a view. Views configure the View Explorer to
display only the configuration items specified in the view.

The interaction between the View Explorer component and the information presented in the other
components on a page varies, according to the context. For example, when you select one or more
configuration items in the Cl Tree, a filter is automatically applied to the Event Browser so that only
those events that are related to the selected configuration items are displayed. The selected view also
limits the events displayed to those related to Cls contained by the view.

Note: The behavior of the Event Browser depends on the type of the Cl selected: Cl Group type,
Node type, or Other types.

The active filter is indicated in the Filter applied list. The View Explorer selections can also be cleared
using the Clear All button.

Some components such as Top View or Topology Map have built-in view explorers, but you may want
to add the View Explorer component to a page with one of these components, for ease of navigation
within a complex view.
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To access
« Workspaces > Operations Console > <select a perspective>
« There are a number of default pages in My Workspace which contain this component.

« You can also create your own pages and include this component; for details see "How to Set Up My
Workspace" on page 220.

Learn More

Browse Views and the Search Cls Tabs
The View Explorer includes the Browse Views and the Search Cls tabs.

« InBrowse Views you can search for and display a view, and browse through the view to locate a
particular CI. You can also perform operations for the Cl from a context menu.

« InSearch Cls you can search for one or more Cls in the views or the RTSM by name or by Cl type.

Unavailable Views and Cls

The View list in the View Explorer may not display all views in the RTSM, or it may not display the
contents of a view, because it includes:

« Only the views for which you have the necessary permissions. To set permissions, open Users,
Groups, and Roles:

Administration > Users > Users, Groups, and Roles
« Only the views that are assigned to the application.
« Inactive views (appear in red) that cannot be selected.

« Out-of-the-box views for which you do not have a license. These views do not contain Cls. For
information about the out-of-the-box views, see "Predefined Folders and Views" in the Modeling
Guide.

Tasks

How to Select a View
1. Open the Event Perspective or the Health perspective to display the list of known events:
Workspaces > Operations Console > <select a perspective>
2. Do one of the following:
o Inthe View Explorer pane, select the Browse Views tab and use the View list to display the
available views and select the required view.

Note: Entering a character in the View field highlights the first matching view name.

o Inthe Event Browser, select a view from the View Selector. The five most recent selections
are displayed at the top of the list.
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The events displayed in the Event Browser are limited to events associated with the selected
view. The Event browser title changes to show the view selected.

Note:

o The OMi perspectives are wired so that selecting a view in the Event Browser View
Selector disables the Cl selected in the View Explorer.

o The Event Browser View Selector is disabled in locked Event Browser pages so that only
events associated with a preselected view are displayed.

How to Refresh the View Explorer

Using the Modeling Studio, you can configure new views or modify existing views to change, increase,
or decrease the information displayed:

Administration > RTSM Administration > Modeling > Modeling Studio

The RTSM view lists are cached and reused for subsequent requests by the same user. The view lists
are not loaded directly from the RTSM every time they are required.

The cache is automatically cleared after 3 hours or when the OMi server is restarted.

Ul Descriptions

Browse Views Tab

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul

Element

(A-2) Description

<Cls> The Cls contained in the currently selected view.

<Tooltip> Holdthe cursor over a Cl to display a tooltip with the relevant CI type.

<View> The View box displays the currently selected view. To select a view to display, click
the down arrow on the right side of the View box; this displays an abridged list of views,
containing the most recently accessed views. Click the arrow at the bottom of the list to
scroll through the entire list.

Alternatively, place the cursor in the list and begin typing the view name. If the first few
letters that you type match an existing entry, the view name is completed. If the names
of several views begin with those letters, all matching views are displayed in the list.

Search ClIs Tab

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element (A-2) Description

<Context sensitive = The View Explorer shortcut menu contains different options in each of the
menu options> pages in which it appears.

<Search results> After you run the search, the results are listed in the lower part of the View
Explorer component. The results are shown in two columns:

« Name. Contains the name of the CI.
« Type. Contains the Cl type of the CI.

If the Cl or view name is abbreviated, resize the table columns. You can sort
the search results by clicking the appropriate heading.

Name To search for a Cl by name, enter the name of the CI for which to search.
Search Performs the search.
Type To search for Cls by ClI type, enter the ClI type for which to search.

Watch List Component

The Watch List component provides high level health overview of critical Cls from different views.

You can view Cl information for a customizable list of Cls. For example, if a System Administrator has
eight servers in different geographic locations that are critical for the running of the operation, they could
create a Watch List which shows the status of those Cls.

Details of each Cl are displayed on an individual card.

End User Monitors

SHAArtApplicati

BusinessApplication

(%

[ e =)

E 811712 4:26 PM !._—

To access

Create additional Watch Lists as components in My Workspace user pages. For details, see "How to
Set Up My Workspace" on page 220.

Learn More

Information on a Watch List Card

The Watch List displays information about Cls on virtual cards. Each card contains the following
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information about the ClI:

« The name of the RTSM view that the Cl was added from.

« Name of the CI

o ClType

« lconrepresenting the Cl status which is the most severe status of any KPI associated with the CI.

« Business Impact bar which shows the impact that the Cl has on the business Cls and SLAs in your
monitored environment. The business impact is rated from zero (no impact) to five (high impact).

Note: The Business Impact bar is not visible by default in Service Health application
components. To modify, see the OMi Administration Guide.

« Time that the health status changed to the currently shown status.

List of Associated KPIs

Click the lower-right corner of a card to "flip" the card and view the status of KPIs associated with the
CI. The flip side of the card lists up to seven KPlIs that do not have a status of OK.

Hold the pointer over a KPI to display a tooltip showing status and performance data for the KPI.

If there are more than seven KPIs without a status of OK, there is a More link which opens a new
window with a complete list of KPIs that do not have a status of OK.

i .

IT Department (%]

Legacy System (5]
Application Performance €
Application Availability €3

Tasks

How to Add ClIs to the Watch List

You add Cls to the Watch List in Edit mode. You select Cls to add to the Watch List from a list of
views, or search for a specific Cl from the Search tab.

Note: You need appropriate permissions to access Edit Mode.

1. Inthe Watch List page, click Edit Watch List |ﬁ|

2. Onthe Browse Views tab, select a view and then select the required Cls or use the Search tab to
locate the required Cls.

3. Click Add Cls to List |Q| and then click Save changes and open Watch List in View Mode
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Note: You cannot drag and drop Cls onto the Watch List.

How to Add Cls From a Wired Component

Wiring components creates a link between components on the same page so that if you select an item
in one component, Service Health automatically selects the item if it appears elsewhere on the screen.

If a page in My Workspace or Service Health contains Watch List together with other components, you
can add a wired Cl to Watch List from other components on the screen. For example, if you have a
page in My Workspace which contains Topology Map in one pane and Watch List in a different pane,
you can click on a Cl in Topology Map to add it to Watch List.

1. Open or create a page which contains Watch List together with other components.

In Watch List, click Edit Watch List < to open Edit Mode.

. Inadifferent component (for example Topology Map), click on a Cl that is not currently included in
the Watch List and then click OK in the message box to add the CI to Watch List.

Note:

« Ifyouselect a Cl located under a virtual breakdown ClI in the wired component, you may not
receive a prompt to add it to Watch List.

« You cannot add a <view name> root Cl to a Watch List.
« Watch List wiring with OMi (Event Browser) in Edit mode is not currently supported.

Ul Descriptions

Watch List View Mode

Ul Element Description
o3 Edit Watch List. Opens Edit mode so that you can add or remove Cls from the
Watch List.
) Open in a New Window. Opens the Watch List in a separate pop-up window.
Card Size Sets the display size of the Cl cards.

Watch List Edit Mode

Ul Element Description

] Add Cls to Watch List. Adds the selected Cls to the right pane.

HPE Operations Manageri (10.10) Page 189 of 307



OMi User Guide
Chapter 7: Health

Ul Element Description

|5| Cancel all changes since last save. Deletes all changes that you made since
o you opened Edit mode.

|?| Save changes and open Watch List in View Mode. Saves changes and
o closes Edit mode.

Left Pane List of views or search from which you can select Cls to add to the Watch List.
Right Pane List of Cls currently in the Watch List.
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The Actions pane is used to display the actions that are available for the selected event, its related Cl,
or the node that hosts the CI. Actions include Tools, Run Books, Custom Actions, and Performance
Dashboards. The Actions pane is used in the Event Perspective and the Health Perspective and can
be added to custom perspectives.

To access

Open a perspective containing the Actions pane to display the list of known events and their associated
actions:

Workspaces > Operations Console > <select a perspective>

Learn More

This section includes:

« "Event-Related Actions" below

« "Custom Actions" on the next page

Event-Related Actions

Events can contain event-related actions. If event-related actions exist, the following icons are
displayed in the Event Browser in the A column and the U column:

=¥ — Automatic action is available

& User action is available

Operator-initiated actions and automatic actions are also displayed in the Actions tab of the Event
Details pane.

Further icons indicate the status of the actions, including, starting, running, succeeded, and failed. For
a complete overview of the icons and actions available, see "Event Browser" on page 28.

You can execute these actions from either the Actions tab or the context menu of the event. The result
of the action execution creates an entry in the History that is added to the event, if configured in the
policy. It is also possible to stop an event-related action before execution completes.

Event-related actions for assigned and unassigned events require authorization to run. If you are not
authorized to execute event actions, you still see the configured commands but you are not permitted
to execute them.

Note:

Selecting multiple events in the Event Browser disables the Actions pane.

Actions that contain the $0PC_GUI_CLIENT and $OPC_GUI_CLIENT_WEB variables are not supported
and are filtered out.
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Custom Actions

Custom actions are script-based actions that can be executed on the selected event. You configure
custom actions from the Custom Actions manager, where you set up scripts to run custom actions on
events. For example, you can add a text string to certain events to make them easier to identify in the
Event Browser. Available custom actions for an event are executed from the context menu.

Note: Only the attributes that can be edited in the Event Browser can be changed by the custom
action scripts.

For more information about creating and managing custom actions, see the OMi Administration Guide.

Tasks

This section includes:

« "How to Run an Action" below
« "How to Run an Event-Related Action" on the next page

« "How to Launch a Custom Action" on the next page

How to Run an Action

1. Select anevent.
The Actions pane displays the actions available for the selected event.
Action types are identified by the following icons:

o g

“* — Automatic action (see also "How to Run an Event-Related Action" on the next page)
£& — Custom Actions (see also "How to Launch a Custom Action" on the next page)

‘e — Performance Dashboards (see also " Performance Perspective" on page 255)

= _ Run Books (see also "Launching Operations Orchestration Run Books" on page 53)

iT —Tools (see also "Tools" on page 195)

& — User action (see also "How to Run an Event-Related Action" on the next page)

Note: The maximum script and executable command length for tools is limited to 2500
characters including resolved parameters. If the script or command exceeds 2500 characters
including parameters resolved during tool execution, an error message is displayed. Review
the possible custom parameter values or contact the tool designer to reduce the script or
command length.

2. Select an action from the Actions pane.

If the action does not require any further data, it is run immediately. If further data is required, for
example for a Tool or a Run Book, the associated user interface is launched and a wizard guides
you through the action launch.
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Optional. Enter the Action name or part of the Action name in the Search field to reduce the list of
displayed Actions. Similarly, select Cl or Node to limit the list of displayed Actions to those that
are applicable to either the related CI or the host Node.

How to Run an Event-Related Action

1. Select an event that includes event-related actions.
Actions are identified by the following icons displayed in the Event Browser in the A column and
the U column:
“* — Automatic action is available

& User action is available

Further icons indicate the status of the actions, including, starting, running, succeeded, and failed.
For a complete overview of the icons and actions available, see "Tools" on page 195.

2. Select the Actions tab.

The action specification, target node, and the status of the available actions are displayed. A
maximum of one automatic action and one user action is available for an event.

3. Forthe action that you want to run, select Start.
Alternatively, from the context menu for the event, select the appropriate action:
Right-click Actions > Start

The action starts, the status changes to Running and the associated action icon in the Event
Browser changes to reflect this status.

After the action execution has completed successfully, the status changes to Succeeded. If the
action did not execute successfully, the status is changed to Failed.

4. Select the Annotations tab for a summary of the executed action.

How to Launch a Custom Action
Select the Custom Action that you want to run on an event:
Right-click > Launch > Custom Actions > <select a custom action>

The selected custom action is launched in the context of the selected event.

Ul Reference

Actions Pane

Ul

Element

(A-2) Description

Cl Cl related to the selected event.
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Ul

Element

(A-Z) Description

Clear Removes the currently applied search string and displays all applicable actions for the
selected Cl.

Event Title of the event that provides a brief summary of the event.

Filter Used to reduce the number of actions displayed in the Actions pane by showing only
those applicable to Cls or Nodes.
All — Shows all applicable actions for the selected event.
Cl — Shows actions that can be run on the Cl related to the selected event.
Node — Shows actions that can be run on the Node related to the selected event.
Source Cl — Shows all actions that can be run on the source ClI of the received event.

Node Host name to which the event is related.

Search Used to reduce the number of actions displayed in the Actions pane by showing only

those that match the entered search string.

Tips and Troubleshooting

How to Recover the Confirmation Dialog Box

When you run a custom action or a user action, or when an automatic action starts, a dialog box
displays asking you for confirmation. This dialog box can be avoided by selecting the Don't show this
dialog again check box. To recover the confirmation dialog box, you must clear your browser's local
storage.
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You can specify tools, for example, to ping a system. These tools are launched from events, from
configuration items (Cls), or from the Actions pane and run on the associated Cl or node. Tools are
designed to help users solve common problems quickly and efficiently.

The available tools are displayed in the context menu of events, the Run Tool wizard, or the Actions
pane. The selection of tools a particular user sees depends on the tools that are available for the CI
affected by a particular event.

For more information about using the Tools manager to configure tools, see the OMi Administration
Guide.

Learn More

This section includes:

« "Tools and Cl Types" below

« "Launching a Tool on Multiple Cls or Nodes" below

Tools and Cl Types

Tools are associated with a particular Cl type, for example, Node or Net Device. When you run a tool,
you run it from one or more events associated with Cls of the types for which the tool is specified. (You
can also run a tool directly on one or more Cls.)

The name of the Cl associated with the event is displayed in parentheses alongside the tool in the tools
list:

o (Cl)}—impaired CI where the event occurred.
« (Node)—host system where the event occurred.
« (Source Cl)—host system where the monitoring agent or probe is running.

The selected tool runs on the CI of your choice. If required, the tool also retrieves any runtime
parameters from the Cl. For example, the tool Ping (Node) runs on the node where the event occurred
and also retrieves runtime parameters from the node.

Launching a Tool on Multiple Cls or Nodes

In the context of a single event, available tools are displayed in the Launch > Tools > <tools> context
menu and the Actions pane. Selecting a tool starts the Run Tool wizard, which you use to launch the
tool and to evaluate the tool results. The tool is run on the target defined in the tool, for example the
related node Cl of the selected event. You can also launch a tool in the context of a single Cl by
selecting it in the View Explorer and clicking Launch Tool in the context menu.

To launch a tool on multiple Cls or nodes in parallel, select the events in the Event Browser or the Cls
in the View Explorer. You can select multiple items by holding down the Ctrl or Shift key while
selecting them. Clicking the Launch > Tool context menu opens the Run Tool wizard in which you
select the tool, launch it, and view its results.
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Note:

When you launch a tool on multiple events or Cls, OMi shows only those tools that are associated
with a Cl type common to all selected events or Cls.

URL tools can only be launched on a single Cl or event. They are excluded from the list of
available tools when multiple Cls or events are selected.

Tasks

How to Launch a Tool

In this task, you learn how to launch a tool that is configured for a particular CI type. Tools are displayed
in the context menus.

Note: Tools, custom actions, performance dashboards, and OO Run Books available for a
selected event are also displayed in the Actions pane of a perspective.

1.

Open the Event Browser to display the list of known events:
Workspaces > Operations Console > <select a perspective>
In the View Explorer pane, select a view containing the Cl type with the tool you want to start.

3. Toopen the Run Tool wizard, make one of the following selections:

o Right-click an event in the Event Browser and select a tool in the Actions pane. For details on
the Actions pane, see "Actions" on page 191.

o Right-click an event in the Event Browser and select:
Launch > Tools > <select a tool>

o Select and right-click multiple events in the Event Browser and select:
Launch > Tool

o Right-click one or more Cls in the View Explorer and select:
Launch Tool

The Run Tool wizard opens.

If you opened the Run Tool wizard in the context of multiple events or Cls, select the tool you want
to launch in the Select Tool page.

Tip: Enter the tool name or part of the tool name in the Search field to reduce the list of
displayed tools. Similarly, select Cl, Node, or Source Cl to limit the list of displayed tools to
those that apply to the related Cl or the host node.

If the tool does not require additional information, you can launch the tool directly from the Select
Tool page by clicking the Run Tool button.

If the tool requires any additional information, for example to resolve parameters, click Next and
type the required information in the Specify Parameters page.

HPE Operations Manageri (10.10) Page 196 of 307



OMi User Guide
Chapter 9: Tools

5. Torun the selected tool, click Run Tool in the Preview page.

For scripts and executable commands, the Execution Result page opens and displays the output
of the tool execution.

For URL launches, the target is opened in a browser.
Additional options in the Execution Result page include:

o Click the Stop Tool button to stop the execution of the tool. All processes initiated by the tool
are stopped.

o Use the Rerun Tool button to run the tool again if the first execution failed, did not yield the
desired results, or was stopped.

o Click the Word Wrap button to make sure that all output text is displayed within the output
pane.

o If the Execution Result page contains multiple execution results, you can sort and filter the
results for better handling. To sort the results, click the Hostname or Status columns. To filter
the results by status, click the status link to the right of the status icon.

6. Optional. Copy the execution results to the clipboard for further investigation or archiving. The
results are deleted once the Run Tool wizard is closed.

For scripts and executable commands, after the tool is run, click Close.

Troubleshooting and Limitations

This section provides help for troubleshooting problems concerning the launch and use of OMi tools.
For more information about troubleshooting tool configuration and availability, see the OMi
Administration Guide.

No tools display

« Notools are available for the selected type of Cl or the Cl associated with the selected event.
« The selected event does not contain Related Cl, Node, or Source Cl information.

Tool does not run

« The tool depends on external resources such as network or Internet connectivity that are not
currently available.

Tool error: Cannot open file for temporary use

« The following error indicates that two or more tools of the type script are launched in parallel on the
same host:

Open(2) failed; cannot open file for temporary use

Problem: When a script tool is launched, it first stores the execution information in a temporary file
on the host. When two or more script tools are launched in parallel, they all try to access the same
temporary file, which results in the above error for some of the tools.

Workaround: Launch script tools sequentially, not in parallel.
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The configuration item (CI) model in the configuration management database can be very large, holding
thousands of Cls. A view enables you to build a subset of the overall Cl model, containing only those
Cls relating to a specific area of interest. You can define your own views to display only the information
that is relevant to your organization's business needs.

Learn More

This section includes:

« "Filtering By Views" below
« "Managing Views" below
« "Mapping Views" below

« "Service Health View Bundle" on the next page

Filtering By Views

Views for OMi help you to limit the Cls displayed in the View Explorer. OMi filters the contents of the
Event Browser in the Event Perspective and the Health Perspective according to the selected view.

Administrators can also configure users and groups so that you can see only the events filtered by
views associated with that user or group. You can also allow users or groups to deselect the selected
view and display all events. For details see the OMi Administration Guide.

For more information, see "Filtering by Views and View-Based Authorization" on page 45.

Managing Views
To configure and modify views, use the Modeling Studio:
Administration > RTSM Administration > Modeling > Modeling Studio

You can also modify existing views to change, increase, or decrease the amount and type of
information displayed. You can exchange the views between instances of OMi using the Import and
Export features of the Content Packs manager.

OMi Management Packs provide views that group configuration items into sets that help you to perform
your tasks more efficiently.

Mapping Views

A view displays a subset of the overall Configurationltem model, for example, only those Cls that relate
to a specific area of interest. Selecting a view enables you to refine both the type and the amount of
information displayed, for example, in the Cl Tree or the Health Top View pane.

You can map views to configuration item types. The mapped views appear in the Selected Views list
displayed in the Health Top View pane of the Health Perspective tab. For more information about the
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contents of Health Top View and the Selected Views list, see "Health Top View Component" on
page 142.

You can exchange the view mappings that you configure between instances of OMi using the Import
and Export features of the Content Packs manager.

Note: Only users with the appropriate access permissions can use the Administration features.

Service Health View Bundle

Certain views defined in the RTSM are not available by default in OMi, because these applications filter
for a view bundle named service health. To display a view that is not visible in OMi, open the view in
RTSM administration or in the Service Health View Builder, and assign the view to the service health
bundle. For details on bundles, see "Building a Business View" in the Modeling Guide.
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My Workspace is a customizable Web 2.0 user environment for working with OMi. OMi administrators
can create role-based workspaces for different types of users such as operations users, and senior
management. My Workspace provides smooth interactions between different OMi components.

For details on working with My Workspace, see:

« "Monitoring Your Environment With My Workspace" on page 201. This chapter describes My
Workspace, and available pages and components.

« "How to Set Up My Workspace" on page 220. This chapter describes how to create new pages and
add components to My Workspace.
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The My Workspace administrator sets up pages that include components that are of interest to specific
users or groups of users. For each page, the administrator defines the layout of components on the
page, and their interaction with one another.

Understanding OMi My Workspace
My Workspace includes the following:

« Components. Each component is a part of OMi which displays information relevant to users'
business tasks; the Component Gallery contains application components that can be used within
My Workspace, grouped by their source applications. For details, see "Available Components" on
page 204.

You can add components to a page from the Component Gallery. You can also add external URL-
based components, which can interact with other components on a page. For details, see "How to
Create an External Component" on page 225.

« Pages. Pages are collections of several components displayed together, interacting with one
another.

You can open pages from the Page Gallery, which contains predefined pages grouped by
applications. For details, see "Predefined Pages" on the next page.

You can also easily create new pages using both OMi components, and external components. For
details, see "How to Set Up My Workspace" on page 220.

« Wiring. Wiring refers to how components on a page interact with one another. Within a page,
components can pass information to one another, so that one component can react to a change in
another. For example, you can set up a page so that if you select a Cl in one component, the other
components on the page focus on that Cl as well.

Default pages have wiring predefined; you can also define wiring for non-default pages. For details,
see "How to Set Up Wiring Between Components" on page 227.

« Layout. The layout refers to how components are arranged on a page; components can be arranged
horizontally, vertically, and in tabs. For details, see "How to Configure Page Layout — Use-Case
Scenario" on page 222.

Working with My Workspace

« Toopen apage, select the page from the Page Selector drop-down list on the Page Management
toolbar, on the upper right area of your workspace. You can also type part of the page name in the
Page Selector, to limit the number of pages in the drop-down list.

« Toclose a page, click the close icon in the upper right corner of the page.

« Depending on your user permissions, you may also be able to create or delete pages, configure page
layouts, add or remove components on a page, define how components interact with each other, and
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edit page and component categories. For details on these options, see "How to Set Up My
Workspace" on page 220.

Viewing in an External Portal

You can simply copy a component's URL and paste it to an external portal in order to view OMi
information.

Predefined Pages

The Workspaces area of OMi comes out-of-the-box with a number of predefined pages. You can open

these pages using the Page Selector drop-down list on the toolbar, or using the Page GaIIe
button.

You can also create custom pages using components of your choice. For details on how to work with
My Workspace pages and components, see "How to Set Up My Workspace" on page 220.

Some pages have a single component with a built-in view selector; others have multiple components
where one component is used to select views or Cls for the other components. For details on each of
the components, see "Available Components" on page 204.

The following are the predefined pages within My Workspace.

Note: You can only access pages for which you have permissions, as described in "User
Permissions in Workspaces" on page 222.

Page Description
Dashboards
360° View Displays comprehensive data about a selected Cl in one central location. The 360°

View contains the Hierarchy component which provides KPI data about the Cls ina
selected view. If you select a Cl within the Hierarchy component, you can see its
detail links. When you click the detail links, you can access the following
components: Business Impact, Health Indicators, Alerts, and Changes and
Incidents. For details, see "360° View" on page 242.

KPI Over The KPI Over Time dashboard enables you to view the statuses and status

Time summaries of selected KPIs and Cls over time. The dashboard lets you choose from
a number of widgets to survey historical KPI status data and the health of the
monitored environment at a glance. For details, see "KPI Over Time Dashboard" on
page 243.

Monitoring Monitoring Dashboards provide an at-a-glance overview of the events from the

Dashboard  environment you are monitoring. Monitoring Dashboards enable you to quickly
assess the health of the environment and to identify areas that require your attention.
For details, see "Monitoring Dashboard" on page 233.
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Page Description

ROI The Return on Investment Dashboard displays the proportion of events received by

Dashboard = OMi that have been automatically handled against those that required intervention by
operators. The higher the proportion of automatically handled events, the greater the
contribution OMi is making to the management of your infrastructure. If the cost of
manually handling a typical event is known, this value can be entered into OMi,
based on which, the total cost saving achieved through OMi can be displayed.
These statistics can be displayed for any specified time period within which OMi has
been monitoring your IT environment. For details, see "Return On Investment
Dashboard" on page 247.

Operations Console

Discover Enables you to explore OMi step-by-step, following predefined paths and learning

OMi OMi features along the way. The map begins with an interactive tutorial. Each step
offers built-in information as well as links to additional resources, for example, the
related Ul page, online help, or videos. Discover OMi tracks your progress so that
you are aware of the areas you have already visited. Note that progress is stored
locally, and that deleting browser cookies (or clicking Reset States within the map)
will delete your progress.

Event Displays a summary of the events that occur in the operating environment you are
Perspective = monitoring, as well as detailed information about selected events. For details, see
"Event Perspective" on page 253.

Health Displays the health of related Cls in the context of events. The event selected in the
Perspective = Event Browser determines what is displayed in the Health Top View pane and
Health Indicators pane.

The page helps you understand the health status of an object, shows you which
business rules and KPls are being used, and how the health status of the selected
object affects the health of related Cls. For details, see "Health Perspective" on
page 254.

Performance Enables you to draw graphs from templates and create ad hoc graphs by selecting
Perspective | required metrics from a metric list, which is populated based on the Cl you have
selected. For details, see " Performance Perspective" on page 255.
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Available Components

Components from different applications can be added to My Workspace pages. The following section
describes the available OMi components. For user interface details, see "Component Gallery Dialog
Box" on page 214.

Note: To access components from an application, you must have a license for that application.

Some components are also available as predefined pages. For details, see "Predefined Pages" on
page 202.

You can add components from the following applications:

"Event Management" below

"General" on the next page

"NNMi" on the next page

"Performance Management" on page 206

"Service Health" on page 207

"SiteScope" on page 208

"User Engagement" on page 208

Event Management

Component
Name

Actions

Event
Browser

Event
Browser
with Details

Event
Details

Monitoring
Dashboard

Description

Displays a list of the Actions (Tools, Run Books, Custom Actions, and Performance
Dashboards) applicable to a selected event, its related Cl, or the node that hosts the
Cl. For details, see "Actions" on page 191.

Displays a summary of all the events that have occurred in the operating environment
you are monitoring. For details, see "Event Perspective" on page 253.

Displays a summary of all the events that have occurred in the operating environment
you are monitoring, together with the Details pane that displays detailed information
about the selected event. For details, see "Event Perspective" on page 253.

Displays detailed information about the selected event in a dedicated pane below the
Event Browser or as a popup window. For details, see "Event Perspective" on
page 253.

Enables you to select a Monitoring Dashboard configuration that displays a summary
of events that match an event filter or that are related to the configuration items
included in a referenced view. Monitoring Dashboards display status information
using different types of widgets (for example, stack and pie widgets). For details, see
"Monitoring Dashboard" on page 233.
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Component
Name

ROI
Dashboard

General

Component
Name

Discover
OMi

NNMi

Description

The Return on Investment Dashboard displays the proportion of events received by
OMi that have been automatically handled against those that required intervention by
operators. The higher the proportion of automatically handled events, the greater the
contribution OMi is making to the management of your infrastructure. If the cost of
manually handling a typical event is known, this value can be entered into OMi, based
on which, the total cost saving achieved through OMi can be displayed. These
statistics can be displayed for any specified time period within which OMi has been
monitoring your IT environment. For details, see "Return On Investment Dashboard"
on page 247.

Description

Enables you to explore OMi step-by-step, following predefined paths and learning
OMi features along the way. The map begins with an interactive tutorial. Each step
offers built-in information as well as links to additional resources, for example, the
related Ul page, online help, or videos. Discover OMi tracks your progress so that you
are aware of the areas you have already visited. Note that progress is stored locally,
and that deleting browser cookies (or clicking Reset States within the map) will delete
your progress.

To access the NNMi components, you must have the appropriate licenses installed. NNMi
components are only displayed if you have configured a connection to an NNM server in Infrastructure

Settings:

Administration > Setup and Maintenance > Infrastructure Settings

Select Foundations > Integrations with other applications > HP NNM.

Wiring between NNMi and OMi components is enabled only if an NNMi-OMi integration has been
implemented. For details on integrations, refer to the OMi section in the Integrations tab in the HP
Software Integrations site (http://support.openview.hp.com/sc/solutions/index.jsp#tab=tab3).

Tip: If you customize an NNMi node group map and export that customized map to a URL, you
can then add the URL as an external component to My Workspace. For details, see "How to
Create an External Component" on page 225.
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Component
Name

Layer 2
Neighbor
View

Layer 3
Neighbor
View

MPLS VPN
Inventory

Open Key
Incidents

Overall
Network
Health (Node
Group
Overview)

Overall

Network
Health -
Routers

Overall
Network
Health -
Switches

Router
Redundancy
Groups
Inventory

Description

Shows a map view of a selected device and its connector devices within a
specified number of hops from the selected device. This view is useful for
understanding the switch connectivity between devices.

Shows a map view of a selected device and it connector devices within a specified
number of hops from the selected device. This view is useful for understanding the
router connectivity between devices.

This is an enterprise customer view of how their sites are connected via service
provided MPLS networks.

Shows the incidents that are most important to network operators, and that often
require more immediate action.

Displays a map containing all (top-level) Node Groups that do not have parent Node
Groups.

Displays a Node Group Map of the Router connectivity in your network.

Displays a Node Group map of the Switches connectivity in your network.

Shows the available Router Redundancy Groups created by the NNMi
administrator. Each Router Redundancy Group is a set of two or more routers that
use one or more virtual IP addresses to help ensure that information packets reach
their intended destination.

Performance Management

Component
Name

Description

Performance Displays the Performance pane from which you can create and customize

Dashboards
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Service Health

Component

Name Description

Business Displays business Cls and SLAs that are impacted by the selected CI. For details,
Impact see Business Impact Component.

Changes and

Displays the incidents opened for the selected Cl, as well as planned changes and

Incidents actual changes made to the CI. For details, see "Changes and Incidents
Component" on page 123.

Custom Displays a user-defined custom image that describes the real world that a view

Image represents, with the view's Cls represented by real-time status indicators in the

Geographical
Map

image. For details, see "Custom Image Component" on page 127.

Displays, on a geographical map, real-time status indicators at the geographical
location assigned to the view's Cls. The status indicator shows the worst status of
the Cls at the geographical location. For details, see "Geographical Map
Component" on page 131.

Health Displays details regarding the health indicators that are used to calculate and set

Indicators the current status of a selected Cl. For details, see "Health Indicator Component”
on page 139.

Health Top Displays a topological view of the configuration items affected by the event

View selected in the Event Browser pane. For details, see "Health Top View
Component" on page 142.

Hierarchy Displays a hierarchy of Cls in a view, the KPIs assigned to each Cl, and their KPI
statuses. If you select a Cl within the Hierarchy component you can see its detail
links. When you click the detail links, you can access additional components
which provide comprehensive data regarding the ClI. For details, see "Hierarchy
Component" on page 149.

KPI Over The KPI Over Time dashboard enables you to view the statuses and status

Time summaries of selected KPIs and Cls over time. The dashboard lets you choose
from a number of widgets to survey historical KPI status data and the health of the
monitored environment at a glance. For details, see "KP| Over Time Dashboard"
on page 243 and "Working with the KPI Over Time Dashboard as a Component"
on page 245.

Neighborhood ' Displays the parent Cls and child Cls of a selected Cl, in an interactive

Map hierarchical graphic. For details, see "Neighborhood Map Component” on
page 160.

Top View Displays ClI bars that represent real-time IT performance metrics mapped onto
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business applications, linked by lines that represent relationships between Cls.
For details, see "Top View Component" on page 165.
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Component

Name Description

Topology Map Displays the Cls within a view in an interactive hierarchical graphic. Topology Map
display links between Cls, and enables you to view Cls divided into layers or
groups. For details, see "Topology Map Component" on page 177.

View Explorer @ Contains alist of views and Cl hierarchies in each view. The component enables
you to select a view and to select Cls, or to search for a Cl. View Explorer is used
with other components which respond to view or Cl selection. For details, see
"View Explorer Component" on page 184.

Watch List Displays a high-level health overview of important Cls, from multiple views. For
details, see "Watch List Component" on page 187.

SiteScope

Component Name

SiteScope Multi-View

User Engagement

Component Name

User Engagement
Achievements

User Engagement
Dashboard

User Engagement

Experts

User Engagement
Timeline

Description

Displays availability and status information of SiteScope objects that
belong to different hierarchical levels in a single view. For details, see
"SiteScope Multi-View" in the Using SiteScope Guide.

Description

Displays an overview of all running achievements grouped by
categories. Disabled and paused achievements are not shown. Each
category is displayed with a progress bar. For details, see
"Achievements" on page 18.

Using gaming technology, User Engagement adds fascination to work
and recognizes users' achievements as they learn to use OMi and
become progressively more knowledgeable. For details, see "User
Engagement" on page 17.

The Experts Boards make it easy for you to identify and contact the
individuals in your organization with the most experience of the various
OMi domains. The User Engagement Experts page displays the overall
most experienced individuals and those for a selected category. You
can drill down into each category and see the complete list of
participants taking part in the Expert Boards. For details, see "Experts"
on page 17.

Shows the history of a user's Achievements. The Timeline provides a
personal overview of User Engagement participation and is not shared.
For details, see "Timeline" on page 18.
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My Workspace User Interface

This section includes:

+ "My Workspace" below

« "Page Gallery Dialog Box" on page 212

« "Component Gallery Dialog Box" on page 214

« "New/Edit Component Dialog Box" on page 216
« "Wiring Dialog Box" on page 218

My Workspace

My Workspace enables you to view default pages from OMi, and to create new pages containing OMi
components and external components. Each page is displayed as a tab within the workspace. For a list
of default pages, see "Predefined Pages" on page 202. For alist of default OMi components, see
"Available Components" on page 204.

To access
Workspaces > My Workspace

« Important Information: This help topic appears if you create a non-default page and access Help >
Help on this page in the OMi menu bar.

« Relevant Tasks: "How to Set Up My Workspace" on page 220.

Learn More

Page Management Toolbar

The Page Management toolbar on the upper right of the workspace, enables you to create pages, add
components to pages, and define how components interact between one another.

User interface elements are described below:

ul
Element Description

<Page Select a page from this drop-down list to open the page in your workspace. The list
Selector>  contains the pages that are defined in the Page Gallery.

If you start typing a page name in this box, the list includes only those pages whose
name starts with the typed letters.

Refresh. Refresh the page.

o]
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Ul
Element Description

Save or Save As. Save the current page to the Page Gallery. A dialog box enables you
to name the page, give the page a description, and select a category for the page.

The description appears as a tooltip for the page, within the Page Gallery.

mo Page Gallery. Open the Page Gallery. The Page Gallery contains default pages, as
well as pages you have saved. You can then edit page definitions, or open pages. For
user interface details, see "Page Gallery Dialog Box" on page 212.

E New Page. Create a new page.

After opening a new page you can configure its layout, add components to the page, and
define wiring between the components. For task details, see "How to Set Up My
Workspace" on page 220.

< Edit Page Layout. Modify the layout of an existing page. Use the Layout tools in the
top left corner of each layout to modify the layout areas.

Exit Editing. When you are done, click this button to stop editing.

[az] Components. Open the Component Gallery, which contains default components, as
well as components you have added. You can then edit component definitions, or add
components to a page. For user interface details, see "Component Gallery Dialog Box"
on page 214.

Page Wiring. Define the wiring between components, which determines how
components interact with one another. For user interface details, see "Wiring Dialog
Box" on page 218.

Start Slideshow/Stop Slideshow. Start a slideshow of open pages. A dialog box
enables you to define how often the pages are rotated. Pages are refreshed before they
are displayed.

If a slideshow is running, click this button to stop the slideshow.

Note: If the page refresh interval is longer than the slideshow interval, the page will not
be refreshed. For example, if a component is set to refresh every minute, but the
slideshow rotates pages every 30 seconds, the page will not be refreshed.

Layout Tools

When a layout is empty, the layout tools on the upper left area enable you to define the layout. Icons in
the center of the layout indicate the type of layout: horizontal, vertical, or tabbed.

User interface elements are described below:
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Ul
Element Description

Layout Tools

Remove Layout. Remove a layout from the page.

iy
™

)

. Add Component. Open the Component Gallery. You can then double-click a component
aa| to place it in the layout area. For user interface details, see "Component Gallery Dialog
Box" on page 214.

Split. Divide a vertical layout into two layouts, one above the other.

Split. Divide a horizontal layout into two layouts, side by side.

= Switch to Horizontal. Change the layout from vertical or tabbed to horizontal.

ENE Components placed in this area will be added side by side.

K Switch to Vertical. Change the layout from horizontal or tabbed to vertical. Components
a& placed in this area will be added one above the other.

Switch to Tabs. Change the layout from vertical or horizontal, to a tab layout.
.) Components placed in this area will be added as tabs.

Layout Icons
<Horizontal layout>. This icon in the center of a layout indicates that the layout is

horizontal. Components placed in this area will be added side by side.

<Vertical layout>. This icon in the center of a layout indicates that the layout is vertical.
Components placed in this area will be added one above the other.

<Tabbed layout>. This icon in the center of a layout indicates that the layout is
horizontal. Components placed in this area will be added as tabs.

Component Toolbar

The component toolbar on the upper right of each component enables you to administer the component.

User interface elements are described below:
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Ul
Element

B

Description

Open one of the following:

« Preferences. Enables you to rename a component, and customize refresh rates.

« Wiring. Enables you to customize how this component interacts with the other
components on the page. For details, see "Wiring Dialog Box" on page 218.

« Refresh. Manually refresh the component.
« Help. Access help on the component.
Note:

« Depending on the component, some of these options may not be available.

« Within Mozilla Firefox, if you have a number of components on a page and you open
the Preferences or Wiring dialog box for a component, it is recommended that you not
drag the dialog box to a new location as this may cause Ul problems.

Configure Component. Define filtering for the component, when a component supports
internal filtering.

Display the component in a separate popup window.

Note: The popup window that opens does not support wiring.

Temporarily collapse a component (the button on the left is for horizontal components; the
button on the right is for vertical components).

Restore a collapsed component (the button on the left is for horizontal components; the
button on the right is for vertical components).

Note: When you collapse a horizontal layout, it collapses into a narrow stripe. Click the
stripe to restore the component.

In a vertical or horizontal layout, closes a component and removes it from the page.

In a tabbed layout each tab has a button which closes the tab; the main close button
removes the layout.

Page Gallery Dialog Box

This dialog box enables you to select a page and open it in My Workspace, and to manage the Page
Gallery. Within the Page Gallery, pages are assigned to categories. You can add, edit, or delete page
categories; assign pages to categories; and open, edit, or delete pages.

To access

Workspaces > My Workspace

In My Workspace, click the Page Gallery button.
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« Important Information: To open a page in My Workspace, double-click a page within the Page
Gallery.

« Relevant Tasks: "How to Set Up My Workspace" on page 220.

Learn More

Categories (left side)
User interface elements are described below:

ul
Element Description

B New Category. Create a new category. You can then assign pages to this category.
For details see "How to Modify Page and Component Categories" on page 228.

Edit Category Name. Select a user-defined category and click to rename (default
categories cannot be renamed).

Delete Category. Select a user-defined category and click to delete (default
categories cannot be deleted).

Categories This contains a list of categories to which pages are assigned. A category can have
the following indications after its name:

« A number following the category name shows how many pages are in the category.

« Alock icon following the category name shows that the category is a default
category, and cannot be renamed or deleted.

You can use the toolbar to manage a category, or select a category to display its pages
on the right side of the dialog box.

Note that categories are not exclusive - you can assign a page to more than one
category.

Pages (right side)

User interface elements are described below:

Ul
Element Description

Open Page. Select a page and click to open it in My Workspace.

= Categorize Page. Select a page and click to assign it to a category.
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Ul
Element Description

ﬁ| Clone Page. Select a page and click to create a copy of it. You can then make changes
to the page and save it with a new name.

A dialog box enables you to name the new page, give the page a description, and select a
category for the page. The description appears as a tooltip for the page within the Page
Gallery.

Delete Page. Select a page and click to delete it from the gallery.
Pages This shows the default pages available for display in My Workspace, as well as custom
pages that you have saved.

You can select a page and use the toolbar to edit page definitions, or double-click a page
to open it in My Workspace.

Search | Type atext string to search for a specific page.
box

Component Gallery Dialog Box

After you open a page, this dialog box enables you to manage components, and to open them in My
Workspace. Within this dialog box you can modify component categories, assign components to
categories, and open, edit, or delete components.

To access

Workspaces > My Workspace

In My Workspace, click the Components button.

« Important Information: To open a component in My Workspace, select a component and drag it to
your page. The components displayed by default are those for which you have appropriate licenses.
For details, see "Available Components" on page 204.

« Relevant Tasks: "How to Set Up My Workspace" on page 220.

Learn More

Categories (left side)

User interface elements are described below:
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Ul

Element Description

|:| New Category. Create a new category. You can then assign components to this
category. For details see "How to Modify Page and Component Categories" on
page 228.

Edit Category Name. Select a user-defined category and click to rename (default

categories cannot be renamed).

Delete Category. Select a user-defined category and click to delete (default
categories cannot be deleted).

Categories = This contains a list of categories to which components are assigned. A category can
have the following indications after its name:

« A number following the category name shows how many components are in the
category.

« Alock icon following the category name shows that the category is a default
category, and cannot be renamed or deleted.

You can use the toolbar to manage a category, or select a category to display its
assigned components on the right side of the dialog box.

Note that categories are not exclusive - you can assign a component to more than one
category.

Components (right side)

User interface elements are described below:

Ul Element  Description

E| Add External Component. Add a new component based on a URL.

This opens a dialog box where you define the new component. For details, see
"New/Edit Component Dialog Box" on the next page.

You can add any URL as a component.

Edit Component Properties. Select an external component and click this button to
edit the component's definitions. For details, see "New/Edit Component Dialog Box"
on the next page.

= Categorize Component. Select a component and click this button to assignit to a
category.

Delete Component. Select a component and click this button to delete it from the
gallery.
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Ul Element Description

Components This shows the default components available for display in My Workspace, as well
as external components that you have added.

Select a component and use the toolbar to edit component definitions, or drag the
component onto the page.

Search box  Type atext string to search for a specific component.

New/Edit Component Dialog Box

This dialog box enables you to define a component based on an external URL. You can set up wiring to
use attributes from contexts sent by other components to define the URL's pattemn, such as CI
attributes.

To access
Workspaces > My Workspace

Access the Component Gallery and click Add External Component, or select an external component
and click Edit Component Properties.

« Important Information: URLSs for external components must begin with one of the following:
https://, http://, orftp://. If aURL s saved with a different prefix, the OMi session will hang.

« Relevant Tasks: "How to Set Up My Workspace" on page 220

See Also: "How to Create a Component Using a Dynamic URL — Use-Case Scenario" on page 226

Learn More
Upper Pane
User interface elements are described below:
Ul Element Description
Name Enter the name you want to assign to the component.
URL Enter the URL of the component. If you are creating a dynamic URL using

parameters, enter the static part of the URL here.

For example, the URL to search for the string hpe in Google.com uses the
following format: http://www.google.com/search?qg=hpe

The static part of this URL is the section before the question mark:
http://www.google.com/search

Description Enter a description of the component.
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Ul Element Description

Display last Select this checkbox if you want the component to display its last update time.
update label

Categorize Component Area

Optional. Select one or more categories to which you want the component assigned.

Configure Wiring Area
Wiring Context

This area enables you to select one or more contexts whose attributes will be used to define the URL
pattern:

« If you select CIChange, Cl attributes can be used to define the URL.

« If you select EventChange, event attributes can be used to define the URL.
« If you select ViewChange, the view name can be used as an attribute.
User interface elements are described below:

Ul Element (A-
Z) Description
Gl Add Context. Add a context whose attributes can be used to define the URL
pattern.
A dialog box enables you to select which context to add.
ey Remove. Select a context and click this button to remove it from the list.
<Context> Each line represents a context whose attributes can be used to create the URL

pattern.

URL Parameters and Values

This area enables you to add URL parameters and values to build the URL pattern, using wiring context
attributes.

User interface elements are described below:

Ul Element Description

New Parameter. Add a URL parameter.

In the dialog box that appears, select one of the following elements of the URL: path,
query string, or fragment of the URL, and type the parameter name.

Use the following pattern: https://domain/ <path> ? <query_string> # <fragment>.

For example, to create a dynamic URL based on
http://www.google.com/search?q=hpe addaURL parameter named q.
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Ul Element Description

Remove. Select a URL parameter and click this button to remove it from the list.

Attributes This contains a list of the attributes that can be used to build the URL pattern. This
list is dependent on the contexts you select in the Wiring Context area.

For example, if you select CIChange in the Wiring Context area, the attribute
<<ciId>> is available to build your URL pattern.

To use an attribute as the value of a URL parameter, drag the attribute from this area
to the Value area of the parameter.

URL Each line represents the name of a URL parameter which is used to create the URL
Parameter pattern, and its value.
and Value

After defining a parameter name, drag an attribute from the Attributes area to the
Value area of the parameter.

To edit a parameter name or value, click the parameter or value itself and edit its
contents.

URL This shows the URL pattern that was built using the static URL that you entered in
Parameters  the URL field, and the URL parameters that you defined in the URL Parameters area.

Wiring Dialog Box

This dialog box enables you to define wiring between the components on a page, which determine how
components interact with one another. After you place components on a page, you can use this dialog
box to define which components (sources) send contexts to which components (targets). When you
finish setting up your wiring, save the page.

For example, suppose View Explorer is defined as a source component which sends the CIChange
wiring context to Top View (target component). When you select a Cl in View Explorer, Top View
focuses on this Cl as well.

To access
Workspaces > My Workspace

In My Workspace, click the Wiring button.
« Relevant Tasks: "How to Set Up My Workspace" on page 220

Learn More

User interface elements are described below:
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Ul Element

(A-Z) Description

Contexts After you select a source component, this contains a list of the contexts that can be
sent from this source to the target components.
Select the context which you want sent to one or more targets, then select the target
components.

Source This displays all of the components on the page that have the ability to send

Components contexts to other components.
Select a source component, then select context and target components.

Note: This list will be empty if no components on the page have the ability to send
information to other components. To resolve this, add a component to the page
which enables you to select a Cl or a view, such as Top View or View Explorer.

Summary of | This displays a summary of the wiring that has been defined for the page. Each line
Page Wiring shows a source, the context it sends, and the target component receiving this
context from this source.

Target After you select a source component and context, this displays all of the
Components components on the page that have the ability to receive this context from the
specified source.

Select one or more target components which will receive contexts from the source
component.
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This section describes how to set up My Workspace. The following tasks are optional, and can be
performed in any order.

Note that your ability to perform these tasks depends on your user permissions. For information on
roles and permissions, see the OMi Administration Guide.

« "Open a page" below

« "Configure the layout of a page" below

« "Add components to a page" below

« "Add an external component to the Component Gallery" on the next page
« "Define how components interact with one another" on the next page

« "Modify categories of pages and components" on the next page

« "Close a page or delete a page" on the next page

Open a page

My Workspace is provided with predefined pages, which are located in the Page Gallery, together with
any pages you have created and saved. For details, see "Predefined Pages" on page 202.

« Toopen apage, select the page from the Page Selector dropdown list on the Page Management
toolbar, on the upper right area of your workspace. You can also type part of the page name in the
Page Selector, to limit the number of pages in the dropdown list.

« Tocreate anew page, click the New Page button on the Page Management toolbar.

Configure the layout of a page

After you open a page, you can configure how the components will be arranged on the page. My
Workspace enables you to define each layout as horizontal (components are displayed side by side),
vertical (components are displayed one above the other), or in tabbed areas.

For details, see "My Workspace" on page 209.

For an example of defining layout, see in "How to Configure Page Layout — Use-Case Scenario" on
page 222.

Add components to a page

My Workspace is provided with default components from the OMi applications, as described in
"Available Components" on page 204. The default components are located in the Component Gallery,
together with any external components you have added.

You can add a component to a page in one of two ways:

« Within an empty layout area, click the Add Component button. Within the Component Gallery,
double-click a component to place it in the layout area.
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« Click the Components button on the Page Management toolbar. Select a component in the
Component Gallery, and drag it to an area on the page.

For details, see "Component Gallery Dialog Box" on page 214.
When adding components to a page, note the following:

« If the target area is hidden by the Component Gallery dialog box, click the dialog box title bar and
drag it to another location on your screen.

« If you are dragging a new component to a target area that already has a component defined, drag the
new component to the title bar of the target area, and not to the part of the component that is colored
white.

Add an external component to the Component Gallery

You can add a URL as a component within My Workspace. Open a page, and click the Components
button on the Page Management toolbar.

Click the Add External Component button, and define the component as described in "How to Create
an External Component” on page 225. The new component is added to the Component Gallery, and
can then be added to any page.

For details, see "New/Edit Component Dialog Box" on page 216.

Define how components interact with one another

The interaction between components on a page in My Workspace is called wiring. After you place
components on a page, you can define how components interact with one another.

Default pages have wiring predefined. You can also modify default wiring definitions. For example, if
you have two components on a page, and you do not want them to interact with each other, you need to

disable the wiring between them. Click the Page Wiring button , and clear the corresponding
checkbox.

For details, see "How to Set Up Wiring Between Components" on page 227.

Modify categories of pages and components

My Workspace contains default categories within the Page Gallery and the Components Gallery to help
you organize pages and components. You can add categories, edit or delete user-defined categories,
and add or remove pages and components from categories.

For task details, see "How to Modify Page and Component Categories" on page 228.

Close a page or delete a page

To close a page, click the close icon in the upper right corner of the page. The page is closed in your
workspace, but it is not removed from the page gallery.

To delete a page from the page gallery, click the Page Gallery button, select the page, and delete it.
For details, see "Page Gallery Dialog Box" on page 212.
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User Permissions in Workspaces

Permissions to work with Workspaces components and pages are defined in Users, Groups, and
Roles.

To access

Administration > Users > Users, Groups, and Roles > Edit Role or Create Role > Permissions
> Workspaces

The operations that can be defined for a user are dependent on the area within Workspaces, as follows:

« Predefined Pages. These pages are defined out-of-the-box. Users cannot add, modify, or remove
components on these pages. The only operation that can be defined via user permissions is View, to
enable a user to view these pages.

« User Pages and User Components. Users can be granted permissions to perform the following
regular operations on user-defined pages and components: Add, Change, View, Delete, and Full
Control.

Within user pages, there is an additional permission level unique to My Workspace called Locked. If

you want specific users to only monitor information, but not to select a view or apply filters on a page,

you can apply Locked permissions to a user-defined page. This is relevant for pages which include
built-in view explorers such as the Service Health components (Top View, Hierarchy, Geographic Map
and so on), and the Event Browser.

How to Configure Page Layout - Use-Case Scenario

This section provides an example of how to configure the layout of components on a page. The layout
defines the appearance of the page—how many areas are on the page, whether components are
arranged horizontally, vertically, in tabbed areas, and so on.

It is recommended that you plan in advance which components you want to place on your page and
how they should be arranged, and then configure your page layout accordingly.

1. Background

Adam, an administrator at ACME corporation, wants to set up a page with two components in tabs
on the left side of the page, and a vertical area (with components arranged one above the other) on
the right side of the page.

2. Open a page

Adam opens a new page, which has a horizontal layout by default:
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New Pagec x secarige - B b

3. Switch the page layout to vertical

From the layout tools in the upper left area, he clicks Switch to Vertical. The layout is now
oriented horizontally:

New Page(2) Select Page > B 0

|

4. Split the page
Adam then clicks Split to divide the layout into a left and right pane:
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@)

5. Create a tab layout in the left pane
Within the layout on the left side, he clicks Switch to tabs to create a tabbed areain the left pane:

Page) x Select Page - B 0

6. Result
Within the layout, Adam now adds components to the two areas; the components added to the left
side of the screen (Top View and Topology Map) are displayed in tabs, and the components added
to the right side (Hierarchy and Geographical Map) are displayed vertically:
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How to Create an External Component

The following task describes how to create a component using a URL. You can use a static URL,
where the component simply opens the URL that you enter. You can also create a dynamic URL,
where the component URL responds to other components on the page.

For a scenario which shows how to create a component based on a dynamic URL, see "How to Create
a Component Using a Dynamic URL — Use-Case Scenario" on the next page.

Note: The URL for an external component must begin with one of the following: https://,

http://, orftp://

1. Open the Add Component dialog box

Open the Component Gallery, and click the Add External Component button on the Component
Gallery toolbar. The New Component dialog box appears; for details, see "New/Edit Component

Dialog Box" on page 216.

2. Define the static part of the URL

In the upper area of the New Component dialog box, enter a name for the component and the

component's URL.

o To create a component using a static URL, enter the full URL.

o To create a component using a dynamic URL, enter the static portion of the URL only.
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3. Categorize the component (optional)

To help you organize your content, you can assign pages and components to default categories, or
to user-defined categories. For details, see "How to Modify Page and Component Categories" on
page 228.

In the Categorize Component area, select one or more categories to which you want the
component assigned. Note that this is optional.

4. Define the dynamic part of the URL

If you are creating a component using a dynamic URL, perform the following steps:

a.

In the Wiring Context area, select one or more contexts whose attributes can be used to
define the URL pattern, as follows:

m Select CIChange if the URL should respond to a component where Cls are selected.

= Select EventChange if the URL should respond to a component where events are
selected.

m Select ViewChange if the URL should respond to a component where views are selected.

Inthe URL Parameters and Values area, add one or more URL parameters which are used
to define the URL pattern. You can define the URL's path, query, or a fragment of the URL,
using the following pattern:

https://domain/ <path> ? <query_string> # <fragment>

For example, you could use dynamic URL parameters to create one of the following:
= www.google.com/search?hl=<<lang>>&q=<<viewlD>>

= en.wikipedia.org/wiki/<<articleName>>

A pattern such as: http://download.oracle.com/javase/1.4.2/docs/api/
<<className>>.html#<<methodName>> might take you to:
http://download.oracle.com/javase/1.4.2/docs/api/java/net/URL.htmi#toString() (which
is avalid URL).

The Attributes list contains a list of attributes that can be used to build the URL pattern,
based on the contexts you selected in the Wiring Context area. To use attributes as
parameter values, drag attributes from the Attributes list into the Value areas of URL
parameters.

The URL Parameters area shows the dynamic URL you have built, using the static URL in
the upper area of the dialog box, and the URL parameters that you defined.

How to Create a Component Using a Dynamic URL -
Use-Case Scenario

Jane is an administrator in the ACME corporation, and she wants to set up a page in My Workspace as
follows: the left side of the page will display the Service Health Topology Map, and the right side of the
page will display the ACME Support directory.

When a Cl is selected in Topology Map, the Support directory will display details on whom to contact
when this Cl is in a problematic state.
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The dynamic URL of the ACME Support directory is as follows:
http://www.acme.com/support/search?q=<contact person>.

Tip: In this scenario, the dynamic URL is built using the query string. You can also define the
URL's path, or a fragment of the URL, using the following pattern: https://domain/ <path> ?
<query_string> # <fragment>.

1. Jane opens a new page, and divides it into two panes. She opens the Component Gallery, and
drags Topology Map into the left pane. She then clicks the Add External Component button on
the Component Gallery toolbar.

2. Inthe upper area of the Add Component dialog box, she types ACME Support as the component
name, and enters the static portion of the Support directory URL:
http://www.acme.com/support/search.

3. Inthe Wiring Context area, Jane adds CIChange to the list of contexts, so that the Support
directory will respond when a Cl is selected in the Topology Map.

4. Inthe URL Parameters and Values area, she adds a URL parameter named q.

The ACME corporation uses a Cl attribute called <<CIContact>>, todefine whom to contact
when a Cl is problematic. The Attributes list includes the attribute <<CIContact>>. Jane drags this
attribute to the Value field of the parameter named q.

The URL Pattern now shows the following:
http://www.acme.com/support/search?q=<<CIContact>>.

5. Jane clicks OK to save the component, and then drags the ACME Support component into the
right pane.

6. Jane then clicks the Wiring button on the Page Management toolbar, and defines the page wiring
so that the Topology Map source component sends ClChange contexts to the ACME Support
target component.

When a Cl is selected in Topology Map, the Support directory displays details on whom to contact
regarding the CI.

How to Set Up Wiring Between Components
The following task describes how to configure the wiring between components on a page. Wiring
defines how components interact with each other.

A component can send a wiring context to another component indicating what has changed in the first
component, and the second component can respond to this change. For example, suppose View
Explorer is defined as a source component which sends the Cl Selection wiring context to Top View
(target component). When you select a Cl in View Explorer, Top View focuses on this Cl as well.

Default pages have wiring predefined; you can also modify default wiring definitions.

1. Open the Wiring dialog box

Open the page whose wiring you want to configure, and click the Page Wiring button on the Page
Management toolbar. The Wiring dialog box appears. For details, see "Wiring Dialog Box" on
page 218.
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2. Select a source component for wiring

From the list of Source Components on the left side of the Wiring dialog box, select a component
whose contexts will be sent to one or more target components.

3. Select a context to send from the source component

The list of Context Types shows which contexts can be sent from the selected source
component:

o Select Cl Selection to control which components are notified when a different Cl is selected in
the source component.

o Select Event Change to control which components are notified when a different event is
selected in the source component.

o Select View Change to control which components are notified when a different view is
selected in the source component.

4. Select target components for wiring

From the list of Target Components on the right side of the Wiring dialog box, select one or more
components that will receive contexts from the source component.

The Summary of Page Wiring area displays all of the wiring defined for the page.

To define wiring for this page from additional source components, repeat the above steps as
required.

How to Modify Page and Component Categories

To help you organize your content in My Workspace, you can add or remove pages and components
from categories, create new categories, and edit or delete user-defined categories. This section
describes how to work with categories within the Page Gallery and Components Gallery to help you
organize pages and components.

Tip: Categories are not mutually exclusive; you can assign a page or a component to more than
one category.

« Fordetails regarding pages, see "Page Gallery Dialog Box" on page 212.
« Fordetails regarding components, see "Component Gallery Dialog Box" on page 214.

Create a new category

My Workspace is provided with categories to which pages and components are assigned. To add a
new category, click the Components or Page Gallery button on the Page Management toolbar, then
click the New Category button. Type a name for the new category.

You can then assign existing pages and components to the category, or add new external components
to the category.
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Rename or delete a user-defined category
To rename a user-defined category, select the category and click the Edit Category Name button.
To delete a user-defined category, select the category and click the Delete Category button.

Note that default categories cannot be renamed or deleted.

Assign a page or component to a category

To assign a page or component to a category, select it and click the Categorize Page or Categorize
Component button. Select one or more categories to which you want the page or component
assigned.

Modify category assignments of a page or component

To change the category assignments of a page or component, select the page or component and click
the Categorize Page or Categorize Component button. Modify which categories the page or
component is assigned to as needed.

How to Modify the Maximum Number of Pages

By default, up to 10 pages can be open at the same time. If you have multiple pages open, upto 5
pages are refreshed automatically (based on which pages were accessed most recently); any
additional open pages are refreshed when you select them.

These limits apply both to My Workspace and Service Health.

This section describes how to modify these limits. Note that if you increase these limits, performance
may be impaired.

Modify the maximum number of open or active pages

To modify the open pages limit or the number of pages automatically refreshed in My Workspace and
Service Health, open Infrastructure Settings:

Administration > Setup and Maintenance > Infrastructure Settings

1. Select Applications > MyBSM.

2. Inthe MyBSM - General area, modify the Maximum number of open pages or Maximum
number of active pages entry as needed.

Note that if you increase the maximum number of pages, performance may be affected.

How to Enable the Screen Capturing Applet

By default, the screen capture applet is disabled. You can enable it so that every time you save a page,
a screen shot of it is taken, which is then shown as a thumbnail in your Page Gallery.

To enable the screen capturing applet, follow these steps:
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1. Navigate to Infrastructure Settings:
Administration > Setup and Maintenance > Infrastructure Settings
2. Select Applications > My Workspace.

3. Inthe My Workspace - General area, click the Edit Setting button for the Enable screen
capture applet option.

4. Inthe Edit Setting dialog box, select true from the drop-down list associated with the Value field.
By default, the value is false.

5. Click Save.

Troubleshooting My Workspace

My Workspace pages and components are missing

If you modified databases on a running OMi deployment, My Workspace will no longer contain any
pages and components. To restore pages and components:

1. Open the following directory:
<OM1_HOME_GATEWAY>/conf/uimashup/import
This contains two directories: 1loaded and toload.

2. Copy the contents of the 1oaded directory into the toload directory.
Restart OMi.
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Dashboards give you an overview of the health of the environment in graphical form. The data updates
in real time so that you are always presented with the most recent information. OMi provides the
following dashboards by default:

« Monitoring Dashboard. (Formerly known as Event Dashboard.) Monitoring Dashboards provide an
at-a-glance overview of the events from the environment you are monitoring. Monitoring Dashboards
enable you to quickly assess the health of the environment and identify areas that require your
attention. For details, see "Monitoring Dashboard" on page 233.

« 360°. This page provides a high-level overview of the status of Cls in a selected view. The page
displays a hierarchy of Cls in a view, the KPIs assigned to each Cl, and their KPI statuses. For
details, see "360° View" on page 242.

« KPI Over Time. The KPI Over Time dashboard enables you to view the status or the value of
selected KPIs and Cls over time. The report also lets you choose from a number of layouts to
monitor statuses and values at a glance. For details, see "KP| Over Time Dashboard" on page 243.

« ROI Dashboard. (Retun on Investment.) The ROI Dashboard displays the proportion of events
received by OMi that have been automatically handled against those that required intervention by
operators. The higher the proportion of automatically handled events, the greater the contribution
OMi is making to the management of your infrastructure. If the cost of manually handling a typical
event is known, this value can be entered into OMi, based on which, the total cost saving achieved
through OMi can be displayed. These statistics can be displayed for any specified time period within
which OMi has been monitoring your IT environment. For details, see "Return On Investment
Dashboard" on page 247.
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Monitoring Dashboards provide an at-a-glance overview of the events from the environment you are
monitoring. Monitoring Dashboards enable you to quickly assess the health of the environment and to
identify areas that require your attention.

For example, operators might use Monitoring Dashboards in the following ways:

« Toget anoverview of their monitored environment.

« Tocheck a health status of various OMi components.
« As astarting point for daily management operations.
« Toquickly apply event filters to the Event Browser.

Monitoring Dashboards display status information using different types of widgets (for example, stack
and pie widgets). Each widget references an event filter, a view, or both, and only displays the status of
those events that match the criteria of the filter and that are related to the configuration items included
in the referenced view.

In OMi, Monitoring Dashboards are available as My Workspace components and can be added to My
Workspace pages as required.

To access
Workspaces > Dashboards > Monitoring Dashboard
Note: You can also create custom pages using components of your choice. For details on how to

work with My Workspace pages and components, see "How to Set Up My Workspace" on
page 220

Learn More

This section contains the following:
« "Combining Monitoring Dashboards with Other My Workspace Components" below
« "Monitoring Dashboard" above

« "Dashboard Preferences" on page 237

Combining Monitoring Dashboards with Other My Workspace Components

My Workspace pages are collections of several components displayed together, and interacting with
one another. Within a page, components can pass information to one another, so that one component
can react to a change in another.

For example, you can combine the Monitoring Dashboard component with the Event Browser
component or the Top View component. By clicking a widget, the context is passed to the Event
Browser and Top View. The Event Browser reacts by displaying only events that match the event filter
orview. Top View reacts by displaying the view associated with the widget.
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. Example: Monitoring Dashboard and Event Browser

Clicking the Unassigned Events widget causes the Event Browser to display only those events
that match the Unassigned Events event filter.
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. Example: Monitoring Dashboard and Top View

Clicking the Data Center 1 Overall widget causes Top View to display the Datacenter
Topology view associated with the widget, and causes the Event Browser to display only those
events that match the Data Center 1 Overall event filter.
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. Example: Parent and Drill-Down Dashboard on the Same Page
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Clicking the Overview widget causes its drill-down dashboard Example:Operations Manager
Overview to be displayed within the second dashboard on the same page. For this to happen, the
wiring between these two dashboards has to be configured as described in the "How to Set Up
Wiring Between Components" on page 227.

Note: To display the drill-down dashboard of the first dashboard within component, use the drill-
down icon in the lower right corner of the component. To disable this feature, deselect the Open
Drill-Down Dashboards within component option in the Preferences dialog of the parent

i Operations Manager i Workspaces v Administration~  Q, search for menu ftems Radminy @~
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Dashboard & Event Browser X Drilldown X select Page ] © B T | e € @
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Overview Assigned to me
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=

. Context Wiring in My Workspace

The Monitoring Dashboard component sends the following wiring contexts to target components:

o EventDashboardClickEvent. The Event Browser reacts to the EventDashboardClickEvent
context by displaying only those events that match the filter or view associated with the
dashboard widget.

Note: In case there are more than one monitoring dashboard open, and one of them has drill-
down dashboard configured, the other one reacts to the EventDashboardClickEvent context
by displaying the drill-down dashboard of the first dashboard widget.

o ViewChange. The ViewChange context can be consumed by many components, for example
the Top View.

For more information about wiring, see "How to Set Up Wiring Between Components" on page 227.

Monitoring Dashboards can include many different widget types. Some types, such as the Overview,
the Simple Status and the Group, enable you to quickly determine the status of the monitored area by
displaying a color that reflects the severity of the most critical event (for example, red for the severity
critical). The number of events per severity is also shown.

The following types of widgets can be incorporated into a Monitoring Dashboard:
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« Overview Widget The number in the upper right-hand corner indicates the number of all events that

match the filter and view.

Overview widgets can be displayed in normal and compact mode. In compact mode, the severity

icons and the corresponding numbers are hidden.

OM internal
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@ s Active Directory )
« Stack Widget
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« History Widget. History widgets display the number of events per severity (y axis) against time (x
axis).

Event History

004 0205 0206 0207 oz08 0z:00 Lera 1]

« Group Widget. Group widgets group multiple widgets under a common heading (OMi Server, in the
example below).

The color of the "lamp" in the title bar indicates the severity of the most critical event in the group. If
the widgets in the group do not display status information (for example, if no events match the filter),
the group widget also does not show any status information.

. OMi Server
. g. OMi Server Processes o] . + Event Processing 2
[l y oy i
. B OMi Server Infrastructure ] . ‘-’ Job Handling 0

Dashboard Preferences

« Name. Name of the Monitoring Dashboard. My Workspace users select Monitoring Dashboard
configurations by their names.

Note: The name of the Monitoring Dashboard can be changed from Administration, where
Monitoring Dashboard are configured. For more information see the OMi Administration Guide.

« View Mode. Changes the displayed size of the selected Monitoring Dashboard in the Dashboard
Details pane. Possible options are Compact, Medium, and Large.

« Use Dark Theme. Changes the appearance of the Monitoring Dashboard so that it uses the HPE's
dark theme.

« Open Event Browser on Click. This option configures the Monitoring Dashboard to open the Event
Browser in a pop-up window when you click a widget. With this option selected, you can save space
on your My Workspace page by excluding the Event Browser from the page. The Event Browser
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opens on demand in a new window.

« Open Drill-Down Dashboards within component. Opens a drill-down dashboard within the
selected component. For more information on this option, see "How to Display the Monitoring
Dashboard" below.

« Hide filter errors. Hides filter errors. When you do not have permission for some filters, or they do

not exist, the exclamation mark icon (ﬂ- )is displayed in the widget, and when you hover on the
widget, a tooltip with an error message appears. See "Troubleshooting " on page 241 for the
examples of these errors. When this option is enabled, these widgets are shown empty.

Tasks

This section contains the following:

« "How to Display the Monitoring Dashboard" below
« "How to Create a Monitoring Dashboard Page in My Workspace" on the next page

« "How to Drill-Down into Dashboards" on page 240

How to Display the Monitoring Dashboard

Note: To display a user-defined My Workspace page, the administrator must grant users a role
with appropriate permissions in Administration > Users > Users, Groups, and Roles. For more
information, see the OMi Administration Guide.

To display the Monitoring Dashboard:
1. GotoWorkspaces > My Workspace.

2. Select the predefined OMi Monitoring Dashboard page or any other user-defined Monitoring
Dashboard page for which you have permission.

3. Openthe Configure Component dialog box, and choose a dashboard configuration from the
Choose a Dashboard configuration drop-down list.

If the drop-down list does not contain any dashboard configurations, the administrator must first
create one as described in the OMi Administration Guide.

To display the Monitoring Dashboard outside of My Workspace:

1. You can display Monitoring Dashboard pages in a Web browser outside of My Workspace by
using the following URL.:

https://<server_name>.<domain_name>/opr-
web/dashboard/app?dashboardId=<dashboard _id>

Note: To enable drill-down dashboards within component, use the following URL instead:

https://<server_name>.<domain_name>/opr-
web/dashboard/app?dashboardId=<dashboard id>&enableDrillDownWithin=true

2. Select one of the Monitoring Dashboard pages from the Choose a Dashboard configuration
drop-down list.
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The selected Monitoring Dashboard page opens and displays in the Medium view. To change the
view to Compact or Large, set appropriately the ViewMode parameter as described below.

You can set the following parameters in the Monitoring Dashboard URL:

« dashboardld. ID of a Monitoring Dashboard. Enables you to access a Monitoring Dashboard
directly. To display a specific Monitoring Dashboard, add the dashboardId parameter to the URL,
for example:

http://<server_name>.<domain_name>/opr-web/dashboard/app?dashboardId=<dashboard _
id>

Tip: The monitoring dashboard ID is displayed in the dashboard's properties in the Dashboard
Designer.

. eventBrowserOnClick. By default, when you click a widget in a standalone Monitoring Dashboard,
a standalone Event Browser opens and displays the status of those events that match the criteria of
the associated event filter and that are related to the configuration items included in the referenced
view. You can disable this behavior by setting the eventBrowseronClick parameterin the URL to
false:

https://<server_name>.<domain_name>/opr-
web/dashboard/app?eventBrowserOnClick=false&dashboardId=<dashboard id>

To enable this setting again, omit the parameter or set it to true (the default value).

« enableDrillDownWithin. To display the drill-down dashboard of the dashboard within the same
component, use the drill-down icon in the lower right corner of the component. This icon is enabled
when the enableDrillDownWithin parameteris set to true, which is a default value, as follows:

https://<server_name>.<domain_name>/opr-
web/dashboard/app?enableDrillDownWithin=true&dashboardId=<dashboard id>

To immediately open the drill-down dashboard once you click a widget, set the
enableDrillDownWithin parameterto onClick.

To disable this feature, deselect the Open Drill-Down Dashboards within component option in
the Preferences dialog of the parent dashboard, or set the enableDrillDownWithin parameter to
false.

« viewMode. Shows Monitoring Dashboards in a three different view modes, Compact, Medium and
Large. If you choose the Compact mode, the result will be decreasing the font size, and also less
display space consumed. Likewise, the Large mode is used for displaying the text in larger fonts,
which could be useful, for example, for widget headlines. To enable the desired mode, set the
viewMode parameter in the URL to compact, medium or large.

https://<server_name>.<domain_name>/opr-web/dashboard/app?viewMode=<view _
mode>&dashboardId=<dashboard id>

The default view mode is Compact.

How to Create a Monitoring Dashboard Page in My Workspace

1. Select My Workspace in the menu bar.
2. Create a new page.
3. Optional. Design the layout of the page.
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8.

For example, to display both the Monitoring Dashboard and the Event Browser in one page, split
the page into two horizontal panes.

Open the Component Gallery and select the category Event Management. Select the
Monitoring Dashboard component and drag it to your page.

Choose a dashboard configuration and click OK.

Note:

o Toload dashboard configurations into My Workspace pages, the administrator must grant
you a role with appropriate permission for Monitoring Dashboards in Users, Groups, and
Roles:

Administration > Users > Users, Groups, and Roles
For details, see the OMi Administration Guide.

o Administrators create Monitoring Dashboards in the Monitoring Dashboards page in
Administration. For details, see the OMi Administration Guide.

o The OOTB Contents for OMi content pack provides several Monitoring Dashboard
configurations that demonstrate how Monitoring Dashboards can help users to better
monitor their environment. For details, see the OMi Administration Guide.

Optional. Click ¥+ Component Menu to configure preferences and the wiring of the Monitoring
Dashboard component:

o Click Preferences to change the name, the view mode (Compact, Medium, or Large), the way
the Event Browser opens when you click a widget and so on. For more information, see
"Dashboard Preferences" on page 237.

o Click Wiring to open the "Wiring Dialog Box" on page 218. The Monitoring Dashboard
component includes default wiring. You can modify this default wiring definition if required.

Optional. Add other components to your page, for example the Top View or the Event Browser
component.

Click OK and save your page to the Page Gallery.

How to Drill-Down into Dashboards

Select My Workspace in the menu bar.

Open the dashboard with the configured drill-down dashboard. The widget with the drill-down
dashboard has the drill-down icon in the lower right comner.

Click the drill-down icon to drill into the dashboard associated with this widget. The drill-down
dashboard offers the additional information to the one offered by the parent dashboard widget.

Note: To navigate back to the parent dashboard, select its name from the navigation bar in
the upper left corner of the widget.
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Troubleshooting

No matching event filter found for Dashboard Widget

If a widget in a Monitoring Dashboard contains just the exclamation mark icon (ﬂ )and the No
matching event filter found for Dashboard Widget tooltip is displayed when hovering on the
widget, you probably do not have the required permissions for this filter, or the filter is deleted.

Dashboard Widget is empty

If a widget in a Monitoring Dashboard is empty, you probably do not have the required permissions for
this filter, or the filter is deleted. Check with your administrator about your permissions.

No matching view filter found for Dashboard Widget

If a widget in a Monitoring Dashboard contains just the exclamation mark icon (4 ) and the No
matching view filter found for Dashboard Widget tooltip is displayed when hovering on the
widget, the referenced RTSM view does not exist.

More than one matching event filter found for Dashboard Widget

If a widget in a Monitoring Dashboard contains just the exclamation mark icon (Jl )and the More than
one matching event filter found for Dashboard Widget tooltip is displayed when hovering on
the widget, multiple filters have the same name, and the Monitoring Dashboard is unable to identify the
filter to use with the widget.

No permission to clear view filter for Dashboard Widget

If a widget in a Monitoring Dashboard contains just the exclamation mark icon (4 ) and the No
permission to clear view filter for Dashboard Widget tooltip is displayed when hovering on
the widget, you probably do not have permission to remove the view-based filtering in order to see all
events. For more information about the Clear View Filter setting, see the OMi Administration Guide.

No permission to set view filter for Dashboard Widget

If a widget in a Monitoring Dashboard contains just the exclamation mark icon (Jl )and the No
permission to set view filter for Dashboard Widget tooltip is displayed when hovering on the
widget, you probably do not have the permissions required for the referenced view. For more
information about the assigning views to a user, see the OMi Administration Guide.

Wrong Dashboard configuration chosen

If you have selected a dashboard configuration but would like to change it, open the Configure
Component dialog box from the right corner menu and choose the desired dashboard from the Choose
a Dashboard configuration drop down list.
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This page provides a high-level overview of the status of Cls in a selected view. The page displays a
hierarchy of Cls in a view, the KPIs assigned to each Cl, and their KPI statuses.

When you select a Cl within the Hierarchy component you can see its detail links. When you click the
detail links, you can access the following components: Business Impact, Health Indicators, Alerts, and
Changes and Incidents.

This page is taken from the Service Health application.

To access

Workspaces > Dashboards > 360° View

Tasks

This section includes:

« "How to view the 360° View dashboard as a My Workspace Component " below

How to view the 360° View dashboard as a My Workspace Component
The 360° View dashboard can be viewed as a My Workspace component.
For information on components, see "Add components to a page" on page 220.

For information on My Workspace, see "Monitoring Your Environment With My Workspace" on
page 201.

For information on wiring, see "How to Set Up Wiring Between Components" on page 227.

HPE Operations Manageri (10.10) Page 242 of 307



Chapter 15: KPI Over Time Dashboard

The KPI Over Time dashboard enables you to view the statuses and status summaries of selected
KPls and Cls over time. The dashboard lets you choose from a number of widgets to survey historical
KP1I status data and the health of the monitored environment at a glance.

To access

Workspaces > Dashboards > KPI Over Time

Learn More

This section includes:

« "Working with the KPI Over Time Dashboard as a Page" below

« "Configuration Items Dialog Box" on the next page

« "Key Performance Indicators Dialog Box" on the next page

o "Types of Widgets" on page 245

« "Working with the KPI Over Time Dashboard as a Component" on page 245

Working with the KPI Over Time Dashboard as a Page

The dashboard displays the status of each configuration item, and each instance of the attached key
performance indicators (KPIs). Frequently used KPls include unassigned and unresolved events and
system, network, and software performance and availability. The dashboard provides KPI information
for higher-level configuration items (Cls) such as Business Services, Application, and Business
Processes Cls.

For example, an OMi user has set up monitoring for cloud environments in Europe, USA and Asia. Cls
have been created to represent the top-level business services and the underlying cloud infrastructure.

System Performance, System Availability, Network Performance, and Network Availability KPls are
calculated for each environment. A view called 'My Cloud' has been created, which shows current KPI
status.

The current KPI status of the cloud in Europe is red (critical). The OMi user fixes the problem, and
decides to find out if there are more problems in Europe than in the other cloud environments.

The OMi user accesses the KPI Over Time dashboard, the 'My Cloud' view, and selects the three top
level Cloud Europe, Cloud USA, and Cloud Asia Cls. The user then selects 1 month ago until present.
The KPI Over Time dashboard shows the status of the 4 KPIs for each of the 3 Cls during the last
month.

The OMi user now has information on Cloud Europe status compared to the other cloud environments.

« Navigating the KPI Over Time Dashboard
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You can navigate historical data using the arrow buttons. You can select the time window displayed
in the dashboard by selecting day, week, or month, while the hour, day, and week buttons let you
select the amount of time to navigate by.

The E Select Start Time button provides easy access to specific points in time, and the

ﬁ_ﬁ Now Go To Present Time button resets the dashboard to show the current date and time.

You can visually filter data shown in the widgets, which recalculate themselves based on the current
selection context.

To reset the filter selection, click Reset Filters. To change the filter selection, click the filter or filters
you want to remove.

« Important Information

The dashboard displays data only for Cls with persistent KPIs. For details, see the OMi
Administration Guide.

Ensure that the Save KPI data over time for this Cl option has been selected for the Cl. For
details, see the OMi Administration Guide.

The dashboard displays only the status of selected KPIs. Those KPIs may also have values in the
RTSM but the dashboard does not show those values.

The context menu of all Cls except monitor Cls includes the KPI Over Time Report option.

Configuration Items Dialog Box

This dialog box enables you to select the Cls to be included in the KPI Over Time dashboard. The
dashboard provides information based on the selected Cls.

To display data when you access the KPI Over Time dashboard, click the ﬁ Select

Configuration Items button to open the Cl dialog box.
Only Cls that meet the following criteria are available for selection:

o Cls with attached KPIs.

« Cls that are flagged to save KPI data over time (historical data). For information, see the OMi
Administration Guide.

« Cls whose CIT attributes in the RTSM have the Store KPI History For Over Time Reports
attribute value of true.

Key Performance Indicators Dialog Box

This dialog box enables you to select the KPIs to be included in the KPI Over Time dashboard. The
dashboard provides information based on the selected KPls.

To display key performance indicators for the Cls, click the @ Filter Key Performance Indicators

button. The Key Performance Indicators dialog box opens.

By default, all KPIs are selected. You can cancel the selection to exclude KPIs from the dashboard.
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Types of Widgets

You can choose the following widgets as part of the KPI Over Time dashboard. To display the widgets,
clickthe _a) Select KPI Status Widgets button. The Widgets dialog box opens.

« Status by Configuration Item (heat map)

The heat map widget displays KPI data for selected Cls through time intervals defined by the report
granularity (the legend for the x-axis shows the time interval for each point). Each tile represents a
period of time during the overall time frame.

The heat map can be filtered by clicking the dashboard header buttons, one or more tiles, or the
timestamps at the bottom of the widget. You can click any time segment in the graph time footer to
view all of the Cl and KPI information for that period of time. Clicking heat map tiles allows you to
filter data displayed by other widgets.

Each heat map tile displays the most critical KPI status during that time unit.
« Status by Percentage (pie chart)

The pie chart widget represents the sum of KPI instances for the Cls, and summarizes the statuses
of KPIs over the selected time interval. The pie chart is divided into colored status slices. Each slice
represents the percentage of time that a particular status was held by the KPls. More critical
statuses have precedence over less critical statuses occurring over the same time period.

« Status Details (table)

The table widget contains detailed information on the KPI status changes of each Cl and is useful for
detailed surveying.

« OK Status Percentage (number)

The OK status percentage widget shows the percentage of time in which all selected Cls and KPIs
were in OK status, and provides a clear overview of uptime as a percentage of the monitored time
window.

« Notin OK Status Time (number)

The not in OK status time widget shows the actual time during any of the selected Cls and KPIs
were in Not OK status, and provides a clear overview of overall KPI downtime.

« Trend (bar chart)

Each column shows the percentage of OK status over time against all other statuses. For example,
if the KPIs were in OK status for 80% of the time interval, and in Warning status for 20%, then the
bar chart displays the 80% OK status.

o Trend (sparkline)

The sparkline shows the status trend of KPIs for selected Cls, based on a compilation of all
statuses. A warning level line provides a quick reference to evaluate the overall status trend. When
no filters are applied, the sparkline widget displays the trend of the most severe status shown in the
heat map sparklines.

Working with the KPI Over Time Dashboard as a Component

« Forinformation on components, see "Add components to a page" on page 220.
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« Forinformation on My Workspace, see "Monitoring Your Environment With My Workspace" on
page 201.

« Forinformation on wiring, see "How to Set Up Wiring Between Components" on page 227.

Tasks

This section contains the following:

« "How to Display Cls and KPIs in the KPI Over Time Dashboard" below

How to Display Cls and KPIs in the KPI Over Time Dashboard

1. Click the r' Select Configuration Items button to open the CI dialog box. You can select Cls

with KPI data and search or browse views.

Browse Views: The default mode for the Configuration Items dialog box, enabling you to select
aview and Cls.

Search: Click the Search link to move to Search mode.

Only the Cls selected in the currently displayed view are saved for the dashboard filter when you
click OK. If you select another view before clicking OK, all previous Cl selections are discarded.

Select the Cls for which you want to show the KPI status over time. By default, the dashboard
shows no data until Cls are selected. For more information, see "Configuration Items Dialog Box"
on page 244.

2. Optional. Click the @ Filter Key Performance Indicators button to open the KPI dialog box

and select or deselect KPIs to display. For more information, see "Key Performance Indicators
Dialog Box" on page 244.

By default, all KPIs for the selected Cls are preselected.
3. Optional. Clickthe g3 Select KPI Status Widgets button to open the widget dialog box and

select one or more widgets. By default, the heat map is selected. For more information, see
"Types of Widgets" on the previous page.

4. Optional. To change the KPI Over Time component's refresh rate (none by default) and display
name, click the ™ button on the Component Toolbar and click Preferences.

Tip: When viewing the dashboard as a component, you can also change the widget selection
in the Preferences dialog box.

5. You can visually filter data shown in the widgets, which recalculate themselves based on current

selection context. To reset the filter selection, click Reset Filters. To change the filter selection,
click the filter or filters you want to remove.
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This section describes the Return On Investment dashboard user interface that you use to monitor the
effectiveness of your OMi installation.

To access

Workspaces > Dashboards > Return on Investment

Learn More

Return On Investment Overview

The Return on Investment Dashboard displays the proportion of events received by OMi that have been
automatically handled against those that required intervention by operators. The higher the proportion of
automatically handled events, the greater the contribution OMi is making to the management of your
infrastructure. If the cost of manually handling a typical event is known, this value can be entered into
OMi, based on which, the total cost saving achieved through OMi can be displayed. These statistics
can be displayed for any specified time period within which OMi has been monitoring your

IT environment.

OMi can be configured to handle events using a wide range of automation features, for example:

« Event suppression rules based on event filters. The events matching one of these rules are rejected
from further processing.

« Duplicate event suppression detects duplicate occurrences of events and suppress such duplicates
based on the event attributes, such as the event key, or where a set of configurable attributes of a
new event have the same values as an existing event.

« Changing the state of related events automatically is basic event correlation using close key
patterns or health-contributing ETIs, which can be employed to change the lifecycle state of existing
events to closed or resolved.

« Stream-based event correlation (SBEC) uses rules and filters to identify commonly occurring events
or combinations of events and helps simplify the handling of such events by automatically
identifying events that can be withheld, removed or need a new event to be generated and displayed
to the operators.

« Topology-based event correlation (TBEC) uses RTSM topology information to automatically
determine relationships between events, highlighting the causal events as ones needing attention
while suppressing symptom events.

« Automatic actions can be performed automatically and unattended on targets such as systems
running an Operations Agent. Actions can trigger Operations Orchestration run books if the OMi-OO
integration is configured. For details, see the OMi - Operations Orchestration Integration Guide.

« Time-based event automation functions can be used to further tune event processing, for example,
by increasing an event's priority after a certain period of time or automatic, time-based restarting of
failed actions.
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Return On Investment User Interface
The Return on Investment Dashboard presents its information using the following features.
Pie Chart

A two-sector pie chart displays the proportion of events handled automatically by OMi compared with
the events that were actually received in the Event Browser needing operation interaction, which helps
you to immediately visualize the value that OMi is providing to your IT organization.

Total Number of Events

Displays the total number of events received by OMi from the IT environment during the selected time
period.

Reduced by OMi
Displays the number of events handled automatically by OMi during the selected time period.
Stack Chart

The stack chart displays the ratio of automatically handled events in comparison with those handled by
OMi operators divided into predetermined time periods. The granularity of these time periods reduces
as the length of the overall time period is increased. Short time periods show one stack per hour, the
stack granularity decreasing, for example, through days, weeks and months as the total time period is
increased. In addition, a trace of the percentage of automatically handled events is superimposed on
the chart.

Cost Saving

If Event Cost Saving Calculation is enabled in the Operations Management - Return On
Investment Infrastructure Settings, and a value for the cost of manually handling a typical event is
entered in OMi, the total cost saving achieved through OMi is displayed for the selected time period.
The default value for costs per event and currency are set up in the Operations Management -
Return On Investment Infrastructure Settings.

Tasks

"Configuring the ROI Cost Saving Calculation" below
"Using the ROI Dashboard" on the next page

"Return On Investment Dashboard" on the previous page
"Return On Investment Dashboard" on the previous page
"Return On Investment Dashboard" on the previous page

"Printing the ROI Dashboard" on the next page

Configuring the ROI Cost Saving Calculation
To Configure the Return On Investment Cost Saving Calculation:

1. Open the Infrastructure Settings for Operations Management:
Administration > Setup and Maintenance > Infrastructure Settings
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Go to the section:

Operations Management - Return On Investment

Open the Enable Cost Saving Calculation setting for editing (ﬁ)and set to true.

Optional. If you want to display the calculated cost saving being achieved by OMI, and you have a
default value for manually handling an event for your organization, enter that value for under Cost
Per Event. In addition, set the applicable currency appropriate for your geography under
Currency.

4. Go tothe Return On Investment Dashboard:
Workspaces > Dashboards > Return on Investment

Open the Event Cost Savings dialog ().

Select the Display cost savings through Operations Manager i in the report check
box.

7. Select a value for the cost of handling an event. The available choices are:
o Use default value:

Uses the value set inthe Cost Per Event Infrastructure Settings under Operations
Management - Return On Investment.

o Use custom value:

Uses the value that you enter in the associated value field.

8. Click OK.

Using the ROI Dashboard
To Use the Return On Investment Dashboard:

1. Gotothe Return On Investment Dashboard:
Workspaces > Dashboards > Return on Investment
2. Select atime period over which you want to display the return on investment data.

o Use the from calendar to set the start date either by entering the date directly in the date field or
selecting the date from the calendar with a mouse click. Alternatively, select the current date
with the Today button.

o Use the to calendar to set the end date either by entering the date directly in the date field or
selecting the date from the calendar with a mouse click. Alternatively, select the current date
with the Today button.

Note: The selected start and end dates are displayed in the calendars with a blue
background. All other dates included in the time period selection are displayed with a gray
background. The current date, if not selected, is displayed with a yellow background.

Printing the ROl Dashboard

To print the content of the dashboard:
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1. Go to the Return On Investment Dashboard:

Workspaces > Dashboards > Return on Investment
2. Click the Printbutton (T7).

The currently configured ROI Dashboard is sent to the print application.

Note: For best results, use the following printer settings:

Orientation: Landscape

Page size: A4 (preferred) or Letter

Ul Reference

Dashboards Pane

Ul
Element

Statistics
for
timeframe

Total
Number
of Events

Reduced
By OMi

Cost
Savings
By OMi

Description

Event Cost Savings: Opens the Event Cost Savings dialog from which you can
enable and disable the displaying of the Cost Saving By OMi information in the Retun
On Investment dashboard.

Note: Enable Cost Saving Calculation must be enabled in the Operations
Management - Return On Investment Infrastructure Settings. The cost
for handling an event (Cost Per Event)and the appropriate currency should also
be specified.

Presents a summary of the time period selected over which to display the Return On
Investment data.

Displays the total number of events received by OMi from the IT environment during the
selected time period.

Displays the number of events handled automatically by OMi during the selected time
period.

Displays the total cost saving achieved through OMi during the selected time period.

Enable Cost Saving Calculation must be enabled in the Operations Management
- Return On Investment Infrastructure Settings. The cost for handling an
event (Cost Per Event)and the appropriate currency should also be specified.

Display cost savings through Operations Manager i in the report mustbe
selected in the Event Cost Savings configuration dialog.
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Ul

Element  Description

Time from: Displays the selected start date for the return on investment calculation.
Frame

to: Displays the selected end date for the return on investment calculation.

Dates can be input directly in the to and from fields, by selecting the dates in the
calendars or by using the Today button.

The selected start and end dates are displayed in the calendars with a blue background.
All other dates included in the time period selection are displayed with a gray
background. The current date, if not selected, is displayed with a yellow background.

Event Cost Saving Dialog

Ul Element Description

Display cost Select this check box to enable displaying of the Return On Investment
savings through dashboard in the Operations Manager i user interface.

Operations

Manager i in the Note: Enable Cost Saving Calculation must be enabled inthe
report Operations Management - Return On Investment Infrastructure

Settings. The cost for handling an event (Cost Per Event)and the
associated currency should also be specified.

Use default value = Select this option to use the value specified in the Cost Per Event setting
under the Operations Management - Return On Investment
Infrastructure Settings.

Use custom value = Select this option and specify an alternative value to override the value
specified in the Cost Per Event setting under the Operations Management
- Return On Investment Infrastructure Settings.
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« Event Perspective. The Event Perspective page displays event-related information.

« Health Perspective. The Health Perspective page displays topological information and health
indicators related to the selected event. This display enables you to simultaneously see events from
different perspectives and helps you to better understand complex relationships and dependencies.

For example, you can view the following:
o List of active events.

o Topological view of the Cl related to the selected event.
o Healthindicators assigned to the objects, their state and value.

« Performance Perspective. Enables you to visualize performance metrics in the form of a
performance dashboard. By default, OMi Performance Dashboard comprises out-of-the-box
dashboards. In addition, you can also create and customize performance dashboards for the
Configuration Items (Cls) that you are monitoring.

« Discover OMi. Enables you to explore OMi step-by-step, following predefined paths and learning
OMi features along the way. The map begins with an interactive tutorial. Each step offers built-in
information as well as links to additional resources, for example, the related Ul page, online help, or
videos. Discover OMi tracks your progress so that you are aware of the areas you have already
visited. Note that progress is stored locally, and that deleting browser cookies (or clicking Reset
States within the map) will delete your progress.

« OMi Health Status. The OMi Health Status page displays the health status information of the OMi
deployment. To ensure efficient operations, OMi keeps track of the health of its components and
reports problems so that you can take a corrective or preventive action.
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The Event Perspective page helps you to better manage the events that occurin your IT environment.
The Event Perspective contains the following main panes:

« View Explorer
Displays the contents of the configuration item database and enables you to configure filters that
determine how you view the contents of the database. For more information, see "View Explorer
Component" on page 184.

« Event Browser
Displays a detailed summary of all the events that occur in the operating environment you are
monitoring. For more information, see "Event Browser" on page 28.

« Event Details

Contains more detailed information about the selected event. Event details can be displayed as a
pane below the Event Browser or as a popup window. For more information, see "Event Details" on
page 57.

« Actions Pane

Display, and execute tools, OM actions, and Run Books that can be executed on the selected
events in the Event Browser. For details, see "Tools" on page 195, "Actions" on page 191, and
"Launching Operations Orchestration Run Books" on page 53.

The size of all panes can be manually modified. You can also use the Expand and Collapse buttons to
alter the display formats to predefined settings. The Restore button reverts the associated pane to the
default size.
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The Health Perspective tab is used to display the health of related Cls in the context of events. The
event selected in the Event browser determines what is displayed in the Health Top View and the
selected Cl in the Health Top View determines what is displayed in the Health Indicators pane.

In the Health Perspective tab, the following panes help you understand the health status of an object,
show you which business rules and KPIs are being used, and how the health status of the selected
object affects the health of related objects:

« View Explorer

Displays a list of all the objects in your monitored environment. For more information, see "View
Explorer Component" on page 184.

« Event Browser

Displays alist of the active events in your environment. For more information, see "Event Browser"
on page 28.

« Health Top View

The Health Top View pane in the Health Perspective tab displays a topological view of the
configuration items affected by the event selected in the Event Browser pane. The view shows the
relationships between the configuration items that represent the monitored objects and indicates
their current health status. You can also use the Health Top View to see what affects the health of
individual objects has on the health of other objects.

The Health Top View is designed to help investigate problems that require root cause analysis. For
more information, see "Health Top View Component” on page 142.

« Health Indicators

Displays a list of the KPIs and health indicators for the selected Cl, used to calculate health-related
information such as availability and performance of the selected configuration item. For more
information, see "Health Indicators" on page 110.

« Actions Pane

Display, and execute the tools, actions and Run Books that can be executed on the selected events
in the Event Browser. For details, see "Tools" on page 195, "Actions" on page 191, and "Launching
Operations Orchestration Run Books" on page 53.

Health indicators (HI) and key performance indicators (KPI) are used to determine the health of an
object. OMi calculates how severe the problems directly associated with the selected object are and
combines this information with any additional information available about dependent objects. The
combined data is passed to calculation rules that evaluate and set the KPIs that indicate the overall
health of an object.

The color of an object displayed in the Health Top View is used to indicate its health, and the most
critical status of any contributing objects. For example, green can be set to represent normal and red to
represent critical. The color used depends on the view settings. Whatever you specify in the view
settings contributes to the color of the CI.

For more information about HIs and KPls, see "Health Indicators" on page 110 and "HI-Based KPI
Calculations" on page 111.
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The OMi Performance Dashboard enables you to visualize performance metrics in the form of a
performance dashboard. By default, OMi Performance Dashboard comprises out-of-the-box
dashboards. In addition, you can also create and customize performance dashboards for the
Configuration Items (Cls) that you are monitoring.

OMi Performance Dashboard helps you perform the following:

« Explore and visualize performance metrics of a host of components such as applications, system,
and network

« Quickly visualize the performance of important Cls using personalized favorites

« Embed charts such as graphs, table, text, and pie into the performance dashboard or you can copy
the URL of any chart and embed in My Workspace page.

« Support for URL launch - Embed performance dashboard or single chart to any Ul mashup page
« Instance Parameterization for managing different multiple instances across systems

« Event Overlay for visualizing event information in the performance dashboard

« Date Range Panel for visualizing time-specific data

« Dashboard Assignment for assigning performance dashboards to Cl Types (CITs)

« Real-time visualization of performance metrics

« Forward critical performance metrics to Business Value Dashboard (BVD)

OMi Performance Dashboard can be used by Performance Experts - System and Application
Administrators, to diagnose specific problems and to troubleshoot server performance.

In the Performance Perspective tab, the following panes help you visualize performance metrics:

« View Explorer

Displays a list of all the objects in your monitored environment. For more information, see "View
Explorer Component" on page 184.

« Performance Pane

Enables you to create, customize, and visualize performance dashboards.

Understanding OMi Performance Dashboard

OMi Performance Dashboard includes the following components:

« View Explorer (part of OMi)
« Performance Pane

View Explorer

The View Explorer pane displays a list of Views and the associated Cls in a tree view. The Cl tree
displays the available list of Cls. You can select the required CI for which you want to view an existing
Performance Dashboard or create a new Performance Dashboard. You can also create your own
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views. In Performance Dashboard, you can select only one CI from the tree view to create dashboards.
If you select more than one Cl, the system displays an error message stating could not load the
performance dashboard. For more information, see the topic "View Explorer Component" on page 184
in the OMi documentation.

Performance Pane

Performance Pane enables you to create and visualize performance dashboards. In addition, you can
also customize and visualize content in the performance dashboard.

To access

Click Workspaces > Operations Console > Performance Perspective
The following table explains the options available in the Performance pane.
Ul Elements Description
ki Click to create a new performance dashboard.

= Click to save the performance dashboard.

Click to forward data to BVD. This option appears only with Favorites.

% Click to refresh the performance dashboard. You get the following
options:
Refresh - You can use this option to refresh the data when connection
is lost and retrieved.
Clear Cache - You can use this option to clear cache and reload meta
data.
L Click to configure performance dashboard settings.
m Click to add rows to the performance dashboard
I Click to add charts, rows, or change other settings.
| Click to view the date range panel.
4 - Click to view Dashboards and Favorites
O] Click to view Real-Time data in the performance dashboard.

Configuring Performance Dashboard

This option enables you to configure and define the settings for a performance dashboard. These
settings can be used to create a new performance dashboard or to edit and customize an existing
performance dashboard.
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To access
1. Click Workspaces > Operations Console > Performance Perspective.
2. Inthe Performance Pane, click &*.

The following tabs are included:

General

You can use this tab to edit the properties of the performance dashboard.

g:ement Description

Title Specify the title of the performance dashboard.

Time You can select Coordinated Universal Time (UTC) or Browser time.

Correction

Auto- You can select the timeline for auto-refresh by choosing 5 minutes, 15 minutes, 30

Refresh minutes, 1 hour, 2 hour, or 1 day.

Points Determines the granularity (number of data points) on the performance dashboard. This
Every value is used in conjunction with the Maximum Points value to determine the level of
summarization to use. The following values are supported:

« auto - Selects the value to display data points within the configured limit. If the
combination of Date Range and Points Every settings results in too many points, the
Points Every value is automatically adjusted to display all of the requested data.

« raw - Displays all the data collected by the datasource for the specified duration.

« 5 min-Displays one data point for every five minutes of the specified duration.

« 15 min - Displays one data point for every fifteen minutes of the specified duration.
« 30 min - Displays one data point for every thirty minutes of the specified duration.
« hour - Displays one data point for every one hour of the specified duration.

« 3 hours - Displays one data point for every three hours of the specified duration.

« 6 hours - Displays one data point for every six hours of the specified duration.

« 12 hours - Displays one data point for every twelve hours of the specified duration.

« day - Displays one data point for every day of the specified duration.

Maximum = Determines the number of data points to be displayed on the performance dashboard

Points (default is 100 points — for auto option). This value is used to summarize the data for
each data point and to fit the chart in a single window, when Points Every value is set to
auto. For other Points Every values, Performance Dashboard determines the number of
(data points or time intervals) for each chart and provides options to view the next or
previous set of data points or intervals.

Hide Check this option to hide controls when viewing the performance dashboard.
Controls
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Features

Ul Element Description

Shared Crosshair | Check this option to compare the data within a performance dashboard.

Parameterization

This option enables you to manage multiple different instances running on different systems by defining
instance parameters in the performance dashboard.

Parameters

You can use this tab to view the parameters that are defined. You can also edit or delete the instance
parameters that are not required.

Ul Element Description

Click to edit the parameter.

Click to delete the parameter.

4

Click to close.

Add

You can use this tab to add the parameters.

Ul Element Description
Parameter Name Specify the parameter name.
Data Source Specify the data source.
Class Name Specify the class name.
Regex Specify the regular expression to filter the instance names.
_ Click to run the regex query.
Add Select to add the parameter.
Edit

You can use this tab to select a parameter and edit.

Ul Element Description

Parameter Name Specify the parameter name.
Data Source Specify the data source.
regex Specify the regex.
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Ul Element Description
Class Name Specify the class name.

— Specify the regular expression to filter the instance names.
Click to update the parameter.

Event Overlay

This option enables you to manage visualizing event information in the performance dashboard. By
specifying the events, you can visualize the occurrence of events in the performance dashboard.

Options Description

Critical Select Critical to visualize critical events in the performance dashboard.
The critical events will be specific to Cl and the time range.

Major Select Major to visualize major events in the performance dashboard. The
major events will be specific to Cl and the time range.

Minor Select Minor to visualize minor events in the performance dashboard. The
minor events will be specific to Cl and the time range.

Warning Select Warning to visualize warning events in the performance dashboard.
The wamning events will be specific to Cl and the time range.

Configuring Rows and Charts

This section provides information about configuring rows and adding charts to the dashboard.

Configure Rows
To access
1. Click Workspaces > Operations Console > Performance Perspective

In the Performance pane, click jl to create a new performance dashboard.
In the Performance pane, by default a row is already added. To add another row, click

3.
Ee=l]

4. Inthe Performance pane, click I and then select the required component.

The following components are included:
Add Chart

You can use Add Chart to include the following charts into the performance dashboard:
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Component Description
Graph Creates a graph chart.
single value Creates a single value chart. By default, the average metric value appears

in the single value chart.

Text Creates a text chart.

Pie Creates a pie chart.

Table Creates a table chart.
Set Height

You can use Set Height to define the height of the chart. Depending on your requirement, you can
choose the height. For example, you can choose 150 pixels or 200 pixels and so on.

Move

You can use this option to move the charts up or down.

Row Editor

You can use this option to edit the properties of the rows. It includes the following tabs:
General

This tab provides the following options:

Ul Element Description

Title Specify the title of the row.

Height Specify the height of the row.

Show Title Specify if you want to show the title of the row
Charts

This tab provides information about the performance dashboard components that are included into a
row. In addition, you can also move or delete the charts.

Ul Element Description

Title Displays the title of the row.

Type Displays the type of chart. For example, graph, single value, text, pie chart, or
table.

Span Specifies the span of the chart.

Move Up or Move the rows up or down.

Down

Delete Delete the chart.
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Delete Row

You can use this option to delete a row in the performance dashboard.

Collapse Row

You can use this option to collapse a row in the performance dashboard.

Configure Charts

You can use this option to configure charts.
To access:

Click the title of the chart to edit.
Ul Element and Options Description
- Click to decrease the width of the chart.

+ Click to increase the width of the chart.

Chart JSON - You can view the JSON file for the chart.
Export CSV - You can export the chart in CSV format.

Toggle Legend - Select to view the legend for the chart.

Maximize Click to maximize and display only the chart.

Edit Click to edit the charts. Using the edit option, you can
define the metrics, axis, grid, and display styles.

Duplicate Click to duplicate the chart.

Share Click to share the chart. After clicking Share, you get the

following options:

« Current Time Range - Uses the current time range
when the performance dashboard is shared using the
URL. If this option is not selected, you can share the
performance dashboard with the time-range that was
already saved.

« Current Panel Only - Displays only the current chart
when the performance dashboard is shared using the
URL. If you do not select this option, then the
performance dashboard will contain all charts.

« Include Parameters - Displays the existing parameters
when the performance dashboard is shared using the
URL. If you do not select this option, the parameters
are not included. If the chart does not contain any
parameters, then this setting is not applicable.

Add to Favorite Click to add the chart as a favorite.

X Click to delete the chart.
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Date Range Panel Option

The Date Range Panel option enables you to visualize the performance data for a specific date range
and time range.

The following table lists all the options that are available to use the date range panel.

Ul Element and Options Description
i Click to show or hide the
date range panel.
Qf25/2015, 12:07:57 PM to 9/25/2015, 4:35:07 PM You can use the slider to
I I choose the date range and

time range within the
specified start date and end
date. The specified start
date and end date is defined
inside the drop-down
custom range option.

You can choose the drop-
B Nov 25,2015 - Nov 27.2015 = down to select the following:

« Custom Range (start
Last 5 Mins date, end date, and
specific time range)

Last 15 Mins « Relative Time Options
(Last 5 minutes, Last 1
Last 1 Hour hour, and so on)
By default, the drop-down
Last & Hours displays the predefined
date range.

Last 12 Hours

Last 1 Day

Last 7 Days

Last 30 Days

Custom Range

Apply Cancel

Custom Range Options
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Ul Element and Options Description

Start Date You can use the calendar to choose the start date or you
can type the start date.

End Date You can use the calendar to choose the end date or you

can type the end date.
> Click to view the next month in the calendar.

< Click to view the previous month in the calendar.

You can specify the time range.
@ n B!G?BPMB Y o

Apply You can click Apply to make the changes.
Cancel You can click Cancel to not make the changes.
Editing Charts

You can use this option to edit charts - graph, table, pie, text, or single value. The settings for each
chart is described in detail. The common and specific settings for each chart are described in this
section.

To access:
Click the title of the chart and click Edit.

The following settings are available for each chart:

Single
Settings Graph Value Pie Table
Metrics
Axis and Grid
Display Styles
Options
Styles
Link

Metrics
You can use this tab to specify the metric attributes for the charts.
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Ul Element and Options Description

Title Specify the title of the chart.

Data Source Choose the data source. The following data sources are
supported:

o Operations Agent
« SiteScope

Class Name Depending on the data source selected, the class
names are displayed. You can choose the class name
from the list.

Metric Name Depending on the class name selected, the metric
names are displayed. You can choose the metric name
from the list.

Instance Name Depending on the metric name selected, the available

instance names are displayed. You can choose the
instance name from the list.

HPE Operations Manageri (10.10) Page 264 of 307



OMi User Guide
Chapter 19: Performance Perspective

Ul Element and Options

Label

Actions

® ) =

HPE Operations Manageri (10.10)

Description

Specifies the label which will be displayed in the chart
for the corresponding query. The label identifies this
metric in the chart. The label can be modified for one
metric at a time. The label can be a literal string, or it
can contain references to special substitution variables.

@@[LABEL] - The metric label is specified by the data
source. For example, (CPU%). If alabel is not specified
by the data source, then the metric name is used.

@@INSTANCENAME - The instance name that is
defined.

@@[METRIC] - The metric name. For example, (GBL_
CPU_TOTAL_UTIL)

@@[CLASS] - The metric class. For example:
(GLOBAL)

@@[SYSTEM] - The node name supplying the metric.
For example:(mysys.net.com)

@@[DATASOURCE] - The data source for this metric.
For example: (PA, EPC)

@@metric - The value of the metric from the same data
source and class. For example: @@BYDSK_
DEVNAME will label the metric with the value of the
BYDSK_DEVNAME metric. If the BYDSK_DEVNAME
metric value were "0", Disk@ @BYDSK_DEVNAME
would produce a label of Disk 0. Example: @@
[SYSTEM]:@@[CLASS]:@ @[METRIC] may produce
a label as "mysys.net.com:GLOBAL:GBL_CPU_
TOTAL_UTIL"

Select one of the options to perform the following
actions:

Hide metric - This option helps you to hide the metric in
the chart. If you enable this option, the metric is not
displayed in the chart. If you disable this option, the
metric displayed in the chart.

Duplicate metric - This option helps you to duplicate the
metric name and its attributes. This is useful while
defining multiple instances for the same metric. To
duplicate the metric, click the Duplicate metric option.

Remove metric - This option removes the metric.
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Ul Element and Options Description

Import Graph Template Select this option to import graph templates from OMi
Management Packs. For more information, see
"Importing Graph Templates" on page 285.

Select this option to add the metrics query.

Note: If you are importing graph templates, do not specify the system name in the title of the chart.

By default, the label of the chart is defined as @ @[METRIC]. If you are defining a chart with a
metric for different instances of a class, then chart legend is duplicated with same metric name
and chart data is not updated correctly. If you are creating a chart for different instances of a class,
it is recommended to differentiate the chart legend by specifying instance name in the label of the
chart. You can update the label of the chart as @ @[METRIC] - @ @INSTANCENAME

Axis and Grid
You can use this tab to specify the axis and grid attributes for the charts.
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Ul Element and Options
Left Y and Right Y

Show Axis

HPE Operations Manageri (10.10)

Description

Depending on your requirements, the
charts can be customized using these
attributes. Based on the selections for
Left Y and Right Y, the chart is
appended with the units, grid
attributes, and labels.

Unit - You can use this option to
specify the following:

« Unit - You can choose short,
percent, or none

o Duration - You can choose the
duration by specifying
nanoseconds, milliseconds,
microseconds, or seconds.

« Data- You can choose the data
size format by specifying bits,
bytes, or kilobytes.

« DataRate - You can choose the
data rate by specifying bits/second
or bytes/second.

Grid Max - You can use this option to
specify the grid values.

Label - You can specify the label for
Left Y and Right Y axis. The labels
appear in the chart.

Select to display x-axis and y-axis.
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Ul Element and Options

Range

Legend

HPE Operations Manageri (10.10)

Description

You can specify the range values
(Level 1 and Level 2 ) and the color
options. The chart is updated when
the metric values exceed Level 1,
Level 2 or both the values.

Level 1 - Click to choose Level 1
value. If the metric value exceeds the
specified Level 1 value, the chart will
be appended using the defined color
options.

Level 2 - Click to choose the Level 2
value. If the metric value exceeds the
specified Level 2 value, the chart will
be appended using the defined color
options.

You can select the Level 1, Level 2, or
both the values.

- Click to choose the Level 1 and
Level 2 color options. The chosen
color options will be appended to the
chart if the metric values exceed Level
1 orLevel 2.

Line Mode - Click to select line mode.
If the metric values exceed the Level 1
or Level 2 values, the chart is
appended with a line.

You can use this option to specify the
legend settings.

Show - Select to show the legend in
the performance dashboard.

Table - Select to show the legend as a
table in the performance dashboard.

Right Side - Select to show the
legend in the right side in the
performance dashboard.

Hide Empty - Select to hide empty
legend.
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Ul Element and Options Description

Legend Values You can choose the legend values
that need to appear in the chart. You
can select Min, Max, Avg, Current,
and Total. For each of these legend
values, the corresponding metric
values are appended in the chart.

Display Styles
You can use this tab to specify the display styles for the charts.

Ul Element and Options Description

Chart Options You can select the chart
options - Lines, Bars, or
Points. Depending on the
selection, the metric values
are visualized as Lines,
Bars or Points.

Line Options You can specify the line
options in the performance
dashboard by choosing the
Line Fill and Line Width.

You can also specify how
the null values should be
depicted in the performance
dashboard by defining the
Null Point Mode.

You can select staircase
line to visualize the charts
as a staircase.

Multiple Metrics You can choose how
multiple metrics can be
visualized in the chart. You
can choose Stack or
Percent. If you choose
Stack, the metric values are
stacked in the chart. If you
choose Percent, the metric
values are displayed as
percentage.
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Ul Element and Options

Tooltip

Metric Specific Overrides

Add Metric Override Rule

Label

Options

Description

You can choose how tool
tips can be depicted in the
performance dashboard.

All Metrics - Shows all
metrics on same tooltip with
a shared crosshair to help
follow all metrics.

Stacked Values - Shows
metrics as stacked values.
You can choose cumulative
or individual for specifying
how the values in stacked
charts must be calculated.

You can add custom display
styles for each metric using
metric override rule. This
will override the generic
display styles.

You can click add metric
override rule and select
specific styles for a metric
by specifying the label for
the metric.

Click to delete the metric
override rule.

Click to add the display
styles for a metric.

Click to choose the label
from the list of available
labels.

You can use this tab to specify the font and coloring options for the charts.
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Ul Element and Options

Big Value

Font Size

Unit

HPE Operations Manageri (10.10)

Description

The Big Value comprises the
following options:

Prefix - The value is prefixed with the
specified prefix name. For example,
if you specify Sample as the Prefix.
The chart is displayed as Sample
<Value>.

Value - You can choose which
values need to appear in the chart.
You can choose Min, Max, Avg,
Current, or Total.

Postfix - The value is postfixed with
the specified postfix name. For
example, if you specify MB as the
Postfix. The chart is displayed as
<Value>MB.

You can choose the font size for the
Prefix, Value, and Postfix data.

Depending on your requirements, the
charts can be customized using
these attributes. Based on the
selections, the chart is appended
with the units.

Unit - You can use this option to
specify the following:

« Unit - You can choose short,
percent, or none.

o Duration - You can choose the
duration by specifying
nanoseconds, milliseconds,
microseconds, or seconds.

« Data- You can choose the data
size format by specifying bits,
bytes, or kilobytes.

« DataRate - You can choose the
data rate by specifying
bits/second or bytes/second.
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Ul Element and Options Description

Coloring You can select the range options and
the coloring options.

Background - Select if you want a
background color to be displayed.

Value - Select if you want coloring
for the values.

Range - Specify the range values
(Level 1, Level 2, Level 3). If the
metric values exceed these levels,
then the chart is appended with the
defined color options.

Colors - Click to select and choose
colors for Level 1, Level 2, and Level
3 range values.

Invert Order - Click to invert the
order of the range values (Level 1,
Level 2, and Level 3).

Spark Lines You can view the historical data that
provides valuable context at a
glance. It does not include x ory
axis.

You can specify the following
options for spark lines:

Show - Click to show the spark
lines.

Background Mode - Click to show
the background.

Line Color - Click to specify the line
color for spark lines.

Fill Color - Click to specify the fill
color for spark lines.
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Ul Element and Options

Value to Text Mapping

Link

Description

This option enables you to map
values to text. For example, you can
map value 12 to appear as N/A. You
can do this by using the following
options:

x - Click to delete the value to text
mapping

Value - Specify the value that needs
to be mapped to text.

Text - Specify the text

+ - Click to add the value to text
mapping

You can use this option to link the chart to a performance dashboard.

Ul Element and Options
Link Label

Dashboard

Styles

Description
Specify the name for the link label.

Specify the performance dashboard to which the chart
must be linked.

You can use this tab to specify the table attributes. This option appears only for tables.

Ul Element and Options

Table Type

Styling Options

Sorting

Formatting

HPE Operations Manageri (10.10)

Description

You can choose the table type as TimeSeries or
Structured. If you choose TimeSeries, the metric
values are for a specific duration are displayed. If
you choose Structured, the latest metric values are
displayed.

You can define the column width.

You can enable this option to choose table sorting.
By enabling sorting, you can sort the column
headers in ascending or descending order. It allows
multi-level sorting. You can sort the data of one
column and then followed by another column.

You can define the formatting by choosing the
decimal places. The values are updated
accordingly.
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Ul Element and Options Description

Time as Date You can select this option if you want to display the
time as date. If selected, the UNIX timestamp will
be displayed in a regular date format.

Column Coloring You can select the column coloring options.

Background - Select if you want a background
color to be displayed.

Value - Select if you want values to be displayed.

Range - Specify the range values (Level 1, Level 2,
Level 3). If the metric values exceed these levels
then the chart is appended with the defined color
options.

Colors - Click to select and choose colors for Level
1, Level 2, and Level 3.

Invert Order - Click to invert the order of the range
values (Level 1, Level 2, and Level 3).

Getting Started

The following section provides information about the tasks that you need to perform to start using OMi
Performance Dashboard.

Task 1: Creating Performance Dashboard

You can create the performance dashboard. For more information, see Creating Performance
Dashboard

Task 2: Configuring Performance Dashboard

After creating the performance dashboard, you need to add content and configure the performance
dashboard. For more information, see Configuring Performance Dashboard.

Task 3: Launching Performance Dashboard

After configuring the performance dashboard, you can launch the performance dashboard to visualize
the performance metrics. For details, see "Launching a Performance Dashboard" on page 283.

For more information about designing and managing performance dashboard, see Designing
Performance Dashboard and Managing Performance Dashboard.
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Designing Performance Dashboard

OMi Performance Dashboard comprises out-of-the-box dashboards for exploring and visualizing the
performance metrics. In addition, you can also create customized performance dashboards to visualize
the performance metrics of Cls.

Using OMi Performance Dashboard, you can perform the following tasks to manage the performance
dashboard:

Creating Performance Dashboard
Configuring Performance Dashboard
Visualizing Events in the Performance Dashboard

Managing Different Multiple Instances across Systems using Instance Parameterization

Creating Performance Dashboard

You can create and customize dashboards. Using the Performance Pane, you can create the
performance dashboard for visualizing the performance metrics.
To create the performance dashboard from OMi, follow these steps:

Click Workspaces > Performance Perspective.

2. Inthe View Explorer pane, select the View from the drop-down list. For example, you can select
System_Infrastructure to view the Cls associated with this view.

3. Inthe View Explorer pane, click the CI for which you want to create a performance dashboard.
In the Performance pane, click New to create a new performance dashboard.

5. You can create rows and add the charts such as graph, table, pie, single value, and text into the
performance dashboard. For more information, see "Configuring Performance Dashboard" below.

Configuring Performance Dashboard

This section provides step-by- step information about creating and configuring a performance
dashboard. Before configuring the performance dashboard, you must create a new performance
dashboard. For more information, see "Creating Performance Dashboard" above.

Add the Rows and Required Charts

You must add new rows and then you can add a graph, single value, table, pie chart, or text to the
performance dashboard.

1. Click Workspaces > Operations Console > Performance Perspective

2. Inthe Performance pane, click m

3. Inthe Performance pane, cIickI > Add Charts.

Note: You can also drag and drop charts to another row.
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4. Click the required chart. For example, you can select Graph.
5. The chart is added to the performance dashboard. Similarly, you can add the required charts to the
performance dashboard.

Edit the Charts
You can click the title to edit and configure the charts. You can modify the attributes of the charts.
1. Inthe Performance pane, click the title of the chart to edit. For example, you can click the title of
the graph to edit.
2. Click Edit. You can now add or modify the Metrics, Axis & Grid, and Display Styles.
3. After specifying the attributes, you can click Back to Dashboard. For more information about
editing charts, see "Editing Charts" below.

Save the Performance Dashboard

1. Inthe Performance pane, click Save to save the performance dashboard.

2. Specify a name and click Save.

Editing Charts

You can edit and customize the charts - graph, single value, text, pie, and table. Before editing charts,
you need to create or launch an existing performance dashboard. For information about creating a
Performance Dashboard, see "Creating Performance Dashboard" on the previous page. For
information about launching an existing Performance Dashboard, see "Launching a Performance
Dashboard" on page 283. After you create or launch a Performance Dashboard, you need to configure
the Performance Dashboard. For more information, see "Configuring Performance Dashboard" on the
previous page

How to Edit Charts (graph, single value, pie, and table)

To edit the charts, click the title of the chart and click Edit. Depending on the chart type, the different
options appear. To specify the attributes for the charts, follow these tasks:

Task 1: Specifying the Metrics

You can specify the metrics and other attributes using the Metrics tab. This tab is available for Graph,
Single Value, Pie, and Table. To define these attributes, follow these steps:
1. Specify the title of the chart. This title appears in the top of the chart.

2. Choose the data source. The data sources - Operations Agent and Site Scope are supported. You
can choose one of the data sources.

3. Depending on the data source selected, the class names are displayed. You can choose the class
name from the list.

4. Depending on the class name selected, the metric names are displayed. You can choose the
metric name from the list.

5. Depending on the metric name selected, the available instance names are displayed. You can
choose the instance name from the list.

6. Specify the label which will be displayed in the chart for the corresponding query. The label
identifies this metric in the chart.

N

<optional> Select one of the options to perform the following actions:
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a. Hide metric - This option helps you to hide the metric in the chart. If you enable this option, the
metric is not displayed in the chart. If you disable this option, the metric displayed in the chart.

b. Duplicate metric - This option helps you to duplicate the metric name and its attributes. This is
useful while defining multiple instances for the same metric. To duplicate the metric, click the
Duplicate metric option.

c. Remove metric - This option removes the metric.
<optional> To add more metrics, click Add Metric
<optional> If you are using OMi Management Packs and need to import graph templates, you can

click e . For more information about importing graph templates, see
"Importing Graph Templates" on page 285.

Task 2: Specifying the Axis and Grid

Depending on your requirements, the charts can be customized using the following attributes. This tab
is available only for Graph charts. You can define a host of attributes such as axis, grid, range, legend,
and so on using the Axis and Grid tab. To define these attributes, follow these steps:

1.

Based on the selections for Left Y and Right Y, the chart is appended with the units, grid
attributes, and labels.

Units: You can choose any of the following units:

o Unit - You can choose short, percent, or none

o Duration - You can choose the duration by specifying nanoseconds, milliseconds,
microseconds, or seconds.

o Data-You can choose the data size format by specifying bits, bytes, or kilobytes.
o DataRate - You can choose the data rate by specifying bits/second or bytes/second.

Grid Max - You can use this option to specify the grid values.
Label - You can specify the label for Left Y and Right Y axis. The labels appear in the chart.

In Show Axis, you can select X-Axis and Y- Axis if you want to view it in the performance
dashboard.

In Range, you can specify the range values (Level 1 and Level 2 ) and the color options. The chart
is updated when the metric values exceed Level 1, Level 2 or both the values.

a. Level 1-Click to choose Level 1 value. If the metric value exceeds the specified Level 1
value, the chart will be appended using the defined color options.

b. Level 2-Click to choose the Level 2 value. If the metric value exceeds the specified Level 2
value, the chart will be appended using the defined color options.

c. Click to choose the Level 1 and Level 2 color options. The chosen color options will be
appended to the chart if the metric values exceed Level 1 or Level 2.

d. Line Mode- Click to select line mode. If the metric values exceed the Level 1 or Level 2
values, the chart is appended with aline.

In Legend, you can specify the legend settings.
Show - Select to show the legend in the performance dashboard.
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Table - Select to show the legend as a table in the performance dashboard.
Right Side - Select to show the legend in the right side in the performance dashboard.
Hide Empty - Select to hide empty legend.

5. InLegend Values, you can choose the legend values that need to appear in the chart. You can
select Min, Max, Avg, Current, and Total. For each of these legend values, the corresponding
metric values are appended in the chart.

Task 3: Display Styles
You can customize the display styles for the charts using the Display Styles tab. This tab is available
only for Graph charts.

1. In Chart Options, you can select the chart options - Lines, Bars, or Points. Depending on the
selection, the metric values are visualized as Lines, Bars or Points.

2. InLine Options, you can specify the line options in the performance dashboard by choosing the
Line Fill and Line Width. For example, you can specify Line Fill as 6 and Line Width as 4. The chart
is updated accordingly.

3. InLine Options, you can also specify how the null values should be depicted in the chart by
defining the Null Point Mode as Connected, Null, or Null as Zero.

In Line Options, you can select staircase line to visualize the charts as a staircase.

In Multiple Metrics, you can choose how multiple metrics can be visualized in the chart. You can
choose Stack or Percent. If you choose Stack, the metric values are stacked in the chart. If you
choose Percent, the metric values are displayed as percentage.

6. InTooltip, you can choose how tool tips can be depicted in the performance dashboard. You can
choose the following option:

All Metrics - Shows all metrics on same tooltip with a shared crosshair to help follow all metrics.

7. InMetric Specific Overrides, you can add custom display styles for each metric using metric
override.

a. Click Add Metric Override Rule. The metric override rule appears.
b. Inthe label field, click to choose a metric label from the list of available labels.
c. Click ¥ tochoose the display style. You can use this option and also choose more display

styles for a specific metric label. For example, you can choose Bars as true and Line Fill as 4
for a specific metric label.

d. The chart will be updated with the bars and line fill as 4 for the chosen metric label.

€. <optional> To delete a metric override rule, choose X

Task 4: Specifying the Options

You can use the Options tab to specify the Prefix or Postfix data, coloring options, value to text
mapping and so on. This tab is available only for Single Value and Pie charts. To define these
attributes, follow these steps:

1. InBig Value, you can specify the following options:
a. Prefix - The value is prefixed with the specified prefix name. For example, if you specify
Sample as the Prefix. The chart is displayed as Sample <Value>.

b. Value - You can choose which values need to appear in the chart. You can choose Min, Max,
Avg, Current, or Total.
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c. Postfix - The value is postfixed with the specified postfix name. For example, if you specify
MB as the Postfix. The chart is displayed as <Value>MB

2. InFont Size, you can choose the font size for the Prefix, Value, and Postfix data.
In Unit, you can choose any of following options that will be displayed in the chart.
o Unit - You can choose short, percent, or none

o Duration - You can choose the duration by specifying nanoseconds, milliseconds,
microseconds, or seconds.

o Data- You can choose the data size format by specifying bits, bytes, or kilobytes.
o Data Rate - You can choose the data rate by specifying bits/second or bytes/second.

4. InColoring, you can select the following range options and the coloring options.
a. Background - Select if you want a background color to be displayed.

b. Value - Select if you want coloring for the values.

c. Range - Specify the range values (Level 1, Level 2, and Level 3). If the metric values exceed
these levels then the chart is appended with the defined color options.

d. Colors - Click to select and choose colors for Level 1, Level 2, and Level 3 range values.
e. Invert Order - Click to invert the order of the range values (Level 1, Level 2, and Level 3).

5. In Spark Lines, you can view the historical data that provides valuable context at a glance. It does
not include x ory axis. You can specify the following options:
a. Show - Click to show the spark lines.

b. Background Mode - Click to show the background.
c. Line Color - Click to specify the line color for spark lines.
d. Fill Color - Click to specify the fill color for spark lines.

6. InValue to Text Mapping, you can map values to text. For example, you can map value 12 to
appear as N/A. You can do this by using the following options:
a. x-Click to delete the value to text mapping

b. Value - Specify the value that needs to be mapped to text.
c. Text- Specify the text
d. +-Click to add the value to text mapping

Task 5: Specifying the Styles

You can use the Styles tab to specify the table attributes. This tab is available only for Table charts. To
define these attributes, follow these steps:

1. InTable Type, you can choose the table type as TimeSeries or Structured. If you choose
TimeSeries, the metric values for a specific duration are displayed. If you choose Structured, the
latest metric values are displayed.

In Styling options, you can choose the width of the columns.

In Sorting, you can select if you want table sorting. By enabling sorting, you can sort the column
headers in ascending or descending order. It allows multi-level sorting. You can sort the data of
one column and then followed by another column.
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4. InFormatting, you can define the formatting by choosing the decimal places. The values are
updated accordingly.

5. InTime as Date, you can select if you want to display the time as date. If selected the UNIX
timestamp will be displayed in a regular date format.

6. InColumn Coloring, you can select the range, coloring options and so on. You can do the
following:
a. Background - Select if you want a background color to be displayed.

b. Value - Select if you want values to be displayed.

c. Range - Specify the range values (Level 1, Level 2, and Level 3). If the metric values exceed
these levels then the chart is appended with the defined color options.

d. Colors - Click to select and choose colors for Level 1, Level 2, and Level 3.
e. Invert Order - Click to invert the order of the range values (Level 1, Level 2, and Level 3).

Task 5: Specifying the Link

You can use this option to link the chart to a performance dashboard. This tab is available only for
Graph and Pie charts.

1. InLink Label, specify the name for the link label. The chart will be linked to the performance
dashboard using the link.

2. In Dashboard, specify the performance dashboard to which the chart must be linked.

Click Back to Dashboard. In the Performance Pane, at the bottom of the performance
dashboard, an arrow appears with the link label.

4. If you click the click the link, it points to the performance dashboard that was specified.

How to Edit Text Charts

You can use text charts to add information that helps you understand the chart data. To specify
information for the text charts, follow these steps:

1. To edit the text charts, click the title of the chart and click Edit.
In Title, specify the title of the text chart. This information will appear in top of the text chart.

In Mode, choose Markdown, Text, or HTML. Based on the selection, you can write the text
accordingly.

4. In Content, you can write the content in the specified format. This content will appear in the text
chart.

5. Click Close to exit and return to the performance dashboard.

Visualizing Events in the Performance Dashboard

Using the event overlay feature, you can visualize when the events of a specific severity occurin the
time frame shown in the performance dashboard. By visualizing such events, you can diagnose
specific issues.

Use Case: If there is a spike in the metric, and if the spike can be overlaid on the performance
dashboard along with the event being generated, this helps the performance expert to co-relate
information about the spike and the event generated. The performance expert can diagnose and take
action.
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How to Visualize the Events in the Performance Dashboard

You can visualize the events into a new performance dashboard or to an existing performance
dashboard. For information about creating a performance dashboard, see "Creating Performance
Dashboard" on page 275. For information about launching an existing performance dashboard, see
"Launching a Performance Dashboard" on page 283.

1. Inthe Performance Pane, click #* . The Dashboard Settings appear.
In the Dashboard Settings, click Event Overlay.
Select the event types that you want to visualize in the performance dashboard:

Major - Displays Major events within the chosen time range in the performance dashboard. The
major events are highlighted in orange.

Critical - Displays Critical events within the chosen time range in the performance dashboard. The
critical events are highlighted in red.

Minor - Displays Minor events within the chosen time range in the performance dashboard. The
critical events are highlighted in yellow.

Wamning - Displays Warning Events within the chosen time range in the performance dashboard.
The critical events are highlighted in blue.

Click Close

5. Inthe Performance Pane, you can visualize the events in the performance dashboard based on
your selections.

Managing Different Multiple Instances across Systems using
Instance Parameterization

You can manage multiple different instances running on different systems by defining instance
parameters in the performance dashboard. For example, if System A has 3 instances for metric class X
and System B has 4 instances for metric class X, you can create a performance dashboard with
instance parameter for metric class X and reuse the performance dashboard on both the systems. The
instance parameter gets updated with the instances of metric class X dynamically based on the
system.

Use Case: If you have many disks or application instances and you want to visualize the performance
metrics for only some disks or application instances. You can use Instance Parameterization and
visualize the performance metrics for some instances.

How to Define Instance Parameters

You can define the instance parameters in a new performance dashboard or to an existing performance
dashboard. For information about creating a performance dashboard, see "Creating Performance
Dashboard" on page 275. For information about launching an existing performance dashboard, see
"Launching a Performance Dashboard" on page 283.

In the Performance pane, click ¥ . The Dashboard Settings page appears.

Click the Parameterization tab. The Parameterization page appears.

Click the Add tab to define the instance parameters.

A o bd =

In the Add tab, you can specify the parameter Name and other fields.
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5. You can select the Data Source. The available Data Sources are listed based on the Cl that is
selected in the View Explorer.

6. You can select the Class Name. The available Class Names are listed based on the Cl that is
selected in the View Explorer.

7. After selecting the Class Name, the available instances for the Class Name are displayed.

8. You can specify the regular expression in the regex field to filter the instance names. For example
you can specify test* to retrieve all the class names starting with the keyword test.

9. Click Add to add the parameter.
The parameter name appears in the parameters tab.

How to View the Instance Parameters in the Performance Dashboard

1. Inthe Performance pane, click == and click the performance dashboard to view. For example,
you can click any out-of-the-box performance dashboard.
2. Inthe Performance pane, you can view the parameter and the instances in a drop-down list.

3. You can choose the drop-down list and select the instances for which you want to visualize the
performance metrics. In addition, the drop-down list contains the following options:

a. Select All - Click to select All Instances.

b. Select None - Click to show no instances.
How to Use the Defined Instance Parameters

1. In the Performance pane, click == and click the performance dashboard to view the content. For
example, you can click any out-of-the-box performance dashboard to view the content of the
performance dashboard.

2. Click the panel and click Edit.
Click the Metrics tab and specify all the fields - Data Source, Metric Name, and Class Name.

4. Specify the Instance Name. In this case, you must specify the parameter Name. You must prefix
the parameter name with $.

5. Click Back to Dashboard.
The graph chart is updated with the instances.

Managing Performance Dashboard

This section provides information about the tasks related to managing performance dashboard.

Using OMi Performance Dashboard, you can perform the following tasks to manage the performance
dashboard:

Launching a Performance Dashboard
Saving a Performance Dashboard

Exporting a Performance Dashboard
Importing a Performance Dashboard

Adding and Using Favorites
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Data Forwarding to Business Value Dashboard (BVD)
Using the Date Range Panel to Visualize Time-Specific Data
Using the Dashboard JSON

Deleting a Performance Dashboard

Launching a Performance Dashboard

You can launch the out-of-the box performance dashboards and the dashboards that you have created.
You can launch the performance dashboards using one of the following methods:

Using the Performance Perspective
To list the dashboards for a specific Cl, follow these steps:
1. Inthe View Explorer pane, select View. For example, you can select System_Infrastructure and
view the Cls related to System_Infrastructure.
2. Inthe View Explorer pane, you can choose a specific Cl for which you want to view the
performance dashboards.
In the Performance pane, click == to view the available dashboards for a specific Cl.

Click an item to view the performance dashboard. For example, you can click any out-of-the-box
performance dashboard. In addition, you can search for a performance dashboard by specifying
the title in the search option.

The performance dashboard appears in the Performance pane.

Note: You cannot delete the out-of-the-box performance dashboards. Hence, they do not
have a delete option.

Using the Event Perspective tab:

1. Click Workspaces > Operations Console > Event Perspective.

2. Click the event for which you want to view a performance dashboard in the Event Browser pane.

3. Inthe Actions pane, click Show Performance Dashboard to view the performance dashboard.
Using My Workspace
You can add OMi Performance Dashboard as a component to a My Workspace page by following these
steps:

1. Click New Page button in the Page Management tool bar. You can add the OMi Performance

Dashboard component to an existing page.

2. Click Split button. (optional) You can split the layout area into a number of vertical or horizontal
panes.

3. Click Add Componenticon. Double-click Performance Dashboard or drag it from the
Component Gallery window to place it in one of the panes.
Alternatively, click Component button in the Page Management tool bar. Select Performance
Management > Performance Dashboard from the component gallery and drag it to any area on
the page.
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4. (optional) Select View Explorer from the component gallery and drag it to any area on the page.
You can get the Cl information from other Ul mashup components.

Saving a Performance Dashboard

You can use the save option to perform the following actions:

« Save the performance dashboard as the home page

« View the performance dashboard JSON

« Export the performance dashboard

To save the performance dashboards, follow these steps:

Using Performance Perspective:

1. Inthe View Explorer pane, select the View and then select the Cl. For example, you can select
System_Infrastructure and view the Cls related to System_Infrastructure.

2. Inthe Performance pane, click New to create a performance dashboard.
For information about creating a performance dashboard, see Creating Performance Dashboard.

3. Click = to save the performance dashboard. The Save Page appears with the following options:

a. Save as Home - Save the performance dashboard as home page.

b. Dashboard JSON - Select to save the Dashboard JSON.

c. Export Dashboard - Select to export the performance dashboard.
4. Specify the name of the performance dashboard and click =

A message appears stating that the performance dashboard is saved.

Exporting a Performance Dashboard

You can export the performance dashboard to edit or review the performance dashboard content.
To export the performance dashboards, follow these steps:

1. Inthe View Explorer pane, select View and then select the Cl. For example, you can select
System_Infrastructure and view the Cls related to System_Infrastructure.

2. Inthe Performance pane, click New to create a performance dashboard.
For information about creating a performance dashboard, see Creating Performance Dashboard

3. Click =l to save the performance dashboard. The Save Page appears with the following options:

a. Save as Home - Save the performance dashboard as home page.
b. Dashboard JSON - Select to save the Dashboard JSON.
c. Export Dashboard - Select to export the performance dashboard.

4. Click Export Dashboard. If you want to include the instances already existing in the performance
dashboard, select Include Instances.

The performance dashboard is saved locally.
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Note: If you are selecting a Microsoft Excel or a TSV graph, you must configure the browser
settings to display Microsoft Excel and TSV files.

Importing Graph Templates

You can import graph templates from OMi Management Packs into OMi Performance Dashboard. This
helps you visualize the performance metrics as a performance dashboard for a host of applications.

How to Import Graph Templates

You can import graph templates to a new performance dashboard or to an existing performance
dashboard. For information about creating a new performance dashboard, see "Creating Performance
Dashboard" on page 275.

To import graph templates to an existing performance dashboard, follow these steps:

1.

In the View Explorer pane, select the View and then select the Cl. For example, you can select
System_Infrastructure and view the Cls related to System_Infrastructure.

In the View Explorer pane, you can choose a specific Cl for which you want to view the
performance dashboards.
Click == to view the available performance dashboards for a specific Cl.

Click an item to view the performance dashboard. For example, you can click any out-of-the-box
performance dashboards. In addition, you can search for a performance dashboard by specifying
the title in the search option.

The performance dashboard appears in the Performance pane.

If you already have a graph chart in the performance dashboard, you can click the title of the graph
chart and then click Edit. The graph options appear.

If you do not have a graph chart, you need to configure the performance dashboard and add a
graph chart. For more information, see "Configuring Performance Dashboard" on page 275.

Click Import Graph Template. Navigate to the specific Management Pack and select the
appropriate graph templates.

Click Import. The graph templates are imported to the performance dashboard.

Duplicating Charts

You can duplicate the charts within the performance dashboard. This feature enables you to create a
copy of the chart which can be edited and customized easily.

1.

In the View Explorer pane, select the View and then select the CI. For example, you can select
System_Infrastructure and view the Cls related to System_Infrastructure.

In the View Explorer pane, you can choose a specific Cl for which you want to view the
dashboards.
Click == to view the available performance dashboards for a specific Cl.

Click an item to view the performance dashboard. For example, you can click any out-of-the-box
performance dashboard. In addition, you can search for a performance dashboard by specifying
the title in the search option.

HPE Operations Manageri (10.10) Page 285 of 307



OMi User Guide
Chapter 19: Performance Perspective

5.

The performance dashboard appears in the Performance pane.

If you already have a chart in the performance dashboard, you can click the title of the chart and
then click Duplicate. A copy of the chart is created and added to the consequent row in the
performance dashboard.

Importing a Performance Dashboard

You can import the performance dashboard using the Import feature.

To import the performance dashboards, follow these steps:

1.

In the View Explorer pane, select the View and then select the CI. For example, you can select
System_Infrastructure and view the Cls related to System_Infrastructure.

In the Performance pane, click == and then click Import.

Click Browse and select the performance dashboard that needs to be imported.

Click Open.

The performance dashboard is imported successfully.

After importing the performance dashboard, you have to click Save to load the content for the
current ClI.

Sharing a Performance Dashboard

You can share the URL of dashboard or charts (graphs, singlevalue, table, text, and pie) and embed in
My Workspace page or any Ul mashup page. This feature helps you to quickly and easily share
performance dashboards or charts.

How to Share a Performance Dashboard

1.

In the View Explorer pane, select the View and then select the CI. For example, you can select
System_Infrastructure and view the Cls related to System_Infrastructure.

In the View Explorer pane, you can choose a specific Cl for which you want to view the
dashboards.

Click == to view the available dashboards for a specific Cl.

Click an item to view the performance dashboard. For example, you can click any out-of-the-box
performance dashboards. In addition, you can search for a performance dashboard by specifying
the title in the search option.

The performance dashboard appears in the Performance pane.
If you already have a graph chart in the performance dashboard, you can click the title of the
chart and then click Share. The following options appear:

o Current Time Range - Uses the current time range when the performance dashboard is shared
using the URL. If this option is not selected, you can share the performance dashboard with the
time-range that was already saved.

o Current Chart Only - Displays only the current chart when the performance dashboard is shared
using the URL. If you do not select this option, then the performance dashboard will contain all
charts.
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o Include Parameters - Displays the existing parameters when the performance dashboard is
shared using the URL. If you do not select this option, the parameters are not included. If the
chart does not contain any parameters, then this setting is not applicable.

You can choose the required options and copy and share the performance dashboard URL.

If you have created a performance dashboard and do not have a chart, you need to configure the
performance dashboard and add a chart. For more information, see "Configuring Performance
Dashboard" on page 275.

Adding and Using Favorites

The Favorites feature helps you to quickly visualize the performance metrics of frequently monitored
Cls. The Favorites comprises group of charts from different Cls. For example, if you are monitoring Cls
- A and B, and you want to visualize the CPU utilization in the form of a graph for the first Cl and the
CPU Percentage breakdown in the form of a table for the other Cl. You can add the charts - graphs and
table from specific Cls to the Favorites for faster visualization of performance data.

By default, there is a My Favorite that is available. You can add any number of user-defined Favorites
for quick visualization of performance metrics from different Cls. The default My Favorite is available
for all the users. Each user can see the charts that they have added. The user-defined Favorites are
user specific. The Favorites created by one user are not available to other users.

Use Case: Consider a scenario where as an Administrator you want to see the performance of all

business critical servers and applications from a single performance dashboard. You do not want to
view different performance dashboards to visualize this information. You can view the performance
metrics for business critical servers in a single performance dashboard using the Favorites feature.

How to Add Favorites and Create User-Defined Favorites

1. Inthe View Explorer pane, select the View from the drop-down list. For example, you can select
System_Infrastructure to view the Cls associated with this view.

2. Inthe View Explorer pane, click the CI for which you want to create a performance dashboard.
3. Inthe Performance pane, click == and click the performance dashboard to view the performance

dashboard. For example, you can click any out-of-the-box performance dashboard to view the
content.

4. Inthe Performance pane, click the title of the chart and then click Add to Favorite. The Favorites
appears with the selection options. You can add the Favorite to the default performance
dashboard, user-defined Favorite or create a new user-defined Favorite To create a new user-
defined Favorite , follow these steps:

a. Click + to create a user-defined Favorite.
b. Specify the name for the user-defined Favorite.
5. Click Save.
Note: You can perform the same steps for adding other Favorite charts.

How to View Favorites

In the Performance pane, click == and click the My Favorite or user-defined Favorites to view the
Favorite charts. For example, you can click My Favorite to view the Favorite charts. The My Favorite
appears with the frequently used Cls.
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How to Delete Favorite performance dashboards
In the Performance pane, click == The list of performance dashboards and favorites appear.

1. You can hover over the Favorite that you want to delete and click oy . For example, you can
hover over My Sample Favorite and click Ty .
2. Click Yes. A message appears stating that the Favorite is deleted.

Note: You cannot delete the out-of-the box default Favorite - My Favorite.

Data Forwarding to Business Value Dashboard (BVD)

OMi Performance Dashboard supports integration with BVD. The critical performance metrics from
different datasources is forwarded from OMi Performance Dashboard to Business Value Dashboard
(BVD). The performance metrics can be visualized in BVD. This option is available only with the
Favorite feature. Before enabling the data forwarding to BVD, you must complete the task for adding
favorites. For more information, see "How to Add Favorites and Create User-Defined Favorites" on the
previous page. Before you forward data to BVD, ensure that you have the defined the Infrastructure
Settings for BVD. . For more information, see the section Infrastructure Settings for OMi Performance
Dashboard in the the OMi Administration Guide

How to Forward Data to BVD

1. Inthe Performance pane, click == and click the My Favorite page or user-defined pages to view
the Favorite charts. For example, you can click My Favorite to view the Favorite charts. The My
Favorite page appears with the frequently used Cls.

2. Inthe Performance pane, click to enable or disable BVD.
The OMi Performance Dashboard forwards the data to BVD.

Note: For information about using BVD, see the BVD documentation.

Using the Date Range Panel to Visualize Time-Specific Data

You can use the date range panel to visualize performance data for specific date and time range. You
can perform the following operations by using the date range panel:

« Use the slider and choose the specific date range and time range within the specified start date and
end date.

« Use the custom range option to choose the start date and end date from calendar for visualizing
custom time-specific data.

« Select relative time options for visualizing data. You can choose relative time options such as last 5
minutes, last 1 hour, and so on.

Note: To visualize time-specific data, you can use either date range panel or real-time. If you are
using date range panel to visualize data, the real-time option will be disabled.

To perform these operations using the date range panel, follow these steps:
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1. Inthe View Explorer pane, select the View from the drop-down list. For example, you can select
System_Infrastructure to view the Cls associated with this view.

2. Inthe View Explorer pane, click the CI for which you want to open a performance dashboard and
use the date range panel.

3. Inthe Performance Pane, click == and click any of the performance dashboard to view the
performance dashboard. For example, you can click any out-of-the-box performance dashboard to
view the content.

Click L] to view the date range panel.

5. You can use the slider to view the performance data for a specific date range and time range within
the specified Start Date and End Date. You can drag the slider and choose the specific date range
and time range.

6. You can select the drop down to view the different options that are available. To choose the
custom options (start date, end date, and specific time periods) follow these steps:
a. You can choose the date period by specifying the Start Date and End Date. For example, you
can choose October 2nd, 2015 as the Start Date and October 3rd, 2015 as the End Date for
visualizing time-specific data.

b. You can also choose the timeline for the already specified dates.

c. Click Apply to make the changes. The date range and time range changes will appear in the
slider.

d. Youcan now use the slider and choose the date range and time range within the specified
start date and end date. The performance dashboard is visualized according to the selection.

7. You can also use the drop down to choose the relative time for data visualization. For example,
you can click last 5 minutes or last 1 hour and so on. The performance dashboard is visualized
according to the relative time selection.

Using the Dashboard JSON

You can use the Dashboard JSON to view the metadata or attributes of the performance dashboard.
For example, you can use the Dashboard JSON to review the metric names.

Sample Dashboard JSON

The following image provides information about the structure of performance dashboard JSON.
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Dashboard

Row

Panel

Target-1
Target -2

Dashboard JSON

The performance dashboard JSON contains the following attributes:

Element Attribute Description
Row Title You can specify the title of the row.
Height You can specify the height of the row.
Charts Title You can specify the title of the chart.
Span You can specify the width of the chart ranging from 1-
12.
Targets Data Source You can specify the data source.
Class Name You can specify the class name.
Metric You can specify the metric name.
Instance You can specify the instance name.

Deleting a Performance Dashboard

You can delete the performance dashboards that you have created. You cannot delete the out-of-the-
box performance dashboards.

To delete performance dashboards, follow these steps:

1. Inthe View Explorer pane, select the View and then select the ClI.

For example, you can select System_Infrastructure and view the Cls related to System_
Infrastructure.

In the Performance pane, click == to view the existing performance dashboards.
3. Navigate to the performance dashboard and select Delete.
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4. Click Yes to delete the performance dashboard.
A message appears stating the performance dashboard is deleted.

Visualizing Real-time Data

Real-time feature helps you to visualize real-time data in the performance dashboard. You can switch
from historical data to real-time data quickly. By default, the real-time data is available for 30 minutes
time range. In addition, you can define the time range for visualizing the real-time data. The real-time
data is auto refreshed every 5 seconds. If you enable real-time, then the time-specific data chosen
using Date Range Panel will be overwritten with the real-time data in the performance dashboard. If you
disable real-time, then the time-specific data chosen using the Date Range Panel will be available in
the performance dashboard. By default, when you select real-time the real-time data appears in the
performance dashboard with a blue background. The real-time feature is available only for the following
data sources:

« HPE Operations Agent
« SiteScope
How to Enable or Disable Real-time

You must create or open an existing performance dashboard and then you can enable or disable real-
time data visualization. To enable or disable real-time data visualization, follow these steps:

1. Inthe View Explorer pane, select the View and then select the Cl. For example, you can select
System_Infrastructure and view the Cls related to System_Infrastructure.

2. Inthe View Explorer pane, you can choose a specific Cl for which you want to view the
dashboards.

Click == to view the available performance dashboards for a specific Cl.

Click an item to view the performance dashboard. For example, you can click .any out-of-the-box
performance dashboard.

The performance dashboard appears in the Performance pane.
5. Inthe Performance pane, click © . By selecting real-time, you are enabling real-time data
visualization in the performance dashboard. If you cancel the selection, the real-time data is no

longer displayed and it rolls back to the previous settings that were chosen using the date range
panel.

The real-time data is now visualized in the performance dashboard.
Configuring SiteScope for Real-time
SiteScope version 11.22 and above is supported for real-time.
To get the real-time data from SiteScope, follow these steps:

Go to SiteScope Server Ul
Click Preferences Option > Search Filter/Tag.

Click New Tag. Specify the Tag Name. For example, you can specify PMiDefault.

Ao Dd =

Click New for Values. Type the value name and value description. For example, you can specify
PMiDefault as the value name and value description.
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5. Click OK and then click Monitors. Select a group or specific monitor for which you want real-time
data and click Properties and then click Search/Filter tag.

6. Select the tag that was created and click Save.
Go to Preferences > Integration Preferences.

Click New and select Data Integration and specify the following details:
a. Type the name. For example, you can specify name as PMiDefault.

b. Type the Receiver URL as http://<OMi_GateWay_Server_host_
name>/OVPM/SiteScopeDataReceiver.

Type the Encoding as UTF-8.

Type the Reporting Interval as 15 seconds.

Type the Time Synchronization Interval as 10 minutes.
Select GZIP compression only.

@ -~ 0o 2 0

Web Server Security Settings - Type the username and password of the OMi server Ul if the
server is configured to use basic authentication. Otherwise, leave it as blank.

h. Reporting Tags - Select the tag that was newly created and click OK.
For more information about configuring SiteScope for real-time, see Data Integration Preferences
Dialog Box section of Sitescope Help.

Configuring HPE Operations Agent for RTM

If you are using Operations Agent version 11.x, then RTMD services should be running in the
Operations Agent. If you are using Operations Agent version 12.00, HPCS should be running in the
Operations Agent. For more information, see the HPE Operations Agent documentation.

Data Sources

A data source can be an agent, agent component, or agentless collector that monitors an entity or an
element on which it is deployed.

OMi Performance Dashboard supports the following data sources:

« HPE Operations Agent

« SiteScope

« BSM Connector

« Application Performance Management (APM)
« Virtualization Performance Viewer (vPV)

OMi Performance Dashboard validates the data source set for the Monitored_by attribute in RTSM
and collects data only from the listed data sources. For example, if a Cl is monitored only by
SiteScope, then OMi Performance Dashboard collects data only from SiteScope data sources. If no
value is set for the Monitored_by attribute, OMi Performance Dashboard tries to connect to the HPE
Operations agent data source.

The data sources continuously collect data about the monitored elements and store it in the data store
for future use. Performance Graphing enables you to visualize this historical data stored in the
persistent data stores.
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Note: The Real-Time Metric Access component of the HPE Operations agent (11.00) provides
you with real-time access to performance data for a monitored element. For more information,
see the HPE Operations agent documentation.

Metrics

A metric is a measurement that gives an indication of the operational health and performance of a
resource. It is a parameter or a set of parameters that can be used to monitor and measure the health,
performance, and availability of a monitored resource.

OMi Performance Dashboard enables you to visualize this data in several formats such as graphs,
tables, and so on. A performance dashboard consists of data points available for the selected metrics.
A metric class is a set of related metrics grouped together based on the type of data it reports.

The metric values collected by the HPE Operations Agent and HPE Performance Agent provide
information about the monitored systems: processes, applications, transactions, CPU, file system,
disk, network interface, and logical systems. These details indicate operational efficiency and health of
the monitored system. In addition, various Smart Plug-ins (SPIs) supplement these agents to provide
in-depth information about different applications running on these managed systems.

SiteScope collects metrics from different systems without the help of the agent software. Metric values
collected by SiteScope provides information on the server health, availability of a URL, Web service,
database, or application servers. These collected parameters indicate the availability and performance
of the IT infrastructure.

BSM Connector integrates data collected by third-party systems (typically, enterprise management
systems) in OMi. The metrics collected by BSM Connector provide information about the systems and
applications monitored by the third-party software.

For details, see the OMi Integrations Guide.

Troubleshooting

This section provides information about tracing, logfiles, and troubleshooting scenarios for OMi
Performance Dashboard.

Tracing

You can enable tracing to troubleshoot OMi Performance Dashboard. To enable OMi Performance
Dashboard log level to Debug or Trace in 1log4j . properties, go to the following locations:

Windows: %TOPAZ_HOME%\conf\core\Tools\log4j\pmi\log4j.properties
Linux: $TOPAZ_HOME/conf/core/Tools/log4j/pmi/log4j.properties

You must set all 1og47j.category to DEBUG or TRACE

Log Files

The OMi Performance Dashboard and BVD log files are available at the following locations:
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OMi Performance Dashboard

Windows: %»TOPAZ_HOME%\log\pmi\pmi.log
Linux: $TOPAZ_HOME/log/pmi/pmi.log
BVD

To check the logdfiles related to integration of OMi Performance Dashboard with BVD, check the
following locations:

Windows: %TOPAZ_HOME%\1log\pmi\bvd. log
Linux: $TOPAZ_HOME/log/pmi/bvd.log

Troubleshooting Scenarios

Event Overlay does not work correctly
Problem: Events do not appear in the graph charts.

Solution: To resolve this problem, you need to zoom in and check the events. It could be possible that
the events are overlapping.

Real Time Graphing displays error message

Problem: Real Time graphing displays error message stating No data found error.... in OMi
Performance Dashboard.

Solution: To resolve this problem, follow these steps:
For Operations Agent version 12 Cls:

1. Check if HPCS is running by using the URL: http://<systemname:portno>/hpcs/lwistatus
For example, http://hostnamel:383/hpcs/lwistatus

2. Check if data is loaded from the system by running the URL:
http://<systemname:portnumber>/hpcs/v2/Metrics/all Forexample,
http://hostnamel:383/hpcs/v2/Metrics/all

3. IfHPCS is not running, start the HPCS service using the following command:
# ovc -restart hpsensor

4. Check if the HP Ops OS Inst to Realtime Inst LTU license is enabled
oalicense -get -all

5. Ifthe HP Ops OS Inst to Realtime Inst LTU license is not enabled, you can enable HP
Compute sensor license on the Cl using the following command:

# oalicense -set -type PERMANENT "HP Ops 0S Inst to Realtime Inst LTU
6. Restart HPCS service using the following command:
# ovc -restart hpsensor

For Operations Agent version 11 Cls:

1. Check if the HP Ops OS Inst to Realtime Inst LTU license is enabled by running the following
command:

oalicense -get -all
2. If HP Ops OS Inst to Realtime Inst LTU license is not enabled, enable RTM license on the Cl
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using the following command.

# oalicense -set -type PERMANENT "HP Ops OS Inst to Realtime Inst LTU
The LTU is set successfully

Restart perfd component and rtmd component.

Check if the RTM component of Operations Agent is running on the node.

Check perfd and rtmd are running on the node.

I

If the components are not running, start the perfd component and rtmd component on the node.
Real Time graphing is not updated every 5 seconds

Problem: Real Time graphing is not updated for every 5 seconds in OMi Performance Dashboard for
Operations Agent version 12 Cls.

Solution: To resolve this problem, follow these steps:

1. Change the HPCS data collection interval by editing the HPCS configuration file.
#vi /var/opt/perf/hpcs.conf
Change collection_Interval value whichis in seconds and save the file.
3. Restart HPCS service using the following command:
#ovc -restart
Restart OMi Performance Dashboard from Operations Agent
Go to OMi Performance Dashboard and in the Performance pane, click Refresh.

6. Choose the option Clear Cache to reload the OMi Performance Dashboard data collection from
HPCS.

Performance Dashboard is not loading
Problem: Performance Dashboard is not loading and not working as expected.
Solution: Check the network log, for any failures in URL calls.
To check the network log, follow these steps:

1. Press F12in the browser, the debug panel appears.

2. Select Network tab in the debug panel.
Inconsistency in the data shown in the performance dashboard
Problem: Inconsistency in the data shown in the performance dashboard.
Solution: To resolve this problem, follow these steps:
1.In the Performance pane, click Refresh.

2. Select the Refresh option from the drop down. The performance dashboard will be updated with
latest data.

3. You can use the following URL to make sure that data is coming for the required time interval.

http://<HOST_NAME>/OVPM/rest/1.0/data/graphdata?ciid=<CI_
ID>&class=<CLASS>&ds=<DATASOURCE>&endtime=<END_TIME>&instances=<INSTANCE_
NAME>&interval=<INTERVAL>&metrics=<METRIC_NAME>&starttime=<START_TIME>
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Instances are added in a Cl but not available in OMi Performance Dashboard

Problem: The instances are available in a Cl but not able to view the instances in OMi Performance
Dashboard.

1. In the Performance pane, click Refresh.
2. Select Clear Cache from the the drop down

Cl Type tree does not appear
Problem: In Performance Dashboard Mappings, Cl Type tree does not appear in the left pane
Solution: To resolve this problem, follow these steps:

1. Check if Adobe flash player is installed in the browser.

2. If Adobe Flash Player is installed, check if it is enabled. If it is disabled, enable it.

Cl Type tree loads with error message

Problem: Cl Type tree loads with error message

Solution: To resolve this problem, you need to log out from OMi and login to OMi.
Save icon is not enabled

Problem: In the Performance Dashboard Mappings, the save icon is not enabled.
Solution: To resolve this problem, follow these steps:

1. If you make any changes, the Save option is enabled.

2. Toenable Save option, you can edit the Cl Attribute or Assigned Dashboards.
Performance Dashboard Mappings does not change locale in Internet Explorer
Problem: Performance Dashboard Mappings does not change locale on Internet Explorer.
Solution: To resolve this problem, follow these steps:

Close all the tabs of the browser.
Open the browser again.

Open the OMi console.

Logon with the credentials.

a e Dd -~

Click Administration > Operations Console > Performance Dashboard Mappings

Real-Time Graph Window Stops Receiving Updates

Problem: A performance dashboard drawn with metrics obtained from the RTM data source stops
receiving updates if the HPE Operations agent (or the RTM component of the agent) on the node that
hosts the RTM data source stops running. The performance dashboard title bar shows no data point.

Solution: When the HPE Operations agent (or the RTM component of the agent) starts running on the
node again, the performance dashboard window starts showing the updated data.

SiteScope Real Time is not working
Problem: SiteScope Real Time is not working

Solution: To resolve this problem, follow these steps:
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Check if configured SiteScope version is 11.22 or above.

2. Check connectivity with the SiteScope server from OMI server. You need to ensure that the
SiteScope server is up and running.

3. Check monitored_by attribute of the Selected CIin OMicontains SiteScope. If SiteScope is
not available then there could be a synchronization issue with SiteScope to OMi. Contact
SiteScope or OMi team.

4. Check if the Integration XML is available at the following location:

Windows: %ovdatadir%\shared\server\conf\perf\pmiworkdir\data\SiteScope RTM GC_
Integration.xml

Linux: /var/opt/0V/shared/server/conf/perf/pmiworkdir/data/SiteScope RTM GC_
Integration.xml

5. In SiteScope, click Preferences and perform the following steps:
Search/Filter tag
a. Check if Filter is created

b. Click group containing monitors or a monitor and click Properties > Search/Filter tag. Check
if the filter is listed and the option is enabled.

c. Click Properties > Monitor run settings > Frequency and check if frequency is set to 15
seconds for the monitors for which RTM data is not showing up in OMi Performance
Dashboard.

Integration Preferences

a. Click Integration Preferences. Check if Data integration is added. If data integration is not
added, see SiteScope documentation.

b. If the data integration is available, select a data integration , click Edit and check for the
following configurations
i. Check if the Receiver URL is OMi Performance Dashboard listener URL. For example,
http://<OMI_HOST_ NAME>/OVPM/SiteScopeDataReceiver

ii. Check if the Encodingis UTF-8.

iii. Check if the Reporting Intervalis 15 seconds.

iv. Check ifthe Time Synchronization Intervalis 10 minutes.
v. Check if the GZIP compression only.

vi. Check the Web Server Security Settings, Specify the username and password to
access the OMi Performance Dashboard if the OMi Performance Dashboard is
configured to use basic authentication. Otherwise, leave blank

vii. Inthe Reporting Tags, check if the filter applied on monitors is selected.

6. Check for the configured receiver URL in SiteScope, if there are any errors in the data_
integration.log file of SiteScope installed machine.

a. Check <Sitescope_Installed Folder>\log\data_integration.logfile.

If error exists then configured receiver URL is incorrect. For more information, see SiteScope
documentation.

b. If there are no errors in the log file then enable debug mode for SiteScope data integration log
file.

Cc. In<Sitescope_Installed
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Folder>\conf\core\Tools\log4j\PlainJava\log4j.properties file , change following
text:

log4dj.category.dataIntegration=${loglevel}, data.integration.appender
to
log4j.category.datalntegration=DEBUG, data.integration.appender

d. Enable OMi Performance Dashboard log level to Trace in log4j.properties
Windows: %TOPAZ_HOME%\log\pmi\pmi.log
Linux: $TOPAZ_HOME/log/pmi/pmi.log ()

6. Check if RTM data as shown in the following text is getting logged for the selected monitor.
com.hp.pm.core.adapter.metric.SiSRTMDataReceiver:doPost() -> RTM XML Content
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<performanceMonitors collector="SiteScope" collectorHost="martellvm8">

<group name="Demo_Monitors" desc="">

<monitor type="Memory" target="IWFVMOO127.hpswlabs.adapps.hp.com"
targetIP="16.183.88.177" time="1417567245958" quality="1" name="Memory monitor
on iwfvm@e127">

<counter value="49" quality="" name="percent used"/>
</monitor>
</group>

</performanceMonitors>

SiteScope Historical Data is not working
Problem: SiteScope historical data is not working
Solution: To resolve this problem, follow these steps:

Check if configured SiteScope version is 11.22 or above.

2. Check if SiteScope server is configured in OMi > Administration > Setup and Maintenance
>Connected Servers

3. Check connectivity with the SiteScope server from OMi server. You need to ensure that the
SiteScope server is up and running.

4. Check monitored_by attribute of the Selected Cl contains SiteScope. If SiteScope is not
available, then there is a synchronization issue with SiteScope to OMi.

5. Check if the Integration XML is available at the following locations:

Windows: %ovdatadir%\shared\server\conf\perf\pmiworkdir\data\SiteScope GC_
Integration.xml

Linux: /var/opt/0V/shared/server/conf/perf/pmiworkdir/data/SiteScope GC_
Integration.xml

6. Analyze the OMi Performance Dashboard log file for any errors or exceptions:
Windows: %TOPAZ_HOME%\log\pmi\pmi.log
Linux: $TOPAZ_HOME/log/pmi/pmi.log
In the logfiles, check the following:
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7.

Check if Connected Server API returns SiteScope server data.

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:loadMeta() -> Sitescope
Connected Server size : 1

Check if RTSM API returns monitors data for the selected ClI.

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:loadMeta() -> Number of

Serversthe selected CI associated with 1

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:loadMeta() -> Selected CI's

Serve Name martellvm8.ind.hp.com

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:loadMeta() -> Selected CI's
Topology Monitor Map size 2

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:loadMeta() -> Selected CI's

Monitor Name Demo_Monitors/CPU Monitor on iwfvmee127
Check if SiteScope DAL API returns data to OMi Performance Dashboard

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:loadMeta() -> Querying

Sitescope DAL API with query parameters

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:getMonitorsForASiSServer()

-> Full Server Name martellvm8.ind.hp.com

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:getMonitorsForASiSServer()

-> Short Server Name martellvm8

com.hp.pm.core.adapter.metric.SiSHelper:getHistoryData() -> Getting SiS

History data

com.hp.pm.core.

martellvm8

com.hp.pm.core.

-> SiS histroy

com.hp.pm.core.

->Monitor List

com.hp.pm.core.

Output sizevia

com.hp.pm.core
size 2

com.hp.pm.core.adapter.metric.SiSDAMetricAdapter:loadMeta()
Sitescope DAL API with query parameters

com.hp.pm.core.adapter.metric.SiSHelper:getDataFromDALApi()
data from Sitescope DAL API: ; nested exceptionis: java.net.

adapter.metric

adapter.metric
mapsize 1

adapter.metric
size.. 3

adapter.metric
DAL 3

.adapter.metric

Connection refused: connect

com.hp.pm.core.adapter.metric.SiSHelper:getDataFromDALApi()

.SiSHelper:getHistoryData() -> Server Name

.SiSDAMetricAdapter:getMonitorsForASiSServer()

.SiSDAMetricAdapter:getMonitorsForASiSServer()

.SiSDAMetricAdapter:loadMeta() -> Monitor

.SiSDAMetricAdapter:loadMeta() -> Final Output

If SiteScope server is down then you see the following connection refused exception in the log file:

-> Querying

-> Error getting
ConnectException:

-> AxisFault

faultCode: {http://schemas.xmlsoap.org/soap/envelope/}Server.userException

faultSubcode:
faultString: java.net.ConnectException: Connection refused:connect

8. If there is any data request error, you see the following exception in the log file:
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com.hp.pm.core.adapter.metric.SiSHelper:getDataFromDALApi() -> Error getting
data from Sitescope DAL API:
com.mercury.sitescope.api.data.exception.RequestDataExceedLimitException: Error
Code: 77104.

Error Description: Request from start date Tue Sep 02 04:06:14 IST 2014 to Wed
Sep 03 04:06:14 IST 2014 resources are over the configured maximum limit: 20 MB
(approximate request resources size is 660MB).

Process succeed for time range: Tue Sep 02 04:06:14 IST 2014 to Tue Sep 02
04:49:39 IST 2014.

You need to change the resource size limitation. Go to SiteScope infrastructure preferences and
change Data acquisition API single request size value.

Check if the data is getting logged for these monitors in SiteScope Server with status good from
current time to last one day.

<Sitescope_Installed_Folder>\logs\Sitescope.log

Favorites to compare same metrics of different Cls does not display data

Problem: Favorites to compare same metrics of different Cls does not display data. This happens
when the Cls for which the metrics are compared, do not have the system time set as per the time zone
of the region.

Solution: For the Favorites to display data, make sure that the system time is set to the time zone of
the region where the Cls are located.

OMi Performance Dashboard does not forward data to BVD end point

Problem: OMi Performance Dashboard does not forward data to BVD end point

Solution: To resolve this problem, follow these steps:

1.

In OMi, check if endpoint details are configured in bvdcont. json file.
Windows: %0vDataDir%shared\server\conf\opr\bvdconf.json
Linux: /var/opt/0V/shared/server/conf/opr/bvdconf.json

In OMi, click Administration > Setup and Maintenance > Infrastructure Settings. In the
Applications list, select Performance Dashboard.

Check if following settings are configured:

a. Endpoint Name - Name of the endpoint to which the OMi Performance Dashboard data is
forwarded. It must match the endpoint name specified in the bvdconf.json file.

b. Turnon Data forwarding to Endpoint by setting it to true

In OMi, click Workspaces > Operations Console > Performance Perspective, check if
Favorites are available and Enable/Disable data forward to BVD option is set for the Favorite.

After all these configurations are done and still OMi Performance Dashboard is not forwarding data
to endpoint then check bvd. log file for any errors or exceptions:

Windows:: %TOPAZ_HOME%\log\pmi\bvd. log
Linux:: $TOPAZ_HOME/log/pmi/bvd. log

If there is any parsing exception related to endpoint, then make sure that you have added proper
json endpoint details in bvdconf. json file.
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7. Check for the following errors or exceptions in the log file:

Predefined performance dashboards are not listed when NIC is selected

BVD - Data not available to post means data not available from datasource - You need

trouble shoot datasource for not getting data.

BVD - Failed to post data to endpoint with status code - You need to check if endpoint is

accessible from OMi server. If not make sure add proxy settings in bvdconf. json

BVD - Error posting data to endpoint - Check if configured endpoint URL is valid and also

proxy details are valid.

Problem: When you select the MAC address of an NIC as a Cl from the View Explorer, the
corresponding predefined performance dashboards are not listed. This is because while creating the
Performance Dashboard Mappings, the NIC name is mapped to the predefined performance
dashboards and not the MAC address.

Solution: You can select the corresponding host to view the predefined performance dashboards.

VPV integration issues

Problem: Unable to integrate OMi Performance Dashboard with vPV

Description: To resolve this problem, follow these steps:

1.

Check if the monitored_by attribute of the Selected Cl in OMi contains vPV. If it does not contain
vPV then there could be a synchronization issue with vPV to OMi. Contact vPV team.

Check if the Integration XML is available in the following locations:

Windows: %ovdatadir%\shared\server\conf\perf\pmiworkdir\data\vPV_GC_

Integration.xml

Linux: /var/opt/0V/shared/server/conf/perf/pmiworkdir/data/vPV_GC_

Integration.xml

Check if the time configured in both OMi and vPV is same.

Check instance information in RTSM Response:
<graphParameters>

<systemNames>

<systems>
<systemName>16.184.47.225</systemName>
<port>8444</port>

</systems>

<systems>
<systemName>martell.ind.hp.com</systemName>
</systems>

</systemNames>

<instanceNames>

<instance>
<instanceName>martell.ind.hp.com</instanceName>

<graphParameters>
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<systemNames>

<systems>

<systemName>16.184.47.225</systemName>

<port>8444</port>

</systems>

<systems>

<systemName>martell.ind.hp.com</systemName>

</systems>

</systemNames>

<instanceNames>

<instance>

<instanceName>martell.ind.hp.com</instanceName>
5. Check if metadata that is querid using Rest API to vPV server is successful

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:loadMeta() -> In
loadMeta - The selected CI id c751a5dccc27daafd9922abcael580b4

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:loadMeta() -> The
selected CI typeunix

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:loadMeta() -> The
selected CI Name syspulsevm200.ind.hp.com

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:loadMeta() -> The
selected CI's Server Name 16.184.47.225

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:loadMeta() -> The
selected CI's Server Port 8444

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getRestOutputData()
-> The resturl
https://16.184.47.225:8444/PV/api/v1l/loadmeta?name=syspulsevm200.ind.hp.com&typ
e=unix&context=PMI

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:queryRestAPI() ->
The response status code 200

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getRestOutputData()
-> Connection to vPV Rest url is success

6. If querying via Rest API fails, then you see following error in the log file

com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getRestOutputData() -> The
rest url
https://goldrch7vm8.ind.hp.com:8444/PV/api/v1l/loadmeta?name=goldrch7vm7.ind.hp.
com&type=unix&context=PMI

com.hp.pm.core.adapter.metric.AbstractMetricAdapter:queryRestAPI() -> Error
occured while connecting to vPV rest url

com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getRestOutputData() ->
Failed to get response from the vPV rest url with status code ©
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com.hp.pm.core.adapter.metric.AbstractMetricAdapter:loadMeta() -> vPV Output
for the selected CI is null or empty

7. Forchecking the URLs, open a new tab in the same browser where OMi is launched. Copy the
URL to the new tab and launch them.

8. Valid JSON response should be retrieved
9. Check if data queried from Rest API from vPV is successful.

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getDataRows() -> In
GetDataRows

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getDataRows() ->
Instance Full Name 16.184.47.225/VCENTER_HOST__ 2

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getDataRows() ->
Instance Name VCENTER_HOST__ 2

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getRestOutputData()
-> The rest url
https://16.184.47.225:8444/PV/api/vl/getdatarows?instanceId=VCENTER_HOST_
2&className=VCENTER_
HOST&metrics=CPUPhysTotalUtil&summarizeMins=5&startEpochMillis=14483214390008&en
dEpochMillis=1448364639000

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:queryRestAPI() ->
The response status code 200

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getRestOutputData()
-> Connection to vPV Rest url is success

INFO : com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getDataRows() -> Get
data rows row count 143

10. Open a new tab in the same browser where OMi is launched. Copy the URL to the new tab and
launch them. Valid JSON response should be retrieved.

11. If initstring configured in vPV is not correct then you see following exception in the log file:

com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getRestOutputData() -> The
rest url
https://goldrch7vm8.ind.hp.com:8444/PV/api/v1l/loadmeta?name=goldrch7vm7.ind.hp.
com&type=unix&context=PMI

com.hp.pm.core.adapter.metric.AbstractMetricAdapter:queryRestAPI() -> Error
occured while connecting to VPV rest url.

com.hp.pm.core.adapter.metric.AbstractMetricAdapter:getRestOutputData() ->
Failed to get response from the vPV rest url with status code 401 (forbidden
access)

12. Check if SSO (Single Sign-On ) is configured properly in vPV server similar to OMi.

13. In OMi, click Administration > Users > Authentication Management > Single Sign-On
Configuration

14. Check for Token Creation Key (initString). Logon to vPV server machine and check for
initString in the following location:

/opt/0V/www/webapps/PV/WEB-INF/classes/lwssofmconf.xml
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The OMi Health Status tab displays the health information of the OMi deployment. To ensure efficient
operations, OMi keeps track of the health of its components and reports problems so that a corrective
or preventive action can be taken.

OMi Health Status contains the following panes that provide the health status of OMi self-monitored
components, display a list of related events and show how the health status of the selected object
affects the health of the related objects in a view:

« Monitoring Dashboard - OMi Health Status

The health status of each OMi object is displayed using the following widgets: simple status, pie,
and history. Each widget references an OMi area for which the health-related information is
displayed or provides an overall health status summary of all self-monitored objects.

Widgets enable you to quickly determine the status of the monitored area by displaying a color that
reflects the severity of the most critical event (for example, red for the severity critical). The number
of events per severity is shown as well.

Each widget references an event filter and a view, and only displays the status of those events that
match the filter criteria and are related to the configuration items included in the referenced view.
When you click a widget, the information on the related OMi self-monitored area is passed to the
Event Browser and the Top View components. As a result, the Event Browser displays only the
matching events and the Top View displays the view associated with the widget.

For more information on widgets and monitoring dashboards, see "Monitoring Dashboard" on
page 233.

The following widget group is part of the OMi Server self-monitored area of the OMi Health Status
monitoring dashboard:

o Event Processing

This widget displays the status information on the health of the event processing. It monitors a
number of OMi log files, including the log files for the OMi Marble Status Calculation and the
processing of the OMi JMS bus event queue. The events displayed in the Event Browser are
created for the monitored log file entries with the severity ERROR.

o Job Handling

This widget displays the status information on the health of the deployment jobs. The critical
events displayed in the Event Browser may relate to various job deployment issues, for example,
failed policy templates transfer from the OMi server to monitored nodes, or the problems with
transferring the assignment information from nodes to the server.

o OMi Server Processes

This widget displays the status information on the health of the OMi server processes. The
events displayed in the Event Browser result from monitoring the OMi Nanny process log file, as
well as from monitoring if the Nanny process itself is up and running.

Note: The OMi Nanny process monitors all processes running on an OMi system. If an OMi
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process fails, Nanny restarts it automatically and records this information to a separate log
file.

o OMi Server Infrastructure

This widget displays the status information on the health of the OMi server infrastructure
(resulting from monitoring the disk 10 operations and space utilization of the system).

The status indicator next to OMi Server combines all statuses displayed by related widgets. It takes
the most critical status as the overall status indication (for example, if a critical issue is detected in
one area, the indicator color changes to red).

The following widget group is part of the Operations Agent self-monitored area of the OMi Health
Status monitoring dashboard:

o Agent Health

This widget provides the status information on the health of the HPE Operations Agent. The
events displayed in the Event Browser are generated from internal messages sent by the agent
(they may include agent communication problems and failed processes).

o Agent Connectivity

This widget provides the information on the HPE Operations Agent connectivity status. The
events displayed in the Event Browser are related to the agent's heartbeat checking: if no
heartbeat event is received from the agent within the configured interval, an event indicating a
problem is created.

The History chart is a status-trend widget that displays the number of events per severity against
time.

The Overall chart is a pie-chart widget that gives an at-a-glance overview of the severity of all
events occurred over a certain period of time. It is divided into colored status slices, each slice
representing a number of events having a critical, warning, or normal state.

Note: The widget selected in Monitoring Dashboard - OMi Health Status determines which
events are displayed in the Event Browser and which view is selected as the Top View.

« Event Browser

Displays a detailed summary of the events that occur in the OMi self-monitored environment. The
list of events is updated dynamically based on the widget selection in the Monitoring Dashboard -
OMi Health Status. For more information, see "Event Browser" on page 28.

o Top View

Displays a topological view of the configuration items (Cls) affected by the events displayed in the
Event Browser pane. The view shows the relationships between the Cls that represent the
monitored objects and indicates their current health status. The color of an object displayed in the
Top View takes the most critical status of the contributing objects: if at least one critical issue is
detected, the entire Cl is marked red. (The color used depends on the view settings. For example,
you can set green for a normal and red for a critical state.)

Two views that are integrated with the OMi Self-Monitoring are OMi Deployment and OMi
Deployment with Operations Agent.

For more information on the Top View, see "Top View Component" on page 165.
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Note: The size of all panes on the OMi Health Status tab can be manually modified. You can use
the Expand and Collapse buttons to change the display formats to the predefined settings or open
each pane in a new window.
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on OMi User Guide (Operations Manager i 10.10)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to ovdoc-asm@hpe.com.

We appreciate your feedback!

E . | =
Go OMi!


mailto:ovdoc-asm@hpe.com?subject=Feedback on OMi User Guide (Operations Manager i 10.10)
https://hpln.hpe.com/group/operations-manager-i-omi
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